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Preface

Welcome to the Opsware Server Automation System (SAS) — an enterprise-class
software solution that enables customers to get all the benefits of the Opsware data
center automation platform and support services. Opsware SAS provides a core
foundation for automating formerly manual tasks associated with the deployment,
support, and growth of server and server application infrastructure.

This guide describes how to use Opsware SAS, starting with an introduction to the system
and how to navigate the user interface. It provides information about managing servers,
operating system provisioning, managing software packages, provisioning applications,
managing patches, reconciling servers, script execution, configuration tracking, and
deploying and rolling back code. This guide is intended for system administrators who are
responsible for all aspects of managing and provisioning the servers in an operational
environment.

Contents of this Guide

This guide contains the following chapters and appendices:

Chapter 1: Introduction to Opsware SAS: Provides a high-level overview of Opsware
SAS, including the system features, Web Service APIs, and multimaster.

Chapter 2: Getting Started with the Opsware Command Center: Includes information
about supported operating systems and browsers, navigation of the user interface, and an

explanation of each of the features found on the Opsware Command Center Home page.

Chapter 3: Getting Started with OCC Client: Includes information about how to get
started using the OCC client, the user interface, the client installation and launch, and
OCC Client main features.

Chapter 4: Server Tracking in the OCC: Provides information about server asset
tracking, server lists, server search, server histories and reports.
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Chapter 5: Exploring Servers and Jobs in OCC Client: Provides information browsing
servers, server groups, and jobs, also includes information about copying files on a
managed server’s file system.

Chapter 6: Opsware Agent Management: Includes information about Opsware Agents
on managed servers, the Opsware Discovery and Agent Deployment feature, and
Opsware Agent reachability communication test.

Chapter 7: Server Management in Opsware Command Center: Provides information
about all aspects of server management including server groups, server life cycle, server
locking, and service levels.

Chapter 8: Server Compliance: Includes information about the server compliance and
auditing features, and explains how to create snapshots, differencing servers, and
auditing servers.

Chapter 9: Visual Packager: Provides information about creating software packages
from managed server information, and includes such topics as how to configure the OCC
Client to access a packaging server, how to create a package, and explains different
methods of software packaging.

Chapter 10: Global Shell: Provides information about the Global Shell, the Opsware
Global File System, setting user and group permissions with the Global Shell, accessing
the Global Shell and remote terminals on servers, and explains Global Shell commands.

Chapter 11: Distributed Script Execution: Describes script types, permissions required
for scripting tasks, script version history, and how to create, edit, and delete scripts. It also
discusses script execution for all script types, script execution results, and scripting error
resolution.

Chapter 12: Patch Management for Windows: Provides information about managing
patches for the Windows 2000, Windows 2003, and Windows NT4.0 operating systems.
These patches include Service Packs, Update Rollups, and hotfixes. It describes the user
roles: a policy setter, a patch administrator, and a system administrator. It also describes
reconciling, previewing (an install), installing, and uninstalling patches.

Chapter 13: Patch Management for Unix: Provides information about managing
patches for Unix operating systems. It discusses patch types, testing, and installing and
uninstalling patches. It review the roles of the patch administrator and system
administrator in applying patches, and the permissions required for performing patch
management.
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Chapter 14: Software Provisioning: Provides information about installing and
uninstalling software and using templates for installation.

Chapter 15: Operating System Provisioning: Provides information about supported
environments for OS provisioning and an overview of the permissions and server life
cycles associated with OS provisioning. It also describes the process for provisioning, an
overview of the hardware preparation, information about booting new servers, and using
the Opsware Command Center to install operating systems.

Chapter 16: Application Configuration Management: Provides information about
managing application configurations through the OCC Client, and includes such topics as
creating Application Configurations, Application Configuration inheritance, editing value
sets, and applying Application Configurations to a server.

Chapter 17: Configuration Tracking: Provides information about configuration tracking
policies, the supported types of configuration files and databases, how changes are
detected, node-based tracking policies, and the tracking policies for a specific server. It
also discusses reconciling customized tracking policies, performing manual backups,
viewing backup history, restoring backed up files, and enabling and disabling
configuration tracking.

Chapter 18: Code Deployment and Rollback: Provides information about uploading
code and content to staging, and performing services, synchronizations, and sequences
to deploy code and content to managed servers.

Appendix A: Reconcile: Reviews the server reconciliation process and how it works, with
an in-depth discussion of how to perform a reconcile, reconcile and package metadata,
installation and uninstallation order, adopted software, patches and reconcile, and
reconcile preview. Types of reconcile are also discussed, along with reconcile on
supported operating systems, reconcile and scripts, reconcile output, assigning servers to
and removing servers from nodes, and the Reconcile Software Wizard.

Appendix B: Opsware Agent CLI Utilities: Provides information about installing

Opsware Agent using the Opsware Command Line Interface and the Agent Upgrade Tool.

Appendix C: Communication Test Troubleshooting: Provides troubleshooting
information to diagnose Opsware Agent unreachability problems.

Appendix D: Content Pack: Describes content for Opsware SAS application
configurations, selection criteria for snapshots, and Global Shell scripts.

Appendix E: Glossary: Defines terminology and acronyms that are unique to Opsware
SAS.
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Conventions in this Guide

This guide uses the following typographical and formatting conventions.

Bold Identifies field menu names, menu items, button names, and
inline terms that begin with a bullet.

Courier Identifies text that is entered or displayed at the
command-line prompt, such as Unix commands, Opsware
SAS commands, file names, paths, directories, environment
variable names, contents of text files that are viewed or edited
with a text editor, source code in a programming language,
and SQL (database) commands.

ltalics Identifies document titles, DVD titles, web site addresses.
Used to introduce new terms when they are first defined in a
document and for emphasis.
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Icons in this Guide

This guide uses the following iconographic conventions.

This icon represents a note. It identifies especially important
concepts that warrant added emphasis.

(I

This icon represents a requirement. It identifies a task that
must be performed before an action under discussion can be
performed.

<

This icon represents a tip. It identifies information that can
help simplify or clarify tasks.

)

This icon represents a warning. It is used to identify significant
information that must be read before proceeding.

=
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Guides in the Documentation Set and Associated Users

+ The Opsware® SAS User’s Guide is intended to be read by the system administrator
who is responsible for performing the day-to-day functions of managing servers,
provisioning operating systems, uploading packages, setting up the Software Tree and
node hierarchies, attaching software applications and installing them on servers,
managing patches, reconciling servers with software, creating and executing scripts,
tracking configuration, and deploying and rolling back code and content. It also
documents the day-to-day functions of managing servers, such as server compliance
and auditing, software packaging, application configuration, agent deployment, and
global shell remote data center management.

+ The Opsware® SAS Administration Guide is intended to be read by Opsware
administrators who will be responsible for monitoring and diagnosing the health of the
Opsware SAS components.

* The Opsware® SAS Deployment and Installation Guide is intended to be used by
system administrators who are responsible for the installation of Opsware SAS in a
facility. It documents how to run the Opsware Installer and how to configure each of the
components.

« The Planning Deployments for Opsware® SAS is intended to be used by advanced
system administrators who will be responsible for planning all facets of an Opsware
SAS installation and deployment. It documents all the main features of Opsware SAS
and scopes out the planning tasks necessary to successfully deploy Opsware SAS.
Sections include: planning the Opsware SAS design for a core, types of installations,
and discusses business goals that can be achieved using the software. It also includes
information on system sizing, checklists, and best practices.

+ The Opsware® SAS Configuration Guide is intended to be used by system
administrators who are responsible for all facets of configuring the Opsware Command
Center. It documents how to set up users and groups, how to configure Opsware server
management, and how to set up the main Opsware Command Center features, such
as patch management, configuration tracking, software repository replicator setup,
code deployment, and software provisioning.

Opsware, Inc. Contact Information

The main web site and phone number for Opsware, Inc. are as follows:

* http://www.opsware.com/index.htm

* +1(408) 744-7300
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For links to the latest product documentation and software downloads, see the Opsware
Customer Support site:

* https://download.opsware.com/opsw/main.htm

For troubleshooting information, you can search the Opsware Knowledge Base at:
* https://download.opsware.com/kb/kbindex.jspa

The Opsware Customer Support email address and phone number follow:
+ support@opsware.com

* +1(877) 677-9273
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This section discusses the following topics:
+ Overview of Opsware SAS

+ Types of Opsware Users

+ Opsware SAS Features

» Opsware SAS Terms and Concepts

Overview of Opsware SAS

Opsware SAS provides a core set of features that automate critical areas of server and
application operations — including the provisioning, deployment, patching, and change
management of servers — across major operating systems and a wide range of software
infrastructure and application products.

Opsware SAS does not just automate your operations, it also allows you to make changes
more safely and consistently, because you can model and validate changes before you
actually commit the changes to a server. Opsware SAS helps ensure that modifications to
your servers work on your first attempt, thereby reducing the risk of downtime.

Using Opsware SAS, you can coordinate many operations tasks, across many IT groups
with everyone working with the same understanding of the state of servers, applications,
and configurations. This coordination ensures that all IT administrators have full
knowledge of the current state of the environment before further changes are made.

Opsware SAS allows you to incorporate and maintain operational knowledge gained
through long hours of trial-and-error processes. After an administrator has found and
tested a procedure or configuration, that knowledge can be translated into a model that is
stored in a central repository. This allows you to continue to benefit from the operational
knowledge gained by your system administrators, even if they are no longer working in
your organization.
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The following figure provides an overview of how Opsware SAS automates server and
application operations across all major platforms and a wide range of applications. Each
feature that is shown in the diagram is discussed in the following sections.

Figure 1-1: Overview of Opsware SAS Features
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Types of Opsware Users

The following table identifies the types of Opsware users and their responsibilities.

Table 1-1: Types of Opsware Users

Data Center and Operations | After manually racking and stacking servers, manage
Personnel customer facilities and boot bare-metal servers over the
network or from an Opsware boot image.

System Administrators Install operating systems and applications (for example,
Solaris 5.7 or WebLogic 6.0 Web Server), upgrade
servers, create operating system definitions, and set up
software provisioning.

Site Engineers and Deploy custom code on servers.
Customer Project Managers

In addition to the Opsware users listed above, this guide describes the following three
types of users:

« End Users are responsible for all aspects of managing and provisioning the servers in
an operational environment. In the Opsware SAS documentation, these users are
referred to as Opsware users or system administrators. These users log into the
Opsware Command Center and OCC Client and use these interfaces to manage
servers in their [T environment.

- Opsware Administrators are the users, with special training and information, who are
responsible for installing and maintaining Opsware SAS. In the Opsware SAS
documentation, these users are referred to as Opsware administrators. They use the
Administration features in the Opsware Command Center to manage Opsware SAS and
Opsware users (by adding user accounts and assigning permissions for different levels
of operation and access), to add customers and facilities, and to change Opsware SAS
configurations. They monitor and diagnose the health of Opsware SAS components.
Opsware administrators need to understand how Opsware SAS features operate to
support users and Opsware SAS.

» Policy Setters are the power users who are responsible for architecting what Opsware
SAS will do in the managed environment; for example, they determine which operating
systems can be installed on your managed servers and how those operating systems
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will be configured during installation. Policy setters, for example, prepare specific

features in Opsware SAS by defining the Software Tree, preparing Operating System
Definitions, and acting as Patch Administrators to approve patches for installation in the
operational environment.

Opsware SAS Interfaces and Tools

Depending on the type of operation you need to perform with Opsware SAS, you select
the appropriate user interface, as Figure 1-2 shows.

Figure 1-2: Interfaces in Opsware SAS
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+ Opsware Command Center: The web-based user interface to Opsware SAS through
which users can manage servers, provision applications and operation systems onto
servers, run distributed scripts on servers, and deploy code and content to servers,
among other things.

+ OCC Client: A Java Web-Start application that extends the Opsware Command Center

(OCC) features and provides the following new features:

Discovery and Agent Deployment
Server Explorer

Server Compliance

— Visual Packager
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— Application Configuration Management

— Global Shell

Opsware Command Line Interface (OCLI): A command line interface that users can
use to upload packages to the Opsware Software Repository (version 1), and perform
many other Opsware SAS operations (version 2).

DCML Exchange Tool (DET): A utility that enables users to export almost all server
management content from any Opsware core — standalone or multimaster mesh — and
import it into any other Opsware core. Opsware SAS can also provide pre-packaged
server management content appropriate for new installations that can be imported into
a core after initial setup. See the Opsware® SAS DCML Exchange Tool (DET)
Reference Guide for information about using this utility.

ISM Development Kit: A development kit that consists of command-line tools and
libraries for creating, building, and uploading ISMs. An ISM is a set of files and
directories that include application bits, installation scripts, and control scripts. See the
Opsware® SAS ISM Development Kit Guide for information about using the ISM
Development Kit.

Opsware Web Services APIs: A standards-based programming environment built on
open industry standards such as SOAP (Simple Object Access Protocol) and WSDL
(Web Services Definition Language). The Web Services API enables the integration of
applications and other systems with Opsware SAS. This broadens the scope of how IT
can use Opsware SAS to achieve operational goals

Opsware SAS Features

Opsware SAS is made up of a set of Opsware SAS features. Opsware SAS features are

the components that automate particular IT processes.

The features are designed to replace ad hoc, error-prone, manual processes. For example,

by using the OS Provisioning feature, users can set standards for different types of servers
and automatically provision the servers, saving time and ensuring that operating system
builds are consistent. By using the Patch Management feature, users can establish
polices about how patches are installed. Opsware SAS uniformly enforces those polices.

The following features are currently available as part of Opsware SAS:
+ Software Provisioning

+ Operating System Provisioning
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« Patch Management for Unix

+ Patch Management for Windows

+ Code Deployment & Rollback

+ Configuration Tracking

» Script Execution

« Data Center Intelligence Reporting
« Discovery and Agent Deployment
» Server Explorer

» Server Compliance

 Visual Packager

» Application Configuration Management

+ Global Shell
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All Opsware SAS features support cross-platform environments and are designed to
automate both new and existing data center environments. See the following figure

Figure 1-3: Opsware SAS Features
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Software Provisioning

The Software Provisioning feature provides a systematic way to install, configure, and
remove packaged software across Windows, Unix, and Linux servers distributed across
different data centers. The Opsware SAS unique model-based approach enables many
different teams, such as the system administration team, the database team, and the
application development team, to manage the same set of servers. Each of these teams
has a common view of the environment.

The Software Provisioning feature leverages the Opsware SAS model-based approach,
which provides the following unique capabilities and benefits:

¢ Detailed information about the latest system state and configurations

The Software Provisioning feature automatically creates and updates two lists: the list of
software that users indicate should be installed on a server and the list of software that
is actually installed on a server. By maintaining this detailed model of the server’s
current state, Opsware SAS helps keep different IT groups managing the same server
in sync and ensures that all groups making server changes are working with the same
knowledge of the current state of the environment.

Using this model, Opsware SAS enables multiple groups to manage the same server
without stepping over each other’'s changes. An accurate model of the software
installed on a server, granular role-based access control, a unified audit trial, and the
ability to rollback changes, all contribute to the Opsware SAS ability to coordinate the
activities of many different administrators managing the same server.

¢ Integration with other automation functions

The Software Provisioning feature is fully integrated with other Opsware SAS features,
enabling software provisioning to be performed automatically with other tasks, such as
operating system provisioning. Because software provisioning shares the same
environment model as the other functions, the state of the environment is always
known. This means that different groups, such as OS administrators, application
administrators, security administrators, and others, can work together and communicate
more effectively.

¢ Simulation of software installation and removal

The Opsware SAS provisioning engine simulates installation and uninstallation actions
before it applies changes to production servers. Users can view the list of software
packages to be added or removed before they authorize Opsware SAS to execute the
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change. This ensures that all changes are pre-tested and validated before propagating
changes to the production environment.

An up-to-date model of the actual server environment

Opsware SAS regularly refreshes its view of what is installed on a server, including both
hardware and software. This real-time understanding of server state and configurations
ensures that administrators provision the right software to the right servers at the right
time. It also ensures that dependencies and prerequisites are checked and installed as
needed.

Sophisticated role-based access control

Opsware SAS enforces a security policy that allows only authorized users to install or
remove particular types of software on a particular server. For example, companies can
define an access control rule that permits only DBAs to add or remove database
software from a server.

A unified audit trail

Opsware SAS maintains a comprehensive audit trail of the software that Opsware users
install, configure, and remove from a server. When combined with the additional events
that Opsware SAS tracks — including configuration updates, business application
pushes and rollbacks, hardware upgrades, and executed scripts — organizations gain a
complete view of server activity over time.

The ability to rollback to a last known good state

The Software Provisioning feature allows users to back out of software provisioning
operations. In the event an upgrade or installation goes awry, administrators can back
out the change to return to the last known good state.

Ability to store powerful name-value pairs

Opsware SAS helps organizations increase software package re-use by enabling
administrators to install the same software package on different servers. Server-specific
configuration values are fetched from Opsware SAS (or calculated based on those
values).
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Operating System Provisioning

The OS Provisioning feature gives administrators the ability to provision operating system
baselines onto bare metal servers quickly, consistently, and with minimal manual
intervention. Bare metal OS provisioning is a key part of the overall process of getting a
server into production.

Benefits of the OS Provisioning feature include the following items:
+ Integration with the other features of Opsware SAS

Because the OS Provisioning feature is integrated with the suite of Opsware SAS
automation capabilities, including patch management, software provisioning, and
distributed script execution, handoffs between IT groups are seamless. Opsware SAS
ensures that all IT groups are working with a shared understanding of the current state
of the environment, which is an essential element of delivering high-quality operations
and reliable change management.

« The ability to easily update server baselines without re-imaging servers

Unlike many other OS provisioning solutions, systems provisioned with Opsware SAS
can be easily changed after provisioning to adapt to new requirements. The key to this
benefit is the Opsware SAS use of templates and its installation-based approach to
provisioning.

¢ Flexible architecture designed to work in many environments

Opsware engineers carefully designed the OS Provisioning feature to handle many
different types of servers, networks, security architectures, and operational processes.
Opsware SAS works well in floppy (Windows provisioning), CD (Linux provisioning), or
network-boot environments, with scheduled or on-demand workflows, and across a
large variety of hardware models. This flexibility ensures that you can provision
operating systems to suit your organization’s needs.

Opsware SAS automates the entire process of provisioning a comprehensive server
baseline, which typically consists of the following tasks:

» Preparing the hardware for OS installation
+ Installing a base operating system and default OS configuration

« Applying the latest set of OS patches, the exact list depends on the applications
running on the server
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+ Installing system agents and utilities such as SSH, PC Anywhere, backup agents,
monitoring agents, or anti-virus software

+ Installing widely-shared system software such as Java Virtual Machines

» Executing pre-installation or post-installation scripts that configure the system with
values such as a root password

Patch Management for Unix

The Patch Management for Unix feature provides two features critical to patch
management: the ability to react quickly to newly-discovered threats and the degree of
control required to ensure that a new patch has been properly tested and installed in a
uniform way.

Opsware SAS has a deep understanding of native patch formats and structure. System
administrators upload patches directly into Opsware SAS, which understands and
respects the structure of those patches in their native forms. It treats Solaris patch
clusters, for example, differently from AIX APARs. Native patch support greatly increases
both the flexibility and reliability of patch installation.

The Patch Management for Unix feature provides the following functionality:

+ Scalable, cross platform patch deployment

» Reduced risk throughout automated patch rollback

« A central, shared patch repository to improve access

+ Secure access control

« The ability to install patches on one server, or simultaneously on many servers

« The ability to schedule automated future installation (for example, to take advantage of
maintenance windows)

« The inclusion of patches in the template for an operating system, so all newly
provisioned servers receive the most up-to-date set of recommended patches

Code Deployment & Rollback

Opsware SAS automates code and content deployment to reduce the risk and time
requirements associated with pushing new code to production. The Code Deployment &
Rollback (CDR) feature provides an automated system for deploying code (such as, ASP,
JSP, JAR, Java, C++, and Perl files) and content (such as, HTML, JPEG, GIF, and PDF
files).
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Specifically, CDR enables you to perform the following actions:

» Push code from staging or development environments to production environments.
+ Synchronize code and content across multiple servers and locations.

+ Automatically rollback to the previous version of code or content.

« Sequence multiple, complex deployment steps into repeatable workflows.

+ Manage changes across heterogeneous operating systems.

Configuration Tracking

The Configuration Tracking feature tracks, backs up, and recovers critical software and
system configuration information across Unix and Windows servers.

System administrators set up policies that describe the configuration files and databases
to track, and the actions to take when a change in configuration is detected. Policies can
be assigned to software, individual servers, groups of servers, and customers, and
applied either locally or globally across data centers.

When Opsware SAS notices a server configuration change, it can log the change, notify
administrators about the change with email, or back up the configuration, depending on
the policy set by the administrator.

When a bad configuration change forces administrators to rollback to a previous version,
they can use Opsware SAS to restore the configuration file to the saved version of the
configuration. By notifying users about configuration changes — and maintaining a version
history of those changes — organizations can quickly diagnose problems related to
configuration errors and rollback to a known good state. In addition, this capability helps
teams plug security holes inadvertently created by bad server configurations.

Typically, system administrators define configuration-tracking policies on a per-application
basis. So for example, a policy for BEA WebLogic might specify, “Monitor the
weblogic. conf file, notify app-server-admins@company.com of any changes, and
maintain a version history of any changes that occur for 30 days.” After a policy is defined
in this fashion, administrators can apply the policy to all the WebLogic servers running in
their environment or to specific servers.

Script Execution

The Script Execution feature enables you to share and run ad-hoc or custom scripts
across an entire farm of Opsware-managed servers.
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By executing scripts with Opsware SAS instead of manually, administrators benefit by
using the following features:

.

Parallel script execution across many Unix and/or Windows servers, saving time and
ensuring consistency.

Role-based access control, ensuring only authorized administrators can execute scripts
on hosts to which they have access.

The ability to control access to scripts by storing them in private or in public libraries.

The ability to see and download script output one server at a time or in a consolidated
report, which captures output from all servers in a single place.

The ability for scripts to be mass-customized. Administrators can access information in
Opsware SAS about the environment and the state of servers. This is critical to ensuring
that the right scripts are executed on the right servers.

A comprehensive audit trail that reports who, what, when, and where a particular script
was executed.

The ability to rollback changes (when used in conjunction with the Configuration
Tracking feature).

Automatic backup of all private and shared scripts to all other Opsware-managed data
centers (when used in conjunction with an Opsware Multimaster Mesh).

Because the Script Execution feature is an integrated part of Opsware SAS, administrators
enjoy unigue benefits when compared to standalone script execution tools:

Using known system state and configuration information to customize script execution,
users can tailor each script by referencing and accessing the rich store of information in
Opsware SAS, such as the customer or business that owns the server, whether the
server is a staging or production server, which facility the server is located in, and
custom name-value pairs.

By sharing scripts without compromised security, users can share scripts with each
other without compromising security because Opsware SAS maintains strict controls on
who can execute scripts on which servers and generates a comprehensive audit trail of
script execution.
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Data Center Intelligence Reporting

Every change made to your managed servers is recorded in the Opsware SAS Model
Repository. The Model Repository maintains precise information about the state and
configuration of every server under your management.

You can now take advantage of this information though the Opsware SAS Data Center
Intelligence Reporting (DCI) component. The DCI provides accurate, detailed, and up-to-
date information about your operational environment. The DCI provides a new level of
visibility into your operational environment that can help organizations make better
decisions.

DCI reporting provides the following features and benefits:
+ Exact information about the latest system state and configurations

DCl reports display the most accurate and up-to-date information available, even during
periods of frequent and substantial change. This level of accuracy reduces your risk of
making the wrong decisions because of old data.

+ Visibility across the data center environment

Opsware SAS provides a comprehensive view across all operating systems and
locations, allowing IT managers to generate on-demand snapshots driven from a
single, high-quality data source. The ad-hoc capability allows you to view a variety of
report types, filter by specific criteria, and display summary graphics or list views. In
addition, a set of Quick Reports are pre-designed for one-click access to real-time
information from the Reports Home page.

« Accurate and detailed change history information

When a server’s performance suddenly degrades, the best way to diagnose the cause
is to learn the changes made to the server and who made the changes. Often, talking
with the people who made the changes can help you understand the cause of the
performance degradation.

In most facilities, however, it's often difficult, if not impossible, to find out a server's
exact change history, since records are not accurately kept. But Opsware SAS
maintains a detailed record of each change: who made the change, what was the
nature of the change, and when it occurred. This record is presented in a
comprehensive series of reports; these reports can significantly reduce the time and
effort in debugging server and software problems.
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* A comprehensive set of patch reports

One of the most time-consuming aspects of patching servers is identifying the
vulnerable servers. Data collection for this task typically involves manually logging in to
each server to see if it contains a particular version of software, what patches are
already installed on the server, and what patches are not installed on the server.
Opsware SAS helps administrators avoid this up-front effort by offering a
comprehensive set of patch management reports.

¢ The ability to extend the DCI reports

You can create new reports or modify the reports that ship with Opsware SAS. Opsware
SAS provides the database necessary for creating reports.

The Reports Home page checks for any new custom reports that you create, and
presents them on the Reports Home page for easy access to all users. These reports
are created by using the readily available Crystal Reports Designer 9.

New reports can be extended to integrate with your own data sources (databases,
spreadsheets, XML, and so forth), creating a powerful tool for more advanced data
intelligence.

See the Opsware System DCI Administrator's Guide for information about how to set
up the DCI Reporting component.

See the online Data Center Intelligence help and tutorial documentation for information
about how to use and run the reports.

The Opsware Data Center Intelligence Reporting component is an optional component.
By default, it is not installed with Opsware SAS. If this reporting component is not available
for your organization, contact your Opsware Support Representative for information about
how to obtain it so that you can generate reports. The DCI component must be installed
and running in order to access the online documentation.
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Discovery and Agent Deployment

The Opsware Discovery and Agent Deployment (ODAD) feature allows you to deploy
Opsware Agents to a large number of servers in your facility and place them under
Opsware management.

Using the ODAD features, you can perform the following tasks:
« Scan your network for servers.
+ Select servers for Opsware Agent installation.
« Select a communication tool and provide user/password combinations.

+ Choose agent installation options and deploy agents.

Server Explorer

The Server Explorer lets you view information about servers in your managed
environment.

From the Server Explorer, you can perform the following tasks:

« Create a server snapshot, perform a server audit, audit application configurations,
create a package, and open a remote terminal session on a remote server.

« Browse a server's file system, registry, hardware inventory, software and patch lists,
and services.

« Browse Opsware information such as properties, configurable applications, and even
server history.

From the Server Groups Browser, you can perform the following tasks:
+ Audit system information, take a server snapshot, and configure applications.
» View and access group members (servers and other groups).

+ View group summary and history information.

Server Compliance

The Opsware Server Compliance feature enables you to compare existing servers to a
known working server and perform an audit that shows the difference between the two.
With the audit results, you can investigate and identify servers that are not performing
well. troubleshoot them and fix the malfunctioning servers.

Using Opsware Server Compliance, you can perform the following tasks:
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« Compare servers or snapshots to reference servers or snapshots.
+ Create compliance audits for repeated use.
+ Associate audits with individual servers or dynamic server groups.

+ Remediate problems at multiple levels, including files, directories, patches, registry
keys, and packages.

Patch Management for Windows

The Patch Management for Windows feature enables you to identify, install, and remove
Microsoft® Windows patches and maintain a high level of security across managed
servers in your organization. With OCC Client user interface, you can identify and install
patches that support security vulnerabilities for the Windows 2000, Windows 2003, and
Windows NT4.0 operating systems. These patches include Service Packs, Update
Rollups, and hotfixes.

Visual Packager

The Create Package feature allows you to create an installable software package from a
managed server and from server compliance information, such as server snapshots and
audit results. File system objects that are recorded in snapshots and compliance
information produced by audits help you define the content of a package. In turn, you can
use that package to update a server with new or missing server objects.

Create Package enables you to selectively package server objects according to the
operating system of the servers that you want to distribute the package to, supporting
both Unix and Windows operating systems.

It allows packages to contain the following objects:

+ A Unix package can contain files (including attributes), directories, packages, patches,
and patch clusters.

+ A Windows package can contain files (including attributes), directories, packages,
patches, Windows registry, and Windows services.
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Application Configuration Management

Opsware Application Configuration Management (ACM) allows you to create templates so
you can modify and manage application configurations associated with server
applications. ACM enables you to manage, update, and modify those configurations from
a central location, ensuring that applications in your facility are accurately and consistently
configured.

Using ACM, you can perform the following tasks:

+ Manage configurations based on files and objects, such as Windows registry, IS
metabase, WebSphere, COM+, and more.

+ Preview configuration changes before applying them.

+ Edit and push configuration changes to individual servers or server groups.

« Use information in the Opsware data model to set configuration values.

* Manage configurations of any application by building configuration templates.

+ Audit the Application Configurations on a server to determine if any of the
configuration files on the server are out of sync with the values stored in your
templates.

Global Shell

The Opsware Global Shell feature enables you to manage servers by using a command-
line interface. You can remotely perform the following tasks:

« Complete routine maintenance tasks on managed servers.
+ Troubleshoot, identify, and remediate problems on managed servers.

Global Shell consists of a file system and a command-line interface to that file system for
managing servers in Opsware SAS. The file system is known as the Opsware Global File
System (OGFS). All object types in the OGFS (such as servers, customers, and facilities)
are represented as directory structures in this file system.

The Global Shell feature also manages user permissions for accessing the file system,
Windows Registry, and Windows Services objects on managed servers.

Opsware SAS Terms and Concepts

This section discusses the following topics:

« Agent-Server Architecture of Opsware Technology
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+ Opsware SAS Model-Based Approach

+ Opsware SAS Model and Server Management

« Software Tree, Nodes, Packages, and Templates
+ Software Tree Nodes and Server Management
» Packages and Server Management

+ Templates and Server Management

+ Server Management in Multiple Facilities

» Multimaster Support

Agent-Server Architecture of Opsware Technology

The agent-server architecture of Opsware SAS enables server management. The server

portion of Opsware SAS consists of multiple, integrated components, each with a unique
purpose. Each server managed by Opsware SAS runs an intelligent agent (the Opsware

Agent).

Figure 1-4: Opsware SAS Agent-Server Architecture
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See the Opsware® SAS Administration Guide for a detailed description of the
components that make up the Opsware SAS server portion of the architecture.

The Opsware Agent is the agent of change on a server. Whenever Opsware SAS needs to
make changes to servers, it does so by sending requests to the Opsware Agents.
Depending on the request, the Opsware Agent on a server might use global Opsware
SAS services in order to fulfill the request. For example, the Opsware Agent might often
make requests to the Model Repository, the central database for all Opsware SAS
components, and the Software Repository, the central repository for all software that
Opsware SAS manages.

Some functions that the Opsware Agent supports are:
+ Software installation and removal

« Configuration of software and hardware

« Periodically reporting server status

+ Auditing of the server

An Opsware Agent is idle unless Opsware SAS is trying to perform some change on the
server. In addition, each Opsware Agent periodically contacts the Data Access Engine
and registers itself. The Data Access Engine is an XML-RPC interface to the model
repository. The Data Access Engine sends this data to the Model Repository, which allows
the Model Repository to keep track of server status, and know when particular servers are
disconnected from or reconnected to the network.

After you install an Opsware Agent on a server, users can manage the server by installing
or upgrading software, patching the OS software, removing software, changing server
properties, or decommissioning the server.

See “Agent Reachability Communication Tests” on page 204 in Chapter 6 for information
about how to install an Opsware Agent on a server so that Opsware SAS can manage it.

Opsware SAS Model-Based Approach

Opsware SAS employs a methodical, model-based approach, using a centralized
information system as the starting point for any changes made to the physical
environment. This information system approach to initiating change into the environment
means that when team members need to make a change, they model the change first to
verify and validate the change. Next, they let Opsware SAS propagate that change out to
the environment in a secure, consistent, quick, and reliable manner.
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Figure 1-5 gives a high-level view of the steps involved when users interact with the
model.

Figure 1-5: High-Level View of User-Model Interaction
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Opsware SAS includes three additional components to automate core functions. The role
of these components is to provide policies, environment state information, and a
comprehensive audit log for activity and asset reporting.

e Software Tree

The Software Tree records a variety of information for software applications and
operating systems, including, for example, data about how changes to a given software
application might impact other existing applications.

¢ Environment Tree

The Environment Tree manages characteristics about a customer’s unique facility
environment, including hardware, location of servers, network infrastructure, application
names, business units, and service levels assigned to servers and applications. The
information contained in the Environment Tree, combined with the data contained in the
Software Tree, is used by Opsware SAS to model and simulate operational changes
before they are executed in the production environment.
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¢ Modeling and Change Simulation Engine

Opsware SAS enables users to first model and simulate proposed operational changes
to their environment before propagating these changes to production servers and
applications. Utilizing the information contained in the Software and Environment Trees,
the Modeling and Change Simulation Engine maintains a model of the various
hardware and software configurations and other customer characteristics associated
with each of the production servers under Opsware SAS control.

Before committing any proposed changes to the production servers, this engine first
conducts an impact analysis of the requested operation, enabling customers to test
and validate changes prior to executing them in the production environment. This
feature of Opsware SAS is designed to increase the success rates associated with
initial deployments, improve the accuracy and security of these changes, and reduce
application downtime.

Opsware SAS Model and Server Management

Opsware SAS employs a model-based approach to managing the operational
environment. Users interact with the Opsware Command Center to accomplish OS
provisioning, software provisioning, patch management, and server asset tracking for the
operational environment. When users work in Opsware SAS, they work in the model, and
Opsware SAS pushes the changes to the managed environment by reconciling the
managed environment with the model. See Figure 1-6.
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See “Opsware SAS Model-Based Approach” on page 68 in this chapter for information
about how Opsware SAS is model-based.

Figure 1-6: Opsware SAS Model-Based Approach to Server Management
Opsware Driven
Changes Policy Enforcement Manual Changes

Q ®

Managed Environment

-

The Opsware Command Center visualizes the model as a tree called the Software Tree.
By using the Software Tree, Opsware SAS enables users to embed technical best
practices by specifying software installation order and by creating templates.

Asset & Activity Tracking

Before system administrators can use Opsware SAS to manage servers in the operational
environment, the operational environment must be modeled in the Opsware Command
Center.

A policy setter for your organization performs this goal by completing the following setup
tasks:

+ Defining the Software Tree applications that are available to install on the servers
running in your environment

See the Opsware® SAS Configuration Guide for more information about software
provisioning setup.

» Uploading the packages that you will use in the operational environment
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See the Opsware® SAS Configuration Guide for more information about package
management.

« Creating templates so that users can quickly install a complete software baseline on
servers in the environment

See the Opsware® SAS Configuration Guide for more information about creating
templates.

« Setting up OS provisioning by preparing OS definitions for the operating systems that
you need to install on your servers

See the Opsware® SAS Configuration Guide for more information about OS
provisioning setup.

+ Setting up the patch management by uploading the required patches for your
environment.

See the Opsware® SAS Configuration Guide for more information about setting up
patch management.

After a policy setter completes these setup tasks, end-users are ready to manage the
servers running in the operational environment. These setup tasks do not need to be
repeated by end users for them to manage servers.

Software Tree, Nodes, Packages, and Templates

To understand the way that Opsware SAS manages servers through the Opsware model,
you need to understand the distinctions between the following elements in the model:

+ The Software Tree and its nodes

« Packages uploaded to the Software Repository and added to nodes

+ Templates that model complete software baselines

Software Tree Nodes and Server Management

The Software Tree organizes all the technology building blocks of your organization’s
environment, including the software and hardware. The Software Tree is made up of
nodes and subnodes, modeling the interrelationships and dependencies among the

software and customer accounts in the operational environment. Users navigate the
Software Tree to perform specific operations.
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Using nodes simplifies server management within Opsware SAS and the management of
the software applications and configurations associated with those servers. Nodes are a
hierarchical set of categories or types that classify software, configuration, and other
components running in the operational environment.

The Software Tree provides the model for the operational environment, as shown in

Figure 1-7.

Figure 1-7: lllustration of the Software Tree
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In the Opsware Command Center, you create nodes in the Software Tree. From the
navigation panel, click Software » Applications. The Applications page appears. As you
navigate the Software Tree, you see the hierarchy of nodes in each category of
applications, as shown in Figure 1-8.

Figure 1-8: Hierarchy of Nodes within an Application Category
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The Software Tree has the following characteristics:

Each point in the Software Tree is called a node.

The node information at the top of the Software Tree is more general, and as you travel
farther down the tree, each successive subnode contains more detailed and specific
information that relates to the node above it.

A node inherits properties or software from the nodes above it.
Users can add nodes and subnodes within each category.

Software or a server might be assigned to a node depending on its location in the
Software Tree.

See the Opsware® SAS Configuration Guide for more information about setting up the
Software Tree for software provisioning.

The user's guide primarily documents how servers are automatically assigned to and
removed from nodes when you use one of the Opsware wizards to install or uninstall
software. Using an Opsware wizard is an efficient and easy method to assign or to
remove servers from nodes.

In certain situations, you might want to use the Software Tree and the reconcile
operation to install or uninstall applications from managed servers.

See “Assigning to and Removing Servers from Nodes” on page 710 in Appendix for
more information.

Assigning a server to a node determines the software that is installed on the server and
its configuration.
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Users perform the following tasks for servers by using nodes:
» Locating servers and viewing the nodes to which they are assigned
« Copying the configuration (assigned to nodes) of a server to other servers

+ Assigning servers to and removing servers from nodes (so that you can install or
uninstall software by running the reconcile operation).

See “Reconcile” on page 699 in Appendix A for more information.

See the Opsware® SAS Configuration Guide for more information about how to set up
the Software Tree in the Opsware Command Center so that end users can install
applications on managed servers in Opsware SAS.

Packages and Server Management

In Opsware SAS, packages contain software that is registered in the Software Repository.
Packages contain software for operating systems, applications (for example BEA
Weblogic, IBM WebSphere), databases, customer code, and software configuration
information.

Packages are made available in Opsware SAS by uploading the packages to the Software
Repository with the Opsware Command Center or by using the Opsware Command Line
Interface.

The term package describes the collection of executables, configuration, or script files
that are associated with an Opsware SAS-installable application or program.

See the Opsware® SAS Configuration Guide for more information about managing
packages in Opsware SAS.

Templates and Server Management

Opsware templates allow you to group related sets of software so that they can be
installed in a single operation by using the Opsware wizards. The two basic types of
Opsware templates are:

« Templates that include the installation of an operating system
« Templates that do not include an operating system

You can, for example, use Opsware templates to quickly bring new servers into
production. A template might include an operating system for a new server, the latest
security patches for the operating system, plus all the applications required to run a full-
fledged web service. Or, you can use templates to install a new service, made up of a set
of applications and patches, on servers that are already in production.
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Templates require little set up, and you can create them and deploy them quickly. To
create a template, select packages, patches, or operating systems that are already
configured and tested for installation, and add them to the template. You can later edit the
template. For example, if a new patch is released, you can edit the template and add the
patch to the template.

See the Opsware® SAS Configuration Guide for more information about creating
templates.

Server Management in Multiple Facilities

The managed environment might span several facilities. A facility refers to the collection of
servers that a single Opsware Model Repository manages, and the database that stores
information about the managed environment. For example, one facility might be
dedicated to an organization’s Intranet, while another facility might be dedicated to the
web services offered to the public. Your Opsware SAS can contain facilities (a full
Opsware SAS is installed) and Satellite facilities. See Figure 1-9.

Figure 1-9: Server Management in Multiple Facilities
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See the Planning Deployments for Opsware® SAS for more information about the types of
installations that Opsware SAS supports.
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Users can manage servers in any facility from an Opsware Command Center in any
facility. When a user updates data in a facility, the Model Repository for that facility is
synchronized with the Model Repositories located in all remote facilities.

When using Opsware technology in multiple facilities, users should follow these work
process rules to reduce the chance of data conflicts between facilities:

« Users should not change data in one facility and then make the same change in
another facility.

« More than one user should not change the same object in different facilities at the
same time. For example, two users should not manage the same server from different
facilities.

Multimaster Support

With the Opsware Model Repository Multimaster Component, customers can store and
maintain a blueprint of software and environment characteristics of each data center
(referred to as a facility in the Opsware Command Center) in multiple locations so the
infrastructure can be easily rebuilt in the event of a disaster. The Multimaster Replication
Engine not only provides the ability to replicate an environment in case of a disaster, but
can also assist in facility migration activities as well as knowledge sharing across the
enterprise.
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Through the Model Repository Multimaster Component, Opsware SAS provides the ability
to easily rebuild server and application environments, provision additional capacity,
distribute updates, and share software builds, templates and dependencies — across
multiple facilities and from one user interface. See Figure 1-10.

Gt

Figure 1-10: Multimaster Support
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Chapter 2: Getting Started with the Opsware
Command Center

This section provides an overview of the Opsware Command Center and discusses the
following topics:

+ Getting Started with the Opsware Command Center
» Access to Features in the Opsware Command Center

» Opsware Command Center User Interface

Getting Started with the Opsware Command Center

The following section describes Supported Browsers for the Opsware Command Center
(a web application) and Browser Configuration Requirements.

Supported Browsers for the Opsware Command Center

The following table lists the supported browsers for the Opware Command Center.

Table 2-1: Supported Browsers for the Opsware Command Center

Microsoft

Internet X
Explorer

55

Microsoft

Internet X X X
Explorer

6.0

Mozilla 1.6 X X X
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Table 2-1: Supported Browsers for the Opsware Command Center

Firefox 1.0 X X X

Browser Configuration Requirements

To run the Opsware Command Center, your browser must be configured in the following
manner:

« The browser must accept cookies and be able to use Java.
« The browser must support SSL and should provide 128-bit encryption (recommended).

+ Using a pop-up blocker might prevent some functions from working correctly. Either
disable the pop-up blocker completely or use the supported browser's native pop-up
blocking function instead of a third-party product.

Access to Features in the Opsware Command Center

This section explains how to configure your user profile to access features within the
Opsware System. This section contains the following topics:

« System Management of Opsware User Information
» Best Practices for Selecting Passwords

» Updating User Profiles and Passwords

System Management of Opsware User Information

An Opsware administrator creates additional users who can use the Opsware Command
Center, and the Opsware administrator assigns them temporary passwords. Once added
to the system, an Opsware user can update their personal information, password, and
time zone and date display preferences by using the My Profile link.

An Opsware user cannot change their access permissions by using the My Profile link. If
an Opsware user needs additional access permissions, they contact their Opsware
administrator.
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Best Practices for Selecting Passwords

Th
au
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.
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e Opsware Server Automation System (SAS) enforces a security policy that allows only
thorized users to log into the Opsware Command Center. Opsware users are advised to
lect a password based on the following guidelines:

Change your password frequently to ensure that your account information is secure.
Select a password that is easy to remember so that you don't have to write it down.

Use a mixture of upper and lower case letters, numbers, and punctuation in your
password.

Do not share your password.

Do use a password that you can type quickly, without having to look at the keyboard.

Updating User Profiles and Passwords

As an Opsware user you can change your name, contact information, password, and
preferences such as time zone and date display. You cannot change your access
permissions. Contact your Opsware administrator to change your access permissions.

Perform the following steps to change your profile and password.

~ o

Log into the Opsware Command Center. The Opsware Command Center Home
Page appears.

Click the My Profile link located at the top of the page. The Edit My Profile Page
appears.

To change your profile information, enter new information in the Edit My Profile Page.
Click Save.

To change your password, click the Change Password Link. The Password Change
page appears.

Enter your old password.
Enter your new password.
Confirm your new password in the Confirm Password field.

Click Save. A confirmation page appears indicating that your password was
successfully changed.

Click Okay. The Edit Profile page appears.
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Opsware Command Center User Interface

The following section discusses getting started with the Opsware System and contains
the following topics:

» Requirements for Logging In

+ Overview of the Opsware Command Center User Interface
+ My Profile

+ Search

« My Servers

* Mouseover Icon Tooltips

Requirements for Logging In

In order to log in and access Opsware Command Center features, your Opsware
administrator must have created a login ID and password for you, and assigned user
permissions that control the features you can access and the actions you can take when
you use them.

Overview of the Opsware Command Center User Interface

The Opsware Command Center user interface consists of the five following sections:
* Home Page

+ Tasks

+ My Jobs

+ My Customers

« Navigation Panel
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Home Page

Figure 2-1 shows the Home page as it appears when you log in or when you click the

Home link in the navigation bar.

Figure 2-1: Opsware System Home Page
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The time zone that appears in the upper right corner of the Home page is taken from the

time zone preference that was defined for you when your profile was created.

Consequently, the date and time information that displays throughout the Opsware

Command Center is for that time zone. The occasional exceptions however are always

labeled GMT.
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Tasks

The Tasks area of the Home page displays links to the wizards that you have permissions
to access, a link to the Data Center Intelligence reports if you have that module installed,
and a link to the Code Deployment page if you have that permission. If you do not have
permissions to a task in this area, the task name still displays, but it is italicized and it is
not an active link. Figure 2-2 shows the Tasks area with all permissions enabled.

Figure 2-2: Tasks Area of the Home Page
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The My Jobs area of the Home page is populated with details of the jobs that you have
run, jobs that are currently in progress, or jobs that you have scheduled to run, including
the name of the job, the start time, the number of servers affected by the job, and the
status of the job. If there are more than six jobs, you can see the rest of them by clicking
the See All link, which also shows the total number of jobs in parentheses, as Figure 2-3
shows.

If the job was run in the OCC Client, then there will be a link next to the job that (when
clicked) will launch the OCC Client. You can view the more detailed information about the
job in the OCC Client.

Figure 2-3: My Jobs Area of the Home Page
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My Customers

The My Customers area of the Home page is populated with customer information,
including unreachable servers associated with a customer and the total number of
servers associated with that customer. To select the customers to display in the My
Customers area of the Home page, click Edit and select the check box next to the
customer name. See Figure 2-4.

Figure 2-4: My Customers Area of the Home Page
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Navigation Panel

The navigation panel on the left side of the Opsware Command Center shows all possible
features, as shown in Figure 2-5. The features you can access and the actions you can
perform depend upon your user profile, as defined by the Opsware administrator.

Figure 2-5: Navigation Panel, All Permissions View
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The items that appear in the navigation panel depend on the permissions the user has.
Clicking an item on the navigation panel displays that feature in the main part of the
Home page. For a user with all permissions, the following links appear:

Home: Displays the top level of the Opsware Command Center. The Home page is
described in this section of the guide. Wizards are documented in their respective
functional areas of the system.

My Jobs: Displays the My Jobs page, showing jobs completed during the previous 30
days, jobs currently in progress, and currently scheduled jobs. This page is an expanded
view of the contents of the My Jobs area of the Home page and has the same effect as
clicking Show All in the My Jobs area of the Home page.

Servers: Expands to display these selections:

« My Servers: Use to add any server or server group to your own personal view of
servers. My Servers provides an efficient way to manage servers when your
operational environment contains hundreds or thousands of servers.

+ Manage Servers: Use filters to display a list of servers and perform operations on
them such as edit server values, assign, reconcile, run scripts, and add servers to My
Servers. See “Server Management in Opsware Command Center” on page 219 in
Chapter 7 for more information.

+ Search: Find specific servers using default criteria or user-defined criteria. See
“Server Search” on page 124 in Chapter 4 for more information.

+ Server Pool: Use filters to display a list of servers, install operating systems on the
servers, and delete the servers. See “Operating System Provisioning” on page 567 in
Chapter 15 for more information.

Software expands to display these selections:

» Operating Systems: Prepare operating systems for installation and delete existing
operating systems. See “Operating System Provisioning” on page 567 in Chapter 15
for more information.

» Patches: Prepare Unix patches for installation and define Unix patch preferences.
See See “Patch Management for Unix” on page 519 in Chapter 13 for more
information.

» Applications: Define nodes in the Software Tree, identify packages to attach to
nodes, and assign servers to nodes. See the Opsware® SAS Configuration Guide for
more information about software provisioning setup.
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+ Templates: Define templates and associate operating systems, patches, applications
and service levels. See the Opsware® SAS Configuration Guide for more information
about software provisioning setup.

+ Packages: Upload packages, browse uploaded packages, and search for packages.
See the Opsware® SAS Configuration Guide for more information about Package
Management.

« Scripts: Run scripts, upload scripts, and create new scripts. See “Distributed Script
Execution” on page 411 in Chapter 11 for more information.

Environment expands to display these selections:

« Customers: Create new customers and edit or delete existing customers. See the
Opsware® SAS Configuration Guide.

« Facilities: Create new facilities, edit facility properties, and assign and edit custom
attributes for facilities. See the Opsware® SAS Deployment and Installation Guide.

« Hardware: A read-only view of servers categorized by the hardware manufacturer
and model, and their related information. See “Hardware Information for Managed
Servers” on page 155 in Chapter 4 for more information.

- Service Levels: Define service levels and custom attributes. See the Opsware® SAS
Configuration Guide for more information.

+ IP Ranges: Identify and create IP ranges and IP range types. See the Opsware® SAS
Configuration Guide for more information.

+ IP Range Groups: Create IP Range Groups. See the Opsware® SAS Configuration
Guide for more information.

Code Deployment expands to display these selections:

+ Deployment Home: The exact CDR links that you see in the Code Deployment area
are based on the permissions that you have for the customer you want to work with.

+ Service Management: Create, modify, and delete service definitions. Services
define the location and commands to manipulate applications on hosts.

* Run Service: Perform service operations on one or more hosts, or request that a
service operation be performed on your behalf. Service operations include starting or
stopping applications, cutting over or rolling back code, and backing up or restoring
code.
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Sync Management: Create, modify, and delete synchronization definitions.
Synchronizations define the path for pushing code from a source host to one or more
destination hosts.

Synchronize: Perform a synchronization to one or more hosts, or request that a
synchronization be performed on your behalf.

Sequence Management: Create, modify, and delete sequence definitions.
Sequences allow the grouping of service operations and synchronization operations
to define higher level code deployment operations.

Run Sequence: Perform a pre-defined sequence of service operations and
synchronizations on one or more hosts, or request that a sequence be performed on
your behalf.

View History: Get information about previously run Code Deployment operations.
See “Code Deployment and Rollback” on page 671 in Chapter 18 for more
information.

Reports: Displays the Data Center Intelligence top-level page (if this module is installed).
See Opsware System DCI Administrator’s Guide for more information.

Administration: Expands to display the following features. For more information about
these features, see the Opsware® SAS Administration Guide and Opsware® SAS
Configuration Guide.

.

Users & Groups: Administrators use this feature to create user groups, define
permissions for those groups, create new administrators, and add users to groups.

Server Attributes: Define and edit server use attributes, enable them for code
deployment, and define deployment stages. Also define and edit server deployment
stage attributes.

System Configuration: Contains the configuration parameters that define how the
Opsware System works in your environment. This selection is only used at the
direction of Opsware Inc.

System Diagnosis: Runs a series of tests on Opsware components to make sure
that they are functioning correctly.

Gateway: Allows you to connect Satellites with this or other cores.

Opsware Software: Provides a view of the properties, custom attributes, installation
order, and history of the software attached to the Opsware nodes in the system.
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The Administration set of features is only available if you are logged in as an Opsware

administrator.

Opsware Command Center Navigation

Top-level navigation from the Home page is simple. To access any of the features in the
navigation panel, click the feature name. To access any of the wizards or other features in
the Tasks area of the Home page, click the name of the task.

After you select a task or a feature, other pages appear, which might have one or more of
the following means of navigation:

Clicking a hyperlinked name to display a page

For example, if you select Software » Applications (assuming that you have the correct
permissions), the page that appears shows all of the applications that have been
uploaded so far. Each application name is a hyperlink that takes you to another page
with information about that application already displayed.

Selecting a tab to display a page

For example, when you select Applications and click one of the hyperlinked application
names, the resulting page shows a row of tabs, like Figure 2-6 shows.

Figure 2-6: Example of Tabs

0 0 0 0 0

Each tab displays a page, each with its own buttons and functionality.
Clicking a button to display a page

For example, when you select the Custom Attributes tab, a page appears with several
buttons: Add, Delete, and Copy, which are common to each page called by these tabs,
and Add Custom Attribute, which is unique to this particular tab. You will find similar
functionality on all tabbed pages in the Opsware System.

My Profile

You can update your own personal user information without the assistance of the
Opsware administrator with the My Profile link. You can change your first and last name,
your contact information, your password, and your time zone and date display
preferences.
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Search
At the top of the Home page open the dialog box as Figure 2-7 shows.

Figure 2-7: Opsware Command Center Search Function

niatmed I G0

Applications
Home JEES

Packages
Server Groups

Tas Service Levels
Templates

You can search for servers, applications (nodes), packages, jobs, server groups, service
levels, and templates by making the selection from the drop-down list, and then entering
an identifying string in the text box.

My Servers

The My Servers feature provides a convenient place to store a set of servers that have
been selected and stored using the Add to My Servers function in Manage Servers. You
might use it as a shortcut to the servers you work with most often, or as a way to gather a
group of servers when you want to apply the same changes to all of them. All functions
that are available in the Manage Servers page are also available from within My Servers.

Mouseover Icon Tooltips

When an icon appears on a page in the Opsware Command Center, a tooltip displays
information about the icon when your mouse pointer hovers over it. For example, server
icons display messages such as “Available or Build Failed” to describe the state of the
server. Packages and patches display messages such as Available, Managed,
Unmanaged, and so forth.
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This section discusses the following topics:

Overview of the OCC Client
Requirements for Running the OCC Client
Installing and Launching the OCC Client
OCC Client User Interface

Accessing OCC Client Options

Overview of the OCC Client

The OCC Client is a powerful, speedy Java client for the Opsware Server Automation
System which provides the responsiveness and look-and-feel of a Microsoft Windows
desktop application with the cross-platform flexibility of Java. Over time, more and more of
the Opsware Server Automation System's features will be available via the OCC Client.

The OCC Client provides the following features:

Discovery and Agent Deployment
Server Explorer

Server Compliance

Patch Management for Windows
Visual Packager

Application Configuration Management

Global Shell

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2006 Opsware Inc. All Rights Reserved.

93



Opsware® SAS 5 User’s Guide

Discovery and Agent Deployment

The Opsware Discovery and Agent Deployment (ODAD) feature allows you to deploy
Opsware Agents to a large number of servers in your facility and place them under
Opsware management.

Using the ODAD features, you can perform the following tasks:
+ Scan your network for servers.
» Select servers for Opsware Agent installation.
+ Select a communication tool and provide user/password combinations.

+ Choose agent installation options and deploy agents.

Server Explorer

The Server Explorer lets you view information about servers in your managed
environment.

From the Server Explorer, you can perform the following tasks:

» Create a server snapshot, perform a server audit, audit application configurations,
create a package, and open a remote terminal session on a remote server.

+ Browse a server's file system, registry, hardware inventory, software and patch lists,
and services.

+ Browse Opsware information such as properties, configurable applications, and even
server history.

From the Server Groups Browser, you can perform the following tasks:
+ Audit system information, take a server snapshot, and configure applications.
« View and access group members (servers and other groups).

« View group summary and history information.

Server Compliance

The Opsware Server Compliance feature enables you to compare existing servers to a
known working server and perform an audit that shows the difference between the two.
With the audit results, you can investigate and identify servers that are not performing
well. troubleshoot them and fix the malfunctioning servers.

Using Opsware Server Compliance, you can perform the following tasks:
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« Compare servers or snapshots to reference servers or snapshots.
+ Create compliance audits for repeated use.
+ Associate audits with individual servers or dynamic server groups.

+ Remediate problems at multiple levels, including files, directories, patches, registry
keys, and packages.

Patch Management for Windows

The Patch Management for Windows feature enables you to identify, install, and remove
Microsoft® Windows patches and maintain a high level of security across managed
servers in your organization. With OCC Client user interface, you can identify and install
patches that support security vulnerabilities for the Windows 2000, Windows 2003, and
Windows NT4.0 operating systems. These patches include Service Packs, Update
Rollups, and hotfixes.

Visual Packager

The Create Package feature allows you to create an installable software package from a
managed server and from server compliance information, such as server snapshots and
audit results. File system objects that are recorded in snapshots and compliance
information produced by audits help you define the content of a package. In turn, you can
use that package to update a server with new or missing server objects.

Create Package enables you to selectively package server objects according to the
operating system of the servers that you want to distribute the package to, supporting
both Unix and Windows operating systems.

It allows packages to contain the following objects:

+ A Unix package can contain files (including attributes), directories, packages, patches,
and patch clusters.

+ A Windows package can contain files (including attributes), directories, packages,
patches, Windows registry, and Windows services.
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Application Configuration Management

Opsware Application Configuration Management (ACM) allows you to create templates so
you can modify and manage application configurations associated with server
applications. ACM enables you to manage, update, and modify those configurations from
a central location, ensuring that applications in your facility are accurately and consistently
configured.

Using ACM, you can perform the following tasks:

+ Manage configurations based on files and objects, such as Windows registry, IS
metabase, WebSphere, COM+, and more.

+ Preview configuration changes before applying them.

+ Edit and push configuration changes to individual servers or server groups.

« Use information in the Opsware data model to set configuration values.

* Manage configurations of any application by building configuration templates.

+ Audit the Application Configurations on a server to determine if any of the
configuration files on the server are out of sync with the values stored in your
templates.

Global Shell

The Opsware Global Shell feature enables you to manage servers by using a command-
line interface. You can remotely perform the following tasks:

« Complete routine maintenance tasks on managed servers.
+ Troubleshoot, identify, and remediate problems on managed servers.

Global Shell consists of a file system and a command-line interface to that file system for
managing servers in Opsware SAS. The file system is known as the Opsware Global File
System (OGFS). All object types in the OGFS (such as servers, customers, and facilities)
are represented as directory structures in this file system.

The Global Shell feature also manages user permissions for accessing the file system,
Windows Registry, and Windows Services objects on managed servers.
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Requirements for Running the OCC Client

Java J2SE v 1.4.2 JRE must be installed on the system that runs the OCC Client. To
download this version of Java, go to http://java.sun.com/j2se/1.4.2/download.html. The
OCC Client is supported on the following operating systems:

* Windows 2003
* Windows 2000

* Windows XP

When using Internet Explorer, if you try to launch the OCC Client without installing Java
J2SE v 1.4.2 JRE, you are prompted to install JRE and run the OCC Client in one step.
When you select this option, Java v 1.4.2 JRE is installed and you get the following error
message: Java Web Start -unexpected Error. Unable to launch OCC
Client. To launch the OCC Client, ignore the error message and click Retry.

Installing and Launching the OCC Client

To access the OCC Client for the first time, you must launch the OCC Client installer from
the Opsware Command Center. You only need to install the OCC Client once.

Once you have downloaded and installed the OCC Client, you can start it from the
following locations:

+ In the Power Tools section of the Opsware Command Center home page

+ On your desktop (an OCC Client program icon is installed to your desktop if you
choose to install one on your desktop)

+ From the Start menu select » All Programs » OCC Client

By default, the core you log into is the core of the Opsware Command Center where you
launched the OCC Client download. You can change the default core by configuring your
general options. See “OCC Client Options” on page 105 in this chapter for more
information.
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To install and launch the OCC Client, perform the following steps:

2]

Launch the OCC and log in.

From the Home page of the OCC, in the Power Tools section, click the Launch OCC
Client link.

If you are a Firefox user, you will be able to open the JSP file to launch the OCC
Client installation. (Internet Explorer users should go to the next step.)

After the OCC Client has downloaded to your computer, the Login window displays,
as seen in Figure 3-1.

Figure 3-1: Login the OCC Client Dialog Box.

¥ please login... |Z||E|rz|

PSWAREFE

SERVER AUTOMATION
User Marne: |
Password:
Core Server: occ,c03, dev.opsware, com

| Login _” Cancel

Enter your user name and password, and click Login. If you have access to more
than one core server, you can enter the core server's IP address or name in the core
server field. If you don't specify a port with the host:port notation, port 443 is used.

If you are asked to accept the certificate from the core server, click Yes. The OCC
Client now appears.
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OCC Client User Interface

The OCC Client user interface provides easy access to all of the OCC Client features and
functionality. The OCC Client user interface has six main areas:

* Menus

« Navigation Pane

Content Pane
* Preview Pane
» Status Bar

Figure 3-2: OCC Client User Interface
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Menus

OCC Client menus include the following menus:

.

File: This allows you to open a new OCC Client window, or close the current window,
or exit all open OCC Client windows.

Edit: This allows you to cut, copy, paste and delete text.

View: This refreshes the current view and shows the latest information from the core
that you are currently logged into. From here, you can also access OCC Client
features in the Navigation pane, such as Servers (server groups, managed and
unmanaged servers), Software Library (application configuration, server compliance,
patch management, Jobs and Sessions (job logs and shell sessions), and Opsware
Administration (patch configuration and compliance rules). This also allows you to
show or hide the Action pane and the Preview pane.

Tools: This allows you to open a Global Shell session or access the OCC Client
options.

Actions: Depending upon the feature that you have selected in the Navigation panel,
this menu allows you to perform numerous functions related to all main OCC Client
features.

Window: This allows you to access multiple instances of OCC Client windows, if
more than one window is open.

Help: This menu provides help for the OCC Client. Help F1 provides context-sensitive
help relevant to the current feature window or dialog box selected or opened (same
as F1). The contents and index will open the OCC Client help system to the main
table of contents. (About OCC Client provides version and system information.)
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Navigation Pane

To access OCC Client features, select a feature in the Navigation pane, as shown in
Figure 3-3. When you select a feature, the contents of it appear in the Contents pane. You
can access functions related to it through the Actions menu or the Actions pane.

Figure 3-3: Navigation Pane

Servers

Zoftwware Likrary

l@’ Application Configuration

2 Compliance

Patches

N Patch Paolicies

= [ wWindowes
[ windows NT 4.0 016
I_;_-‘,'.'.’I I."'.' =
[ windowes 2000 (13)

Jobs and Sessions

Opsware Administration

Content Pane

Depending on the selection in the Navigation pane, the Content pane lists the following
information:

« All managed servers and server groups, including unmanaged servers
« Compliance snapshots and audits

« Patches and patch policies

+ Application Configurations and Application Configuration Templates

« Agent deployment information

+ Jobs that the user has run

+ Access to the Global Shell sessions

+ Patch configuration and patch compliance rules
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You can perform actions on features in the Content area using the Action Menu or Action
Pane, or you can right-click to perform various actions or double-click to open.

Figure 3-4: Feature Content Window Showing Managed Server
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Content Pane Tools
From inside the Content pane, you can perform the following actions:

« With the View drop-down list, you can change the view of a selected feature. For
example, you can select a patch from the Navigation pane, and then from the View
drop-down list, choose Servers to see all the servers that the patch is attached to as
shown in Figure 3-5.

Figure 3-5: View Drop-down List

P Windows 2003

BY win 2003 Patch Palicy G, Test 1
B \windows 2003 MLOS

+ In column headings of the Content pane, you can sort data about a feature. For
example, for a managed servers, you can sort by Name, Patch Compliance, IP
address, OS, and so on.

« With the search tool, you can search the Content pane by feature attribute, as shown
in Figure 3-6.

Figure 3-6: Search Tool

O | acdress | [1921889 |

Preview Pane

The preview pane allows you to preview information about servers, server groups,
patches, and patch policies selected in the Content pane without having to open a new
window.

You can use the Preview pane to perform the following actions:

+ To preview information about a server, server group, patch, or patch policy, select it in
the Content pane.
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« To filter the type of information you view in the Preview pane, from the top of the
content area, choose a view from the View drop-down list.

« To deactivate the Preview pane, from the View menu, select Preview Pane »

Minimize.

For example, if you are viewing Windows 2003 patched from the Software Library, you
can select a patch in the Contents pane and see information about the patch in the

Preview pane. This is shown in Figure 3-7.

Figure 3-7: Main Application Windows Showing Patch Properties Information in the Preview Pane
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If you would like to view other types of information about the selected patch, from the

View drop-down list, choose a view.

Preview Pane Show Filter

Some features displayed in the Preview panes allow you to further filter the feature. Using
the Show drop-down list, you can choose different views of the feature.
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For example, if you are viewing all of the servers that the patch policy is attached to, in the
Preview pane you can select to filter either Servers with Policies Attached or Servers
without Policies Attaches, as shown in Figure 3-8.

Figure 3-8: Show Drop-down List

&/ Windows 2003 MLOS

Status Bar

At the bottom of the OCC Client application window, the status bar provides the following
information:

+ Informational text (left hand side) about the selected object

+ A progress bar that shows progress on retrieving information from the core
* UserID

+ Current Opsware SAS time

Figure 3-9: OCC Client Status Bar
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OCC Client Options

You can configure the following options for the OCC Client:

+ General Options: This enables you to set options such as choosing the core you want
to log into by default, how to handle caching, and so on.

+ Unmanaged Servers: This enables you to set options for the Opsware Agent
Discovery and Deployment (ODAD) feature.

+ Packaging Servers: This enables you to view and specify packaging servers available
on the core.

+ Terminal and Shell: This enables you to configure your Terminal (UNIX) and RDP
(Windows) client for the Global Shell and Remote Terminal connections.
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« Patch Policies: This enables you to specify that a confirmation message will display
when you try to remove a patch policy or a patch policy exception from a managed
server.

Accessing OCC Client Options

To set OCC Client options, perform the following steps:

E From the Tools menu, select Options.

H From the left side of the Set Options dialog box, choose an option.

General Options

The following general options enable you to select your default core:

Core Server Defaults
This option allows you to configure the core that you log into from the OCC Client. Options
include:

* Host: The name or IP address of the Opsware Command Center host that you log into
by default.

+ Port: The port number of the Opsware Command Center host that you log into by
default; 443 is the default.

Cache
This option enables you to configure the caching of data displayed inside the OCC Client.
You can configure the following cache settings:

» Check for updates every X minute(s): Enter a value for how many minutes will pass
before the cache is refreshed.

+ Check Now: Click to check instantly for new information from the core.

* Reload the Cache: Click to immediately reload (refresh) the cache.

Progress Information

This option shows the progress of a job. When a job finishes, the progress window closes.

Unmanaged Servers

These options allow you to control the operation of the ODAD. You can set the following
ODAD options:
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+ Installer Options
» Protocols
» Advanced

See Chapter 6, “Opsware Agent Management” on page 181 of this guide for more
information.

Installer Options

From the Installer Options window, you can set the Installer options and control the
installation of an Opsware Agent on a server. The Installer Options window enables the
following actions:

- Start the Opsware Agent after Installation: Starts the Opsware Agent after installing
it on the server. By default, the Opsware Agent Installer does not start the Opsware
Agent.

+ Remove existing machine IDs and cryptographic material: Removes any existing
machine specific identifying materials, such as Machine ID file (MID), and all machine-
specific cryptographic material from the server.

+ Ignore prerequisite check failures: Ignores prerequisite check failures and forces
Opsware Agent installation.

+ Set the server’s time from the Opsware core: Synchronizes the time on the serverin
which the Opsware Agent is installed with the Opsware core.

« Install Windows Installer (MSI) if required: Installs MSI along with the Opsware
Agent. If MSl is already installed, this option has no effect.

+ Install Windows Management Instrumentation (WMI) if required: Installs WMI
along with the Opsware Agent. If WMI is already installed, this option has no effect.

+ Reboot Windows servers after agent installation: Reboots Windows servers after
Opsware Agent installation is complete.

 Install Red Hat Package Manager (RPM) on AIX and Solaris: Installs the RPM
handler with the Opsware Agent. Opsware recommends that you always include this
option when you install Opsware Agents on Solaris and AlX servers.

* Reset Opsware Agent configuration, if present: Replaces the existing Opsware
Agent configuration.

+ Delete gateway address list, if present: Deletes the Opsware Gateway address list, if
present and is no longer required.
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.

.

Overwrite staged Opsware Agent installer: Overwrites the existing Opsware Agent
Installer.

Log Level: Sets the log level for log messages. With this option, you can specify levels
for error, warning, info, and trace.

Protocols

The Protocol window allows you to specify the standard port to connect to the servers for
deployment. Protocols used are SSH, Rlogin, Telnet, Netbios, and WTS.

.

SSH: The standard port to connect to the servers for deployment using the SSH
protocol.

Rlogin: The standard port to connect to the servers for deployment using the Rlogin
protocol.

Telnet: The standard port to connect to the servers for deployment using the Telnet
protocol.

NetBIOS: The standard port to connect to the servers for deployment using the
NetBios protocol.

WTS: The standard port to connect to the servers for deployment using the WTS
protocol.

Advanced
The Advanced Installer Options window allows you to set the following:

.

Immediately do a full hardware registration: This option forces the Opsware Agent
Installer to report full hardware information to the core.

Immediately do software registration: This option forces the Opsware Agent Installer
to report full software information to the core.

Suppress Opsware Agent reachability check: This option disables this check during
installation. By default, the installer triggers the core to check if the server is reachable.

Disallow anonymous SSL connections if Opsware Agent is dormant: This option
configures the Opsware Agent so that browsers cannot connect without a valid
certificate.

Force creation of new device record if conflict found: This option suppresses this
functionality. During registration, the Data Access Engine creates a new device record.
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Fail if initial hardware registration fails (do not go dormant): This option does not
allow the Opsware Agent to become dormant, if it fails to report hardware information.

Reconcile Type: This option reconciles the server against any nodes assigned to the
server. The reconcile type can be Full or Add only.

Attach to template ID: This option assigns the nodes contained in the template to the
server.

Extra Installer options: This option allows you to specify any other installer options.

nmap parameters: This option allows you to specify parameters used when scanning
for unmanaged servers. If you find that the Opsware Discovery and Agent Deployment
is unable to correctly locate and identify unmanaged servers due to the network firewall
configuration, you can specify a different set of scan parameters. See the nmap
documentation for more information.

Packaging Servers

In
in

Th

order to create packages with the OCC Client, you need to configure a managed server
your Opsware core as a packaging server.

e Set Options window lists all configured packaging servers on the core. To sort the list

alphabetically by operating system, click the OS column heading. To sort this list of

se

rvers by existing configured packaging servers, click the Default Server column

heading. For servers that are already configured as packaging servers, the IP address is
displayed in this column. For servers that are not configured as packaging servers, Not
Configured is displayed in this column.

To
H

configure a packaging server, perform the following steps:
In the right pane, select a managed server and click Edit.

In the Select Server window, select the managed server that you want to configure
as the packaging server and then click Select. In the Set Options window, the
Default Server column will now display the IP address of the server. (Before you
configured this as the packaging server, the Default Server column displayed Not
Configured.)

In the Set Options window, click Save to save your changes or click Cancel to close
this window without saving your changes.
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Terminal and Shell

These settings define the command that the OCC Client invokes on your PC to open a
Global Shell or Remote Terminal session. (For instructions on using an ssh client instead
of the OCC Client, see “Opening a Global Shell Session” on page 387.)

« Terminal Client: Specifies the terminal client that the OCC Client uses for Remote
Terminal sessions on Unix managed servers and for Global Shell sessions. The default
value is:

cmd /c start /w cmd /c "telnet %$h %$p && echo %m && pause > nul"

The telnet program emulates a command-line terminal session. The %h represents
the host and the %p is for the port. (See Table 3-1.)

If you change the Terminal Client setting from the default value, make sure that the
command blocks until the terminal application terminates. The terminal application
must not run in the background. If you specify cmd /c start, include the /w switch
to make cmd block until the underlying command (such as telnet) completes.

You are not required to use telnet as the terminal application. For example, to use a
PUTTY client, specify the following command:

"C:\\Program Files\\putty\\putty.exe" -telnet %h %p

* RDP Client: Specifies the remote desktop protocol (RDP) client that the OCC Client
uses for Remote Terminal sessions on Windows managed servers. The default value is
the Microsoft Terminal Services Client:

mstsc "%r"

The OCC Client supports the Windows XP version of the Remote Desktop Connection
N
Software, which can be downloaded from the following URL:
http://www.microsoft.com/windowsxp/downloads/tools/rdclientdl.mspx

The specified terminal client must be installed on your PC. To verify the existence of the
terminal client, click Test.
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The command can include variables such as $h and $p. When the terminal client is
launched, these variables are replaced with the values shown in Table 3-1. To override a
replacement value, specify a constant instead of a variable. For example, you might
specify 435 for the port instead of %p.

Table 3-1: Variables for the Terminal and RDP Client Options

o
()

o\
oy

oe
3

o\
o)

o°
R

o\°
par

The character encoding. | For Remote Terminal sessions, the encoding of the managed
server. For Global Shell sessions, the value of the Encoding
field.

The host name that the | The value of the localhost of the managed server.
telnet client connects

to.
A locale-specific For English locales, “Press the Enter key to close this
message on how to window.”

close the window.

The port that the telnet | A randomly chosen port.
client connects to.

The name of the A temporary RDP file generated at runtime by the OCC
Remote Desktop (RDP) | Client.

connection file. This

variable is used only for

the Microsoft Terminal

Services Client

(mstsc).

The title displayed in the | For Remote Terminal sessions, the name of the managed
terminal window. server. For Global Shell sessions, the string “Global Shell.”

* Encoding: Sets the encoding for Global Shell and the Remote Terminal sessions. This
option is the replacement value of the %e variable in the command specified by the
Terminal Client field. The default value of the Encoding option is UTF-8.

Patch Policies

This option allows you to specify that a confirmation message will display when you try to
remove a patch policy or a patch policy exception from a managed server.
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This section discusses the following topics:
» Server Tracking

+ Server Lists

+ My Servers

+ Server Search

+ Server Identification

+ Server Histories and Reports

« Hardware Information for Managed Servers

Server Tracking

This section discusses the following topics:
+ Ways to Locate, List, and Display Servers
» Tracked Server Properties

+ Supported Operating Systems for Managed Servers.

Ways to Locate, List, and Display Servers

You can locate, list, and display servers in the Opsware Command Center in the following
four ways:

+ By searching when you know the name, host name, or IP address of the server you
want to provision or manage.

« By viewing the Manage Servers list and Server Pool list when you want to see a
complete list of all your servers. You can refine the lists by using filters.

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2006 Opsware Inc. All Rights Reserved.

113



Opsware® SAS 5 User’s Guide

« By browsing nodes in the Software Tree to determine which servers specific software
should be installed on or find all servers that match certain rules; for example all
servers with a specific application installed.

+ By viewing servers sorted by hardware category. (Click Environment » Hardware in the
navigation panel.) The Servers tab in the Hardware pages shows each manufacturer
and model that you have running in the operational environment. See “Hardware
Information for Managed Servers” on page 155 in this chapter for more information.

* You can also browse managed servers and server groups using the OCC Client.

Tracked Server Properties
Every server that Opsware SAS manages has the following properties:
« |P addresses, host name, and the server ID

« Which nodes the server is assigned to in the Software Tree categories. Click a node link
to display specific information about that node.

+ What software should be installed on the server. Select the Install List tab from the
Manage Servers: Server Properties page to display the list of software packages that
should be installed on that server by virtue of that server's assigned nodes.

Opsware SAS is able to determine what software should be installed on a server
because of its model-based approach to server management. The software that should
be installed is recorded in the Opsware Model Repository.

« All software that is installed on the server. Select the Installed Packages tab from the
Manage Servers: Server Properties page to display the list of software that is reportedly
installed on the server.

Opsware SAS is able to determine what software is installed on a server because the
Opsware Agent communicates with the Opsware core and reports the installed
hardware and software for the server.

In some cases, Solaris packages might only be partially installed. In these cases, the
partially installed Solaris package does not show up in the installed list.

See “Server Information that the Opsware Agent Tracks” on page 185 in Chapter 6 for
information about a complete list of all the hardware and software information that
Opsware SAS tracks for managed servers.
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Supported Operating Systems for Managed Servers

This section lists the supported operating systems for Opsware Agents, the Opsware
Command Center, and the OCC Client.

The following table lists the supported operating systems for Opsware Agents, which run

on the servers managed by Opsware SAS.

For the supported operating systems for Opsware Agents, Opsware SAS supports Red
Hat Linux 3 AS/ES/WS and Red Hat Linux 4 AS/ES/WS on both 32 bit (also known as
i386) and 64 bit (also known as AMD64 or EM64) x86 architecture. All other versions of

Red Hat Linux are supported on 32 bit architecture only.

Table 4-1: Opsware Agent Supported Operating Systems

AIX

HP-UX

Sun Solaris

Fujitsu Solaris
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AIX 4.3
AIX 5.1
AIX 5.2
AIX 5.3

HP-UX 10.20
HP-UX 11.00
HP-UX 11.11

HP-UX 11i v2

Solaris 6
Solaris 7
Solaris 8
Solaris 9
Solaris 10

Solaris 8
Solaris 9
Solaris 10

POWER
POWER
POWER
POWER

PA-RISC
PA-RISC
PA-RISC
PA-RISC and Itanium

Sun SPARC

Sun SPARC

Sun SPARC

Sun SPARC

Sun SPARC, 64 bit x86 and
Niagara

Fujitsu SPARC
Fujitsu SPARC
Fujitsu SPARC
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Table 4-1: Opsware Agent Supported Operating Systems

SUPPORTED

OPERATING SYSTEMS VERSIONS ARCHITECTURE

FOR OPSWARE AGENT

Windows Windows NT 4.0 32 bit x86
Windows 2000 Server Family 32 bit x86
Windows Server 2003 32 bit x86

Red Hat Linux Red Hat Linux 6.2 32 bit x86
Red Hat Linux 7.1 32 bit x86
Red Hat Linux 7.2 32 bit x86
Red Hat Linux 7.3 32 bit x86
Red Hat Linux 8.0 32 bit x86
Red Hat Enterprise Linux 2.1 AS | 32 bit x86
Red Hat Enterprise Linux 21 ES | 32 bit x86
Red Hat Enterprise Linux 2.1 WS | 32 bit x86

Red Hat Enterprise Linux 3 AS
Red Hat Enterprise Linux 3 ES
Red Hat Enterprise Linux 3 WS
Red Hat Enterprise Linux 4 AS
Red Hat Enterprise Linux 4 ES
Red Hat Enterprise Linux 4WS

32 bit x86 and 64 bit x86
32 bit x86 and 64 bit x86
32 bit x86 and 64 bit x86
32 bit x86 and 64 bit x86
32 bit x86 and 64 bit x86
32 bit x86 and 64 bit x86

SUSE Linux

SUSE Linux Enterprise Server 8
SUSE Linux Standard Server 8
SUSE Linux Enterprise Server 9

32 bit x86
32 bit x86
32 bit x86 and 64 bit x86

The following table lists the operating systems supported for the OCC Client.

Table 4-2: OCC Client Supported Operating Systems

SUPPORTED
OPERATING SYSTEMS

FOR OCC CLIENT

VERSIONS

ARCHITECTURE

Windows

Windows XP
Windows 2000
Windows 2003

32 bit x86
32 bit x86
32 bit x86

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2006 Opsware Inc. All Rights Reserved.




Chapter 4: Server Tracking in the OCC

Java J2SE v 1.4.2 JRE must be installed on the system that runs on the OCC Clinet. To
download this version of Java, go to http://java.sun.com/j2se/1.4.2/download.html

Server Lists

This section discusses the following topics:
« Types of Server Lists

+ Server Pool

+ Manage Servers List

+ Filters on the Manage Servers List

Types of Server Lists

The Opsware Command Center displays lists for two types of servers, as Figure 4-1
shows.

Figure 4-1: Servers Section in the Navigation Panel

=l =ervers
= by Senrars
*hanage Senrars
= Search
*Senrer Poal

Server Pool: Servers in the Server Pool have registered their presence with Opsware SAS
but do not have the target OS installed. An OS Build Agent is running on each server so
that they can communicate with Opsware SAS.

See “Operating System Provisioning” on page 567 in Chapter 15 for information about
how to use the Server Pool when you install the target OS on a server.

Manage Servers: The Manage Servers list contains servers on which Opsware SAS can
perform management tasks, because Opsware Agents are installed on them. However,
Opsware SAS might not have provisioned all software running on the servers.

You begin the OS provisioning process by reviewing the servers in the Server Pool list.
From the Server Pool, you can install a target OS by selecting a server and clicking Install
0S.
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Server Pool

The Server Pool provides the following information about each server waiting to be
provisioned with the target OS:

The host name set by booting the server for the first time over the network or by using
an Opsware Boot Floppy

The MAC address
The manufacturer and model

The OS that the OS Build Agent is running - DOS (Windows operating systems), Linux,
or Solaris

You use this information to select the target OS for servers. If the server is in the
process of installing an OS, this value might change.

The last date and time that the Opsware Agent on the server communicated with
Opsware SAS (by submitting the server's hardware and software information)

If the server is in an unreachable state (that is, if the server icon has a red “x” on it), you
can run a Communication Test to help you troubleshoot why that server is unreachable.
See “Agent Reachability Communication Tests” on page 204 in Chapter 6 for more
information.

The life cycle value, such as whether the server is available to have a target OS
installed on it

The facility in which the server is located
The customer association

Additional hardware information (Click the server name to open a window that displays
specific hardware information.)
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Manage Servers List

The Manage Servers list contains servers on which Opsware SAS can perform
management tasks because Opsware Agents are installed on them. When an existing
operational server has an Opsware Agent installed successfully, it appears in the Manage
Servers list and the server icon indicates that it is fully manageable, as Figure 4-2 shows.

Figure 4-2: The Manage Servers List in the Opsware Command Center

Manage Servers (Summary Yiew) 2
All Statuses || Red Hat Enterprise Linux 45 2.1 W || Al Stages w || Al Uzes w

All Facilties || &1 Customers | &l Manufacturers w Updste "_‘f
All Models w || Al Lifecycles w

Reszource  Edit “iew  Tasks  Configuration Tracking

| Mame & Host Mame /P Address OS5 Yersion Stage Use Facility Customer
Public Groups
&
| Eﬂ| mO22.dey . opsvware com  m022 dev.opsware.com  Red Hat Enterprize haot Mt CO3 Pt
-~ 192168197 31 Linuzx &5 2.1 Specified  Specified A=zigned

See “Opsware Agent on Managed Servers” on page 181 in Chapter 6 for more
information. By default, servers in the Manage Servers list are sorted by the Name
column. However, you can re-sort the list based on any of the column headings. For
example, you can click the Hostname / IP Address column heading to re-sort the list by
host name or IP address.

If you have many servers that Opsware SAS manages, the list of servers is grouped by
pages. Click the page number links or the left arrow at the bottom of the list.

The Manage Servers list provides the following information about each server:
» The name of the server

By default, the server’s host name appears in this field. However, you can edit it so that
it is more descriptive or useful.

« The host name of the server determined by the Opsware Agent

« The IP address configured for the server, which users can edit by using the network
configuration feature in the Opsware Command Center

« The reported OS, which is obtained by the Opsware Agent that is running on the server
« The stage of the server, which specifies the stages of deployment for servers

* The server's use
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« The facility in which the server is located

» The customer association

+ Additional hardware information (Click the server name to open a window that displays
specific hardware information.)

Filters on the Manage Servers List

The Manage Servers list displays the following filters that you can specify to qualify the
servers that the Opsware Command Center displays, as Figure 4-3 shows.
Figure 4-3: Filters in the Manage Servers List

Manage Servers (Surmmary View)

Al Statuses w || Al Operating Systems w || A Stages w || All Uses w || Al Facilties || &l Customers w

Al Manufacturers || Al Models hallf2l Litecycles

+ Status: Specifies the ability of Opsware SAS to manage servers. Opsware SAS
automatically detects the status of servers; a server's status is OK or Not Reachable.

+ 0OS: Specifies the operating system on the server, which is obtained by the Opsware
Agent that is running on the server.

+ Stages: Specifies the stages of deployment for servers; for example, a server is live or
offline. Users set this property for servers. The values in this list are customizable by the
Opsware administrator.

« Uses: Specifies how an organization is utilizing servers; for example, a server is a
staging server. Users set this property for servers. The Opsware administrator can
customize the values in this list.

+ Facilities: Specifies the location of servers. From an Opsware Command Center, users
can manage servers located in any facility. For example, a user could log in to the
Opsware Command Center running in facility A and manage the server located in
facility B.

+ Customers: Specifies the customer associated with each server. Your Opsware
administrator defines the options for customer selections by using the Administration
pages.

« Manufacturers: Specifies the manufacturer for the server as reported by the OS Build
Agent running on the server.
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* Models: Specifies the model of the server as reported by the OS Build Agent running
on the server.

 Life cycles: Specifies the various Opsware server life cycle values which include
Managed, Available, Build Failed, Installing OS, and Deactivated.

You can change the filters displayed in the Manage Servers page. To change the filters
Q you want to be displayed on the Manage Servers page, click on the icon as shown in
Figure 4-4 and specify the filters from the Edit Filters Menu.

Figure 4-4: Edit Icon

Figure 4-5 shows the filters that are in the Server Pool list.
Figure 4-5: Filters in the Server Pool List

All Manufacturers w || A Models || &)l Facilties » || Update

+ Manufacturers: Specifies the manufacturer for the server as reported by the OS Build
Agent running on the server.

+ Models: Specifies the model of the server as reported by the OS Build Agent running
on the server.

+ Facilities: Specifies the location of the server. Users can manage servers in any facility
from an Opsware Command Center in any facility.
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My Servers

This section contains the following topics:
+ Overview of My Servers
+ Adding Servers to My Servers

+ Removing Servers from My Servers

Overview of My Servers

The My Servers feature provides an efficient way to manage servers when your
operational environment contains hundreds or thousands of servers.

When you search for servers or browse the server lists, you can add servers to My
Servers (similar to a shopping cart on an e-commerce site). Using My Servers allows you
to view and perform actions on selected servers.

When you use the same browser and login to the Opsware Command Center running in
the same facility, servers stay in My Servers for one year or until you explicitly remove
them. Each time that you login to the Opsware Command Center, you see the servers that
were in My Servers the last time that you logged in.

The My Servers feature is available only on a per-user basis. You cannot log in as an
Opsware administrator to see the servers in the My Servers area of other Opsware users.
Adding Servers to My Servers

Perform the following steps to add a server to My Servers:

E From the navigation panel, click Servers » Manage Servers. The Manage Servers
page appears. Browse the list to find the servers that you want to add to the My
Servers.

Or
Search for the servers that you want to add to My Servers.

See “Using the Search Feature” on page 125 in this chapter for more information.
See “Server Searching by IP Address” on page 141 in this chapter for more
information.

H Select the servers that you want to add to My Servers.
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E Choose Resource » Add to My Servers from the menu above the Manage
Servers list. The Add To My Servers window appears, which indicates that you added
the chosen number of servers to My Servers.

B Click Close to close the window.

B Next select the My Servers link at the top of the page. You see the selected servers
added to My Servers, as Figure 4-6 shows.

Figure 4-6: Servers in My Servers
My Servers (Summary View) /]

Resource  Edit  “iew  Tasks  Configuration Tracking |

D_m Host Mame / P Address OS5 YWersion  Stage Uze Facity Customer

O Eﬂ| miO3s dev.opsware.com mO3s dev.opsware .com SunOS 58 Mot Specified | Production  C03 Opsywware
. 19216819267

You can perform the same server management tasks on servers in My Servers as on the
servers in the Manage Servers list.

Removing Servers from My Servers

Perform the following steps to remove servers from My Servers:

Click the My Servers link in the navigation panel of the Opsware Command Center.
The My Servers page appears that shows the servers currently added to it.

H Select the servers that you want to remove from My Servers and choose Edit »
Remove from My Servers from the menu above the Server list.

The My Servers page refreshes and displays the remaining servers in My Servers.
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Server Search

This section provides information about Server Search and contains the following topics:
« Searching for a Server By Using the Search Box

+ Ways to Use Search

» Using the Search Feature

* Rules for Server Search and for Creating Dynamic Groups

+ Line Break Workaround for Server Search

« Conditions for Searching with Multiple Rules

« Server Searching by IP Address

+ Example: Server Search

+ Searching for a Server Group

Searching for a Server By Using the Search Box
Perform the following steps to search for a server using the Search box:

On the Home page, click the down arrow in the top navigation panel to open the
Search box, as Figure 4-7 shows.

Figure 4-7: Search Text Box on the Opsware Command Center Home Page

LV Servers ~ L=l <Enter search text here=

Applications
Home |, ..

Packages
Server Groups

Service Levels
Termplates

H Verify that the Servers option is selected in the list.

E Type the server's IP address, host name, or name in the Search box and then click
Go.

The search text that you enter can include an asterisk (*) wildcard character.
However, the search feature automatically prepends and appends an asterisk to the
text.

For example, you can type any of the following search queries:

1 24 Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2006 Opsware Inc. All Rights Reserved.



Chapter 4: Server Tracking in the OCC

192.168.68.6
host02.coredev-val.sample.com
192.168.*.19
hostl*.xyz.samplecompany.com

The resulting page contains one or more servers, depending on the type of search
query that you specified. If no servers are found, the Opsware Command Center
displays a message that indicates that no servers were found that matched your

query.

See “Using the Search Feature” on page 125 in this chapter for information about
how to formulate complex, multiple rule search queries.

Ways to Use Search
By using the Opsware Command Center, you can perform searches in the following ways:

+ From Opsware wizards

While using the Opsware wizards from the Tasks panel, you are prompted to select (by
browsing or searching) servers or server groups, operating systems, patches,
applications, and templates at specific points in the process.

What you can search for in the Opsware wizards is context sensitive to the type of
operation that you are performing. For example, if you are using the Install Patch
Wizard, you can select the Search tab to search for patches to install on servers.

* When adding operating systems, patches, or applications to templates

Searching for an operating system, patch, or application to add to a template functions
the same way as searching through the Opsware wizards.

« From the navigation panel, click Servers » Search.
The Search page allows you to search for managed servers that match specified rules.
« While adding or modifying rules for a dynamic group (By clicking Search on the Rules
tab for a group).
Using the Search Feature

In the Opsware wizards, you can browse for servers, operating systems, patches,
applications, templates, and service levels, or use the Search feature to search for these
items.
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Perform the following steps to search by using the Search feature:

In an Opsware wizard, select the Search tab. The following Search page appears.
See Figure 4-8.

Figure 4-8: Search Tab in the Select Servers Step of an Opsware Wizard

Select Software

Select the software application(s) you wish to install.

Browse Search | (0) Software Selected

Match: if all rules are met

| Name v [is ¥ | =)

You can also use the Search tab at other steps in the wizards to search for operating
systems, patches, applications, and templates.

Or

From the navigation panel, click Servers » Search. The Search page appears, as
Figure 4-9 shows.

Figure 4-9: Search Page
Search 2

¥ Rules

Match: | if all rules are met | % |

Search for servers whose:

Agent Discovery Date V| | s after v | | May V| |23 V| |2005 V| =

[ Search ” Save. ][ Reset l

By default, one search rule is added to the search.
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H Specify the rule that you want to search for by selecting it from the first list, as
Figure 4-10 shows.

Figure 4-10: Search Rules List in the Search Page

Agent Discovery Date w
Properties ~
. Agent Discove
Agent Reparting
Agent Status
Agent Version
Custom Attribute (any)
Custom Attribute (local)
Customer
Deployment Stage
Facility
Group Membership
Hostname
Mame (any)
MNotes
Opsware Display Name
Server Use
Senvice Level
Opsware Properties
Application Configuration
Code Deployment
Configuration Tracking
Lifecycle
Server ID
Software
Attached Software
Installed Patches

-aadnstalled Software .. s
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Depending on the rule that you select, a popup window might appear in the page.
For example, if you selected Deployment Stage, a popup window showing the
stages appears in the page as Figure 4-11 shows:

Figure 4-11: Search Popup Window with Values
Search 2

¥ Rules

Match: | if all rules are met | w

Search for servers whose:

Deployment Stage v| | Is

Choose any number of deployment stages:

(0) selected

0| ==

[ Buiding

[ FALED

[0 In Deployment

O Live

[ Mot Specified B

[ Mot Specified

O ffli

F ine =
[ Clear All Selections Apply
&] Dane S @ Internet

You cannot search in Notes that contain line breaks. See “Line Break Workaround for
Server Search” on page 139 in this chapter for more information and a workaround.

If you are searching while using an Opsware wizard, the first search rule list might not
have all the options. The list only includes the options that are relevant for the
Opsware wizard that is being used. For example, the Install OS Wizard does not
include options to search for installed patches on the servers.

H nthe second list, specify how you want Opsware SAS to search by selecting a value.
The operator selected defines how the search text is treated. Negative operators
might not be available in all cases.

See “Rules for Server Search and for Creating Dynamic Groups” on page 130 in this
chapter for more information about the operator for each search rule.
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Bl Enter the text that you want to search for in the text box or choose a value from the
list or popup window. The search text that you enter can include an asterisk (*)
wildcard character. The search text is case insensitive. You can also use the SHIFT or
CTRL key to select multiple values from the list or popup window.

B (Optional) To add additional rules, click the plus (+) button as Figure 4-12 shows and
repeat Steps 2 through 4.

Figure 4-12: Multiple Rules in a Search
Search 3)

¥ Rules

Mateh: | if all rules are met | %

Search for ervers whose:

|Deplnyment Stage V| | Is V| |In Deployment |E =
|Opsware Display Name V| | Contains V| |marketing| |E =

Search Save . || Reset

[ If you specified multiple rules for the search, select whether you want search results
only if all rules are met or if any of the rules are met, as Figure 4-13 shows.

Figure 4-13: Operator Controlling Search Results

Match: | if allrules are met |

if all rules are met |
if anv rules are met

By default, search results appear for servers that match all the search rules. If you are
searching from an Opsware wizard, this field is set to the value if all rules are met;
you can change the value when searching for servers, but you cannot change it
when searching for patches, software, operating systems, and so on.
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Click Search. The list of servers that match your search rules appears in the page, as
Figure 4-14 shows.

Figure 4-14: Displayed Search Results

Results
Resource  Edit  Tazks  Configuration Tracking

= o | |

O @H cazela.znvl.corp.opsware.com casela.znvl.corp.opsware.com 152.168.9.191  SunO055% c12 Opsware
- Web Services test box

O g chamarel.znv1 corp.opsware.com chamarsl.znvi.corp.opasware.com 1921689146  Red Hat c12 Opaware
~ Web Services test box Linux 7.3

The search results include columns for Name, IP Address, OS Version, Facility, and
Customer.

When you search for installed software or patches and include an asterisk in the
search text, Opsware SAS might take several minutes to display the search results.

Rules for Server Search and for Creating Dynamic Groups

The following table describes the rules that you can use to search for servers or to create
dynamic server groups.

Note that anywhere you can enter text, you can enter a wildcard (*) character to broaden
your results.

Table 4-3: Rules for Server Search and for Creating Dynamic Groups

PROPERTIES
Agent Discovery Date: The + |s after Drop-down lists with the day,
date that the Opsware Agent | Is before month, and year
was installed.
* Is within the last User-entered text
+ |s today N/A
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Table 4-3: Rules for Server Search and for Creating Dynamic Groups (continued)

Agent Reporting: Whether « s + Has not reported
the Opsware Agent is
reporting to Opsware SAS.

* Is not + OK
+ Registration in progress

» Reporting error

Agent Status: Whether the e s * Not reachable
Opsware Agent is reachable . Is not . OK
by Opsware SAS.
Agent Version: The version of | « Contains User-entered text
the Opsware Agent — such as | Does not contain
14.2.3b.
« s
* Is not
Custom Attribute (any): The + Contains User-entered text
name of a custom attribute s
that is associated with the
server through attachment or
inheritance.
Custom Attribute (local): The | <+ Contains User-entered text
name of a custom attribute s
that is locally attached to the
server,
Customer: The customer or e s Popup window of customers
account that the server is
* Is not

associated with.
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Table 4-3: Rules for Server Search and for Creating Dynamic Groups (continued)

Deployment Stage: The e Is + In Deployment
stage the server performs
within a lifecycle environment.

* Is not * Live
» Not Specified
« Offline

The values that appear in this
list are customizable; in
addition to the values above,
values specific to your
environment might appear.

Facility: The collection of e s Popup window of facilities
servers managed by an . Is not
Opsware SAS installation. When Opsware SAS is running

multimaster mode, the list can
contain many facilities.

Group Membership: Whether |« Is Popup window of groups
the server belongs to a group.

Host name: The host name of | = Contains User-entered text
the server — such as
mO0Q04.company.com.

» Does not contain
e Is
* Is not

Name (any): This enables + Contains User-entered text
searching for any name or IP
address associated with a

server. . Is

* Does not contain

* Is not
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Table 4-3: Rules for Server Search and for Creating Dynamic Groups (continued)

Notes: The contents of the
Notes field from the Properties
tab for a server.

Opsware Display Name: The
user-configurable name for the
server.

Server Use: How the server is
being used — such as
Development, Staging,
Production.
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Contains

Does not contain
Is

Is not

Contains

Does not contain

User-entered text

User-entered text

By default, Opsware SAS uses
the configured host name of
the server until a user edits it.

» Development
* Not Specified
+ Production

- Staging

You can customize values that
appear in this list. In addition
to the values above, values
specific to your environment
might appear.
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Table 4-3: Rules for Server Search and for Creating Dynamic Groups (continued)

Service Level: The user- + s
defined category that can be
used as an organizational tool.

» |s attached here or
below

OPSWARE PROPERTIES

Application Configuration: * |s not used
Whether the server uses the

Application Configuration

feature.

* |s used

Code Deployment: \Whether |+ Is not used
the server uses the Code

+ Is used
Deployment feature.
Configuration Tracking: + Is off
Whether the Configuration

« Ison

Tracking feature is monitoring
or backing up specific files or
configurations on a server.

Lifecycle: The server states e Is
that are part of bringing a
server into Opsware SAS.

* |s not

Popup window of service
levels

Servers can be associated
with multiple service levels.

See the Opsware® SAS User’s
Guide for more information
about working with service
levels.

N/A

N/A

N/A

+ Available

+ Build Failed
* Deactivated
+ Installing OS

+ Managed
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Table 4-3: Rules for Server Search and for Creating Dynamic Groups (continued)

Server ID: The internal ID
Opsware SAS uses to identify
the server.

SOFTWARE

Attached Software: The
software that is assigned or
modeled through the Opsware
reconcile operation — the
installation process.

Installed Patches: Whether a
patch is installed on the
server.

Installed Software: The
package reported installed on
the server.

OS Version: The OS version
defined by OS definitions in
the OS Provisioning feature.

Reported OS: For Windows —
the version reported by the
OS, for Unix — the version
returned by the uname
command.
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* Is not

Is

» |s attached here or

below

Contains

* Does not contain

Is
Is not

Contains

* Does not contain

Is

Is not

Is

* Is not

Contains

* Does not contain

Is

Is not

User-entered text

In most cases, the Server ID is
the same as the MID.

Popup window of software

User-entered text

User-entered text

A package does not have to

be installed by Opsware SAS
to be reported as installed on
a server.

Popup window of operating
systems

User-entered text
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Table 4-3: Rules for Server Search and for Creating Dynamic Groups (continued)

Windows Service: The names
of the Windows services that
are reported to Opsware SAS.

NETWORK

DNS Search Domains: The
domains configured to be
searched in the server's

network settings.

DNS Servers: The IP
addresses of the DNS servers
configured in the server's

network settings.

Default Gateway: The IP
address of the default router.

IP Address: Any Internet
Protocol address for the server.

MAC Address: Any Media
Access Control address, which
is the network interface card's
unique hardware number.

Contains

* Does not contain

Is

[s not

Contains

* Does not contain

Is
Is not

Contains

* Does not contain

Is
Is not

Contains

* Does not contain

Is
Is not

Contains

» Does not contain

Is
Is not

Contains

* Does not contain

Is

Is not

User-entered text

User-entered text

User-entered text

User-entered text

User-entered text

User-entered text
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Table 4-3: Rules for Server Search and for Creating Dynamic Groups (continued)

WINS Servers: The Windows
Internet Naming Servers
configured in the server's
network settings.

HARDWARE

CPU Make and Model: The
vendor name and CPU model
for the server — such as
GENUINEINTEL Intel(R)
Pentium(R) 4 CPU 2.60GHz.

CPU Speed: The Central
Processing Unit speed in
gigahertz [GHz].

Make and Model: The vendor
name and server model for the
server — such as Compaq -
DL360.

Number of CPUs: The
number of CPUs on the server.

RAM: The amount of RAM on
the server in megabytes [MB].

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2006 Opsware Inc. All Rights Reserved.

Contains

* Does not contain

* Is not

Does not equal

+ Equals

Is greater than
Is less than

Is

* Is not

Does not equal

+ Equals

Is greater than
Is less than

Does not equal

+ Equals

Is greater than

Is less than

User-entered text

Popup window of CPU makes
and models

User-entered text

A 600 Mhz machine should be
entered as 0. 6.

Popup window of server
makes and models

User-entered text

User-entered text

To enter 1 Gigabyte, type
1024.
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Table 4-3: Rules for Server Search and for Creating Dynamic Groups (continued)

Serial Number: The serial « Contains User-entered text

number of the server. .
* Does not contain

« s

* Is not
Storage Make and Model: e s Popup window of storage
The vendor name and storage | | Is not makes and models
model for the server — such as
WDC - WD800BB-75DKAO.
CUSTOM FIELDS
A Numeric field » Does not equal User-entered text

+ Equals

 |s greater than
* Is less than
A String field + Contains User-entered text
+ Does not contain
E
* Is not
A URI field + Contains User-entered text
+ Does not contain
s Is
* Is not
A File field + Contains User-entered text
+ Does not contain
s Is

* Is not
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Table 4-3: Rules for Server Search and for Creating Dynamic Groups (continued)

A Date field + Is after Drop-down lists with the day,
. Is before month, and year
+ Is within the last User-entered text
+ |s today N/A

Line Break Workaround for Server Search

You cannot search in notes that contain line breaks. For example, you cannot search for
text in a note when it is this type of text:

linel <line break>

line2

For example, the following query does not return any results:
Any/all notes contain linel <line breaks> line2
However, the following query does return all servers that have notes:
Any/all notes is not linel <line breaks> line2

To work around this limitation, include an asterisk (*) where the line break occurs, as
Figure 4-15 shows. For example:

Any/all notes is linel*line2

Figure 4-15: Line Break Workaround in the Server Search Feature

Search 2

¥ Rules

WMatch: | ifallrules are met | ¥ |

Search for servers whose:

MNotes V| | Is b | |Iine1*lin92| | E =

tﬁ [ Search l[ Save".][ Reset]
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Conditions for Searching with Multiple Rules

When you perform a search with multiple rules, the following conditions apply to the way
Opsware SAS provides search results:

+ When it evaluates rules, the Search feature considers each rule individually, finding
servers (or operating systems, patches, and so forth) that match the individual rule, and
then the results of each rule are combined.

» You must select at least one rule, and it must have a value. Default filter rules count as
rules with a value. For example, in the MS Updates Wizard, when searching for a server,
the Search feature automatically enters a default rule to search only for servers running
a Windows OS. Therefore, users are not required to specify any more rules.

+ Empty rules are ignored in searches. Users do not have to manually remove them for
the search to proceed.

* You cannot search for empty values. For example, you cannot search for all servers
where the Notes field is empty.

At certain steps in the Opsware wizards, the Search feature provides default values based
on previous selections in the wizard.
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For example, in the Select Servers step of the Install Patch Wizard, the search query
automatically includes the value for OS version that you specified in earlier steps, as
Figure 4-16 shows.

Figure 4-16: Default Values Entered in Searches

Install Patch 2}

Select
Patches

0 Select
Servers

Confirm
Selections

Schedule
and Notify

Install

Select Servers

Select the server(s) you wish to patch.

Browse Search (0) Items Selected
Match: | if all rules are met v|
Search for servers whose:
|Agent Status V| | Is v| Mot Reachable
|OS Version V| | Is (
b N
| Lifecycle v| | Is

The wizards are flexible; for example, when you select multiple servers and applications,

Opsware SAS will install the correct applications on the servers, even if you selected

different OS versions for the servers and applications in the respective steps. Opsware

SAS also matches the customer association for applications, operating systems, and

templates with the customer association of servers.

If Opsware SAS cannot find a match, an error message appears at the end of the wizard;

therefore, use caution when modifying these default values.

Server Searching by IP Address

Users can search for servers by entering a specific IP address in the Search box in the top

navigation or in the Search feature.
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Opsware SAS includes support for static Network Address Translation (NAT). This feature
introduces the concept of a management IP, which might be different from any of the
local IP addresses that the Opsware Agent reported for a server.

When searching for a server based on its IP address, the Search feature searches based
on the server's primary IP address and based on the IP address for any interface that
server has, including its management IP address. In the search results, an extra column is
shown that lists all matching IP addresses for all interfaces. The management IP address
is included if the server's networking is configured for static NAT.

See “Communication Between Managed Servers and Opsware SAS” on page 221 in
Chapter 7 for information about how Opsware SAS handles servers that are affected by
static NAT.

Example: Server Search

Using the Search feature, a user creates a query with the following conditions:

« Installed Software contains ga

+ Installed Software contains man

« If all rules are met is selected

The results of this search will be all servers that have at least one installed package with
ga somewhere in its name and at least one installed package (not necessarily the same
one) with man in its name.

The search results are not limited to packages that contain both ga and man in the
package name.

Find all servers that have some version of Apache or some version of Java installed:
* Installed Package contains apache
+ Installed Package contains java

« If any rules are met is selected
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Searching for a Server Group

From the navigation panel, click Servers » Search. The Search page appears. By
default, the Servers tab is selected.

Select the Groups tab. The rules for server group search appear as Figure 4-17
shows. By default, one search rule is added to the search.

Figure 4-17: Rules for Server Group Search

¥ Rules

Watch: | if all rules are met | ¥ |

Search for groups whose:

Group Mame v || Contains v | 2]=]

ProEerﬁe.s

In the second list, specify how you want Opsware SAS to search by selecting either
“Contains” or “Is". The operator selected defines how the search text is treated.

K Enter the text that you want to search for in the text box. The search text that you
enter can include an asterisk (*) wildcard character. (The search text is case
sensitive. Search is not enabled until you enter text in the text box.)

When searching for a server group, you can only specify one rule for Group Name. The
plus (+) button is disabled.

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2006 Opsware Inc. All Rights Reserved.

143



Opsware® SAS 5 User’s Guide

Bl Click Search. The search results appear as Figure 4-18 shows.

Figure 4-18: Server Group Search Results

¥ Rules

Match: | if all rules are met |
Search for groups whose:

Group Name V||Cuntains VHtest ||I| 2]

Results

Resource  Edit  Tasks  Configuration Tracking |

_ERIEE Total Model Custom
] Locatien Servers Subgroups Servers Tyvpe Aftachmentz Attributes  Last Use

el atest group Public Groups 0 0 0  Dynamic 3 0 05-22-05
O
5] 16:00:00

Server Identification

This section provides information on server identification within Opsware SAS and
contains the following topics:

« Overview of Server |dentification
+ Ways that Servers are Identified by Opsware SAS
« Customer Accounts in Opsware SAS

+ Associating Servers with Customers

Overview of Server Identification
Opsware SAS uses the following IDs to track managed servers:

« MID: Machine ID. The unique identifier that Opsware SAS uses to identify the server.
The MID is usually equal to the server ID.

The MID is stored in a file on a server's disk so that the MID can persist and be read by
the Opsware Agent.
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The MID follows the hard disk, not the chassis, so system administrators can swap
chassis for servers without affecting how Opsware SAS tracks those servers.

See “Example: Opsware SAS Swaps a Server’s Hard Disk” on page 146 in this chapter
for information about swapping hard disks.

« Server ID: The primary key in the Opsware Model Repository (database) that
represents a given server. The Server ID is used internally in Opsware SAS. Generally,
users do not need this value for servers to manage them in Opsware SAS.

* MAC Address: Media Access Control address, which is the network interface card’s
unigue hardware number. The MAC is used as the server's physical address on the
network.

+ Chassis ID: A unigue hardware-based identifier that the Opsware Agent discovers,
typically derived from some property of the server's chassis. As a common source for
this ID, Opsware SAS uses an interface's MAC address or the host ID on Solaris
servers, or the serial number for one of the interfaces.

Ways that Servers are Identified by Opsware SAS

Servers in the Manage Servers list are identified in the following ways when they register
their hardware and software with Opsware SAS:

« Opsware SAS identifies each server by using the MID first.
+ If the MID cannot be determined, the chassis ID is used to identify the server.

 |If the server cannot be identified with the chassis ID, the MAC addresses are used to
identify the server.

In the Server Pool, the MAC Address column displays values by which Opsware SAS
tracks the servers. The value used varies by platform:

+ Intel x86 processor-based servers are identified by the MAC address of the server.
+ Sun SPARC processor servers are identified by the host ID of the server.

The host ID for Sun SPARC processor servers appears in the MAC Address column in
the Server Pool list.

To determine the value in the MAC Address column, Opsware SAS uses the hardware
address by which the server contacted the Opsware Build Manager (a component of
the OS Provisioning feature).
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Example: Opsware SAS Swaps a Server’s Hard Disk

The following steps show how Opsware SAS handles swapping a hard disk for a server:

A system administrator swaps the hard disk of Server A (MID 1230001, chassis ID
AB: 08) with the hard disk of Server B (MID 98730001, chassis ID XY: 96).

The Opsware Agent on Server A registers its hardware with Opsware SAS. The MID
for Server A equals 1230001 and the chassis ID equals XY : 96.

Opsware SAS locates Server A by using the MID.

Opsware SAS updates the data it has for Server A in the Model Repository. It sets the
chassis ID equal to XY : 96.

The Opsware Agent on Server B registers its hardware with Opsware SAS. The MID
for Server B equals 98730001 and the chassis ID equals AB: 08.

Opsware SAS locates Server B by using the MID.

Opsware SAS updates the data it has for Server B in the Model Repository. It sets the
chassis ID equal to AB: 08.

Customer Accounts in Opsware SAS

Many enterprise customers have consolidated disparate IT operations into a single
operation, yet they still need separate reporting, billing, and management for different
business units or groups (for example, West Coast Office, East Coast Office, and London
Office).

Opsware SAS accommodates these requirements with customer accounts created by
your Opsware administrator.
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When your Opsware administrator creates a customer in Opsware SAS, a value for that
customer is automatically added to the customer filter in the Manage Servers list, as
Figure 4-19 shows.

Figure 4-19: Customer Filter in the Manage Servers List

Manage Servers (Summary “iew) /]
All Statuses W | Al Cperating Systems w || Al Stages hd
Al Uzes || Al Customers % || Al Manufacturers “ Update E_‘f

Al Models bactivated v

Rezource Configuration Tracking

[} Mame [P Address  OS Version Stage Uze Customer
@di Public Groups
)
O Ei coretr3opsware.com  corgtr3opsware.com  Red Hat Mot it Opsware
- 172163618 Enterprize Linux  Specified  Specified
AS S
Fl E’ OPSWARE-STROCOL  OPEWARE-STROCOZ  Windows 2000 Mot ot Mot
~ 1721636 45 Specified  Specified  Assigned

By using customer accounts in the Opsware Command Center, you can segregate
servers that belong to different business units. By segregating servers, you can have
separate accounting for each customer or different levels of security for different
customers. You might want to segregate the servers based on the department or
business unit.

By default, Opsware SAS is shipped with the following two customers:

+ Customer Independent: A global customer in Opsware SAS. Resources (applications,
patches, and templates) that are associated with “Customer Independent” can be
installed on any managed server, no matter what customer it is associated with.

* Not Assigned: The servers are not associated with a customer. You can install
applications, patches, or templates that are Customer Independent on Not Assigned
servers. However, you cannot install or use any resources associated with a customer
on a server that is not assigned to a customer.

When you install an Opsware Agent in a server, the server is associated with the Not
Assigned customer if IP ranges were not created to automatically associate Opsware SAS
managed servers with customers. See Figure 4-20.
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Opsware, Inc. recommends that you associate servers with customers, if necessary, by

V using the Server Properties pages.

Figure 4-20: Customers List Under Environment in the Opsware Command Center

Customers
Mame Mame
inu 12204 iﬁu Corp Test
i'ﬂiu Big Corp f'u Big Corpz
Pl TestCust {\l) Customer Indspendert
;'-""u E-Commerce ‘-.”-u Mot Azsigned

Associating Servers with Customers

An Opsware user or an Opsware administrator can set up an IP range group so that
servers are automatically associated with customers when users perform the following
server management tasks:

+ Install Opsware Agents on the servers.

See “Agent Reachability Communication Tests” on page 204 in Chapter 6 for more
information.

« Use the OS Provisioning feature to install operating systems on bare-metal servers.
See “Operating System Provisioning” on page 567 in Chapter 15 for more information.

To set up this automatic customer association, you must create IP range groups for
customers and specify the ranges of IP addresses that the groups contain.

In the Opsware Command Center, an IP range group is both a physical and logical list -
an accounting way to group ranges of IP address and assign them to a particular
customer. An IP range identifies a range of IP addresses within an IP range group.
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When you set this up, IP addresses get their customer association through the IP range,
which, in turn, gets its customer association from the IP range group.

Customer
IP Address > IP Range > IP Range Group

Facility (data center
or server room)

See the Opsware® SAS Configuration Guide for more information.

The loose relationship between server and IP address means that you can associate a
server with a different customer from its IP address.

Even when IP range groups are set up for a customer, a server's IP address does not
necessarily determine the customer to which the server is associated because a user can
change the customer association in the Server Properties page.

See “Editing the Properties of a Server” on page 265 in Chapter 7 for information about
how to change the customer association for a server.

The customer association for a server is based on the management IP address of the
server and not the primary IP address.

See “Communication Between Managed Servers and Opsware SAS” on page 221 in
Chapter 7 for information about how Opsware SAS uses management IP addresses for
servers.
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However, a server always belongs to the same facility (data center or server room) as its
primary IP address. Opsware SAS enforces the relationship between server and facility at
hardware registration. See Figure 4-21.

Figure 4-21: Primary IP Addresses in Opsware SAS

Primary IP Address

"Loopback Network"
10.200.0.0/24

"Core Network"

Loopback Address
=10.200.0.1

10121 | Router | 10-2:21
/

"Network A" y "Network B"
10.1.2.0/24 10.2.2.0/24

Customer A |Switch A Switch B| Customer B

10.1.2,10 10.2.2.20

o —@
Server 1 Server 2 Server 3

10.1.2.11 10.2.2.21
Primary IP
Address

In this illustration, the following conditions apply:

» Server 1 belongs to Customer A.

« Server 2 belongs to Customer A but has IP addresses in Network A and Network B.
» Server 3 belongs to Customer B.

» The Router belongs to the Core Network but has IP addresses in Network A and
Network B.
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Server Histories and Reports
This section provides information on server histories and reporting with Opsware SAS and

contains the following topics:
» Overview of Server History
« Viewing Server History

« Time Stamp for Server Operations

DCI Reporting

Overview of Server History

By using the Opsware Command Center, you can view the history of changes made to a
server. Each action performed on a managed server is logged in the history with the
associated user who performed the action and the time of the action. You can view the
history at any time, but you cannot change it. History is read-only. See Figure 4-22 for
examples of recorded information.

Figure 4-22: Server History for a Server in the Manage Servers List

Manage Servers: History | chamarel smvl_corp.opsware.com 3)

Return to Manage Servers

HISTORY FOR chamarel.snv1.corp.opsware.com BELONGING TO OPSWARE

Show Last: 'Week | 2 Weeks | Month | Guarter

Description Modified By Date Modified

Added server to server group copy of gry’ gshart Thu May 12 01:38:28 2005
Added server to server group Test Dynamic DCHgzse buildmgr Wed May 11 18:57:30 2005
Added server to server group Test GroupsByMaodes DCHugnj buildmgr Wied May 11 18:43:43 2005
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Each History entry contains three pieces of information, as Table 4-4 shows.

Table 4-4: ‘Description of the Entries in the Server History Tab

Event Description Description of the operation performed, for example:
Install Template (Job ID: 21870101L) completed
successfully.

Modified By The name of the Opsware user who made the change.

Date Modified The date and time the change was made, for example:

Mon Aug 06 18:14:41 GMT+00:00 2001)

Actions Logged in History

Opsware SAS also logs the following actions in the history for each managed server:
+ Addition of the server to a node

+ Removal of the server from a node

+ Reassignment of the server from one node to another

+ Addition of a cloned server to a node (when cloning a server, node assignments occur
in Opsware SAS and are logged)

« Installation of a template on the server

» Preview reconcile failure or success

+ Reconcile failure or success

Time Stamps used in History

Data is maintained for servers in Opsware SAS for the following periods of time:

+ The Opsware Command Center maintains the history of changes for the last three-
month interval.

+ Command Engine session logs are retained for 30 days, except for the last reconcile
session for a server, which is retained indefinitely.

The Command Engine is the Opsware SAS component that enables distributed
programs to run across many servers.

+ Server node history is retained for 6 months.
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If longer periods of time are required, Opsware, Inc. recommends regular backups to
enable offline storage of Opsware SAS data.

Opsware SAS deletes old data from the Opsware Model Repository, and does not copy
the data before it removes it, but you can retain information for longer periods of time, by
using Oracle commands to manipulate scheduled jobs. Contact your Opsware, Inc.
support representative for assistance in changing these retention periods.

Viewing Server History
Perform the following steps to view the server history:

E From the navigation panel, click Servers » Manage Servers. The Manage Servers
page appears. Browse the list to find the server whose history you want to view.

Or
Search for the server whose history you want to view.

See “Using the Search Feature” on page 125 in this chapter for more information.
See “Server Searching by IP Address” on page 141 in this chapter for more
information.

H Click the name of the server whose information you want to see. The Manage
Servers: Properties page appears for that server.

E Select the History tab.

By default, the view shows changes made within the past week.

Time Stamp for Server Operations

Opsware SAS maintains a comprehensive audit trail of the software that the Opsware
users install, configure, and remove from a server. By using the Opsware Command
Center, you can view the history of the changes made to a server. Entries are generated
when actions are performed for managed servers in the Opsware Command Center. The
history is read-only. See “Server Histories and Reports” on page 151 in this chapter for
more information.

The time stamps for system events are determined based on the system clocks of the
servers running the Opsware core components. To obtain accurate time stamps in server
histories (displayed in the Opsware Command Center) and Opsware component logs,
you must:
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« Synchronize the system clocks on all servers running Opsware components so that all
the servers are running with a common time.

« Set the time zone for all servers running Opsware components to Coordinated
Universal Time (UTC).

See the Opsware® SAS Deployment and Installation Guide for more information on facility
time requirements.

Additionally, Opsware, Inc. recommends that after installing an Opsware Agent on the
server (so that it becomes managed by Opsware SAS), you should synchronize the
system clock on the server with the system clocks of the servers running the Opsware
core components.

The time stamps appearing in the OCC server History tab and the Opsware Agent logs
are obtained from the Opsware core; however, you might need to review the server's logs
(such as, stdout). Having a consistent time stamp in the server's logs and Opsware SAS is
essential for effective troubleshooting.

DCI Reporting

The Model Repository maintains precise information about the state and configuration of
every server under management. You can access this information through Opsware Data
Center Intelligence (DCI) Reporting. DCI Reporting provides dynamic and detailed
information about the operational environment, and it includes the following features:

« Exact information about the latest system state and configurations
+ Visibility across the entire operational environment

» Accurate and detailed change history information

+ A comprehensive set of patch reports

.

The ability to extend the DCI reports

See the Opsware System DCI 1.8 Administrator’s Guide for information about how to set
up the DCI Reporting component. See the online DCI Reporting documentation for
information about how to use and run the reports. Note that the DCI Reporting feature
must be installed and running in the facility to view the online documentation.

The Opsware Data Center Intelligence Reporting feature is an optional component. By
AS
default, it is not installed with Opsware SAS. If this reporting feature is not available for
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your organization, contact your Opsware, Inc. support representative for information about
how to obtain it so that you can generate reports for your managed servers.

Hardware Information for Managed Servers

The Hardware link of the Opsware Command Center provides a read-only view of all
servers in your managed environment categorized by hardware manufacturer and model.
The Hardware link provides hardware related information for each server, such as:

+ Manufacturer

* Model number

+ MACID

+ Serial number

+ CPUs used on the server

+ Memory

« Storage capacity

See “Server Information that the Opsware Agent Tracks” on page 185 in Chapter 6 for
more information.

Viewing Managed Server Hardware Information

Viewing hardware information allows you to see all the servers in your managed
environment by hardware vendor, and view such information as MAC ID, CPUs, memory,
and so on.

To view hardware of managed servers:

From the navigation panel, click Environment » Hardware. You see the top level of
the Hardware category in the managed environment, as shown in Figure 4-23.

Figure 4-23: Top level hardware node

Hardware /)
Details
O varaware
Mame 0F Yerzion Modified Customer
[} sERVER O Incependent 03-28-2005  Customer Independent
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H To view the servers in your managed environment, click the Servers link.

K Drill down to the type of server you want to look at. For example, you might want to
look at all Dell POWEREDGE 650s, as shown in Figure 4-24.

Figure 4-24: Hardware home page for Dell POWEREDGE 650s

Hardware > SERVER > DELL COMPUTER CORPORATION = POWEREDGE 650

(4 &g POWEREDGE 650

Mo Sub-Modes

Cannot edit or delete this Mode. This Mode is auto-generated. This Node is special and cannot he modified.

Hame: FPOWEREDGE 650
Customer: Customer Independent
Operating Systermn: 05 Independent
Locked: Mo
Allow Servers: Yes

ID: 1360003

Bl Next, select the Members tab. You will see a list of all the Dell POWEREDGE 650s in
your managed environment.

H To view specific hardware information, from the View menu, choose Hardware. You
now see more detailed information about all the Dell POWEREDGE 650s computers
being managed by Opsware SAS.
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hapter 5: Exploring Servers and Jobs in

OCC Client

This section discusses the following topics:

Server Explorer and Groups Browser
Accessing the Server Explorer
Server Information

Server Groups Browser

Browsing Job Logs

Server Explorer and Groups Browser

The Servers feature of the OCC Client allows you to browse and manage servers and
server groups in your facility. Using the Server Explorer enables you to perform the
following tasks on individual servers:

Perform an audit.

Take a snapshot. lion

Configure applications.

View summary and history information.

Browse the file system, registry, hardware inventory, software and patch lists, and
services.

Browse Opsware information such as properties, configurable applications, and even
server history.

Drag-and-drop files between your desktop and servers.
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You can also browse server groups and perform the following operations for groups of
servers:

» Browse server groups and access servers inside of groups.
+ Perform an audit.

» Take a snapshot.

When you perform an action on a server group, it applies to all members of the group,
including other groups and their members. However, changes applied to an Application
Configuration at the group level only apply to members of the group that are servers, but
do not apply to sub groups of the parent group.

Accessing the Server Explorer

You can open the Server Explorer to view server information or perform operations on a
server. To access the Server Explorer, perform the following steps:

Launch the OCC Client. From the Navigation pane, select Servers and then select All
Managed Servers.

H Alist of servers will display in the Content pane.

=
If the list of servers is long, You can use the search tool J"'J to locate a server (upper
right corner) by name, IP address, OS, customer, facility, or description. If you search
by user name, the text entry is case insensitive.

You can also sort the list by clicking a column heading, such as name, IP address,
OS, customer, and so on. To reverse sort, click the column heading a second time.

E Select a server and open it. This opens the Server Explorer. From the Server Explorer,
you can perform the following operations from the Actions menu:

- View more detail information about the selected server in the OCC.
— Configure applications.

— Audit application configurations.

- Perform an audit.

- Create a snapshot.

- Create a package.

— Open a remote terminal.

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2006 Opsware Inc. All Rights Reserved.



Chapter 5: Exploring Servers and Jobs in OCC Client

Server Explorer Interface

The Server Explorer consists of two main components, the server object tree in the left
pane and the content area in the center pane. The server object tree lists objects from the
managed server, and the content area displays content for each of the server's objects. If
you select a server object, the corresponding content appears in the content area. See
Figure 5-1.

Figure 5-1: Server Explorer Interface

H Server: m120
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[ File System QB3S... Wind... MS04... Critical Sat Feb . Multiple securit...
- Installed Packages 0BT ... Wind... MEDA__kanort  Sat Fah & security issu...
Configured Applications QETO... wind.. M3t|  Content & security issu...
2 Windowes Services Lo
" QETI... Wind... MSC P & security izsu...
‘alches
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Patch Policies — —
Windows Registry Q4. Wiind... M303... Critical Wed Jun... & security issu...
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B
Views pane
< | > w
136 terns out of 136 [ | pizzle | FriFen 03 23:04 2008 BtoTC

Actions Menu in the Server Explorer

To access features from the Server Explorer, select a server object, and select an item
from the Actions menu. Action menu items change according to the server object
selected.

For example, if you select the Configured Applications object from the server object tree,
then from the Actions menu, you can add a configuration, remove a configuration, create
a package, and so on.
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Server Information

The Server Explorer allows you to review the following server information:
« Server Summary

« Server Properties

« Server Explorer File System

» Creating a Configuration Template from a File
+ Creating a Package from a File

* Opening a Remote Terminal

» Viewing Installed Packages

» Configured Applications

+ Configuration History

+ Services

+ Patches

+ Patch Policies

» Windows Registry

+ Windows IIS Metabase

+ Windows COM+ Objects

« Compliance

+ Server History Window

Server Summary
Inside the Server Explorer, the Summary window lists the following information:
« System: This displays operating system information.
+ Manufacturer: This displays server manufacturer, hardware, and system details.

+ Opsware Registration: This displays communication status, when the server was
last registered, how many applications and patches are registered with Opsware SAS,
and so on.
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Server Properties

The Server Explorer: Properties Window lists the following property information for the
server that you are browsing:

Management Information

.

Name: This displays the name of the managed server.
Notes: This displays any notes listed.
IP Address: This displays the IP address of the managed server.

OS Version: This displays the operating system (platform) that the managed server
is running on.

Customer: This displays an account within Opsware SAS that has access to
designated resources, such as servers and software.

Facility: This displays the location of the server. Users can manage servers in any
facility from an Opsware Command Center.

Realm (link speed): This displays the minimum bandwidth limit between the
Opsware Agent and the core (if the agent is going through gateways).

Server Use: This displays how an organization is using the managed server; for
example, a server could be a staging server, a production server, a development
server, and so on.

Deployment Stage: This displays the stages of deployment for a server; for example,
a server could be live or offline.

Opsware Lifecycle: This displays the server's stage in the Opsware Lifecycle; for
example, unprovisioned, available, managed, or deactivated.

Server ID: This displays the internal ID that Opsware SAS uses to identify the server.

Status: This displays whether or not the server is reachable and thus managed by
Opsware SAS. “OK” means that the server (its Opsware agent) is reachable;
unreachable means there is a communication problem and Opsware SAS cannot
communicate with the server.

Encoding: This displays the character encoding of the managed server, such as
Shift_JIS (Japanese) or Windows 1252 (Western).
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Reported Information

» Reporting: This displays information about the ability of the server's agent to
communicate with the core. Statuses include Has not reported, OK, Registration in
progress, and Reporting error.

« Agent Version: This displays the version number of the agent.
+ Name: This displays the name of the managed server.

» Reported OS: This displays the operating system (platform) that the managed server
is running on.

* MAC Address: This displays the Media Access Control (MAC) address. This is the
network interface card’s unique hardware number. The MAC address is used as the
server’'s physical address on the network.

+ Serial Number: This displays the serial number of the system. Opsware SAS
attempts to report a chassis ID if possible.

« Chassis ID: This displays a unique hardware-based identifier that the Opsware Agent
discovers, typically derived from some property of the server's chassis. As a common
source for this ID, Opsware SAS uses an interface's MAC address or the host ID on
Solaris servers, or the serial number for one of the interfaces.

From this window, you can also open a remote terminal on the selected server.

Installed Hardware

The Installed Hardware window lists all the reported hardware on the selected managed
server. This includes the following information:

« CPUs: This lists CPU information for all CPUs on the managed server.

« Memory: This lists the total amount and the types of memory on the managed
server.

+ Storage: This lists all storage devices on the managed server.
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Server Explorer File System

The Server Explorer’s File System element enables you to browse the file system of a
managed server and perform the following operations:

» Viewing File Contents
+ Copying Files Between Managed Servers

+ Copying Files from Your Computer to a Managed Server

Deleting Files
* Renaming Files

The File System has two main sections (similar to the Windows file system explorer): the
server's directories and the contents of the selected directory.

The left side navigation panel of the Server Explorer shows all the directories of the
selected server, and the right side of the Server Explorer lists the contents of the selected
directory.

For each file, the OCC Client lists the file's name, size, type, and date modified. To sort the
files by any of these categories, click on the top of the column.

Depending upon your user permissions, you might not have access to a particular
server's file system. In such a case, you cannot select and view the server's file system in
the Server Explorer. If you have access to a server's file system, then you will see user
names, such as Administrator, root, and Local System. These are user names used to
access that server's file system.

Viewing File Contents
To view file contents, perform the following steps:

Launch the OCC Client. From the Navigation pane, select Servers and then select All
Managed Servers.

H Alist of servers will display in the Content pane. Select a server and open it. This
opens the Server Explorer.

From the left side of the Server Explorer, select a File System object.

You are prompted to select a user name to log into the computer, such as
Administrator, LocalSystem, or root. Select a user.
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B To view the contents of disk drives or folders, expand the icon. Select a directory.

B From the Actions Menu, select View Contents. The file content view pane appears
at the bottom of the window.

To change the character encoding, select an item from the Encoding drop-down list.
Ways to Copy Files

You can copy files from a server to another directory on the same server, to a directory on
another Opsware-managed server, or to your local computer (where the OCC Client is
running). You can also copy a file from your local computer to a directory on the managed

server. A few restrictions apply when copying files on a managed server’s file system
using the Server Explorer:

» You cannot copy folders/directories.
« You can only copy to servers that you have permissions to write to and to view.
+ You can only copy one file at a time.
+ You cannot undo a deletion — once you delete a file, it's gone.
Copying Files Between Managed Servers
To copy files between managed servers, perform the following steps:

Launch the OCC Client. From the Navigation pane, select the Servers and then
Managed Servers.

H To launch the Server Explorer, open a server from the server list.

From the left side of the Server Explorer, select a File System object. To view the
contents of disk drives or folders, expand the icon.

Bl Navigate to the directory that contains the file that you want to copy and select it.
H From the Actions Menu, select Copy To.
@ Inthe Copy To dialog box, select from the following locations in the drop-down list:

— Managed Servers (other managed servers in the core)
— This Server

— Local File System

Navigate to the desired directory.

Click Select.
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Copying Files from Your Computer to a Managed Server

To copy files from your computer to a managed server, perform the following steps:

Launch the OCC Client. From the Navigation pane, select the Servers and then
Managed Servers.

To launch the Server Explorer, open a server from the server list.
From the left side of the Server Explorer, select a File System object.
Navigate to the target directory where you want to copy the file.

Use your system'’s file system explorer to select the file that you want to copy, then
drag the file to the desired location in the Server Explorer.

Deleting Files

Once you delete a file, it cannot be recovered. (However, before you delete, you are
prompted with a confirmation dialog box.)

To delete a file, perform the following steps:

BN

Launch the OCC Client. From the Navigation pane, select the Servers and then
Managed Servers.

To launch the Server Explorer, open a server from the server list.
From the left side of the Server Explorer, select a File System object.
Select a file to delete from the Content pane.

From the Actions menu, select Delete.

Click Yes in the confirmation dialog box.

Renaming Files

To rename a file, perform the following steps:

Launch the OCC Client. From the Navigation pane, select the Servers and then
Managed Servers.

To launch the Server Explorer, open a server from the server list.

From the left side of the Server Explorer, select the File System object. To view the
contents of a folder, expand the folder.

Select the file that you want to rename, and from the Actions menu, select Rename.
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B Enter a new name for the file, then press ENTER. Pressing the ESC key on your
keyboard will cancel the rename operation.

Creating a Configuration Template from a File
For any file on a managed server, you can create an Application Configuration Template.

To create an Application Configuration Template from a file, select the file. From the
Actions Menu, select Create Configuration Template. See “Creating a Configuration
Template” on page 618 in Chapter 16 for more information.

Creating a Package from a File

For any file on a managed server, you can create an installable software package. For
each package, you can specify the customer assignment, the reboot requirements, and
the pre/post install and pre/post uninstall scripts.

To create a package from a file on the managed server file system, select the file. From
the Actions Menu, select Create Package. See “Creating a Package” on page 373 in
Chapter 9 for more information on how to create a package.

Opening a Remote Terminal

You can open a remote terminal for any managed server, but not a server group. To do so,
perform the following steps:

E Launch the OCC Client. From the Navigation pane, select Servers and then Managed
Servers.

H Select a managed server and open it.

In the Server Explorer window, from the Actions menu, select Launch Remote
Terminal.

H Log into the remote terminal.

See “Opening a Remote Terminal” on page 386 in Chapter 10 for more information.
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Viewing Installed Packages

To view the installed packages on a server in the Server Explorer, select the Installed
Packages object.

The Installed Packages window enables you to view any installed packages on the
selected managed server. For each package, you can view name, type, size, last
modified, and description. To sort the list by these categories, click the title of each
column. See “Creating a Package” on page 373 in Chapter 9 for more information on how
to create a package.

Configured Applications

To view Application Configurations on a server in the Server Explorer, select Configured
Applications.

In the Content pane, the Installed Configurations tab of the Configured Applications
window allows you to browse and edit all Application Configurations attached to the
managed server.

In the Views pane, expand the Configured Application icon to display all applications
being managed by the Application Configuration Management System. (If you cannot
expand the Application Configurations folder, then no Application Configurations have
been attached to the server.)

Each application can contain one or more instances of a managed application on the
server. You can expand each application to view and edit values sets for each managed
application. For more information about setting values for an Application Configuration,
see “Setting Application Configuration Values on a Server or Group” on page 630.

Configuration History

The Backup Configurations tab of the Configured Applications window provides a history
of all changes made to the selected application configuration template, and allows you to
revert to a previous version of the configuration. Thus, you can rollback the current state of
an application configuration to any previous state in this list.

Reverting to a Previous Configuration State
To rollback the configuration to a previous state, select an item in the list and click Revert.
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Services

The Services window shows you a list of all running services on the selected managed
server. Depending on the installed operating system, you can perform different operations
on the services:

« For Windows services, you can start, stop, pause, resume, and restart a service. You
can also set the service to start manually, to start automatically when the system is
rebooted, or to be disabled altogether.

« For Linux servers (supported by Red Hat and SuSE versions), you can perform any
action that a particular service supports. Supported actions may vary from service to
service, for example, start, stop, restart, condrestart, or status. You can also specify the
run levels that you want a service to run under.

To perform an operation on a service, select the service and right-click.

Depending upon your user's permissions, you might not have access to a server's

services. In such a case, you cannot select and view the server's services in the Server
Explorer. If you do have access to a server's services, then user names appear such as
Administrator, root, and LocalSystem. These are user names that allow access to a
server's services.

Patches

This window displays all patches associated with the selected managed server. You can
use the Show drop-down list to filter what type of patch information to display in the
Server Explorer.

Show Options
« Patches Installed: This option displays all patches that have been installed on the
server.

+ Patches Recommended By Vendor: This option displays all application and operating
system patches that have been recommended by Microsoft (MBSA 2.0) for the selected
server. If multiple patches have the same QNumber, Patch Management detects which
application files are already installed on a managed server and, subsequently,
recommends the correct patch to install.
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« Patches with Policies or Exceptions: This option displays patches in policies
attached to the selected server or patches that have always install exceptions and if
one of the following conditions exist:

» The patches are not currently installed and are recommended by the vendor.
« The patches are currently installed.

+ Patches Needed: This option displays all patches that should be installed on the
selected server but are not. These include patches that are in policies attached to that
server or patches that have always install exceptions and are recommended by the
vendor.

+ Patches with Exceptions: This option displays all patches that have exceptions (such
as always install or never install) and if one of the following conditions exist:

« The patches are not currently installed and are recommended by the vendor.
» The patches are currently installed.

« All Patches: This option displays all patches that are associated with the operating
system of the server.

Patch Contents
« lcon: A dimmed icon means that the patch has not yet been uploaded to the Software
Library.

+ Name: This is the QNumber of a patch that is a hotfix or an update rollup. Service pack
patches do not have a QNumber.

+ Compliance: This shows one of the following three levels of patch compliance, as
defined by a patch administrator:

* Non-Compliant (red): This indicates that the patch is installed on the server, but is
not in the policy, or the patch is not installed on the server but is in the policy.

 Partial (yellow): This indicates that the policy and exception do not agree, and the
exception does not have data in the Reason field.

« Compliant (green): This indicates one of the following conditions:

— A patch is installed on the server and is in a policy, or a patch is not installed on
the server and is not in a policy.

- A patch is installed on the server and there are additional patches with the same
QNumber in a patch policy or exception. In this case, all patches with the same
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QNumber are considered installed when Patch Management calculates patch
compliance.

— A patch is not installed on the server and is in a patch policy or has an always
install exception, and is not recommended by the vendor. In this case, the patch is
considered as if it has a never install exception because it is not recommended by
the vendor.

In the Preview pane, move the cursor over the icon or text in the Compliance column
to view patch compliance information about a server.

Type: This shows the type of patch, such as Windows Hotfix or Windows Update
Rollup.

Bulletin (Optional): This shows the Microsoft Security Bulletin ID number for this patch.

Severity (Optional): This shows one of the following three Microsoft severity ratings for
this patch:

« Critical: This indicates a patch whose exploitation could allow the propagation of an
internet worm, without user action.

+ Important: This indicates a patch whose exploitation could result in a compromise of
the confidentiality, integrity, or availability of user data, or of the integrity or availability
of processing resources.

+ Moderate: This indicates a patch whose exploitability is mitigated to a significant
degree by certain factors, such as default configuration, auditing, or difficulty of
exploitation.

» Low: This indicates a patch whose exploitation is extremely difficult, or whose impact
is minimal.

Release Date: Release Date: This displays the date that Microsoft released this patch.
Exception: This displays the type of patch policy exception set for the selected server.
Installed: This shows if the patch is installed on the selected server.

Recommended: A check mark indicates that this patch was recommended by the
vendor (MBSA 2.0) during the last software registration.

Description: This displays a description of the server.
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Patch Policies

This window displays all patch policies associated with the selected managed server (or
server group). You can use the Show drop-down list to filter the type of patch policies to
display in the Server Explorer.

Show Options
+ Policies Attached to the Server: This displays all policies attached to the server, or
policies attached to a server group to which the selected managed server belongs.

+ Policies Not Attached to the Server: This displays a list of all patch policies relevant
to the selected server that are not attached to the server.

Patch Contents

+ Name: This displays the name of the patch policy.

« OS: This displays the operating system associated with the patch policy.

+ Description: This shows a description of the patch policy.

Windows Registry

This window displays a read-only view of the Windows registry on the selected Windows
managed server. You can navigate to this registry much like the regedit tool on the
Windows operating system.

Folders on the left side of the window represent keys in the registry. Clicking a folder on
the left displays entries in a key in the right window.

To view Windows Registry items, select the top-level Windows Registry icon in the Server
Explorer and select a user from the menu. Your user must have proper permissions to
view Windows Registry keys. If your user is unable to access the Windows Registry for
the selected managed server, contact your Opsware administrator.

The HKEY_CLASSES ROOT might have thousands of entries and can take time to load.
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Windows IIS Metabase

This window displays a read-only view of the IIS Metabase on the selected Windows
managed server. You can browse the IS Metabase much like one of the metabase
browsing tools such as metaedit or the IS Metabase Browser.

The left side of the Metabase window displays the hierarchical layout of the metabase
tree. Selecting an item in the tree on the left shows the data items associated with the
selected key in the right hand view. Clicking the (+) symbol to the left of a key item will
expand the item's child keys.

To view Windows IIS Metabase items, select the top-level Windows Metabase icon in the
Server Explorer, right-click, and select a user. Your user must have permissions to view
Windows Metabase items. If your user is unable to access the Windows Registry, contact
your Opsware administrator.

Windows COM+ Objects

This window displays a read-only view of all the COM+ objects on the selected managed
server. In the Server Explorer window, the Views pane displays two main folders for
browsing COM+ objects:

+ All Objects: This is a flat list of all the COM+ objects on the managed server.

« Component Categories: This contains an alphabetical list of all COM component
categories.

To view the contents of a COM+ object:

Select the All Objects or the Component Categories folder. In the Content pane,
expand the folder until you reach an object.

H To view the contents of a COM+ object, from the Actions Menu, select View
Contents. The contents will then display.

H If the content of the COM+ object uses a different encoding, choose the appropriate
encoding type from the Encoding drop-down list.

You must have specific user permissions to view Windows COM+ objects. If you are
unable to access the Windows Registry, contact your Opsware administrator.
Compliance

The Compliance feature displays the following tabs:

+ Server: Audit Templates Tab
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« Server: Audit Results Tab

+ Server: Snapshot Templates Tab
« Server: Snapshots Tab

Server: Audit Templates Tab

The Audit Templates tab displays a list of all compliance audit templates on the selected
server and provides the following information:

+ Name: The name of the compliance audit template.
+ Last Modified: The date when the audit template was last modified.
+ Modified By: The user who modified the audit template.

You can select an audit template from the Actions menu, choose to create a new audit
template (this chooses the selected server as the source), open the template, delete the
audit template, or perform an audit.

Server: Audit Results Tab
The Audit Results tab displays a list of all compliance audit results that used the selected
server as a source or target for the audit. This window provides the following information:

+ Name: The name of the compliance audit results.
« Last Modified: The date when the compliance audit results were created.
+ Modified By: The user who ran the compliance audit results.

You can select an audit result from the Actions menu, choose to view the results, rerun
an audit, delete the audit results, or create a package from the audit.

Server: Snapshot Templates Tab
The Snapshot Templates tab displays a list of all your snapshot templates on the selected
server and provides the following information:

+ Name: The name of the compliance snapshot template.
+ Last Modified: The date when the compliance snapshot template was last modified.
+ Modified By: The user who modified the compliance snapshot template.

You can select a snapshot template from the Actions menu, choose to create a new
snapshot template, open the template, create a snapshot from the selected template,
delete the snapshot template, or create a package.
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Server: Snapshots Tab

The Snapshots tab displays a list of all snapshots performed on the selected server and
provides the following information:

+ Name: The name of the compliance snapshot.

+ Modified: The date when the compliance snapshot was last modified.

« By: The user who ran or modified the compliance snapshot.

You can select a snapshot from the Actions menu, choose to open the snapshot, delete
the snapshot, perform an audit, or create a package of the snapshot.

Server History Window

The Server History window shows changes made to a managed server. For example, it
displays who modified a server, what change was made, when it was modified, and so
on. Server history specifically shows when a user has performed one of the following
actions:

+ Added the server to a node
+ Removed the server from a node
» Reassigned the server from one node to another

Entries are generated when actions are performed for managed servers in the Opsware
Command Center. The History is read-only. Each entry shows the following information:

» Description: A description of the change.
« Last Modified: The date when the last change occurred.
* Modified By: The user who made the change.

Use the View drop-down list to sort the server history list according to a range of time,
such as last week, the last two months, and so on.

Server Groups Browser

This section discusses the following topics:
» Accessing the Server Groups Browser

« Server Group Members

« Configured Applications for Server Groups

« Server Group History Properties
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The Server Groups Browser provides access to all server groups in the core. From the
Server Groups Browser, you can perform the following actions:

+ Browse server groups and access servers inside of groups.
+ Perform an audit.

+ Take a snapshot.

Accessing the Server Groups Browser

To access the Server Groups Browser, perform the following steps:

El Launch the OCC Client. Select Servers and then select Server Groups.

H Select a server group and open it. (You can expand a group to find sub groups.)

E If the list of server groups is long, sort the list by clicking a column name, such as
name, IP address, OS, customer, or facility.

Bl For each server group, you can also perform an audit, take a snapshot, or configure
applications.
Server Group Members

From inside each server group, you can view all members that belong to the group. This
can include servers as well as other groups. For each server that belongs to the group,
the system displays its name, IP address, OS, customer, facility, and any description.

Configured Applications for Server Groups

If the group is public, then you can add an Application Configuration to the group. The
Application Configuration applies to all servers and groups in this group.

» The Installed Configurations tab allows you to browse and edit all Application
Configurations attached to the server group.

» The Backup Configurations tab provides a history of all changes made to the selected
application configuration template, and allows you to revert to a previous version of the
configuration.

See Chapter 16, “Application Configuration Management” on page 599 of this guide for
more information.
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Server Group Patches

This window displays all patches associated with the selected server group. You can use
the Show drop-down list to filter the type of patch information displayed in the Server
Groups Browser.

Show Options
+ Patches with Exceptions: This option displays all patches that have exceptions, such
as always install or never install and if one of the following conditions exist:

« The patches are not currently installed and are recommended by the vendor.
» The patches are currently installed.

« All Patches: This displays all patches that are associated with the operating system of
a server.

Patch Contents

+ Icon: This displays a dimmed patch icon when the patch has not yet been uploaded to
the Software Library.

+ Name: This indicates the QNumber of a patch that is a hotfix or an update rollup.
Service pack patches do not have a QNumber.

+ Compliance: This shows one of the following three levels of patch compliance, as
defined by a patch administrator:

* Non-compliant (red): This indicates that the patch is installed on the server, but that
it is not in the policy, or the patch is not installed on the server but is in the policy.

« Partial (yellow): This indicates that the policy and exception do not agree, and that
the exception does not have data in the Reason field.

« Compliant (green): This indicates any of the following conditions:

— A patch is installed on the server and is in a policy, or a patch is not installed on
the server and is not in a policy.

- A patch is installed on the server and there are additional patches with the same
QNumber in a patch policy or exception. In this case, all patches with the same
QNumber are considered installed when Patch Management calculates patch
compliance.

— A patch is not installed on the server and is in a patch policy or has an always
install exception, and is not recommended by the vendor. In this case, the patch is
considered as if it has a never install exception because it is not recommended by
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the vendor.

In the Preview pane, move the cursor over the icon or text in the Compliance column
to view patch compliance information about a server.

« Type: This indicates the type of patch, such as Windows Hotfix or Windows Update
Rollup.

+ Bulletin (Optional): This indicates the Microsoft Security Bulletin ID number for this
patch.

« Severity (Optional): This displays one of following Microsoft severity ratings for this
patch:

« Critical: This indicates a patch whose exploitation could allow the propagation of an
internet worm, without user action.

» Important: This indicates a patch whose exploitation could result in a compromise of
the confidentiality, integrity, or availability of user data, or of the integrity or availability
of processing resources.

+ Moderate: This indicates a patch whose exploitability is mitigated to a significant
degree by factors, such as default configuration, auditing, or difficulty of exploitation.

» Low: This indicates a patch whose exploitation is extremely difficult, or whose impact
is minimal.

* Release Date: This shows the date that Microsoft released this patch.

« Exception: This indicates the type of patch policy exception set for the selected server.

+ Installed: This indicates if the patch is installed on the selected server.

+ Recommended: A check mark indicates that this patch was recommended by the
vendor (MBSA 2.0) during the last software registration.

» Description: This shows a description of the server.

Server Group Patch Policies

This window displays all patch policies associated with the selected server group. You
can use the Show drop-down list to filter the type of patch policies to display in the Server
Explorer.
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Show Options

.

Policies Attached to Server Group: This displays all policies attached to the server
group, or policies attached to a server group to which the selected managed server
belongs.

Policies Not Attached to the Server: This displays a list of all patch policies relevant
to the selected server group that are not attached to the server group.

Patch Contents

.

.

Name: This displays the name of the patch policy.
OS: This displays the operating system associated with the patch policy.

Description: This shows a description of the patch policy.

Server Group History Properties

The Server Groups Explorer shows the following information for each server group:

Type: This indicates if the group is dynamic (rule-based) or static.
Rules: If the group is dynamic, this displays all of the group’s rules.

Status: This displays the group’s status. Active means that the group is accessible. “In
use by access control” means that an administrator has set access control boundaries
(security permissions) for the group.

Accessibility: This indicates if the group is public or private.

Servers (this level): This indicates the number of servers that belong to this group at
this level in the group hierarchy.

Groups (this level): This indicates the number of groups that belong to this group at
this level in the group hierarchy.

Unique Servers (all levels): This shows the number of servers for the current group
and all the servers in its subgroups, recursively. For example, if the group has one
server, ServerA, and a sub-group, Group, containing two servers, then this group will
contain a total of three unique servers.

Date last used (by a job): This displays the most recent job run on the group.
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Browsing Job Logs

A job is any major process run by the Opsware Command Center or the Opsware
Command Center Client, such as a communication test, a software installation, an
Application Configuration push, a server compliance audit, and so on.

The Job Logs window shows the details of all jobs run under the currently logged in user
name and jobs that are currently in progress. It also displays jobs scheduled to run,
including the name of the job, the start time, the number of servers affected by the job,
and the status of the job.

The display of a job’s start time and finish time is determined by original user preferences
set in the Opsware Command Center, which may be different than those of the current
user. If a user is working in multiple times zones, it is a good idea to make sure that these
preferences are set to display the time zone in the date.

To see details of a finished job, open a job. If the job is recurring (scheduled to be run),
then opening the job will cause the Schedule Job dialog box to display. You will only be
able to modify the scheduled job if you created the job, or have the Edit All Jobs
permissions. To obtain these permissions, contact your Opsware administrator. See the
Opsware® SAS Configuration Guide for more information.

You can search the job list by selecting the following criteria (located at the top of the Job
Logs window):

« Job ID: Enter the job ID.
+ Job Type: Choose a type of job from this list.

+ Time Restrictions: Limit the search for a job by a time restriction such as the last
week, last two weeks, or last month.

« Job Status: Choose a job status, such as job completed, completed with errors,
cancelled, and so on.

« My Jobs/All Jobs: Choose to show all jobs or just your jobs. Click on the column
header to sort the list. Only users with the View All Jobs or Edit All Jobs permissions will
be able to view all jobs in the core. If you do not have these permissions, you will not
see these options.
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This section discusses the following topics:

+ Opsware Agent on Managed Servers

+ Opsware Discovery and Agent Deployment
+ Opsware Agent Installation Using ODAD

» Viewing Unmanaged Server Information

+ Agent Reachability Communication Tests

Opsware Agent on Managed Servers

This section provides information about the Opsware Agent on managed servers and
contains the following topics:

« Overview of the Opsware Agent on Managed Servers
+ Security for Opsware Agents Running on Managed Servers
« Opsware Agent Functionality on Managed Servers

+ Server Information that the Opsware Agent Tracks

Overview of the Opsware Agent on Managed Servers
The Opsware Agent regularly performs management tasks on each server autonomously:

On a regular interval, the Opsware Agent gathers a hardware and software inventory of
each managed server. It opens a secure communication channel to the Opsware core,
presenting its IP address and public-key certificate for authentication purposes. If properly
authenticated, the Opsware Agent is permitted to write its updates about the server to the
Opsware Model Repository.
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Every 12 hours, the Opsware Agent submits hardware information for the managed server
on which it is running. Hardware registration also occurs during Opsware Agent
installation or software installation. Every 24 hours, the Opsware Agent submits software
information for the managed server to the Opsware core. See Figure 6-1.

Figure 6-1: Server Management Tasks Performed by Opsware Agent

Every 12 hours the Opsware Agent inventories the managed servers it runs on,
registering hardware information in the Opsware System Core.

Managed Servers OPSWARE STANDALONE CORE

Servers with the - N -
Opsware Agent The Model Repository 1

' Gateway | | Registered Hardware:
A A e memory
v v iy o disk drives

® network cards
| ® CPUs

The Reporting field indicates the status of the Opsware Agent's reporting capability and
tells you whether or not the Opsware Agent is reporting regularly and successfully. The
four possible reporting states for the Opsware Agent are as follows:

OK: The Opsware Agent is reporting properly.

* Registration in progress: The Opsware Agent is currently registering server
hardware information.

* Reporting error: The Opsware Agent encountered an error while trying to report
hardware information.

» Last reported days ago: This indicates when the Opsware Agent last reported.

You can access Opsware Agent reporting information in Server Properties by using
advanced search, and by viewing managed servers by Communication status. When
viewing by Communication status, the Opsware Command Center user interface displays
this information in the registration column.

If the Opsware Agent experiences an error in reporting, or has not reported within 24
hours, you can run a Communication Test to troubleshoot the problem.

If you modify the server hardware, it could take up to 12 hours for the change to appear in
the Opsware Command Center user interface, depending on the time that the Opsware
Agent for that server contacted the Opsware core.
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If you install or uninstall software on a managed server outside of Opsware SAS, it could
take up to 24 hours for the change to appear in the Opsware Command Center user
interface. For example, if you update the Microsoft Patch Database, it could take up to 24
hours for all managed servers to display whether they need new patches based on the
updated Microsoft Patch Database.

In some cases, not all of a server's hardware information is reported. For example, if the
Opsware Agent was installed with its default settings, not all hardware information is
reported to the Opsware Command Center until an hour after the agent is installed. There
also might be a problem retrieving certain hardware information, such as a disk failure,
that could prevent some hardware information from being reported. In these cases, the
server's property page lists unreported information as not set.

If configuration tracking is enabled for a server, the Opsware Agent sweeps through the
managed server on a regular interval to see if any of the configurations being tracked are
changed. If a tracked configuration is changed, the Opsware Agent performs the action
specified by the tracking policy, namely, writing the information to a log file, generating a
backup, or sending an email message through SMTP to the email address specified in
the tracking policy.

Security for Opsware Agents Running on Managed Servers

Opsware Agents act as both clients and servers when they communicate with Opsware
SAS. All communication is encrypted, integrity-checked, and authenticated using X.509v3
client certificates using SSL/TLS.

A small number of Opsware core components can issue commands to the Opsware
Agent over a well-defined TCP/IP port. The Opsware Agent can also call back to Opsware
core components, each with its own well-defined port.

The Code Deployment & Rollback (CDR) feature uses agent-to-agent communication for
performance reasons. In particular, CDR synchronizations (the process of copying
changed files and directories from one server to another) happen when an Opsware
Agent connects to another Opsware Agent and sends across the network files that have
changed since the last time the two Opsware Agents connected.

To further safeguard the SSL/TLS-based communication channel, the two Opsware
Agents participating in the code deployment also need to have a common shared secret
provided by the Command Engine. Before one Opsware Agent can begin a file transfer to
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another Opsware Agent, the two agents must verify that they have a common shared
secret provided on a per-session basis by the Command Engine. This safeguard prevents
unauthorized users from copying files from one managed server to another.

Opsware Agent Functionality on Managed Servers
The Opsware Agent is designed such that:

+ It can only discover information about its own managed server (and no others).

+ It cannot make changes on a server unless explicitly instructed to do so by an Opsware
core component.

Opsware SAS runs with administrator privileges (root on UNIX servers and Local System
on Windows servers), because it performs tasks that require administrator privileges,
such as installing patches and rebooting servers.

The Opsware core performs client authentication and, checks to see if the presenting
certificate belongs to that particular server. Opsware SAS does this by comparing the
certificate to the server's IP address that is generated when the Opsware Agent is initially
installed. If the certificate is not valid or the originating IP address does not match the IP
address stored in the Opsware Model Repository, authentication fails and the Opsware
Agent cannot continue communication with Opsware SAS.

If an unauthorized user were able to log on to a managed server with administrator
privileges and compromise a server's security, the user would have only limited access to
the following information in the Opsware Model Repository:

« The server's own hardware inventory (already available to someone logged on with
administrator privileges)

+ The server's own software inventory (already available to someone logged on with
administrator privileges)

+ The set of assignments from itself to the nodes in the Software Tree

» The custom attributes contained in those nodes
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Server Information that the Opsware Agent Tracks

For each managed server, the Opsware Agent reports software, networking, and hardware
information, as shown in Figure 6-2 and Figure 6-3. By communicating with the Opsware
core and reporting the installed hardware and software for the server, Opsware SAS
determines what software should be installed on a server.

Figure 6-2: Manager Servers: Properties Page=Server Information

Manage Servers: Properties | core tr3. opsware.com

Return to Manage Servers

Properties

MANAGEMENT INFORMATION

Name: |core.tr3.0psware.com |

MNotes:

IP Address: 172.16.36.18
05 Version: Red Hat Enterprise Linux AS 3
Customer:
Facility: DATACENTER1
Server Lse:
Deployment Stage:
Config Tracking:

Console: {notsef
Opsware Lifecycle: Managed
Server ID: 10003

Status: ot Reachable as of Tue May 17 13:11:28 2005
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Figure 6-3: Server Properties-Hardware and Additional Information

REPORTED INFORMATION (as of Tue May 17 19:05:47 2004)

186

Reporting:
Agent Version:
Hostname:
Reported O5:
MAC Address:
Serial Number:
Chassis ID:
Manufacturer:
Model:

CPUs:

Memons

Storage:

Metwork:

Ok

3002102

coretrd.opsware.com

Linux 3A5

00:11:43:07:2F:4F

2LLPBE1

2¥LLPE1

DELL COMPUTER CORPORATION
FOVWEREDGE 1850

Model Cache Size

VYendor Speed

GEMUIMEIMTEL
GEMUIMEIMTEL
GEMUIMEIMTEL
GEMUIMEIMTEL

Intel(R) ¥ean(Th) CPU 2 80GHT
Intel(F) ¥eon(Thi) CPU 2 50GHZ
Intel(f) ¥eantThi) CPU 2.80GHE
Intel(R) ¥ean(Th) CPU 2 80GHT

2793 MHz
2793 MHz
2793 MHZ
2733 MHz

1MB
1 MB
1 MB
1 MB

Type
RAM
SyyAP

Capacity
3.9GH
1495 GB

Drive Media Capacity Bus Tvpe Model

hda
zda

CDROM -- IDE SAMSUMG CO-ROM Sh-124
SCSIDISK 6824 GB  SCE| MegaRalD LD 0 RAIDD 633G

See the Metwark tak

Cancel

Software Information

The software that should be installed is recorded in the Opsware Model Repository. To
access that information, click the Install List or Installed Packages tabs. This shows the
software that should be installed on the server or all software that is installed on the

Sserver.

To display the list of what software packages should be installed on that server by virtue
of that server's assigned nodes, select the Install List tab from the Manage Servers:
Server Properties page.

To display the list of software that is reportedly installed on the server, select the Installed
Packages tab from the Managed Servers: Server Properties page.

Partially-installed Solaris packages do not show up in the Installed Packages list, even
though the package was partially installed.
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See the Opsware® SAS Configuration Guide for information about how to set up the

Software Tree.

Hardware Information

Opsware SAS tracks hardware information in a variety of manners. Table 6-1 shows how
the Opsware Agent obtains the server and hardware information about each managed

Server.

Table 6-1: Hardware Information that the Opsware Agent Reports for Servers

Name

Reported OS

OS Version

Serial
Number

The user-configurable
name for the server.
By default, Opsware
SAS uses the
configured host name
of the server until a
user edits it.

The version number
of the server's
operating system.

The OS version
specified for the OS
definition.

The serial number of
the system. Opsware
SAS attempts to
report a chassis ID, if
possible.

Windows: Uses the fully qualified DNS name of
the server.

Linux, Solaris, AIX, HP-UX: Uses the current
host name of the server that the hostname
command returns.

Windows: Uses the Windows version number as
reported by the operating system. This information
includes the major version number, the minor
version number, the Windows build number, and
the Service Pack level.

Linux, Solaris, AIX, HP-UX: Uses the operating
system version that the uname command returns.

Specified by the user who prepared the OS with
the Prepare Operating System Wizard.

See the Opsware® SAS Configuration Guide for
more information.

Windows, Linux: Obtained from the system BIOS.

Solaris, AlX, HP-UX: Obtained from the system
ROM.
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Table 6-1: Hardware Information that the Opsware Agent Reports for Servers (continued)

Manufacturer| The manufacturer of
the server if available.

Model The model of the
server if available.

Memory The amount of

physical RAM and the
total amount of virtual

memory paging
space configured.

Information about
each of the
processors in the
system.

Processors

Windows, Linux: Obtained from the system BIOS.
Solaris, AlX, HP: Obtained from the system ROM.
Windows, Linux: Obtained from the system BIOS.
Solaris, AIX: Obtained from the system ROM.

HP-UX: Output of model command (which is read
from the system ROM).

Windows: Uses the Windows 2000 API
GlobalMemoryStatus ().

Linux: Obtained from information in the file

/proc/meminfo.

Solaris: Obtained from the sysconf and
swapctl APIs.

AIX: Uses the 1sattr command for memory
information and the 1sps command for paging
space.

HP-UX: Uses the pstat system call.

Windows: If WMI is available, iterates over all
instances of Win32 Processor. If WMl is not
available, parses the registry key
HARDWARE\DESCRIPTION\System
\CentralProcessor. There is one sub-key for
each processor.

Linux: Obtained from information in the file

/proc/meminfo.

Solaris, HP-UX: Uses system APIs to enumerate
the processors in the system.

AIX: Uses the 1scfg command.
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Table 6-1: Hardware Information that the Opsware Agent Reports for Servers (continued)

Storage Information about
each installed disk
drive or RAID array.

Server ID The internal ID that
Opsware SAS uses to
identify the server.

MID The MID (Machine ID)
is a unigque number
that Opsware SAS
assigns when the
server first registers.
The server stores the
MID and reports it
each time the server
registers.

All Platforms: Uses system APIs to discover and
probe disk drives and RAID arrays.

In most cases, the server ID is the same as the
MID.

Windows: The MID is stored in the file
$ProgramFiles%\Common
Files\Loudcloud\cogbot\mid if present.

Linux, Solaris, AIX, HP-UX: The MID is stored in
the file /var/lc/cogbot/mid.

In addition to hardware and software reporting, the Opsware Agent reports networking
information. See “Network Configuration” on page 280 in Chapter 7 for descriptions of the
networking information reported and how you can modify that information using the
Network tab in the Opsware Command Center.

Opsware Discovery and Agent Deployment

The Opsware Discovery and Agent Deployment (ODAD) feature helps to deploy Opsware
Agents to a large number of servers through the Opsware Command Center Client (OCC
Client). This feature helps to identify servers on which to install an Opsware Agent, specify
the deployment actions to be carried out on each server, select the login protocols to
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connect to each server, specify the Opsware Agent Installer options for installing an
Opsware Agent, and generate reports on Opsware Agent installation status. See Figure 6-
4,

Figure 6-4: Agent Deployment Process

AGENT DEPLOYMENT PROCESS

OCC Client OCC Client OCC Client OCC Client
O [Scan Location o Unmanaged o c (/ (/ Managed
D | Acme Facility Servers NIINCIN Servers
A “R@a@ ||k
D IP Range A ‘ ‘ ‘ A Password/Login A “.
172.34.65.30 - 70 D | root/@mb3r
STEP 1 STEP 2 STEP 3 STEP 4
User launches Scan results User selects one or Server list is updated
the ODAD in the (unmanaged servers) more servers, provides to show agent
OCC Client, selects are displayed password/login, sets installation status.
scan location in the OCC install options, and
and range of IP Client. clicks install.
address.

This overview section contains the following topics:

+ Discovering Servers for Installing an Opsware Agent

« Setting Deployment Actions for Each Server

+ Specifying Login Settings

» Opsware Agent Installer Options

» Reports on Server Status

See “Installing Opsware Agents Using ODAD” on page 196 in this chapter for information
about how to install an Opsware Agent.

Discovering Servers for Installing an Opsware Agent

Using the Opsware Discovery and Agent Deployment feature, you can select a location to
scan for servers. After selecting a location, you can specify the IP addresses or IP address
ranges to perform a network scan to identify servers in which to install an Opsware Agent.
Instead of performing a network scan, you can also import a file containing a list of IP
addresses or IP address ranges. When the scan is complete, a list of scanned servers is
shown.
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For each server, this feature determines the status of the server, its IP address, its host
name, detected operating system, and open ports used to connect to the server.

Setting Deployment Actions for Each Server

Once you have identified the servers, you can select the servers and perform the
following deployment actions:

+ Verify installation prerequisites.

When you select this action, verification checks are performed to ensure that the
Opsware Agent is successfully installed on the server. The verification checks include:

+ Checking for sufficient disk space for Opsware Agent installation on the server
« Verifying that no other application is using port 1002
« Verifying if ports to the Opsware Gateway are accessible

+ Verify prerequisites, and copy the Opsware Agent Installer to servers.

When you select this action, verification checks are performed to ensure that the
Opsware Agent is successfully installed on the server and the Opsware Agent Installer
is copied to the server.

« Verify prerequisites, copy installer, and install Opsware Agent.

When you select this action, verification checks are performed to ensure that the
Opsware Agent is successfully installed on the server, the Opsware Agent Installer is
copied to the server, and the Opsware Agent is installed on the server.

Specifying Login Settings

After selecting the deployment action, you can select the network protocols to connect to
the server and specify the user name and password to login to each server. The Opsware
Agent needs administrator-level privileges (root on Unix servers and administrator on
Windows servers) to manage a server. Therefore, Opsware Agent installation is performed
as root on Unix operating systems and as administrator on Windows operating systems.
ODAD tries to log into each of the selected servers with the specified user name and
password and performs the specified deployment actions.
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Opsware Agent Installer Options

The Opsware Discovery and Agent Deployment feature allows you to specify the installer

options listed in Table 6-2.

Table 6-2: Opsware Agent Installer Options

Start the Opsware Agent after Installation

Remove existing machine IDs and
cryptographic material

Ignore prerequisite check failures

Set the server’s time from the Opsware
core

Install Windows Installer (MSI) if required

Install Windows Management
Instrumentation (WMI) if required

Reboot Windows servers after agent
installation

Install Red Hat Package Manager (RPM) on
AIX and Solaris

Reset Opsware Agent configuration, if
present

Starts the Opsware Agent after installing it
on the server. By default, the Opsware
Agent Installer does not start the Opsware
Agent.

Removes any existing machine specific
identifying material such as Machine ID file
(MID), and all machine-specific
cryptographic material from the server.

Ignores the prerequisite check failures and
forces Opsware Agent installation.

Synchronizes the time on the server in
which the Opsware Agent is installed to the
Opsware core.

Installs MSI along with the Opsware Agent.
If MSI is already installed, this option has
no effect.

Installs WMI along with the Opsware Agent.
If WMI is already installed, this option has
no effect.

Reboots windows servers after Opsware
Agent installation is complete.

Installs the RPM handler with the Opsware
Agent. Always include this option when you
install Opsware Agents on Solaris and AIX
servers.

Replaces the existing Opsware Agent
configuration.
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Table 6-2: Opsware Agent Installer Options (continued)

Delete gateway address list, if present

Overwrite staged Opsware Agent installer

Log Level

Use Opsware Gateways

Immediately do a full hardware registration

Immediately do software registration

Suppress Opsware Agent reachability
check

Disallow anonymous SSL connections if
Opsware Agent is dormant

Force creation of new device record if
conflict found

Fail if initial hardware registration fails (do
not go dormant)

Reconcile Type
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Deletes the Opsware Gateway address list
if present and is no longer required.

Overwrites the existing Opsware Agent
Installer.

Sets the log level for log messages. With
this option, you can specify the log levels
of error, warning, info, and trace.

Specifies the Opsware Gateways used
during Opsware Agent installation.

Forces the Opsware Agent Installer to
report full hardware information to the
Opsware core.

Forces the Opsware Agent Installer to
report full software information to the
Opsware core.

By default, the installer triggers the core to
check if the server is reachable. This option
disables this check during installation.

Configures the Opsware Agent so that
browsers cannot connect without a valid
certificate.

During registration, the Data Access Engine
creates a new device record. This option
suppresses this functionality.

Does not allow the Opsware Agent to
become dormant, if it fails to report
hardware information.

Reconciles the server against any nodes
assigned to the server. The reconcile type
can be Full or Add only.
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Table 6-2: Opsware Agent Installer Options (continued)

OPTION DESCRIPTION

Attach to template ID Assigns the nodes contained in the
template to the server.

Extra Installer options Allows you to specify any other installer
options.

Reports on Server Status

After the deployment action is complete, the OCC Client displays the results and updates
the status icons for the servers as shown in Table 6-3.

Table 6-3: Server Status

ICONS SERVER STATUS
The server is unmanaged.

0

The server is managed by Opsware.

The server failed prerequisite checks.

B

The server passed prerequisite checks and
the Opsware Agent Installer was copied to
@ the server.

The server passed prerequisite checks.
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Table 6-3: Server Status (continued)

The Opsware Agent was successfully
‘ deployed.

The Opsware Agent was not successfully
deployed.

$

A server is considered to be managed by Opsware when the ODAD determines that the
Opsware Agent is listening for TCP connections on port 1002.

For a failed deployment action, you can view the errors on each server. You can also log
into the server from this feature and correct the errors.

Using this feature, you can create the following reports:

+ All the servers in the current network scan

+ Selected servers in the current network scan

«+ All the servers in the current network scan with successful deployments
« Servers in the current network scan with failed deployments

You can save and export the reports to a CSV, HTML, or text format file.

Opsware Agent Installation Using ODAD

The Opsware Discovery and Agent Deployment (ODAD) feature helps you to deploy
Opsware Agents to a large number of servers through the OCC Client. This section
contains the following topics:

« Prerequisite Setup for Opsware Discovery and Agent Deployment
» Permissions Required for Opsware Discovery and Agent Deployment

+ Installing Opsware Agents Using ODAD

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2006 Opsware Inc. All Rights Reserved.

195



Opsware® SAS 5 User’s Guide

Prerequisite Setup for Opsware Discovery and Agent Deployment

Before you can install Opsware Agents using ODAD, you must install the Windows Agent
Deployment Helper package (required for installing Opsware Agents on Windows server
only) and install JRE version 1.4.2 06 for running the OCC Client.

See the Opsware® SAS Deployment and Installation Guide for more information about
installing the Windows Agent Deployment Helper Package.

See “Requirements for Running the OCC Client” on page 97 in Chapter 3 for information
about installing JRE.

Permissions Required for Opsware Discovery and Agent Deployment

To use the Opsware Discovery and Agent Deployment feature you must have certain
permissions. See Opsware® SAS Configuration Guide for more information about the
permissions required to use the ODAD feature.

To obtain the required permissions for scanning and deploying Opsware Agents, contact
your Opsware administrator.
Installing Opsware Agents Using ODAD

To install Opsware Agents using ODAD, launch the OCC Client from the Opsware
Command Center (OCC). See “Installing and Launching the OCC Client” on page 97 in
Chapter 3 for more information.

Perform the following steps to install an Opsware Agent:
H Log into the OCC Client. The OCC Client Page appears.
From the navigation pane, select Servers and then select Unmanaged Servers.

Select a location to scan for servers from the Scan in drop-down list.

Select Supply IP Address Ranges from the drop-down list to specify a set of IP
address ranges to scan. Enter the IP address range in the From and To field. Click the
plus (+) button (next to the To field) to add another IP address range. You can add a
maximum of five IP address ranges. Click the minus (-) button to delete the IP
address range field.

Or
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Select Explicit list of IPs from the drop down list to specify the list of IP addresses to
scan. Click the ellipsis (...) button as shown in Table 6-5 to display a text editor that
allows you to load and scan a file with IP ranges to scan.

Figure 6-5: Loading a File with IP Addresses

Scan in |C03 '| IF nddresses | |[L_.J

|Explicic Lisk of IPs -|

B Click Scan to scan for servers. When the scan is complete, the list of scanned
servers is shown. For each server, ODAD determines the status of the server, its IP
address, its host name, the detected operating system, the actual operating system,
and open ports that can be used to connect to the server. See Figure 6-6. The actual
operating system of the server can be only determined if ODAD is able to
successfully log into the server.

Figure 6-6: Scan Results

Scanin [C12 M from [192.168.193.1 | to [192.168.193.20 | =
|Supply IF Address Ranges v| | Scan |
| Hestnarne: |1P Address |Detected 05 |actual 05 [55H [Hogin [ Telnet | Metbios
5l 192.168.193.1 Cisco [05 12.%
51'| admin3-eth0-110,dev, opsware,com 192,168,193.2 Linux Linux 2.4, 602,5,802,6,% v
E‘“ 123 dev.opsware,com 192,168,193.4 Linux Linux 2,4,%(2.5,% v
@“ mlB5,dev,opsware, com 192,168,193.5 Linux Linux 2.4.%/2,5.% v v

@ Click on any of the column headings to sort the server list by that column. If you want
to hide managed servers, select Hide Opsware-managed Servers from the View
menu.

Select servers on which you want to deploy the Opsware Agent. The OCC Client
supports hot keys to make multiple selections.
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BH From the Actions menu, select Deploy Agent. The Deploy Agent dialog box appears
as shown in Figure 6-7.

Figure 6-7: Deploy Agents

Actions
() Verify installation prerequisites

() Verify prerequisites and copy agent installer to servers
(3 Werify prerequisites, copy installer, and install agent
Login Settings

Protocal |SEIE|:I: Automatically vl

Username

Passward
[ ] Become rook (UNIS)

4 Installer Options
4 Advanced

| .:é.:. (04 J | Cancel

El Select one of the following deployment actions:
« Verify installation prerequisites.
« Verify prerequisites and copy agent installer to servers.
« Verify prerequisites, copy installer, and install agent.

See “Setting Deployment Actions for Each Server” on page 191 in this chapter for
more information.

Select a network protocol to log in and connect to the server from the drop-down list.
Or

Choose Select Automatically to allow ODAD to select an appropriate protocol for
each server.

Enter the user name to log into the server. For Windows, log in as administrator. For
Unix, log in as root.

If root logging is not allowed, select the Become root (UNIX) checkbox. Select
“Supply root password” and enter the password or select Use sudo, if sudo access is
enabled for that account.
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See “Specifying Login Settings” on page 191 in this chapter for more information.

Specify the Opsware Agent Installer options to control the way the Opsware Agent is
installed on a server. See “Opsware Agent Installer Options” on page 192 in this
chapter for more information.

KK Click OK to deploy Opsware Agents to selected servers.

EH After the deployment action is completed, the OCC Client displays the results and
updates the status icons for the servers. You can view information on an unmanaged
server and generate reports on Opsware Agent Installation status. See “Reports on
Opsware Agent Installation” on page 202 in this chapter for more information.

Viewing Unmanaged Server Information

After the deployment action is completed, you can review the results and generate
reports. You can view the summary and history information for an unmanaged server. For
a failed deployment action, you can view the errors on each server. You can also log into
the server from ODAD and correct the errors.

This section discusses the following topics:

« Summary Information for an Unmanaged Server

+ History Information for an Unmanaged Server

+ Remote Terminal Sessions on Unmanaged Servers

+ Reports on Opsware Agent Installation

Summary Information for an Unmanaged Server

The Unmanaged Server Summary browser shows the following information about the
unmanaged server:

+ Host Name: The host name of the unmanaged server, if defined in the Domain Name
System (DNS).

+ IP Address: The IP address of the unmanaged server.

+ Detected OS: The operating system detected on the server after performing the
network scan.

« Actual OS: The actual operating system detected on the server after the deployment
action.

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2006 Opsware Inc. All Rights Reserved.

199



Opsware® SAS 5 User’s Guide

* MAC Address: The Media Access Control (MAC) address, which is the network
interface card’s unique hardware number of the unmanaged server. The MAC is used
as the server’s physical address on the network. The MAC address is only detected if
the server is on the same physical network as the Opsware Gateway.

* NIC Vendor: The vendor name for the Network Interface Card (NIC) driver. The NIC
vendor is only detected if the server is on the same physical network as the Opsware
Gateway.

+ Open Ports: The available open ports on an unmanaged server.

* Number of Deployment Attempts: The number of deployment attempts on an
unmanaged server.

+ Last Deployment Attempt Date/Time): The Date/Time of the last deployment
attempt.

- Last Deployment Attempt Message: The message stating the possible cause for the
failure of the last deployment attempt.

Viewing Summary Information of an Unmanaged Server

Perform the following steps to view the summary of an unmanaged server.

Log into the OCC Client. The OCC Client Page appears.

H From the navigation pane, select Servers and then select Unmanaged Servers.

From the Unmanaged Servers page, select the unmanaged server. From the Actions
menu, select Open.

The Unmanaged Server Browser page appears.
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Bl Click Summary on the left side navigation panel of the Unmanaged Server Browser
page to view the summary on the unmanaged server. See Figure 6-8.

Figure 6-8: Unmanaged Server Summary Page

% 192.168.198.93 {(Unmanaged)
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o
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Hostname:
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MAC Address:
MIC Yendit:
% Open Porks:
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Last Deplayment Attemnpt Date/ Time:
Last Deployment Attempt Message:

192,165,1958.93
Microsaft \Windaws 2003 MET/NT/2K /%P

139 3389
3
Thu, 7 Apr 2005 15:17:08

The credentials supplied conflict with an existing set of credentials.

| ssunderrajan | Thu Apr 07 23:15 2005

History Information for an Unmanaged Server

The Unmanaged Server History Browser shows a history of all actions executed on

unmanaged servers such as:

« A summary of the actions performed on the unmanaged server

+ Details of all the actions performed on the unmanaged server

* Log information

The history is read-only.

Viewing History Information of an Unmanaged Server

Perform the following steps to view the history of an unmanaged server:
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Log into the OCC Client. The OCC Client Page appears.

From the navigation pane, select Servers and then select Unmanaged Servers.

From the Unmanaged Servers page, select the unmanaged server. From the Actions
menu, select Open.

The Unmanaged Server Browser page appears.

Bl Click History on the left side navigation panel of the Unmanaged Server Browser
page to view the history of all actions executed on unmanaged servers.

Remote Terminal Sessions on Unmanaged Servers

Using the ODAD feature, you can open terminal sessions on an unmanaged server. You
can log into the server using the appropriate protocol to correct the errors on the server or
perform any other operations.

You can use the OCC Client Remote Terminal and Shell preferences to configure the
Terminal (UNIX) and RDP (Windows) clients used to launch terminal sessions. See
“Overview of Global Shell” on page 385 in Chapter 10 for more information.

Opening Remote Terminal Sessions on an Unmanaged Servers

Perform the following steps to open remote terminal sessions on a server:

Log into the OCC Client. The OCC Client Page appears.

H From the navigation pane, select Servers and then select Unmanaged Servers.

From the Unmanaged Servers page, select the unmanaged server. From the Actions
menu, select the appropriate log in with protocol.

Reports on Opsware Agent Installation

Using the Opsware Discovery and Agent Deployment feature, you can create the
following reports:

» All the servers in the current network scan
» Selected servers in the current network scan
« Servers in the current network scan with successful deployments

+ Servers in the current network scan with failed deployments

You can also save and export the reports to a CSV, HTML, or text file format.
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Perform the following steps to create reports:

Log into the OCC Client. The OCC Client Page appears.

H From the navigation pane, select Servers and then select Unmanaged Servers.

H From the Unmanaged Servers page, select the unmanaged server. From the Actions

menu, select Export to the desired report format. The Save Report dialog box

appears.

Bl From the drop-down list, select the type of report as shown in Figure 6-9.

Figure 6-9: Generating Reports

Sawve In: |0 Deskiop

EIREER

(3 My Documents |53rvers ‘Wikh Errors - |

3 My Computer all Servers

3 My Metwork Places Successful Deplovments

E] log.txt Servers \With Errors
Selected Servers

File Marne: |

Files of Type: |Te><t File

b |

Save || Zancel |

B Enter the location and file name to save the report.

Example Report

The following example shows a report of servers with failed deployments.

Servers which the Opsware Agent could not be deployed to:

Hostname : Unknown

IP Address : 192.168.198.93
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Detected Operating System : Microsoft Windows 2003 Server or XP
SP2

Open Ports : 139 3389
MAC Address : Unknown
NIC Vendor : Unknown
# of Deployment Attempts : 2

Last Deployment Message : The credentials supplied conflict with

an existing set of credentials.

Last Deployment Attempt Date/Time : "Wed, 6 Apr 2005 16:18:46"
Failed Phase : Check

Return Code : 2013

Suggested Resolution : The Agent Deployment Helper was unable to

log in to the unmanaged server.

An incorrect login name or password was specified. Try a

different login name and/or password.

Agent Reachability Communication Tests

This section provides information on agent reachability Communication Tests within
Opsware SAS and contains the following topics:

+ Overview of Communication Tests

« Communication Tests and Unreachable Opsware Agents
+ Communication Test Types

+ Communication Test Errors

+ Additional Information on Communication Tests

* Running a Communication Test on an Individual Server
* Running a Communication Test on Multiple Servers

+ Viewing Servers by Communication Status

» Searching for Unreachable Servers
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+ Creating Communication Test DCI Reports
+ Viewing My Jobs Communication Tests

« Exporting the Unreachable Server Status List to CSV

Overview of Communication Tests

Sometimes an Opsware Agent can become unreachable, which means that the Opsware
Command Center has difficulty communicating with the Opsware Agent. When an
Opsware Agent is unreachable, the server it is installed on is considered unmanaged.
This section explains how to use the Communication Test to find unreachable Opsware
Agents and suggests ways that you can resolve these problems.

To help identify those managed servers that have unreachable agents, the Opsware
Command Center runs periodic Communication Tests to verify that Opsware SAS can
communicate with all servers under its management. You can always check the
reachability of Opsware Agents by looking at the server's properties, or by viewing the
current agent reachability status for all managed servers since the last Communication
Test was run by choosing the Communication view from the Manage Servers list.

To determine the current reachability of a specific Opsware Agent, you can run a
Communication Test to find those servers that have unreachable agents by using the
Communication Test feature located in the Server menu of the Manage Server list. A
Communication Test lists all servers with unreachable agents, returns specific errors
associated with each unreachable Opsware Agent, and provides troubleshooting
information to help you get the Opsware Agent back in working order.

You have the ability to check Opsware Agent reachability for individual servers, selected
servers, or all servers under management of Opsware SAS. Each time that you run a
Communication Test, this test is saved in the My Jobs panel, which allows you to view a
history of all the Communication Tests that you have run. You can even export the current
reachability status of all managed servers to a CSV file.

Communication Tests and Unreachable Opsware Agents

The Communication Test works by testing communication and data exchange between
the specific components of the Opsware core and each managed server. The Opsware
core is the entire collection of servers and services that provide Opsware services. In
order to successfully manage servers, the Opsware core needs to be able to
communicate with each Opsware Agent on all servers under Opsware SAS management.
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Communication Test Types

The Communication Test performs the following diagnostics to determine if an Opsware
Agent is reachable:

Command Engine to Agent Communication (AGT): Determines if the Command
Engine can communicate with the agent. The Command Engine is the Opsware SAS
component that enables distributed programs to run across many servers. The
Command Engine handles the entry of scripts into the Opsware Model Repository (the
script storage location in Opsware SAS) and the versioning of stored scripts.

Crypto Match (CRP): Checks that the SSL cryptographic files that the agent uses are
valid.

Agent to Command Engine Communication (CE): Verifies that the agent can
connect to the Command Engine and retrieve a command for execution.

Agent to Data Access Engine (DAE): Checks whether or not the agent can connect
to the Data Access Engine and retrieve its device record. The Data Access Engine
provides an XML-RPC interface to the Model Repository that simplifies interaction with
various clients such as the Opsware Command Center, system data collection, and
monitoring agents on servers.

Agent to Software Repository Communication (SWR): Determines if the agent can
establish an SSL connection to the Software Repository. The Software Repository is the
central repository for all software that Opsware SAS manages. It contains software
packages for operating systems, applications, databases, customer code, and software
configuration information.

Machine ID Mismatch (MID): Checks that the Machine ID (MID) on the server
matches the MID registered in the Model Repository for the agent.

When the test finishes, it returns results that show either success or failure for each test
run on each server. For each failed test, the nature of the failure is indicated in the Test
Summary column of the Communication Test results page. In some cases, the failure of
one test might prevent other tests from being executed.

See “Opsware Agent Functionality on Managed Servers” on page 184 in this chapter for
information about the Opsware Agent and its relationship to managed servers.
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Communication Test Errors

After you run a Communication Test, three icons indicate the success or failure of agent
reachability as Table 6-4 shows.

Table 6-4: Agent Unreachability Status Icons

Communication Test passed. Agent is reachable.

@

Communication Test unable to be executed.
=

Communication Test failed. Agent is unreachable.
&
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Table 6-5 describes each type of Communication Test and all possible errors for each
test.

Table 6-5: Communication Test Types with Possible Results

Command Engine to Agent | Determines if the H oK
Communication (AGT) Command Engine can B Untested
communicate with the
agent H Unexpected error
Bl Connection refused
H Connection time-out
B Request time-out
Server never registered
B Realm is unreachable
El Tunnel setup error
K Gateway denied access
EEl Internal gateway error
EB Gateway could not
connect to server
EE Gateway time-out
Crypto Match (CRP) Checks that the agent’s H OK
Sji:cryptograpmc files are Untested

Unexpected error

Agent certificate
mismatch

SSL negotiation failure
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Table 6-5: Communication Test Types with Possible Results (continued)

Agentto Command Engine | Verifies that the agent can | Kl

Communication (CE) connect to the Command 2]
Engine and retrieve a
command for execution

[~ o I o i~ I <o)

OK

Untested

Unexpected error
Connection refused
Connection time-out
DNS does not resolve
Old agent version
Realm is unreachable

No gateway defined

K Tunnel setup error

EEl Gateway denied access

EB Gateway name resolution

error

EEl Internal gateway error

K Gateway could not

connect to server

EH Gateway time-out

K3 No callback from agent
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Table 6-5: Communication Test Types with Possible Results (continued)

Agent to Data Access Checks whether or notthe ||l OK
Engine (DAE) agent can connect to the Untested
Data Access Engine and
retrieve its device record | Bl Unexpected error
Bl Connection refused
H Connection time-out
@ DNS does not resolve
Old agent version
B Realm is unreachable

Bl No gateway defined
K Tunnel setup error
EEl Gateway denied access

EB Gateway name resolution
error

EEl Internal gateway error

K Gateway could not
connect to server

EH Gateway time-out
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Table 6-5: Communication Test Types with Possible Results (continued)

Agent to Software

Determines if the agent

Repository Communication | can establish an SSL

(SWR)

MID Match

connection to the Software

Repository

Checks that the Machine
ID (MID) on the server
matches the MID
registered in the Model
Repository for the agent

[~ o> I o I~ I <o [~ I |

OK

Untested

Unexpected error
Connection refused
Connection time-out
DNS does not resolve
Old agent version
Server identification error

Realm is unreachable
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See “Communication Test Troubleshooting” on page 743 in Appendix C for information
about how to troubleshoot Communication Test Errors.
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Additional Information on Communication Tests

In the case that the Communication Test cannot be performed on a server, you see an
error named Unexpected Error with a small plus (+) button next to it. Click the plus (+)
button to see the Additional Information window, which provides traceback information
regarding the error. You can send this information to Opsware Customer Support to solve
a problem of this nature. See Figure 6-10.

Figure 6-10: Additional Information on an Unexpected Error

N Opsware Command Center - Microsoft Internet Explorer

Additional Information

@ reach0000.0psware.com

Traceback (nnermost last):

File " ihase/deliverance.py, line 1230, in poke_handler

File " femirpotsmlepelib.py, line 730, in __call__

File " smirpcllexmirpelin py”, line 106, in __request

File " smirpcixmirpelib.py”, line 818, in __request

File " JS5LTransport. oy, line 61, in request

File "Jfasyncssl.py”, line 113, in connect

File "Jasyncsslpy”, line 182, in _blocking_connect
error; host not found

Running a Communication Test on an Individual Server

Perform the following steps to run a Communication Test on an individual server to find
out if the Opsware Agent on that server is reachable:

From the navigation panel, click Servers » Manage Servers.

From the Manage Servers list, click the display name of the server that you want to
perform a Communication Test on.

On the Server Property page, look in the Status field and notice that the server is
either listed as Reachable or Not reachable. If listed as Not Reachable, a date
indicates when the last regularly scheduled Communication Test was performed.
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To see the results of the last Communication Test for this server, click Details. The
Communication Test window for the server appears, as Figure 6-11 shows.

Figure 6-11: Communication Test Results on an Individual Server

3 Communication Test - 172.16.1.34 - Microsoft Internet Explorer |:||E|r5__(|

Communication Test

W 172.16.1.34

Last Tested: 0726004 02:41:20 Run Test Again ]
Tatal Errors: 4

AGT B Connection timeout [7]

CRP O Untested

CE ﬂ Internal gatevway error 7]

DAE ﬂ Gatewsay couldn't caonnectto server [7]
swR B Gateway denied access [7]

MID O Uniested

The results listed in this window show details from when the last regularly scheduled
Communication Test was run.

Bl To view troubleshooting information for any of the test errors, move your mouse over
the error name (for example SWR). When your mouse cursor changes to a question
mark, click the question mark to view the troubleshooting help.

B To rerun the Communication Test, click Run Test Again. The new results display in
the same window when the test finishes.
Running a Communication Test on Multiple Servers

Perform the following steps to run a Communication Test on multiple servers and to find
out which managed servers are not reachable:

From the navigation panel, click Servers » Manage Servers.
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In the Manage Servers Summary View page, select the servers for which you want a
Communication Test.

Choose Tasks » Run » Communication Test. The Communication Test window
opens and the test is initiated. The top of the test window shows the status report for
the Communication Test, which indicates the time of the test, how many servers in
the test were reachable, which servers were not reachable, and a progress bar. This
summary information is shown in Figure 6-12.

Figure 6-12: Communication Test Summary

%}' May 20, 2004 - Testing § Servers

Started: 11:33 PM UTC Comm Test in progress,..1 of 5 completed
Servers: 0 with Errors m
ot 209 |
“summary. B new results available.

® Servers can report more than one errar

Display: [ Hide serers that are OK
[ Fefresh Results

Date: Provides the date of the test.

Statistics: Shows start and finish time, total servers OK, total servers with
unreachable agents, and a summary of errors.

Progress Bar: Provides live feedback of Communication Test progress. Progress
data includes the number of servers completed, the total number of servers to be
completed, and the list of servers completed so far.

Refresh Results Button: Refreshes the results screen with new results.
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Below the summary section is a list of all Opsware Agents that were not reachable
and their details, as Figure 6-13 shows.

Figure 6-13: Communication Test Results on an Unreachable Agent

Communication Test - Job ID: 260003 Close
@ May 17, 2005 - Testing 2 Servers
Started: 8:46 PM UTC Completed Job ID:260003
Servers: O with Errors
00K
CETREL 0 new result available.
" Servers can report more than ane eror . )
Display: []Hide servers that are OK
Refresh Results
Test Summary
Mame * Host Name AP Address  OS Version Agent Wersion Redistrefion Facilty AGT CRP CE DAE SWR MWD Errors ErrorDetailz  Time
coretriopsware.com  coretrdopswars.com  Red Hat 30.0.2.102 Ok DATACENTER ﬂ o @@ @ @ 1 Urexpected In
172.168.36.18 Erterprise error [+] Progress
Linux &5 3
OPSWARE-STROCOZ  OPSWARE-STROCOZ  Windows 300.2.62 Ok DATACEMTER E O oo o o 1 Urexpected In
172.16.36.43 2000 error [+] Progress

» The results section shows a table of all unreachable servers, detailing server name,
host name/IP address, OS, Opsware Agent version, registration (when the Opsware
Agent last reported to Opsware SAS), and the time the test was completed.

« Click the title of each column to sort the test information by specific categories.

« The Test Summary section shows a list of all Communication Test types that were
run, and which errors were returned. For information about each type of error and how
to troubleshoot Opsware Agent reachability problems, click the link on each error to
view online help.

Viewing Servers by Communication Status

Perform the following steps to view all manage servers with the most recent
Communication Test results for each manage server:

From the navigation panel, click Servers » Manage Servers.

H From the View menu, choose Communication. A list of the most recent
Communication Test that was run on all managed servers appears. All servers listed
in this view are listed as unreachable or reachable since the last regularly scheduled
Communication Test was run.
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E To sort the information in this view, click any of the column headings. For example,
you might want to view the servers by number of errors. Click the Error column title
by name, by OS version, and so on.

Bl To export this view to the CSV file format, choose Export to CSV from the Resource
menu.

H To run a new Communication Test for some or all of the servers in this view, select
the servers that you want to run a Communication Test on and then choose Run »
Communication Test from the Tasks menu.

Searching for Unreachable Servers

Another way you can discover unmanaged servers (those with unreachable agents) is to
search for all servers that have a status of unreachable. See “Using the Search Feature”
on page 125 in Chapter 4 for more information.

Perform the following steps to search for unreachable agents:

E From the navigation panel, click Servers » Server Search. The Server Search page
appears.
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H From the Server Search page, choose the Agent Reporting attribute from the first list,

Figure 6-14: Agent Reporting Server Search Attribute

as Figure 6-14 shows.

Agent Heporting

W

Properties

Aoent Reparting

Agent Status
Agent Wersion
Customer

Deployment Stage
Facility

Hostharme

Motes

Opsware Display Name

Server Lse

Opsware Properties

Lifecycle

Software

Installed Patches
Installed Software
05 “ergion

Windows Service

MNatwork

IP Address
MAC Address

Hardhware

Make and Maodel
Serial Mumber

More criteria displays for the search parameters.

From the far right list of search attributes, select Not Reporting. Your search

parameters are Agent Status is Not Reporting.

Click Search. Wait a few moments for the results (the speed of the search results
depends on how many managed servers are being searched). If any of your
managed servers are not reachable, these servers will be listed in the search results.

To run a new Communication Test on these servers, select the server (check box
next to the server), and choose Run » Communication Test from the Tasks menu.
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Creating Communication Test DCI Reports

To view a Communication Test in a report format, you can use the Data Center
Intelligence (DCI) Reporting feature. It enables you to create a printable report of the
Communication Test results. After you make a report of the test results, you can export the
report to HTML, CSV, Microsoft Word, and other file formats, so that you can exchange the
report with others.

For information on how to create a DCI Communication Test report, view the DCI online
help by clicking Help in the Opsware Command Center.
Viewing My Jobs Communication Tests

Each time that you run a Communication Test, the information is saved as a My Job. This
feature automatically saves a history of all tests that you run. To view saved
Communication Tests, perform the following steps:

From the navigation panel, click My Job.
H From the My Job list, click the Communication Test job that you want to view.

In the Communication Test window, wait a few moments for the Communication Test
information to load, then click View Details. You see the Communication Test
window.

Exporting the Unreachable Server Status List to CSV

Perform the following steps to export the list of all servers that have a status of
unreachable to the CSV file format:

From the navigation panel, click Servers » Manage Servers.

H From the View menu, choose Communication. You see a list of all servers that are
in an unreachable or reachable state.

To export a list of these servers to the CSV file format, select the check box next to each
server that you want to include in the report, then from the Resource menu choose
Export to CSV.
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Command Center

This section discusses the following topics:

Overview of Server Management

Communication Between Managed Servers and Opsware SAS
Server Groups

Server Life Cycle

Server Management Jobs

Custom Fields for Servers

Custom Attributes for Servers

Service Levels

Network Configuration

This section does not document how to install operating systems, patches, or applications

on servers. However, it does discuss how those tasks fit into the overall server life cycle,
and it does provide cross-references to the appropriate topics in other sections.

Overview of Server Management

Opsware SAS manages servers in an operational environment in the following ways:

Installing Opsware Agents on servers that are already functioning in the operational
environment, which allows users to deploy and manage new applications installed on
those servers

Provisioning servers with Microsoft Windows, Red Hat Linux, and Sun Solaris operating
systems by using vendor-provided operating system bootstrapping technologies.
Additionally, Opsware SAS integrates with AIX NIM and HP-UX Ignite installation
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technologies to provide a uniform method for OS provisioning across a heterogeneous
environment.

See “Overview of OS Provisioning” on page 569 in Chapter 15 for information about
how Opsware SAS provisions Microsoft Windows, Red Hat Linux, and Sun Solaris
operating systems on managed servers.

See the Opsware® SAS Configuration Guide for information about how Opsware SAS
integrates with AIX NIM and HP-UX Ignite installation technologies.

« Automating patch management on Opsware SAS-managed servers by providing the
ability to react quickly to newly-discovered security threats and the degree of control
required to ensure that new patches are installed in a uniform way.

See “Patch Management for Windows” on page 453 in Chapter 12 for more
information.

See “Patch Management for Unix” on page 519 in Chapter 13 for more information.

+ Managing application provisioning, which enables users to deploy applications and
databases across many servers simultaneously, and track what is deployed on each
server.

See “Software Provisioning” on page 549 in Chapter 14 for more information.

» Providing configuration tracking, which allows users to monitor selected configuration
files and databases and to take certain actions when change is detected.

See “Configuration Tracking” on page 643 in Chapter 17 for more information.

To manage servers with Opsware SAS, you do not need root access on Unix or

IZ administrator access on Windows. However, you will need permissions to use specific
Opsware SAS features, as well as permissions for customers and facilities associated with
servers. To obtain these permissions, contact your Opsware administrator. For more
information, see the Permissions Reference appendix in the Opsware® SAS Configuration
Guide.
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Communication Between Managed Servers and Opsware
SAS

This section provides information about communication between managed servers and
Opsware SAS and contains the following topics:

* Network Address Translation (NAT) for Managed Servers

+ Key Terms of Opsware SAS Managed Server Communication
+ Locating the Management IP Address of a Managed Server
+ Code Deployment and Static NAT

+ Setting the Primary IP Address of a Server

* NAT Table Mapping and Managed Servers

Network Address Translation (NAT) for Managed Servers

To manage a server, Opsware SAS requires that the server have a unique IP address that
is routable from Opsware SAS. However, in a large operational environment, all servers
might not have unique IP addresses. In this case, Opsware SAS supports static Network
Address Translation (NAT) for managed servers.

Static NAT maps public IP addresses to hosts inside the internal network, which allows
Opsware SAS to manage all servers in the environment.

Unlike dynamic NAT, the mapping between Opsware SAS and the servers under
management is set ahead of time, not dynamically at runtime.

Key Terms of Opsware SAS Managed Server Communication

To understand how Opsware SAS communicates with managed servers, you must
understand these three terms:

+ Management IP: The IP address that Opsware SAS uses to communicate with the
Opsware Agent on the server.

During hardware registration for a server, the Opsware Agent opens a TCP/IP
connection to Opsware SAS. The connection contains the source IP (called peer IP)
address of the server. By default, Opsware SAS uses this peer IP address as the
management IP for the server.

+ Management Interface: \When a server has more than one network interface, you can
designate one of them as the management interface.
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« Primary IP: The IP address of the management interface. When you change the
management interface, the primary IP changes to the IP address of that interface. The
primary IP address is a locally-configured IP address.

During synchronizations, the Code Deployment & Rollback feature uses the primary IP
address to communicate with the server. See “Code Deployment and Static NAT” on
page 224 in this chapter for more information.

The Opsware Agents on servers communicate with each other by using the primary IP
addresses, even though Opsware SAS uses management IP addresses to
communicate with the servers.

Opsware SAS does not support managed servers that have IPv6 addresses.

When static NAT is being used, the management IP address for a server will not be the
same as the primary IP address. When static NAT is being used, the management IP is
the NAT-translated IP address for the server. When static NAT is not being used, the
management IP address is always the same as the primary IP address.

Locating the Management IP Address of a Managed Server

In the Opsware Command Center, you can find the management IP address of a server
and check whether it is using static NAT. You might need this information for
troubleshooting any servers marked Not Reachable and to determine whether your NAT
configuration is correct. The Opsware Command Center displays the management IP
address of a managed server in the following two places:

+ The Network tab of the Server Details page

« The Hardware view of the Manage Servers list
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The Network tab shows (and allows the user to set) the management interface for the
server by selecting it from a drop-down list, as Figure 7-1 shows.

Figure 7-1: Management IP Address Information in the Network Tab

NETWORK INFORMATION |

Hostname: |core.tr3.0psware.com

Management IP: 17216.36.18
Facility: DATACEMTER1

Management Interface:

Gateway: |17 15.36.17

DNS Servers: |gf 54 32 78
66.54.0.75

Search Domains: tr3.0psware.com

opsware.com

CONFIGURATION FOR: eth
Use DHCP Settings:

IP Address: 1173 15.36.18 |

MAC Address: 00:11:43:D7:2F:5F
Interface Type: ETHERMET
Interface Speed: {nhot sef)

SubnetMask: |5c5, o5 265,248 |

CONFIGURATION FOR: eth1
Use DHCP Settings:

IP Address: | |

MAC Address: 00:11:43:D7:2F:60
Interface Type: ETHERMET
Interface Speed: {nhot sef)

Subnet Mask: |
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Figure 7-2 shows the Hardware view in the Manage Servers list, which displays the
management interface for the server in the Network Info column. (To access the
Hardware view, choose Hardware from the View menu.)

Figure 7-2: Hardware Tab in the Manage Servers List

Al Statuses Al Operating Systems v Al Stages v AllUses v Al Customers v Al Manufacturers v Al Models v U
nclate
Managed & Desclivated v ]
Resource  Edt  Wiew Tasks  Configuiation Tracking
[ | Host Mame /P Address Recistration  Metwork Info Hardware Info Harchweare Components:
y’q}g‘j Public Groups
(3] E' corelriopsware.com  coredr3.opsware.com Ok 172163618 (ethd)  Man: DELL COMPLTER CORPORATION CPUs  Intelt) ¥eonrTh] CPU 2.80GHz, 2793 MHz, 1 MB
L2 RiA (sth1) Mod:  POWEREDGE 1850 Intel(R) ¥ean(Th) CPU 2.80GHz, 2753 MHz, 1 MB

Mac: 00:11:43:D7:2F:5F InteliR) ¥eoni Th) CPU 2.80GHZ, 2793 MHz, 1 MB
Ser: 2YLLPE1 Intel(R) ¥eon(Th) CPU 2.80GHZ, 2793 MHz, 1 MB

Memory: 3.9 GB RAM
1.95 GB SWAP
Stor: hida (CDROM)
soa (SCE| DISK 65.24 GB)

The Network Info column shows the IP addresses and interfaces configured for each
server in the list. If a server is using static NAT, the management IP is the first entry in this
list and (NAT) appears after the IP address. If it is not using static NAT, the management IP
is the same as the management interface, so it is already shown.

Code Deployment and Static NAT

Code Deployment and Rollback (CDR) synchronizations can only occur between
Opsware Agents in the same NAT domain. Synchronizations cannot be performed
between Opsware Agents in different NAT domains.

Opsware SAS uses the primary IP address (instead of the management IP address)
during synchronization because it is assumed that static NAT is not occurring between
the servers in the synchronization. During CDR synchronizations, two Opsware Agents
must communicate directly. Users can override the IP address that Opsware SAS
determined and designate a specific network interface as the management interface.

See “Code Deployment and Rollback” on page 671 in Chapter 18 for information about
how to use CDR.
Setting the Primary IP Address of a Server

When a server has more than one network interface, users can specify one of them as
the management interface and the IP address for this interface is designated the primary
IP address. The primary IP address is used for Opsware Agent-to-Opsware Agent
communication.
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If static NAT is not being used, the management and primary IP addresses are the same.
If static NAT is being used, the management IP is unaffected when a user changes the
management interface.

Perform the following steps to set the primary IP address of a server:

E From the navigation panel, click Servers » Manage Servers. The Manage Servers
page appears. Browse the list to find the server whose management IP address you
want to view.

Or

Search for the server whose management IP address you want to view.

Click the server name. The Manage Servers: Properties page appears.

Select the Network tab. The network information for the server appears.
The Network tab shows (and allows you to set) the server's management interface.

Bl Set the management interface by selecting it from the Management Interface field.
The IP address for this interface is designated the primary IP address.

B Click Update.

See “Using the Search Feature” on page 125 in Chapter 4 for more information. See
“Server Searching by IP Address” on page 141 in Chapter 4 for more information.

NAT Table Mapping and Managed Servers

Static, one-to-one NAT tables map routable IP addresses between Opsware SAS and
managed servers. Network administrators configure and maintain these NAT tables. After
the static NAT tables are configured, you do not have to perform any additional setup for
Opsware SAS.

Opsware SAS does not control these NAT tables and errors can occur if they are modified
after Opsware-managed servers register their hardware information. The following errors
can occur if the IP address mapping of a server changes:

« |f the IP address on the Opsware SAS side of the NAT mapping is modified, the server
becomes unmanageable and might be marked Not Reachable on the Manage Servers:
Status page. It stays in this state until the Opsware Agent requests another hardware
registration and the server's management IP is updated.

« If an IP address mapped to a particular server is mapped to a different server, both
servers become unmanageable and might be marked Not Reachable on the Manage
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Servers: Status page. This problem is resolved when one of the two servers reports its
IP address during hardware registration. The other server remains unmanageable until
the server registers with the Opsware Agent. Both servers eventually become
manageable.

Server Groups

This section provides information on server groups within Opsware SAS and discusses
the following topics:

« Overview of Server Groups

» Types of Server Groups

* Public Group Modeling

+ Ways to Create Server Groups

« Adding a Server to Static Groups, Both Public and Private

+ Removing Servers from Static Groups, Both Public and Private
» Duplicating Server Groups

» Rules for Deleting Server Groups

Overview of Server Groups

The Server Groups feature is useful for gathering servers into collections. These groups
can be used as a shortcut for performing the same action on all of the servers
simultaneously, instead of performing the action on each individual server, one at a time.
Server groups can also be used to simply organize groups of servers.

Server groups can be comprised of individual servers as well as other server groups.

The My Servers feature can also be used to gather servers and server groups, but it has

Q different functionality than the Server Groups feature. You can add individual servers,
server groups, and nested groups that you access frequently to My Servers. See “My
Servers” on page 122 in Chapter 4 for information about using this feature.
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Uses for Server Groups

Some recommended uses for server groups include:

Grouping servers by OS version

Grouping servers by customer

Grouping servers by facility

Grouping servers by deployment stage

Grouping servers by use (Server Use in the Server Properties page)

Grouping servers by operational boundaries, for example, grouping together all servers
that require identical application configuration

Grouping servers by access control boundaries, for example, creating server groups
that are associated with a specific User Group

Permissions Required for Working with Server Groups

Users must have the permissions shown in Table 7-1 in order to perform specific tasks
related to server groups. Only administrators can set permissions.

Table 7-1: Permissions Required for Working with Server Groups

Manage Servers Create, edit, and delete pri-
vate server groups, both
static and dynamic.

Manage Public Server The Manage Servers Per- Create, edit, and delete pub-
Groups missions section on the lic server groups, both static
Other tab in Users and and dynamic.
Groups

Model Public Server Groups ' The Manage Servers Per- Model public server groups.

missions section on the See “Public Group Model-

Other tab in Users and ing” on page 230 in this

Groups chapter for more
information.
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Table 7-1: Permissions Required for Working with Server Groups (continued)

Allow Run Refresh Jobs The Manage Servers Per- Add or remove servers from
missions section on the groups before a scheduled
Other tab in Users and job is run. This permission
Groups gives you the option to

refresh group membership
before a job is run so that it
is only run on the servers
that belong to the group
when the job is actually run.

Characteristics of Server Groups
When using server groups, groups have the following characteristics:

+ Individual servers can be included in as many groups as you want, or not included in
any groups.

+ Adding servers to a group does not remove those servers from the list of all servers
that appears when you click Servers » Manage Servers in the navigation panel.

+ Groups can contain servers and subgroups.
« Server groups are hierarchical (they can be nested) with these caveats:

 Private and public groups cannot be mixed in a hierarchy, but static and dynamic
groups can.

See “Types of Server Groups” on page 229 in this chapter for more information about
private and public groups.

» The rules for a dynamic group are not inherited from a parent dynamic group to a
dynamic subgroup.

See “Dynamic Groups” on page 230 in this chapter for more information about the
characteristics of dynamic groups.

+ Groups do not inherit modeling data from their parents, including node attachments
and custom attributes.

» When you run an operation on a group that contains nested groups, the operation
also applies to all the servers in the nested groups below the current group.
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* When an Application Configuration operation within the OCC Client is applied to
groups, and those groups contain subgroups, the operation does not apply to all the
servers in the subgroups. It only applies to the group upon which the operation was
directly applied.

Types of Server Groups

There are private groups and public groups, and each can be either static or dynamic.

Private Groups

If you belong to a user group that has access to the Manage Servers list, you can create
groups that you alone can see and work with. Only you see your private groups — other
Opsware users cannot see them. Private groups behave the same way as public groups,
with the exception that modeling is not available for private groups. See “Public Group
Modeling” on page 230 in Chapter 7 for information about how the Opsware model
affects groups.

When you create your first group, the default type will be Private Static, which can be
changed to Private Dynamic, Public Static, or Public Dynamic. When you create a sub-
group, the type of group is private if you are in a private group when you create the new
group, and the type is public if you are in a public group when you create the new group.
Public and private groups cannot be mixed in a hierarchy. In other words, if the parent
group is public, the subgroups must be public, and if the parent group is private, the sub-
groups are also private.

Public Groups

Public groups can be created, edited, or deleted by anybody who has Manage Public
Server Groups permissions. Public groups are visible to all users, and can be used by
anybody, regardless of who created them, but only users with the Manage Public Server
Groups permissions can change the rules that govern dynamic groups.

A link called Public Groups appears at the top of server lists. Clicking that link displays a
list of available public groups.

Only public groups can be used for modeling.

Static Groups

Static groups can be either public or private, and no specific permissions are required for
static groups. A static group has servers that are added to and removed from the group
manually. When using static groups, you first create the group, and then select the
servers to populate it.
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Dynamic Groups

Dynamic groups contain servers that are added to or removed from the group based on a
set of user-defined rules. If the rules are changed or the servers in the environment
change, servers will be added to or removed from the group automatically. Rules apply
only to the group being created or modified, not to any subgroups.

Once the rules have been created, Opsware SAS will search for servers that match the
criteria of that specific group, and add them to the group. When the rules are changed,
Opsware SAS will search again, and the resulting group members reflect the changed
criteria. Consequently, as servers are added to or removed from management using
Opsware SAS, the members of the group will change automatically.

Opsware SAS calculates server group membership each time any of the following actions
occur:

+ After users add, delete, or change the rules for dynamic server groups.

« When attributes of servers change such that dynamic group membership could
change.

Additionally, Opsware SAS automatically recalculates dynamic group membership every
hour.

When a user schedules a job to run, dynamic group membership can be determined in
either of the following ways:

« Based on the servers in the dynamic group when the job was scheduled.

+ Based on the set of servers in the dynamic group when the job actually runs. The
membership is recalculated at that time.

Public Group Modeling

With Opsware modeling, the desired state of a server is defined and then applied to
servers. In the case of public server groups — static and dynamic — you can define a
model consisting of applications, patches, service levels, and custom attributes, which will
be applied to all servers in the group. The modeling information is attached to the group,
but not to any subgroups.

If the modeling information changes, the servers in the group are not affected until the
reconcile operation runs on those servers. If the model has already been reconciled on
that server when it is removed from the group, the installed material will be removed at
the next reconcile.
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Manage Servers Display for Public and Private Groups

As Figure 7-3 shows, server groups appear at the top of the Manage Server list. Public
Groups appear as a link at the top of the list. Private groups, if any have been created,
appear next, followed by the list of individual servers.

Figure 7-3: Manage Servers Displaying Public and Private Groups — Servers and Group View
Resource  Edit  “iew  Tasks  Configuration Tracking § |

D—_ Host Name / [P Address 0S Version Stage Use Facilitvy Customer e

@4 Public Groups
s

O @ barbar, 0 Servers (Static)

O | barfoo, 0 Servers (Dynamic)
| \J dhcp-8-071.corp.opsware.com dhcp-8-071.corp.opsware.com  Red Hat Enterprize Not Not c29 Opsware
faizal's desktop do not touch 192.168.8.71 Linux AS 3 Specified Specified
Manage Servers List - Groups Only

When you select View » Groups Only from the menu, information about the number of
servers in a group, the number of groups in a group, and whether the group is static or
dynamic appears in the list of groups, as Figure 7-4 shows.

Figure 7-4: Manage Servers List — Group Only View

Manage Servers (Summary View - Groups Only)

oK v || All Operating Systems v || Update

Fezource  Edit Yiew  Tazks  Configuration Tracking

Members Total Model Custom
u Servers  Subgroups  Servers Type Attachmentz Attributes  Last Use

54l Public Groups 0 113 222 0 0
s
n [E:ij A Group 0 1 0  Static 0 0

You can modify your views of servers and server groups by selecting Summary,
Hardware, Software, and Communications from the View menu. You can also elect to
further modify your view by selecting Servers and Groups, Servers Only, or Groups Only.

Operations on Server Groups

Any operation that can be done to a server can be done to a server group, because the
group acts as a container for a collection of servers, and so provides a shortcut to avoid
having to repeat the same operation on each individual server.
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When any of the following operations are performed on a group, they are actually
performed on the servers within the group, not on the group itself.

* Install
» Application
« Patch (Unix patch)
« OS
« By Template
+ Uninstall
» Application
» Patch (Unix Patch)
* Run
+ Script
+ Control
+ Custom Extension
+ Comm Test
» Reconcile
+ Customer
+ Usage
» OCC Client operations
» Configure Application
+ Audit Application Configurations
+ Perform Server Audit
+ Create Server Snapshot

Also, some operations allow users to refresh the list of servers in the group (if the user
has the Allow Run Refresh Jobs permissions). Users with the correct permissions
schedule a job, and before the job is run, Opsware SAS will update the members of the
server groups upon which the operation is performed. The following actions allow refresh
when scheduling a job:
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« Install Application

* Install Patch

+ Install By Template

* Run Script

+ Run Custom Extension

* Reconcile

Using Server Groups Tabs

When you view group properties, the information for the group appears in the page, as
Figure 7-5 shows.

You can view group properties in either of the following ways:
+ By clicking the This Group link at the top of each server group list.
« By selecting a group in the list and choosing Resource » Properties from the menu.

Figure 7-5: Tabs Available for Server Groups
Manage Servers / Public / All Windows Servers / Properties )

The following properties describe or restrict use of the current group.

Name: All Windows Servers
Description:
Type: Dynamic
Status: Active
Accessibility: Public
Servers (at this level): 56
Groups (at this level); 0
Unique servers for all levels: 56
Date last used (by a job): 2005-05-23
Server Group 1D 43380004

You can use these tabs to perform the following actions for a server group.
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To perform any of these actions, you must have the correct Opsware SAS permissions.
See “Permissions Required for Working with Server Groups” on page 227 in this chapter
for more information.

+ Properties: This displays information about the group, such as the type of group, the
number of servers in the group, and the status of the group. Clicking Edit allows you to
change the group name and description, and to convert a dynamic group to a static
group.

A created static group without servers added yet — an empty static group — can be
N
converted to a dynamic group. Conversely, a static group that has servers cannot be
converted to a dynamic group.

* Rules: This appears when you are viewing a dynamic group. The rules tab displays the
rules used by the dynamic group to determine group membership. The rules apply to
the current group only and do not apply to subgroups. Click Edit to change the rules for
the group.

See “Creating Groups by Using Search” on page 240 in this chapter for more
information about specifying rules for a dynamic group.

+ Custom Attributes: This allows you to set custom attributes for a server group. Click
New to add an attribute and then click Edit to change existing attributes. Custom
attributes are not inherited by subgroups within a group hierarchy.

See “Custom Attributes for Servers” on page 282 in this chapter for more information
about how custom attributes affect Opsware-managed servers.

« Patches: This allows you to add Unix patches to a server group. Attaching Unix patches
to a server group is like adding a patch to an Opsware Template with one exception —
groups are not associated with a specific OS or customer. Therefore, you can add a
patch for any OS to the group and groups can contain servers running different
operating systems. (Patches are always associated with the customer Customer
Independent.) Templates and folders are always associated with one OS version and a
specific customer.

« Applications: Allows you to add applications to a server group. Attaching applications
to a server group is similar to adding an application to an Opsware Template with one
exception — groups are not associated with a specific OS or customer; therefore, you
can add an application for any OS or for any customer to the group.
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The Reconcile Software wizard is flexible when you run it on a server group; for example,
when you reconcile server groups, Opsware SAS will install the correct applications on the
servers in the group, even if the OS versions for the servers and the patches or
applications do not all match. Opsware SAS also matches the customer association for
applications, operating systems, and templates with the customer association of servers.
If Opsware SAS cannot find a match, an error message (no valid devices found) appears
at the end of the wizard.

+ Service Levels: This allows you to attach service levels to a group. Attaching service
levels to a server is like attaching a service level to an Opsware Template with one
exception — groups are not associated with a specific OS or customer; therefore, you
can add a service level for any OS or for any customer to the group.

See the Application Provisioning Setup chapter in the Opsware® SAS Configuration
Guide for more information about attaching service levels.

« History: This allows you to view the changes to groups. For each action on the group
(but not group members), the history displays a description, the date the action
occurred, and the user who performed the action (if the group is public).

Ways to Create Server Groups

Server Groups can be created by:

» Using the New Group option from the Resource pull down menu on the Manage
Servers page

+ Clicking the Create Server Groups icon in the upper right corner of the Copy to Group
dialog

« Performing a server search, and saving the resulting list of servers or the rules as a
group

Creating Static Groups by Using the New Group Option
Static server groups require servers to be added to them manually. The servers in a static
group also must be removed manually.
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A created static group without servers added yet — an empty static group — can be
AS
converted to a dynamic group. Conversely, a static group that has servers cannot be
converted to a dynamic group.

To create static server groups, perform the following steps:

From the navigation panel, click Servers » Manage Servers. The Manage Servers
page appears.

From the Resource menu, choose New Group. The New Private Static Group dialog
appears, as shown in Figure 7-6.

Figure 7-6: Default New Private Static Group Dialog

New Private Static Group

Save In: |Manage SEnErs =l {ﬂ|
Mame Type =
= Public Groups Oynamic
= Content Groups, Dynarnic Oynamic _|
@ Content Managerment Servers Oynamic
IE Dynaric Content Servers Oynamic =

Save As: |Dan's Private Static Group|

Options: & Static
" Dynamic

Save Cancel

To create a Private Static group in the top level of Manage Servers, perform the
following steps:

1. Enter the name of the group in the Save As text box.
2. Click Save.
Bl To create a Private Static group below another group, perform the following steps:

1. Navigate to the group below which you want to create a new group.
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2. Enter the name of the group in the Save As text box.
3. Click Save.
To create a Public Static Group, perform the following steps:

1. Click the Public Groups link in the Name and Type window, and navigate to the
location in the group hierarchy where you want to create the group.

2. Enter the name of the group in the Save As text box.

3. Click Save.

The Save In drop down list is populated according to the location you drill down to in order

to create your group. You can use the Save In drop down list to verify that you are in the

correct location in the group hierarchy, and you can move to a different location in the

hierarchy by selecting it from the Save In list.

Creating Static Groups by Using the Copy to Group Dialog

To create new server groups by copying existing server groups, perform the following
actions:

From the navigation panel, click Servers » Manage Servers. The Manage Servers
page appears.

Navigate to the servers and groups that you want to copy and click the check boxes
next to the servers and groups you want to copy.

From the Edit menu, choose Copy to Group. The Copy to Group dialog box appears.

Navigate to the place in the group hierarchy where you want to copy the servers and
group then by clicking the group links displayed in the Name and Type field.

In the Options field, select either of the following options:

+ Maintain Hierarchy: Select this option to copy any server groups exactly as they
are.

+ Expand to a Flat List: Select this option to copy only the servers within the group
to the new group.

Each of those options displays the result of choosing that option by showing the
numbers of servers and groups in the new group’s hierarchy, or the number of
unique servers in the flat list.
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If you select the Expand to a Flat List option, and a server is a member of more than one
AS
group, that server will only appear in the list once.

@ (Optional) You can also create an entirely new group for the copied servers and
groups by clicking the Create New Group icon in the upper right corner of the dialog.

A new dialog appears, prompting you to name your new group.
Enter the name of your newly-created group.
B Click OK. The name dialog closes, and the Copy to Group dialog reappears.
El Click OK on the Copy to Group dialog.
Creating Dynamic Groups by Using the New Group Option

Dynamic Server Groups are rule-based, and the servers in dynamic groups will be added
or removed automatically based on the rules that you define.

The method for creating dynamic server groups is the same as for creating static server
groups. The difference is that when dynamic is selected, you are presented with a page
that allows you to define the rules for the group.

Dynamic groups can be converted to static groups, and all servers remain in the group,
A
but all rules will be lost when they are converted.

To create dynamic groups using the New Groups Option, perform the following steps:

E From the navigation panel, click Servers » Manage Servers. The Manage Servers
page appears.

H From the Resource menu, choose New Group. The New Private Static Group dialog
appears.

E To create a private dynamic group, navigate to the place in the group hierarchy where
you want to create the group by clicking the group links displayed in the Name and
Type field.

Or

To create a public dynamic group, click the Public Groups link in the Name and Type
field, and navigate to the location in the group hierarchy where you want to create the

group.
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The Save In drop down list is populated according to the location you drill down to in order
to create your group. You can use the Save In drop-down list to verify that you are in the
correct location in the group hierarchy, and you can move to a different location in the
hierarchy by selecting it from the Save In list.

Bl Enter the name of the group in the Save As text box.
B In the Options field, select Dynamic.

[ Click Create Rules. The Manage Servers Properties page appears, with the Rules
tab selected, as Figure 7-7 shows.

Figure 7-7: Manage Servers Properties Page with Rules Tab Selected
Manage Servers / Dynamic Content Servers / Properties /)

¥ Rules
The following rules describe the server members of this group and do not apply to subgroups . Match: Im
Search for servers whose:

Agent Reporting j |Is j Minirnal

Mot Reporting
Ok =
Partial

Search |
Savel Cancel |

Select the criteria that apply to the servers you would like the group to include. See
“From the navigation panel, click Servers %o Search. The Search Rules page
appears with the Servers tab displayed.” on page 240 in this chapter for more
information.

Create as many lines of criteria as required to adequately describe your server group rules
by clicking the plus button to add a new line. Conversely, to remove lines of criteria, click
the minus button next to the line you want to remove.

B From the Match drop down list select either “If all rules are met” or “If any rules are
met.”

El (Optional) Click Search to apply the rules to a server search to validate the resuilts.
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KK Click Save to save the rules that apply to your group.
Creating Groups by Using Search
To create groups by using search, perform the following steps:

From the navigation panel, click Servers » Search. The Search Rules page appears
with the Servers tab displayed.

To search for servers, use this tab. To search for groups, select the Groups tab.

H Use the criteria to create the rules used for a server search and to identify servers for
dynamic groups. The options in the user interface for specifying dynamic group rules
and for using Search are the same. See “Criteria for Search and Dynamic Group
Rules” on page 240 in this chapter for more information.

Create as many lines of criteria as required to adequately describe your server search or
AN
your server group rules by clicking the plus button to add a new line. Conversely, to
remove lines of criteria, click minus button next to the line you want to remove.

If you are defining dynamic server group rules, click Save to save your rules. You can
also click Search to use your rules to perform a server search.

Or

If you are doing a server search, click Search to perform the server search, or click
Save to save the search as the rules for a dynamic group.

The New Dynamic Group dialog appears.

Criteria for Search and Dynamic Group Rules
The following table describes the rules that you can use to search for servers or to create
dynamic server groups.

Note that anywhere you can enter text, you can enter a wildcard (*) character to broaden
your results.

Table 7-2: Rules for Server Search and for Creating Dynamic Groups

PROPERTIES
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Table 7-2: Rules for Server Search and for Creating Dynamic Groups (continued)

Agent Discovery Date: The + |s after Drop-down lists with the day,
3:: itﬂh;;ﬁk;zOpsware Agent || Is before month, and year
* |s within the last User-entered text
+ |s today N/A
Agent Reporting: Whether « s + Has not reported
the Opsware Agent is . s not . OK

reporting to Opsware SAS.
» Registration in progress

+ Reporting error

Agent Status: Whether the e s * Not reachable
Opsware Agent is reachable . Is not . OK
by Opsware SAS.
Agent Version: The version of | « Contains User-entered text
the Opsware Agent — such as | Does not contain
14.2.3b.
e s
* Is not
Custom Attribute (any): The - Contains User-entered text
name of a custom attribute s
that is associated with the
server through attachment or
inheritance.
Custom Attribute (local): The | <+ Contains User-entered text
name of a custom attribute s
that is locally attached to the
server,
Customer: The customer or e s Popup window of customers
account that the server is
* Is not

associated with.
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Table 7-2: Rules for Server Search and for Creating Dynamic Groups (continued)

Deployment Stage: The e Is + In Deployment
stage the server performs
within a lifecycle environment.

* Is not * Live
» Not Specified
« Offline

The values that appear in this
list are customizable; in
addition to the values above,
values specific to your
environment might appear.

Facility: The collection of e s Popup window of facilities
servers managed by an . Is not
Opsware SAS installation. When Opsware SAS is running

multimaster mode, the list can
contain many facilities.

Group Membership: Whether |« Is Popup window of groups
the server belongs to a group.

Host name: The host name of | = Contains User-entered text
the server — such as
mO0Q04.company.com.

» Does not contain
e Is
* Is not

Name (any): This enables + Contains User-entered text
searching for any name or IP
address associated with a

server. . Is

* Does not contain

* Is not
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Table 7-2: Rules for Server Search and for Creating Dynamic Groups (continued)

Notes: The contents of the
Notes field from the Properties
tab for a server.

Opsware Display Name: The
user-configurable name for the
server.

Server Use: How the server is
being used — such as
Development, Staging,
Production.
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Contains

Does not contain
Is

Is not

Contains

Does not contain

User-entered text

User-entered text

By default, Opsware SAS uses
the configured host name of
the server until a user edits it.

» Development
* Not Specified
+ Production

- Staging

You can customize values that
appear in this list. In addition
to the values above, values
specific to your environment
might appear.
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Table 7-2: Rules for Server Search and for Creating Dynamic Groups (continued)

Service Level: The user- + s Popup window of service

defined category that can be | Is attached here or levels

used as an organizational tool.

below

Servers can be associated
with multiple service levels.
See the Opsware® SAS User’s
Guide for more information
about working with service
levels.

OPSWARE PROPERTIES

Application Configuration: * |s not used N/A

Whether the server uses the

o _ . * Is used

Application Configuration

feature.

Code Deployment: \Whether |+ Is not used N/A

the server uses the Code

* Is used

Deployment feature.

Configuration Tracking: + Is off N/A

Whether the Configuration . Ison

Tracking feature is monitoring

or backing up specific files or

configurations on a server.

Lifecycle: The server states e Is + Available

that are part of bringing a . Is not . Build Failed

server into Opsware SAS.
+ Deactivated

+ Installing OS

+ Managed
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Table 7-2: Rules for Server Search and for Creating Dynamic Groups (continued)

Server ID: The internal ID
Opsware SAS uses to identify
the server.

SOFTWARE

Attached Software: The
software that is assigned or
modeled through the Opsware
reconcile operation — the
installation process.

Installed Patches: Whether a
patch is installed on the
server.

Installed Software: The
package reported installed on
the server.

OS Version: The OS version
defined by OS definitions in
the OS Provisioning feature.

Reported OS: For Windows —
the version reported by the
OS, for Unix — the version
returned by the uname
command.
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* Is not

Is

» |s attached here or

below

Contains

* Does not contain

Is
Is not

Contains

* Does not contain

Is

Is not

Is

* Is not

Contains

* Does not contain

Is

Is not

User-entered text

In most cases, the Server ID is
the same as the MID.

Popup window of software

User-entered text

User-entered text

A package does not have to

be installed by Opsware SAS
to be reported as installed on
a server.

Popup window of operating
systems

User-entered text
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Table 7-2: Rules for Server Search and for Creating Dynamic Groups (continued)

Windows Service: The names
of the Windows services that
are reported to Opsware SAS.

NETWORK

DNS Search Domains: The
domains configured to be
searched in the server's

network settings.

DNS Servers: The IP
addresses of the DNS servers
configured in the server's

network settings.

Default Gateway: The IP
address of the default router.

IP Address: Any Internet
Protocol address for the server.

MAC Address: Any Media
Access Control address, which
is the network interface card's
unique hardware number.

Contains

* Does not contain

Is

[s not

Contains

* Does not contain

Is
Is not

Contains

* Does not contain

Is
Is not

Contains

* Does not contain

Is
Is not

Contains

» Does not contain

Is
Is not

Contains

* Does not contain

Is

Is not

User-entered text

User-entered text

User-entered text

User-entered text

User-entered text

User-entered text
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WINS Servers: The Windows
Internet Naming Servers
configured in the server's
network settings.

HARDWARE

CPU Make and Model: The
vendor name and CPU model
for the server — such as
GENUINEINTEL Intel(R)
Pentium(R) 4 CPU 2.60GHz.

CPU Speed: The Central
Processing Unit speed in
gigahertz [GHz].

Make and Model: The vendor
name and server model for the
server — such as Compaq -
DL360.

Number of CPUs: The
number of CPUs on the server.

RAM: The amount of RAM on
the server in megabytes [MB].
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Contains

* Does not contain

* Is not

Does not equal

+ Equals

Is greater than
Is less than

Is

* Is not

Does not equal

+ Equals

Is greater than
Is less than

Does not equal

+ Equals

Is greater than

Is less than

User-entered text

Popup window of CPU makes
and models

User-entered text

A 600 Mhz machine should be
entered as 0. 6.

Popup window of server
makes and models

User-entered text

User-entered text

To enter 1 Gigabyte, type
1024.

Chapter 7: Server Management in Opsware Command Center

247



Opsware® SAS 5 User’s Guide

Table 7-2: Rules for Server Search and for Creating Dynamic Groups (continued)

Serial Number: The serial « Contains User-entered text

number of the server. .
* Does not contain

« s

* Is not
Storage Make and Model: e s Popup window of storage
The vendor name and storage | | Is not makes and models
model for the server — such as
WDC - WD800BB-75DKAO.
CUSTOM FIELDS
A Numeric field » Does not equal User-entered text

+ Equals

 |s greater than
* Is less than
A String field + Contains User-entered text
+ Does not contain
E
* Is not
A URI field + Contains User-entered text
+ Does not contain
s Is
* Is not
A File field + Contains User-entered text
+ Does not contain
s Is

* Is not

248 Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2006 Opsware Inc. All Rights Reserved.



Chapter 7: Server Management in Opsware Command Center

Table 7-2: Rules for Server Search and for Creating Dynamic Groups (continued)

A Date field + |s after Drop-down lists with the day,
. Is before month, and year
+ Is within the last User-entered text
+ |s today N/A

Adding a Server to Static Groups, Both Public and Private
To add a server or a server group to a static group, perform the following steps:

From the navigation panel, click Servers » Manage Servers. The Manage Servers
page appears.

H Navigate to the static group that you want to add servers and server groups to.

Click the check box next to the group and select Edit » Add Servers. The Select
Servers and Groups to Add to [group name] window opens. The window is populated
with the same servers and groups visible on the Manage Servers page. You can use
the Status, OS, and Customer filters to change the servers and groups that appear
on the list.

When you select Edit » Add Servers and then select a group, the servers in the group
are added. The group itself is not added. If you want to add a group to a group, select Edit
» Copy to Group from the menu.

Bl Click the check box next to the servers and groups you want to add, and click Add at
the bottom of the window.

Adding a Server to Dynamic Groups, Both Public and Private

Servers are added to dynamic server groups automatically, based on the rules created for
the group. To change the membership of a dynamic group, add, delete, or update the
dynamic group rules.
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To update the rules for a dynamic group, perform the following steps:

From the navigation panel, click Servers » Manage Servers. The Manage Servers
page appears.

Navigate to the Properties page of the dynamic group that you want to update rules
for; navigate by clicking the group links in Manage Server list.

Select the Rules tab.
Click Edit.

To add criteria to the existing rules, click the plus (+) button next to existing criteria.
The fields for the criteria appear. Enter the values for the rule. See “From the
navigation panel, click Servers %o Search. The Search Rules page appears with the
Servers tab displayed.” on page 240 in this chapter for descriptions of these values.

To delete criteria, click the minus (-) button next to the criteria you want to delete from
the rules. The criteria are removed from the page.

Click Save.

Groups can be added manually to a dynamic group, in either of the following two ways:

Click the check box next to the name of the server group to which you want to add a
server group, and select Edit » Copy to Group. Then follow the steps for creating a
new group, either static or dynamic. See “Ways to Create Server Groups” on

page 235 in this chapter for more information.

Or
Navigate to the server group that you want to add a server group to.

Click the check box next to “This Group” and select Resource » New Group. Then
follow the steps for creating a new group, either static or dynamic. See “Ways to
Create Server Groups” on page 235 in this chapter for more information.

Removing Servers from Static Groups, Both Public and Private

To remove a server from a static server group, perform the following steps:

A server does not need to be deactivated to be removed from a group. You can remove a
AN
server from a Static group at any time. The Membership tab for a server displays all the
server groups of which the server is a member.
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E From the navigation panel, click Servers » Manage Servers. The Manage Servers
page appears.

H Navigate to the static server group that you want to remove servers from until you
reach the level where the servers in question are located.

Servers can belong to more than one group, so if you want to remove a server from each
group it belongs to, you must locate and remove each instance of the server from all
groups.

Click the check box next to the servers you want to remove and select Edit »
Remove from Group.

As soon as you select that menu option, the server is removed and the screen
refreshes to display the current members of the group.

Removing Servers from Dynamic Groups, Both Public and Private

Servers are removed from dynamic server groups automatically, based on the rules
created for the group. To remove servers, you can create or update rules. To add rules to
an existing server group, perform the following steps:

From the navigation panel, click Servers » Manage Servers. The Manage Servers
page appears.

H Navigate to the Properties page of the dynamic group that you want to add rules to,
by drilling down into the group and clicking the “This Group” link.

Select the Rules tab.

Click Edit.

Add one or more lines of criteria to the existing rules by following the procedure
described in the “Creating Dynamic Server Groups by Using the New Group Option”
topic, step 3 on page 240 or see “From the navigation panel, click Servers %o
Search. The Search Rules page appears with the Servers tab displayed.” on page
240 in this chapter for more information.
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Moving Servers from One Static Group to Another

The process of moving servers from one group to another is similar to copying servers
from one group to another with the exception that with a move, the servers do not remain
in the original group.

The Edit » Move menu option is disabled when you select servers in a dynamic group.

To move servers in a dynamic group, chose the Edit » Copy to Group menu command.
This menu command is also disabled for public groups when you do not have permission
to manage public groups.

To move servers from one group to another, perform the following steps:

From the navigation panel, click Servers » Manage Servers. The Manage Servers
page appears.

H Navigate to the group containing the servers you want to move and select those
servers.

From the Edit menu, choose Move. The Move [group name] Group dialog box
appears.

Bl Navigate to the place in the group hierarchy where you want to create the group by
clicking the group links displayed in the Name and Type field.

B Click Move.

Duplicating Server Groups

Duplicating a group is similar to copying a group. To duplicate an existing group, perform
the following steps:

Navigate to the group that you want to duplicate.

H Click the check box next to the group name.

You can only select one group at a time to duplicate.
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From the Edit menu, choose Duplicate Group. The Duplicate [group name] Group
dialog appears as shown in Figure 7-8.

Figure 7-8: Duplicate Group Dialog Box

2} Duplicate Group -- Web Page Dialog

Duplicate 'test2' Group

Duplicate tu:| Marketing Servers V| 4 {:ﬂ|
MName Type
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Group Name: |test2 |

Options: &) Maintain Static group and 1 subgroups

¢ Convert group and 1 subgroups to a static flat list (0
unique sernvers)

b Show Details

[ Duplicate ] [Cancel]

https: ({192, 168, 196, 245 fcom. opsware..occ.servers/mer | #f8 Internet

Bl Select the location for the newly-duplicated group using the Duplicate In drop down
list.

The Duplicate In drop down list’s default location is the location of the group you select to
duplicate. Navigate through the hierarchy of groups to find the location where you want
the newly-duplicated group to reside.

B Enter the name of the new group.

B The values on the Options field will vary depending on whether the group duplicated
is static or dynamic.

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2006 Opsware Inc. All Rights Reserved.

253



Opsware® SAS 5 User’s Guide

If the group is static, select one of the following options:

+ Maintain Static group and <number> subgroups: Selecting this option copies
the group and its hierarchy as is.

+ Convert group and <number> subgroups to a static flat list: Selecting this
option copies the group and flattens the hierarchy.

B If the group is dynamic, select one of the following options:

+ Maintain rules & group hierarchy: Selecting this option copies the group and
leaves it as a dynamic group, it also copies any subgroups.

+ Convert to static group, maintain hierarchy: Selecting this option copies the
group, but turns it into a static group with the current servers defined by the rules
and also copies any subgroups.

« Convert group and <number> subgroups to a static flat list: Selecting this
option copies the group, and turns it into a static group and flattens any hierarchy.

El Click Duplicate. The newly-duplicated group appears in the selected destination.

Rules for Deleting Server Groups

It's important to note the distinction between removing servers from a group, deleting a
server, and deleting a group.

Removing servers from a group only removes the server from the selected static group,
but the server itself remains in the global list of servers and is still managed by Opsware
SAS.

Deleting a server can only be performed on a server whose status is deactivated.
Selecting the Delete Server option completely removes the server from within Opsware
SAS, although its history remains.

Deleting a server group removes the group, but the servers in the group still remain in the
list of servers and in any other groups for which they are members.

A group cannot be deleted when any of the following conditions apply:
+ Software is attached to the group or a subgroup of the group.
» Access control boundaries are attached to the groups or a subgroup of the group.

+ Servers and groups are selected together for deletion.
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Deleting a Server Group
To delete a server group, perform the following steps:

Click the check box next to the server group you want to delete.

H From the Edit menu, choose Delete Group. A confirmation message appears,
detailing the number of servers and server groups in the server group that you want
to delete.

H Click OK to complete the deletion of the server group.

The screen refreshes, showing the list of servers and groups without the deleted
server group.

Server Life Cycle

This section provides information on the server life cycle within Opsware SAS and
contains the following topics:

+ OS Provisioning and the Server Life Cycle

« Server Properties

« Server Management Tasks Related to the Server Life Cycle
+ Changing the Use and Stage Values for Servers

+ Editing the Properties of a Server

+ Tasks Associated with Deactivating a Server

» Deactivating a Server

» Deleting a Server from Opsware SAS

« Overview of Cloning a Server

OS Provisioning and the Server Life Cycle

Opsware SAS is designed to enable multiple teams to work together to provision servers.
The OS Provisioning feature allows IT teams to separate the tasks of readying servers for
provisioning (such as mounting servers in racks and connecting them to a network) from
provisioning the servers with operating systems and applications.
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For example, someone mounts a new server in a rack and connects it to the Opsware
build network. Next, they boot the server for the first time by using an Opsware Boot
Floppy or CD or by using the network.

At a later time, a different system administrator can select the available server from the
Server Pool list and provision it with an OS. In the available state, servers do not have the
target OS installed and might not have access to disk resources.

During OS provisioning, servers progress through the Opsware SAS life cycle state
changes:

Unprovisioned (No OS Build Agent) » Available » Installing OS » Managed
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Table 7-3 describes the Opsware SAS server life cycle values.

Table 7-3: Opsware SAS Life Cycle Values for Servers

Server Pool Values

Available

Installing OS

Build Failed

Indicates a server on which the OS Build Agent was installed and is
running, but the target OS has not been installed on the server.

The OS Build Agent is a small agent that can run in the memory of the
bare-metal server.

See “Operating System Provisioning” on page 567 in Chapter 15 for
more information.

Indicates that a user is installing the target OS on the server.

The server stays in the Server Pool list until the installation process
finishes successfully. Then the server moves to the Manage Servers list.

See “Installing an OS by Using a Template” on page 585 in Chapter 15
for more information. See “Installing an OS by Using a Custom
Installation” on page 590 in Chapter 15 for more information.

Indicates a server on which the OS Build Agent was installed and is
running, but the installation of the target OS failed.

The server remains in the Server Pool list with this status for 7 days
before Opsware SAS deletes the entry.

See “Recovering when an OS Installation Fails” on page 592 in Chapter
15 for more information.
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Table 7-3: Opsware SAS Life Cycle Values for Servers (continued)

Managed Server Values

Managed Indicates a server that Opsware SAS is managing. Opsware SAS
performs periodic reachability checks on managed servers.

After a server reaches this life cycle state, the entry for the server moves
from the Server Pool list to the Manage Servers list. On managed
servers, you can use Opsware SAS to install applications and patches.

Deactivated Indicates an Opsware-managed server that was removed from service.
However, the server's history still exists in Opsware SAS. Deactivated
servers are not reachable.

Table 7-4 shows which server icons appear in Opsware SAS and explains what each icon
indicates in regard to the server life cycle.

Table 7-4: Server Icons in Opsware SAS

Indicates a server that is available to have a target OS installed on it
_jJ|| and on which an Opsware OS Build Agent is installed.

Appears in the Server Pool list.

Indicates a server on which the OS Provisioning feature is in the
]‘ process of installing the target OS.

Appears in the Server Pool list.

Indicates an available server on which an error occurred while the OS
'@]J‘ Provisioning Subsystem was installing a target OS.

Appears in the My Jobs panel in the home page, in the list in the My
Jobs page, and in the Server Pool list.
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Table 7-4: Server Icons in Opsware SAS

&

Indicates a server that the Opsware Command Center is managing and
that Opsware SAS can communicate with. An Opsware Agent is running
on the server.

Appears in the My Jobs panel in the home page, in the list in the My
Jobs page, in the Manage Servers list, and in the server lists in the
Opsware wizards.

Indicates a server that is scheduled for an operation (install software,
uninstall software, and so forth).

Appears in the My Jobs panel in the home page and in the list in the
My Jobs page.

Indicates a managed server that Opsware SAS cannot communicate
with (it is Not Reachable) because the Opsware Agent on the server
cannot connect to Opsware SAS.

If you want to discover reasons why the managed server is
unreachable, you can run a Communication Test. See “Agent
Reachability Communication Tests” on page 204 in Chapter 6 for more
information.

Appears in the Manage Servers list.

Indicates a managed server on which an error occurred while Opsware
SAS was installing or uninstalling software.

Appears in the My Jobs panel in the home page and in the list in the
My Jobs page.

Indicates a managed server on which a warning occurred while
Opsware SAS was installing or uninstalling software.

Appears in the My Jobs panel in the home page and in the list in the
My Jobs page.

Indicates a server that was deactivated in Opsware SAS so that it is

currently not managed and not reachable.

Appears in the Manage Servers list and in the server lists in the
Opsware wizards (however, it is not selectable in the wizards).
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Table 7-4: Server Icons in Opsware SAS

Indicates a managed server on which the configuration file on the
@\” server is out of sync with the Application Configuration Template
(Opsware model).

Appears only in the Application Configuration feature and the server list
in the OCC Client.

Indicates a static server group. The same states that apply to single
servers apply to groups.

@/

See “Server Groups” on page 226 in this chapter for information about
the different types of server groups.

Indicates a dynamic server group. The same states that apply to single
servers apply to groups.

&

Indicates a public and static server group. The same states that apply to
single servers apply to groups.

<

Indicates a public and dynamic server group. The same states that
apply to single servers apply to groups.

N
N
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Server Properties

Figure 7-9 shows the Server Properties columns. Table 7-5, Table 7-6, and Table 7-7
describe the Status, Stage, and Use properties for managed servers.

Figure 7-9: Server Properties Columns in the Manage Servers List
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The Status property is represented by an icon in the first column in the Manage Servers
list.

Status (short for Agent Status) is set automatically by Opsware SAS.

Opsware SAS toggles each server between OK and Not Reachable by reachability
checks.

The Status value specifies the ability of Opsware SAS to manage servers. Opsware SAS
automatically detects the status of servers. To verify the current status of a server, click
Update in the Server Properties page for that server.

Table 7-5: Values for the Status Property for Managed Servers

OK Server is manageable by Opsware SAS. Represented as text (OK) in
the properties page for a server. Represented as an icon in the
Manage Servers and Server Pool lists:

&
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Table 7-5: Values for the Status Property for Managed Servers (continued)

Not Reachable | Server is unreachable by Opsware SAS due to an error (for example, it
cannot connect to the Opsware core); automatically set by Opsware
SAS. Represented as text (Not Reachable) in the properties page for a
server. Represented as an icon in the Manage Servers list:

If you want to discover reasons why the managed server is
unreachable, you can run a Communication Test. See “Agent
Reachability Communication Tests” on page 204 in Chapter 6 for more
information.

Stage (short for Deployment Stage) is set by a user.

The Stage value specifies the stages of deployment for servers; for example, a server is
live or offline.

Your Opsware administrator can change the values for the Stage property. By default,
Opsware SAS is installed with the following Stage values.

Table 7-6: Values for the Stage Property for Managed Servers

In Deployment Initial stage after being fully initialized.
Live Your organization defines the meaning of this stage.
Not Specified The default value for a server. Cannot be changed by the Opsware

administrator.
Offline Your organization defines the meaning of this stage.

Ops Ready Your organization defines the meaning of this stage.

Use (short for Server Use) is set by a user.

The Use value specifies how an organization is utilizing servers. For example, a server is a
staging server. Users set this property for servers.
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By default, Opsware SAS is installed with the following Use values. Except for the Staging,
Production, and Not Specified values, an Opsware administrator can change the default
values. The CDR feature depends on the Staging and Production values. Therefore, these
default values cannot be changed or deleted.

Table 7-7: Values for the Use Property for Managed Servers

Development A server that is not being used in production.

Not Specified The default value.

Production Fully live in-use servers (includes Opsware core servers).
Staging A staging server for production.

Server Management Tasks Related to the Server Life Cycle

Managing servers in Opsware SAS involves the following standard tasks:

+ Bringing a new server into Opsware SAS so that it appears in the Server Pool
See “New Server Booting” on page 576 in Chapter 15 for more information.

« Installing an operating system on a server

See “Ways to Install Operating Systems on Servers” on page 584 in Chapter 15 for
more information.

« Installing a patch

See “Patch Installation and Uninstallation for Unix” on page 535 in Chapter 13 for more
information.

See “Patch Installation” on page 499 in Chapter 12 for more information.
+ Installing an application

See “Software Provisioning” on page 549 in Chapter 14 for more information.
» Reprovisioning a server with a new OS

See “Reprovisioning a Solaris or Linux Server” on page 596 in Chapter 15 for more
information.

You can reprovision Solaris and Linux servers so that they are running another version
of the same OS so long as the hardware supports that new version of the OS.
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You can reprovision servers built by Opsware SAS and Opsware-managed servers by
using this feature.

You cannot reprovision a Linux server so that it runs a Windows OS.

» Deactivating a managed server so that Opsware SAS no longer manages it.

See “Tasks Associated with Deactivating a Server” on page 267 in this chapter for more
information.

You accomplish server management tasks by using the menus in the Manage Servers
list, as Figure 7-10 shows.

Figure 7-10: Menus in the Manage Servers List
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See “Software Provisioning” on page 549 in Chapter 14 for more information.
See “Reconcile” on page 699 in Appendix A for more information.

See “Distributed Script Execution” on page 411 in Chapter 11 for more information about
how to run a distributed script on a server.

See “Manage Servers List” on page 119 in Chapter 4 for information about managed
servers.
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Changing the Use and Stage Values for Servers

Perform the following steps to change the Use and Stage values for multiple servers
simultaneously:

From the navigation panel, click Servers » Manage Servers. The Manage Servers
page appears. Browse the list to find the server that you want to deactivate.

Or
Search for the server that you want to deactivate.

See “Using the Search Feature” on page 125 in Chapter 4 for more information. See
“Server Searching by IP Address” on page 141 in Chapter 4 for more information.

H Select the servers that you want different Use or Stage values for.

E Choose Edit » Usage from the menu above the Manage Servers list. A window
prompts you to select different values, as Figure 7-11 shows.

Figure 7-11: Edit Server Popup Window
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Mot Specified  » Mot Specified +
[ Save Changes ][ Cancel ]

Bl Select the Use and Stage values from the lists.
H Click Save Changes. The window closes and the Manage Servers list refreshes with

the updated values.

Editing the Properties of a Server

You can edit a server only if you have permission in the Opsware Command Center to
access the customer to whom the server is associated.

When you edit the properties of a server, the server itself does not change; how Opsware
SAS views it changes. Perform the following steps to edit the properties of a server:

From the navigation panel, click Servers » Manage Servers. The Manage Servers
page appears. Browse the list to find the server whose properties you want to edit.
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Or
Search for the server that you want to edit.

See “Using the Search Feature” on page 125 in Chapter 4 for more information. See
“Server Searching by IP Address” on page 141 in Chapter 4 for more information.

Click the Server Display name. The Properties page for the server appears.

Change any of the following properties for the server:

» To change the name that appears in the Opsware Command Center, edit the text
in the Name field.

» To change the description of the server, edit the Notes field.

» To change the customer associated with the server, select a different customer
from the list. Your Opsware administrator defines the options for customer
selections. Contact your Opsware administrator if the list does not contain the
customer that you want to associate with this server.

You cannot change the customer associated with a server when the server is part of a
N
CDR service, synchronization, or sequence. See the Opsware® SAS Configuration Guide
for more information.

« To change the Use or Stage of the server, make your changes in either of those
lists.

See “Server Properties” on page 261 in this chapter for more information.

« To change whether configuration tracking is enabled or disabled for the server,
select a value from the list.

See “Configuration Tracking” on page 643 in Chapter 17 for more information.

Bl To save your changes, click Save.

To change the custom attributes of the server, select the Custom Attributes tab. The
Q Manage Servers: Custom Attributes page appears. See “Managing Custom Attributes” on
page 283 in this chapter for more information.
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Tasks Associated with Deactivating a Server

You will want to deactivate a server when Opsware SAS removes the server from
management. For example, you are moving the server to a warehouse for storage.
Additionally, you might choose to deactivate a server when you need to rebuild it from
scratch, without using the OS Provisioning feature.

When you deactivate a server, information about the server remains in the Opsware
Model Repository for auditing purposes.

After you deactivate a server, you can reactivate it by re-installing an Opsware Agent with
the Opsware Agent Installer and the - -clean command line option.

See “"Agent Reachability Communication Tests” on page 204 in Chapter 6 for more
information.

When you deactivate a server, you accomplish the following tasks:
» Reset the node assignments in the Software Tree to the defaults.
+ Remove custom attributes from the server.

» Delete any configuration tracking policies from the server that are associated with
backups.

+ Set the server life cycle value to Deactivated.

You cannot deactivate a server when it is part of a CDR service, synchronization, or
sequence. See the Opsware® SAS Configuration Guide for more information.

Deactivating a Server
Perform the following steps to deactivate a server:

From the navigation panel, click Servers » Manage Servers. The Manage Servers
page appears. Browse the list to find the server that you want to deactivate.

Or
Search for the server that you want to deactivate.

See “Using the Search Feature” on page 125 in Chapter 4 for more information. See
“Server Searching by IP Address” on page 141 in Chapter 4 for more information.

H Select the servers that you want to deactivate.
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E Choose Edit » Deactivate Server from the menu above the Manage Servers list. A
confirmation dialog box prompts you to confirm the deactivation.

Bl Click OK. The Manage Servers list refreshes and the server appears with a
deactivated icon.
Deleting a Server from Opsware SAS

When you want to remove all record of a server from Opsware SAS, you can delete it.

You must deactivate a server before you can delete it from Opsware SAS.

When you delete a server from Opsware SAS, it has these effects:
+ Deletes all job information in the My Jobs feature

« Deletes the server from the Model Repository

Perform the following steps to delete a server:

E From the navigation panel, click Servers » Manage Servers. The Manage Servers
page appears. Browse the list to find the server that you want to delete.

Or
Search for the server that you want to delete.

See “Using the Search Feature” on page 125 in Chapter 4 for more information. See
“Server Searching by IP Address” on page 141 in Chapter 4 for more information.

Select the servers that you want to delete.

Choose Edit » Delete Server from the menu above the Manage Servers list. A
confirmation dialog box prompts you to confirm the deletion.

Bl Click OK. The Manage Servers list refreshes and the server disappears from the list.

Overview of Cloning a Server

The Opsware Command Center includes a feature that allows users to copy a server.
Copying (referred to as cloning in the Opsware Command Center) is useful when you
need to add more capacity to your operational environment.
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A user selects a source server (the master server) and copies the configuration of that
server to one or more other servers (the target servers). The other servers are assigned to
every node to which the master server is assigned. The copied servers contain the same
operating system, software applications, and configuration as the original server (though
the customer association and facility location remain the same on the target servers). The
copied servers also include any changes to the default server configuration made through
Opsware SAS.

The only restriction to cloning a server is that both servers need to be on the same
platform. However, any existing user-configurable nodes are removed from the target
server when you clone servers. The target server is made to look exactly like the master
server in terms of node assignments.

Cloning a Server
Perform the following steps to clone a server:

From the navigation panel, click Servers » Manage Servers. The Manage Servers
page appears. Browse the list to find the servers that you want to clone.

H Select two or more servers. When copying servers, you must select at least two
servers so that one server can be the master. The other servers are the ones that you
want to copy the nodes to.

Opsware, Inc. recommends that you select servers with similar hardware architecture
(based on the value in the Reported OS column in the Manage Servers list).

H Choose Tasks » Clone model from the menu above the Manage Servers list.
A window prompts you to select the master server, as Figure 7-12 shows.

Figure 7-12: Clone Servers Popup Window in the Opsware Command Center
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Bl Select the option for the master server that you want to use and click Select Master.
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A confirmation page appears that shows how the nodes on the master server are
copied to the server that you select.

B Click Commit Clone.

The Server List reappears and shows the updated target servers.

After you clone a master server to target servers, you must reconcile the target servers for
Iz Opsware SAS to install the software on the target servers. See “Reconcile” on page 699 in
Appendix A for information about reconciling servers.

Server Management Jobs

This section provides information about server management jobs within Opsware SAS
and contains the following topics:

+ My Jobs

* My Jobs Display Information

+ My Jobs in the OCC

* My Jobs in OCC Client

» Viewing Job Details in the OCC

+ Viewing My Job Details from inside the OCC Client

My Jobs

The My Jobs information is available only on a per-user basis. You cannot log in as an
Opsware administrator to see the jobs that other Opsware users have run. The My Jobs
information appears in two places in the Opsware Command Center:

+ A panel on the Opsware Command Center home page that lists your most recent six
jobs

+ A page (accessed by clicking My Jobs in the navigation panel) that lists all the jobs that
you have run

Opsware SAS maintains information about the server operations that you have run for
the last 30 days in the My Jobs list. By default, the jobs are deleted from the Opsware
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Model Repository after 30 days. (The bottom of the My Jobs page indicates how long
this interval is set for the Opsware SAS installation at your organization.)

My Jobs Display Information

For each job, the My Jobs lists display the following information:

« The name of the job, which is a link to a page that displays more detailed information
about the job

+ The date and time the job started or is scheduled to start (using your preference for
time display)

« The number of servers that the job affects
» The status of the job:
» Scheduled

* In Progress

Completed

.

Completed with errors
+ Completed with warnings

« You can search for an existing Job by the Job’s ID. On the Home page, select Job from
the drop-down list and enter a Job ID and click Go.
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My Jobs in the OCC

The My Jobs feature in the OCC provides information about the following Command
Engine scripts:

Reconcile (install software, uninstall software, install a template, patching servers, and
reconcile)

OS provisioning
CDR requests
Distributed script execution

Custom Extensions

My Jobs in OCC Client

My Jobs feature in the OCC Client displays job logs about the following OCC Client jobs:

.

Creating snapshots

Pushing or Auditing an Application Configuration
Auditing Servers

Creating Server Snapshots

Creating, Installing, and Reconciling Packages

Any jobs scheduled to be run at a future date

My Jobs in the OCC Client appears in the Jobs Logs feature window.
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Viewing Job Details in the OCC

Perform the following steps to view the job details:

EH From the Opsware Command Center home page, click the link in the My Jobs panel

for the job that you want to view, as Figure 7-13 shows.

Figure 7-13: My Jobs Panel in the Opsware Command Center Home Page

My Jobs

MName

E Run Custom Extension

[ Fun Script

£

A Fun Script

Audit Servers [Launch OCC Client]

<<l

Create Snapshot  [Launch OCC Client]

&l

#4 Audit Servers  [Launch QCC Client]

Or
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From the navigation panel, click My Jobs and then click the link for the job to open a

window that shows the details of the job, as Figure 7-14 shows.

Figure 7-14: My Jobs Page Accessed from the Navigation Panel

|| Mo Time Restrictions % || All Job Status

[ Launch OCC Client ]

[ Launch QO Client ]

[ Launch QCC Client ]

[ Launch OCC Client ]
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@] SE0B6T  Audt Servers
@] SE0BET Audit Servers
@] 1630666 Audt Servers
@] 1580866 Audit Servers
@] 15TOBEE  Audit Servers
@] 150866 Audt Servers
@] 1550666 Audit Servers
@] 1460B66  Run Seript

1240666 Auddit Servers

1230666 Create Snapshot

[ Launch OCC Clisnt |

[not set)

Wyed Oct 31 21:43:00 2007

Tue May 31 22:29:54 2005

Tue May 31 221918 2005

Tue hlay 31 22:16:50 2005

Tue May 31 22:12:26 2005

Tue May 31 22:04:27 2005

Tue May 31 2200017 2005

Tue hay 31 21:58:3% 2005

Tue hlay 31 21:57:33 2005

Tue bay 31 21:22:06 2005

Tue May 31 21:00:48 2005

Tue May 31 20:57: 05 2005

w || Update

Servers  Groups
4 i]
4 a
2 0
2 0
2 u]
2 a
2 0
2 0
2 0
2 u]
3 a
2 0
1 0

The My Jobs page displays the operations that you performed.
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Click View Details to see detailed information about the job. The My Jobs
information contains a build log for the job. This build log contains any error
messages that Opsware SAS generates. See Figure 7-15.

Figure 7-15: Communication Test Details Page in the My Job Window

Communication Test - Job |D: 2590666

gi:” m119.qa opsware._com

Last Tested:Wed Jun 01 01:24:41 2005 [ Run Test Again ]
Total Errors: 0

AGT @ oK
CRP @ OK
CE @ OK
DAE @ OK
sk @ OK
MD @ OK

Viewing My Job Details from inside the OCC Client

You can also view job details from inside the OCC Client. If the job was run from
inside the OCC Client, you will see a link next to the job named Launch OCC Client,
as shown in Figure 7-16.

Figure 7-16: My Jobs with link to OCC Client
My Jobs

MHame

Create Snapshat [ Launch 0CC Client]
Audit Sewvers  [Launch OCC Client]

To launch the OCC Client and view the job details, click the link.
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Server Management Scheduling and Notification
This section contains the following topics:

» Scheduling a Job

» Sending Email Notification

The time used for the scheduled job is specified in the user's preferred time zone (which
can be modified in My Profile). If the user does not have a preferred time zone set, the
time zone is derived from the Opsware SAS core server (usually UTC).

Scheduling a Job
Perform the following steps to schedule server management tasks:

H Inthe Schedule and Notify page of an Opsware Wizard, choose the Run Now option
to execute the operation immediately or choose the Specify Time Option to schedule
the operation at a later date and time. See Figure 7-17

The time used for the scheduled job is specified in your preferred time zone which can be
AN
modified in My Profile. If you do not have the preferred time zone set, the time zone is
derived from the Opsware SAS core server (usually UTC).

H When you schedule a job for a server group, you can specify how the members of
the group are determined. The membership of a dynamic server group changes
based on the changes in your operational environment. If you have “Allow Run
Refresh Jobs” permissions, you will see additional options. Select either of the
following options:

« Option 1: Membership is determined based on the “Time of Confirm Selection.”
Select this option to run the job on the servers that were in the group when you
scheduled the job. Changes to the group membership do not affect the list of the
servers that the job will run on.
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« Option 2: Membership is updated when the job runs. Select this option to
recalculate the group membership prior to running the job. Changes to group
membership are reflected in the list of servers that the job will run on.

Figure 7-17: Scheduling a Job in an Opsware Wizard

Run Custom Extension 0

Select Schedule and Notify

Extension
| Select the time and date for this job to run. ¥You can choose to be notified after the job runs.
Select
Servers Schedule: @ oo jow
Specify I
Settings O Specify Time
Confirm
Settings
<3 Schedule
& and Notify Notify: & none
Run O condition Recipients
Extension

Options: Run the job on the servers from the Groups based on the time of Confirm
Selections.

Af the scheduled time, update the list of servers from the groups (0) selected prior
to running the job.

Cancel = Previous

H Additionally, you can view a scheduled job in the My Jobs page and change the date
and time for the job to run, or cancel the job entirely. (Click the name of a scheduled
job to open a window to change the date or time that the job will run or cancel it.)

Sending Email Notification

The email notification feature provides you with an option to receive an email
summarizing the job details when a job is over, and to notify others at the address they
have registered with Opsware SAS.

You have the option of sending the notification
+ On the job success only
« On the job failure only

+ On any result
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You can also send notification to various people based on the condition of the job. For
example, you can select to send the notification to your manager only on the job success,
select to send the notification to yourself on any result of the job, and select to send the
notification to support only on the job failure.

To send an email about the job details, choose the Condition option on the Schedule and
Notify page and set the parameters to send an email when the operation is completed.
You can choose to have an email sent on any result, if the operation fails, or if the
operation is successful. To add another email recipient, click the plus (+) button next to
the Recipients field. See Figure 7-18.

Figure 7-18: Notifying about a Job in the Opsware Command Center

<A Install Template - Microsoft Internet Explorer

Select Schedule and Notify

: Select the time and date for this job to riﬁn. You can choose to be notified after the job runs.
Select
5 .

Ervers Schedule: @& ¢ 1 yow
Confirm o
Selections O specify Time

@ Preview
= Schedule .
and Notify Notify: & pone
Install @ Conditian Recipients
|on any result V| |ssunderrajan@opsware cam, ‘ =
&] Dore S @ Internet

Install Template
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Time-Outs for Server Management Jobs

Table 7-8 describes the time-out values that apply to the server management operations
in Opsware SAS.

Table 7-8: Time-Quts in Opsware SAS

420 Reconciling software (installation and uninstallation).
(7 hours)
2 Starting Command Engine sessions in response to a command. If the

Opsware Agent does not start executing the command within this time, the
command will time out and the Command Engine script will continue.

30 Responding to a command (for example, after a reboot, the maximum time
to wait until a server responds) or sending a message to the Command
Engine from the Opsware Agent.

If the Opsware Agent does not respond to the Command Engine at least
once during this interval, the command will time out and the Command
Engine script will continue.

Opsware SAS polls the Opsware Agent every 15 minutes and if the
Opsware Agent fails to respond two consecutive times, the command will
time out.

Customizing the Monitor Time-Out Duration

If you would like to set a different monitor time-out duration, you can create a custom
attribute named OPSW_reconcile monitor timeout and change the number of
minutes before a time out occurs. For each type of hardware running in your operational
environment, you can set a custom attribute with the time-out duration that you want. To
set a time-out duration for a type of hardware, click Environment » Hardware in the
navigation panel. Then, navigate to the type of hardware that you want to add a custom
attribute for.

During reconcile, a periodic heartbeat occurs between the Opsware Agent and the
Command Engine to ensure that the agent is still responsive. This setting controls the
maximum amount of time that can pass between these heartbeat messages. Typically,
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you only need to increase this setting if you install software that reboots the server, and
the time that it takes for the server to reboot and for the agent to restart exceeds the
default value.

Custom Fields for Servers
This section provides information on custom fields for servers within Opsware SAS and
discusses the following topics:

» Overview of Custom Fields for Servers

» Changing the Value for a Custom Field

Overview of Custom Fields for Servers

In Opsware SAS, you can store custom server data that is specific to your operational
environment. These fields were created specifically for your Opsware SAS installation — all
servers in an Opsware SAS installation contain the same number and type of custom
fields. Custom fields can contain files, URLs, text strings, numbers, and dates.

In addition to adding files, URLs, text strings, numbers, and dates, you can use custom
fields to search for servers based on a value stored in a custom field. You can also use a
custom field as criteria to create a dynamic server group.

In order for the custom fields to appear in the Manage Server: Properties page, you will

have to initially create a custom field. To create a custom field, you will need to install the
custFields.py Custom Extension which is available only from the Content Starter Pack.
Contact your Opsware Technical Support for assistance in installing the custFields.py
Custom Extension in Opsware SAS.

Typed Data Supported for Custom Fields

The custom fields designated for your operational environment will vary. However, the
custom fields created for your environment support values with the following data types:

* Number: The value provided must be a long integer.
+ Short String: A text string that must be less than or equal to 4000 characters.

+ Long String: A text string with no length restrictions. Custom fields with this type
cannot be used in search or in the rules for dynamic server groups.
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» Date: The value will be verified for correctness.
+ File: Indicates a file attachment.
« URI: A Uniform Resource Identifier string, which is validated as a URI.

Opsware SAS validates the value you enter in a custom field based on the data type
specified for the field.

Uses of Custom Fields
The custom fields designated for your operational environment will vary. However, you can
use custom fields to accomplish any of the following goals:

« To store the date of patch installation
« To assign a severity rating between 1 and 10 to a Hotfix
« To store an ID from an internal bug tracking system with its associated patch

« To store a JPEG image of the back of a server and have that JPEG associated with that
server

+ To store a Microsoft Word document describing the disaster recovery steps for a server
or group of servers

» To search for a server based on the value of a custom field

Changing the Value for a Custom Field

E From the navigation panel, click Servers » Manage Servers. The Manage Servers
page appears. Browse the list to find the server whose custom fields you want to
change.

Or

Search for the server whose custom fields you want to change.
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H Click the server name. The Manage Servers: Properties page appears. Scroll to the
Custom Fields section of the page. The custom fields that appear in the properties
page are specific to your operational environment. Figure 7-19 shows an example of
the types of custom fields that can appear for a server.

Figure 7-19: Custom Fields That Appear for a Server

CUSTOM FIELDS

Date tobe installed |0+ +| | octoer v || 2004 v [ [0 (w|[o0 v |TVT
External 0S5 system ID |CQ12345 ”:‘ Enter up to 4000 characters in this field

Microsoft bulletin http:/fiwww. microsoft camibulletin/hotfixes/a23909 html @7

Severity |4 | Please enter an integer with a maximum of 18 digits:

Support document support.doc

Thiz is the support document for this patch.

Cancel

To change a value in a field requires a number or text, enter the value in the field.
To add a file, click Browse and select the file from the dialog box.

To remove a file, click Remove.

To specify a URL, enter the URL in the field or click Edit to change an existing URL.

To add or change a date, click the icon and select the date or enter the date in
the field by selecting the appropriate day, month, and year from the drop-down lists.

[~

Click Save.

Custom Attributes for Servers

This section provides information on custom attributes for servers within Opsware SAS
and contains the following topics:

+ Overview of Custom Attributes for Servers
+ Managing Custom Attributes

+ Adding Server Custom Attributes

+ Editing Server Custom Attributes

» Deleting Server Custom Attributes
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Overview of Custom Attributes for Servers

Users often need to store specific miscellaneous information in the Opsware Model
Repository to facilitate server or application installation and configuration, scripting, or
other purposes.

The Opsware Command Center provides a data management function by allowing users
to set custom attributes for servers. These custom attributes include setting
miscellaneous parameters and named data values. Users can write scripts that use these
parameters and values when performing a variety of functions, including network and
server configuration, notifications, and CRON script configuration.

Custom attributes can be accessed by software packages at installation time to configure
settings that might be unique to the installation.

For information about how to set custom attributes required by the software running on a
specific server, contact the group responsible for packaging your applications, as
Figure 7-20 shows.

Figure 7-20: Custom Attributes Set for a Server

Return to Manage Servers

Custom Attributes

Walue Source

[ev) (a1 |

OPSW reprovizion_device_sttributes_to_preserve  kernel_arguments reboot_c... Operating Systems f Red Hat Enterprise Linus 245 3§ Mat
Asszigned (Dperating Systems)

Managing Custom Attributes

Do not edit or remove custom attributes without verifying that the change you are making
A does not impact other users or critical Opsware operations.

To set custom attributes that affect a specific server, use the Manage Servers list. After
locating the server and displaying the server properties, select the Custom Attributes tab.
The Opsware Command Center displays the currently defined custom attributes for the
selected server.
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When you add or edit server custom attributes using the Opsware Command Center,
Opsware SAS removes leading and trailing whitespace characters from custom attribute
values.

See “Adding Server Custom Attributes” on page 284 in this chapter for more information.

To set custom attributes for all the servers assigned to a node in the Software Tree,
navigate to the node where you want to set attributes, select the Custom Attributes tab,
and add attributes for all the servers assigned to the node. Inheritance applies when you
set custom attributes for nodes in the Software Tree.

See the Opsware® SAS Configuration Guide for more information.

Additionally, you can set custom attributes that affect every server associated with a
specific customer or for every server in a facility. Navigate to the customer or facility where
you want to set attributes. Select Environment » Customers or Facilities in the navigation
panel, and click the correct name in the list. Select the Custom Attributes tab, and add
attributes for all the servers associated with the customer or located in the facility. When
you use this option, you define custom attributes at a customer-specific or facility-specific
level. The procedure to add custom attributes to a customer or facility is the same as
adding custom attributes to individual servers.

Additionally, you can add custom attributes for a server group by viewing a server group,
and then selecting the Custom Attributes tab for that group. The procedure to add custom
attributes to a server group is the same as adding custom attributes to individual servers.
Adding Server Custom Attributes

For information about how to set custom attributes required by the software running on a
specific server, contact the group responsible for packaging your applications.

Perform the following steps to add a custom attribute for a server:

From the navigation panel, click Servers » Manage Servers. The Manage Servers
page appears. Browse the list to find the server for which you want to add custom
attributes.

Or
Search for the server for which you want to add custom attributes.

H Click the display name of the server. The Manage Servers: Server Properties page
appears.
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Select the Custom Attributes tab. The Manage Servers: Custom Attributes page
appears.

Click New.
Enter the name and value for the custom attribute that you want to add.

Click Save.

See “Using the Search Feature” on page 125 in Chapter 4 for more information. See
“Server Searching by IP Address” on page 141 in Chapter 4 for more information

Editing Server Custom Attributes

If you want to change the name of a custom attribute entry, you need to create a new

custom attribute and delete the old custom attribute.

Perform the following steps to edit custom attributes for a server:

From the navigation panel, click Servers » Manage Servers or Server Pool. The
Manage Servers page appears. Browse the list to find the server for which you want
to edit custom attributes.

Or
Search for the server for which you want to edit custom attributes.

Click the display name of the server. The Manage Servers: Server Properties page
appears.

Select the Custom Attributes tab to change the custom attributes of the server. The
Manage Servers: Custom Attributes page appears.

Click the attribute name link for the custom attribute that you want to change.
Update the value of the custom attribute.

Click Save to save your changes. The Manage Servers: Custom Attributes page
reappears with the updated value.

See “Using the Search Feature” on page 125 in Chapter 4 for more information. See
“Server Searching by IP Address” on page 141 in Chapter 4 for more information.
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Deleting Server Custom Attributes

Perform the following steps to delete custom attributes for a server:

From the navigation panel, click Servers » Manage Servers or Server Pool. The
Manage Servers page appears. Browse the list to find the server from which you
want to remove custom attributes.

Or
Search for the server from which you want to remove custom attributes.

See “Using the Search Feature” on page 125 in Chapter 4 for more information. See
“Server Searching by IP Address” on page 141 in Chapter 4 for more information.

Click the display name of the server. The Manage Servers: Server Properties page
appears.

Select the Custom Attributes tab. The Manage Servers: Custom Attributes page
appears.

Select the check box for the custom attribute that you want to delete.
Click Delete. The Opsware Command Center displays a confirmation page.

Click OK to delete the custom attribute.

See “Using the Search Feature” on page 125 in Chapter 4 for more information. See
“Server Searching by IP Address” on page 141 in Chapter 4 for more information.

Service Levels

Th

is section provides information about service levels within Opsware SAS and contains

the following topics:

.

Overview of Service Levels

Adding a Service Level to the Opsware Command Center
Editing a Service Level

Ways to View the Service Level for Servers

Assigning a Server to a Service Level

Removing a Server from a Service Level

286 Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2006 Opsware Inc. All Rights Reserved.



Chapter 7: Server Management in Opsware Command Center

Overview of Service Levels

Service levels are user-defined categories that enable you to group servers in an arbitrary
way and design your own organizational schemes. For example, you can organize your
servers by functionality (finance, engineering, and so forth) or tier (Web, application, and
database) or by ontogeny (development, staging, and production).

You can also create service levels to indicate the Service Level Agreement (SLA) for the
servers that your IT organization manages. For example, you might create service levels to
denote Silver, Gold, and Platinum services.

Please note that assigning servers to service levels does not cause Opsware SAS to
operate any differently with respect to those servers. When you first use service levels, the
categories will be fairly empty and by default, when an Opsware Agent is installed on a
server in the operational environment, the server will be added to the UNKNOWN Service
Level.

Adding a Service Level to the Opsware Command Center
Perform the following steps to add a service level to the Opsware Command Center:

From the navigation panel, click Environment » Service Levels. The Service Levels
page appears.
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H Navigate the hierarchy of service levels until you reach the point in the hierarchy
where you want to add a new service level, as Figure 7-21 shows.

Figure 7-21: Service Level Hierarchy

Service Levels = OTHER B
4 & OTHER

Mo Sub-Modes

Properties 0 0 0

Cannot edit ar delete this Made. This Made is reserved.
Hame: OTHER
Description: Other service level
Customer: CustomerIndependent

Operating 05 Independent
System:

Locked: [Mo
Allow Servers: “ves

ID: 50003

EF Click Add. The Service Levels page refreshes and the ADD SUB-NODE TO Service
Levels form appears in the page.

Bl Enter a name for the service level (required), and (optionally) enter notes and a
description for the service level.

B Click Save. The service level is added to the hierarchy of service levels. The Edit
Service Level page appears, where you can change the properties of the service
level, such as the customer association.

Editing a Service Level

Perform the following steps to edit a service level:

From the navigation panel, click Environment » Service Levels. The Service Levels
page appears.

H Navigate the hierarchy of service levels until you reach the point in the hierarchy
where you want to edit an existing service level.
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E Click Edit in the Properties tab. The page refreshes and an editable form appears for
the service level properties.

Bl Make changes to the service level name, description, notes, whether servers are
allowed to be assigned to the service level, the associated customers and operating
systems.

Unlike nodes in the Software Tree, service levels can have multiple customers and
operating systems associated with them.

B Click Save.

Ways to View the Service Level for Servers

Find the server whose service levels you want to view by searching or browsing the
Manage Servers list.

« If you are browsing the Manage Server list, you can find the service level for a server by
locating the value in the Environment column, as Figure 7-22 shows.

Figure 7-22: Service Level Node Appearing in the Software Tab of the Server List
Managed Servers: Software View

0Ok w || Al Stages w || Al Uses w | | COB w || Mt Azzigned + | Update

Server  Software  Configuration Tracking  Yiew

] Mame Hostname fIP Address Software Enviranmert

DE-EU wentoux snvl corp opsware com  ventoux snyl corp opsware com o Red Hat Linus Cust: Mot Assigned
H 192165979 7.3 Mot Fac: COG

A=ssigned
Hyy DELL COMPUTER
CORPORATION f PRECISICN
WORKSTATION 380

Rim,
Sl Platinum Service
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« If you searched for the server, click the server name and then select the Attached
Nodes tab. You can find the service levels, as Figure 7-23 shows.

Figure 7-23: Nodes Tab That Shows the Service Level to Which a Server is Assigned

Attached Hodes
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hub from Service Levels F Opsware
oce from Service Levels F QOpsware
zhin from Service Levels F Opsware
twist from Service Levels [ Opsware
weay fram Service Levels f Opsware
wiord from Service Levels ¥ Opsware

Dpsuare

« To view all the servers assigned to a particular service level, click Environment »
Service Levels in the navigation panel. Navigate the hierarchy of service levels until you
reach the one for which you want to see which servers are assigned. Select the
Members tab, as Figure 7-24 shows.

Figure 7-24: Manage Server Assigned to a Service Level

Service Levels ® Cpsware # adh # windows = Details

(¢ Ej windows

FResource  Edit  “iew Tasks  Configuration Tracking

D__ Host Mame /P Address OF Version Stane Use Customer

O gi:” m201 tr3 opsware com mhi3 Windows 2000 Mot Specified Mat Specified Mot Assigned
172.16.36.34

Assigning a Server to a Service Level
Perform the following steps to assign a server to a service level:

From the navigation panel, click Servers » Manage Servers. The Manage Servers
page appears. Browse the list to find the server you want to assign to a service level.
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Or
Search for the server that you want to assign to a service level.
H Select the servers that you want to assign to a service level.

E Choose Tasks » Assign Node from the menu above the Manage Servers list. A
window displays the categories of nodes, as Figure 7-25 shows.

Figure 7-25: Assign Nodes Popup Window

Top Level

Assign Node

IP address Hostnarne
192 .1658.218,189 dhop-189,coreZ.custgall,com
Select Node
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Bl Click the Service Levels link. The window refreshes to show the service levels
created for your operational environment.

H Navigate to the service level to which you want to assign the server.

@ Click Assign. The window closes and you are returned to the Manage Servers list.
See “Using the Search Feature” on page 125 in Chapter 4 for more information. See
“Server Searching by IP Address” on page 141 in Chapter 4 for more information.
Removing a Server from a Service Level

Perform the following steps to remove a server from a service level:

From the navigation panel, click Servers » Manage Servers. The Manage Servers
page appears. Browse the list to find the server that you want to remove from a
service level.

Or
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Search for the server that you want to remove from a service level.

See “Using the Search Feature” on page 125 in Chapter 4 for more information. See
“Server Searching by IP Address” on page 141 in Chapter 4 for more information.

Select the server that you want to remove from a service level.

E Choose Tasks » Remove Node from the menu above the Manage Servers list. A
window displays the nodes to which the server is assigned, as Figure 7-26 shows.

Figure 7-26: Remove Nodes Popup Window
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Remove Cancel

Bl Select the service level node from which you want to remove the server and click
Remove. You are prompted to confirm that you want to remove the server from the
service level.

H Click Confirm Remove. The window closes and you are returned to the Manage
Servers list.

Network Configuration

This section provides information about network configuration within Opsware SAS and
contains the following topics:

+ Overview of the Server Network Configuration

» Configuring Networking for an Opsware Managed Server
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Overview of the Server Network Configuration

You can use Opsware SAS to automatically configure network settings for a server after
you install the OS.

The OS Provisioning feature provisions servers with an OS by using DHCP addresses.
Because DHCP servers often assign temporary IP addresses to servers that boot over a
network, system administrators typically need to assign static IP addresses (and other
network properties) before the servers can be put into service. Opsware SAS enables
system administrators to do this through the Opsware Command Center rather than
logging onto the server manually after OS provisioning is complete.

Opsware SAS does not support managed servers that have IPv6 addresses.

The Server Network Configuration feature allows you to configure the following settings
on a server that are related to its network configuration:

+ Host Name
+ Domain Name System (DNS) servers

+ Management interface (the interface that Opsware SAS should use when managing
the server)

See “Locating the Management IP Address of a Managed Server” on page 222 in
Chapter 7 for more information.

+ Gateway (the IP address of the default router)
+ DNS search domains
+ WINS (Windows Internet Naming Service) Servers

« Configuration for each network interface, including whether the interface is configured
statically or with a Dynamic Host Configuration Protocol (DHCP) IP address, host name,
and subnet mask

You can alter any of these options and then apply the settings to the managed server.
Opsware SAS updates the server and reboots it to cause the new settings to take effect.
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Configuring Networking for an Opsware Managed Server

You can only use the Network Configuration feature for servers running Sun Solaris, Red
Hat Linux, and Microsoft Windows operating systems.

Perform the following steps to configure networking for an Opsware managed server:

E From the navigation panel, click Servers » Manage Servers. The Manage Servers
page appears. Browse the list to find the server that you want to configure
networking on.

Or
Search for the server that you want to configure networking on.

See “Using the Search Feature” on page 125 in Chapter 4 for more information. See
“Server Searching by IP Address” on page 141 in Chapter 4 for more information.

H Click the name of the server that you want to configure networking for. The Manage
Servers: Properties page appears for that server.

Select the Network tab. The network information for the server displays.

Modify any of the following settings to configure the server networking.
For all fields, the default value is the one currently configured on the server.

» Host Name: The host name configured on the managed server. This field only sets
the name by which the server knows itself and does not update DNS records for
the server.

+ Management Interface: Instructs Opsware SAS to use a particular network
interface when contacting the server. This is useful, for example, when a server has
multiple network interfaces, but not all of them are reachable by the Opsware core.
Designating a particular interface as the management interface allows Opsware
SAS to know which interface to use for managing the server.

+ Gateway: The IP address of the default router
* DNS Servers: A list of DNS nameserver |IP addresses

+ Search Domains: A list of DNS domains to search when attempting to resolve
host names

+ WINS Servers: Set for Windows only; a list of WINS server IP addresses

+ Interface Configuration (for each network interface in the system):
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« DHCP: If DHCP is enabled for an interface, the system uses DHCP to configure
this network interface. In this case, static configuration settings (IP address, host
name, and subnet mask) are not relevant for this interface, and the Opsware
Command Center makes those fields not editable. If DHCP is not enabled, then
static settings are required.

« IP Address: The IP address for this interface (unless DHCP is enabled).

+ Host Name: The local host name for the server. This item is only required for
servers running Solaris. Like the Computer Name field, this setting only affects
the name by which the managed server knows itself, and does not update DNS
records.

* Subnet Mask: The IP network mask to use for this interface.

In addition, Opsware SAS displays the management IP address and MAC address
for the server; however, you cannot change these values reported by the Opsware
Agent.

Click Update Server at the bottom of the page.

(If you click Revert, it causes any changes that you made to the fields to be
discarded.)

A confirmation dialog box appears that shows the changes that will be made to the
server. The confirmation dialog box includes a check box that allows you to indicate
that the server should revert to its old network configuration when it cannot contact
the Opsware core after you save the new network configuration. By default, the
Revert check box is selected.

The Opsware Command Center does not validate the network configuration changes
that you make in the Network tab. Therefore, it is possible to provide a malformed IP
address in the IP address field for an interface.

To have the server revert to its previous network configuration if an error occurs,
ensure that the check box is selected in the confirmation dialog box.

Click OK to proceed with the configuration changes.

A progress dialog box appears that shows the progress of the operation. The process
of setting a new network configuration involves rebooting the managed server. The
operation might take several minutes.
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You can wait for the operation to complete or close the progress dialog box and perform
other work in the Opsware Command Center. The status of the task is available in the My
Jobs user interface if you want to check the status of the network configuration update.

Details About Changing the Domain for Windows Servers

You cannot use the DNS Domain field to change the domain name for a Windows server.

Opsware SAS does not change the domain name of a Windows server because
changing the domain name of a server requires password authentication. Changing the
domain name of a Windows server is a manual operation. See Figure 7-27.

Figure 7-27: DNS Domain Field Displays in the Network Tab for a Server

Return to Manage Servers

NETWORK INFORMATION
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Facility: DATACEMTER1
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Opsware.com
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This section discusses the following topics:
» Overview of Server Compliance
« Server Objects

+ Selection Criteria

» Snapshots

+ Ways to Create a Snapshot

» Snapshot Templates

» Snapshot Scheduling

» Uses of Snapshots

+ Ways to Find a Snapshot

+ Auditing

+ Ways to Perform an Audit

+ Audit Templates

+ Audit Schedules

+ Audit Results

+ Ways to View Audit Results

Overview of Server Compliance

In your IT environment, it is common for a server to not perform well when changes are
made outside of Opsware SAS. These changes include when new patches and packages
are installed, when configuration files have been modified, and when processes are
started and stopped.
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The Opsware Server Compliance feature enables you to keep managed servers
up-to-date by comparing them to a known working server. Managed servers are
compared to either the current state of a known working server or to a saved state that
was recorded in a snapshot. A known working server is a managed server that is
compliant (performs as expected) and is also referred to as a reference server or a
baseline server.

In Server Compliance, snapshot functionality and audit functionality are used to keep
servers up-to-date. A snapshot records how an Opsware-managed server is configured at
a particular point in time. To create a reference server, administrators create a snapshot of
a managed server deemed to be compliant. An audit compares managed servers, server
groups, and snapshots to determine how they differ. By performing an audit,
administrators can compare a problematic server with a known working server or with a
snapshot of the problematic server when it was previously working properly. When an
audit reports a difference between a reference server and a noncompliant server, they
can install software and server objects to remediate the discrepancy. For example,
administrators can use snapshots to audit the configuration of servers and deploy files
and software to correct disparities. They can also define schedules that specify when they
want snapshots to be created and audits performed, either once or as a recurring job.

The snapshot functionality is intended to assist system architects and developers who
need to record objects that are worth tracking on Opsware-managed servers, such as
installed packages, installed patches, hardware, and file system objects. Server
Compliance provides selection criteria that let them specify what server objects they want
to collect information about and how to collect the server objects. The information
collected includes file comparison data, inclusions/exclusions criteria, file modification
dates, and user and user group access permissions.

The auditing functionality is intended to be used by system administrators who need to
investigate and identify servers that are not performing well. System administrators can
use these audit results to remediate servers that are not compliant. By performing an
audit, they can compare a problematic server with a known working server or with a
snapshot of the problematic server when it was previously working properly.

Administrators can also use Server Compliance in their IT environment to preemptively
discover problems by performing routine (scheduled) audits. Routine audits identify
changes made to installed software, hardware information, configuration files, system
settings, and so on. As a best practice, regularly scheduled audits may significantly
reduce the volume of noncompliant servers in your IT environment.
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Service Compliance consists of several processes that allow administrators to compare
objects across servers: performing an audit, creating a snapshot, and fixing a server that
is malfunctioning. These processes and their results enable the following actions:

Performing an ad hoc audit by comparing a reference server that is behaving
normally to managed servers that are not behaving normally. The results from this
audit allow administrators to see differences between servers that may affect their
ability to operate properly.

Auditing managed servers to determine whether critical files have been modified by
comparing servers.

Comparing a server snapshot to live servers.
Comparing a snapshot to a snapshot.

Packaging differences discovered between servers to create a uniform set of
managed servers. See “Visual Packager” on page 363 in Chapter 9 for more
information.

Server Objects

Server Compliance creates snapshots to record information about managed servers and
server groups, and performs audits to compare server objects. Some objects are captured
and audited live and some objects are captured from the Model Repository.

The following server objects are captured and audited live from a managed server:

File System (files, directories, and symbolic links)

Windows Registry

Windows Services

Windows COM

Windows IIS Metabase

A Windows COM category (folder) that does not have any objects will not be included in

a snapshot or audit, even though Opsware SAS will display an empty COM folder in the

Server Explorer. A snapshot or audit will include a Windows COM category when it

includes at least one object.
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The following server objects are captured and audited from the Model Repository:
» Installed Packages
+ Installed Patches

+ Installed Hardware (CPU, network interfaces, storage, memory)

Server Compliance does not support device files, door files, and sockets.

Selection Criteria

This section discusses the following topics:
* Inclusion and Exclusion Rules
» Snapshot Selection Criteria Overlap

To create a server snapshot or perform an audit, you must provide instructions for
Opsware SAS so that it knows what to collect and compare, how to collect and compare,
and what files to include and exclude. In Server Compliance, these instructions are called
selection criteria.

In Server Compliance, you can record and compare information about a managed server,
such as hardware, packages, and patches that are installed on a server, and services that
are running on a server. You can specify detailed selection criteria that allow you to select
file system directories for a recursive snapshot or comparison into subdirectories, and to
include or exclude files from the snapshot and audit processes. Selection criteria also
allow you to record and compare the checksum of files, and store contents of files.

Opsware SAS provides selection criteria recommendations for certain operating systems.
See “Selection Criteria for Snapshots” on page 789 in this chapter for more information.

You must have a set of permissions to manage selection criteria. To obtain these
Iz permissions, contact your Opsware administrator. See the Opsware® SAS Configuration
Guide for more information.

The following selection criteria are used in the server snapshot and audit processes:
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« Content: Specifies how to collect and compare server objects and certain types of
object content, such as:

Content of subdirectories (Recursive)

Full contents of a file (Contents)

Windows NT Access Control List (ACL)

Checksum for each file (Checksum)

For the Recursive option, you can specify content that applies to the entire file
system or Windows Registry of the managed server. You can also specify content
that applies only to selected subdirectories or files in the file system or Windows
Registry. If you do not specify options for subdirectories or files, the default content is
derived from the options that are set at the top level directory.

For the Checksum option, you can select detailed options, depending on whether
you want the snapshot or audit to include all of the content of the files (Full), only the
first megabyte (MB) of each file (Lite), or no content (None). Checksum is performed
only on the contents of a file; therefore, file owner and file permission changes are
not audited. The default checksum is Full (all of the content of the files).

+ Inclusions/Exclusions: |dentifies the directories and files in the file system of the
managed server you want included in and excluded from the snapshot or audit. See
“Inclusion and Exclusion Rules” on page 302 in this chapter for more information.

« Comparison Criteria: Enables you to select whether you want the audit to compare
the file modification date (Date), and the user and group access permissions (Access).
For example, if two files have the same checksum, you can further compare these files
by the file modification date comparison criteria. Comparison criteria is optional in the
audit process. Comparison criteria does not apply to the snapshot process.

+ Override Default Options: Enables you to select one or more individual directories
(folders), files, or registry entries in the file system and then check Override Default
Options to override the selection criteria that applies to the entire file system. This
option allows you to specify different selection criteria for different directories and files.
The selection criteria that is specified at the file system level (default options) will not be
applied to these individual objects during the snapshot or audit process. The selection
criteria you defined for these individual objects will be applied during the snapshot or
audit process.
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« Clear All Overrides: Enables you to select one or more individual directories (folders),
files, or registry entries in the file system, remove options that were previously set, and
return them to the default options.

For the Windows Registry object, only the Content tab is enabled and only the Recursive
N
and full Contents options are available. Options are not available for Windows Services
objects.

Inclusion and Exclusion Rules

To specify the directories and files that you want included in and excluded from a
snapshot or an audit, you need to understand the rationale that Server Compliance
applies. It is important to understand what the inclusion and exclusion rules are, and how
Server Compliance applies these rules to the relative subset of the absolute path of the
file. These concepts are best explained by providing examples and supporting text.

Server Compliance provides the following three types of inclusion and exclusion rules:
+ Afile-type rule applies to the file name path and contains neither a “/” or a “\".

+ A relative-type rule applies to the relative path and can contain a “/” for Unix and a “\”
for Windows, and is not fully qualified.

+ An absolute-type rule applies to the absolute path. In Unix, an absolute path begins
with a “/”. In Windows, an absolute path begins with a volume letter that is followed by
“\" and is fully qualified, such as “C:\”, “d:\", “f:\", and so on. If you use a “/” (forward
slash) for Windows paths, Server Compliance will convert it to a “\” (backslash) to be
able to use it as a valid path.

Server Compliance processes all exclusion rules first. After all exclusion rules are applied,
then the inclusion rules are applied. The default for include is to include all objects in the
file system. In many cases, inclusion rules may not even be processed because,
combined with the exclusion rules (which occur first), they may become a moot point.

You can also use the asterisk (*) and the question mark (?) as valid wildcards in inclusion
and exclusion rules. The wildcard character is a placeholder for matching to a path, or one
or more characters.

Depending on the type of inclusion and exclusion rule, the rule is applied only to the
relevant subset of the absolute path of the file. In Server Compliance, there is one top
level for each snapshot or audit. Each file that you compare against the inclusion and
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exclusion rules has an absolute path. In Figure 8-1, the absolute path is /usr/home/
abc/defg. A snapshot or an audit looks down the /usr/home/abc/defg absolute
path and sees abc/defg as the relative path and defg as the file name. In this
example, the inclusion and exclusion rules would apply in the following manner:

+ Afile-type rule applies to the file name path defg.
+ A relative-type rule applies to the relative path abc/defg.
« An absolute-type rule applies to the absolute path /usr/home/abc/defq.

See Figure 8-1 for an illustration of how Server Compliance applies the inclusion and
exclusion rules to a relative subset of the path of the file.

Figure 8-1: How Inclusion and Exclusion Rules Apply

/

Absolute Path ' Relative Path "

/usr/home/abc/defg abc/defg defg
| |
Apply Apply Apply
Absolute-type Rules Relative-type Rules File-type Rules

To best explain how these rules are applied, the following examples are provided.

The sample file system structure used in “Example: Including all files with the .txt
extension in your snapshot or audit”, “Example: Including only the file a in your snapshot
or audit’, and “Example: Including the last temp.txt file and excluding everything else” is:

/dirl/dir2/a

/dirl/dir2/b
/dirl/dir2/names.txt
/dirl/dir2/temp.txt
/dirl/dir2/versionl.exe
/dirl/dir2/subdir/version2.exe

Example: Including all files with the .txt extension in your snapshot or audit
If you want to include all files with the .txt extension in your snapshot or audit, your
inclusion and exclusion rules would be:
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* /dir1/dir2

+ include *.txt (This is a file-type rule.)

+ exclude * (This is a file-type rule.)

The following steps explain how Server Compliance iterates through the file structure and
applies any corresponding inclusion and inclusion rules:

1.

The * causes /dir1/dir2/a to be excluded. Then *ixt is applied against the file
portion of /dir1/dir2/a (a) and there is no match. The file is not included.

The * causes /dir1/dir2/b to be excluded. Then *.txt is applied against the file
portion of /dir1/dir2/b (b) and there is no match. The file is not included.

The * matches names.txt, but *.txt matches names.txt as well, which causes the
file to be included.

Same as step 3.

Compare a to *, which is a match; compare a to a, which is a match. The file is
included.

Compare b to *, which is a match; compare b to a which is not a match. The file is
excluded.

These step numbers correspond to the paths in the sample file structure, with the
numbering starting with the top-level path.

Example: Including only the file a in your snapshot or audit

If you want to include only the file a in your snapshot or audit, your inclusion and
exclusion rules would be:

* /dir1/dir2

+ exclude * (This is a file-type rule.)

+ include a (This is a file-type rule.)

The following steps explain how Server Compliance iterates through the file structure and
applies any corresponding inclusion and inclusion rules:

1.

The * causes /dir1/dir2/a to be excluded. Then *.txt is applied against the file

portion of /dir1/dir2/a (a) and there is no match. The file is not included.

2. The * causes /dir1/dir2/b to be excluded. Then *.txt is applied against the file

portion of /dir1/dir2/b (b) and there is no match. The file is not included.
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The * matches names.txt, but *.txt matches names.txt as well, which causes the
file to be included.

Same as step 3.

Compare a to *, which is a match; compare a to a, which is a match. The file is
included.

Compare b to *, which is a match; compare b to a which is not a match. The file is
excluded.

These step numbers correspond to the paths in the sample file structure, with the
numbering starting with the top-level path.

Example: Including the last temp.txt file and excluding everything else
If you want to include the last temp.txt file and exclude everything else in your snapshot
or audit, your inclusion and exclusion rules would be:

* /dir1/dir2

+ exclude * (This is a file-type rule.)

+ include dir8/temp.txt (This is a relative-type rule.)

The following steps explain how Server Compliance iterates through the file structure and
applies any corresponding inclusion and inclusion rules:

1.

The * causes /dir1/dir2/a to be excluded. Then *txt is applied against the file
portion of /dir1/dir2/a (a) and there is no match. The file is not included.

The * causes /dir1/dir2/b to be excluded. Then *.txt is applied against the file
portion of /dir1/dir2/b (b) and there is no match. The file is not included.

The * matches names.txt, but *.txt matches names.txt as well, which causes the
file to be included.

Same as step 3.

dir3/temp.txt is dir3/temp.txt is compared against the relative portion of /dir1/dir2/
dir3/temp.txt and there is a match.

Compare a to *, which is a match; compare a to subdir/version2.exe, which is not
a match. The file is excluded.

These step numbers correspond to the paths in the sample file structure, with the
numbering starting with the top-level path.
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Snapshot Selection Criteria Overlap

When you include a parent directory (with options) in the selection criteria and a child
directory (with different options) as additional selection criteria, the parent directory
snapshot and the child directory snapshot will overlap each other as one snapshot. This
logic also applies to Windows NT ACL collection and content collection options, and
Windows Registry content collection options. How selection criteria for a parent and child
directory will overlap is best explained by the following examples.

Consider the following file system, where an ending forward slash (/) represents a
directory:

/cust/app/bin/
/cust/app/bin/filel
/cust/app/bin/conf/
/cust/app/bin/conf/confl
/cust/app/bin/conf/conf2
/cust/app/bin/conf/dev/
/cust/app/bin/conf/dev/conf3

Example A
If you create a snapshot using the following two selection criteria:

Directory /cust/app/bin (recursive, no checksum)
Directory /cust/app/bin/conf (not recursive, checksum)
The snapshot will record the following file system information:

/cust/app/bin/ (directory)
/cust/app/bin/filel (no checksum)
/cust/app/bin/conf/ (directory)
/cust/app/bin/conf/confl (*checksum*)
/cust/app/bin/conf/conf2 (*checksum*)
/cust/app/bin/conf/dev/ (directory)
/cust/app/bin/conf/dev/conf3 (no checksum)
As you can see, even though /cust /app/bin was recursive and had no checksum, the
/cust/app/bin/conf directory overrode it and all files in that directory have
checksums recorded for them.

Example B

If you create a snapshot using the following two selection criteria (by switching the
options used in Example A):

Directory /cust/app/bin (recursive, checksum)
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Directory /cust/app/bin/conf (not recursive, no checksum)
The snapshot will record the following file system information:

/cust/app/bin/ (directory)
/cust/app/bin/filel (checksum)
/cust/app/bin/conf/ (directory)
/cust/app/bin/conf/confl (*no checksum*)
/cust/app/bin/conf/conf2 (*no checksum*)
/cust/app/bin/conf/dev/ (directory)
/cust/app/bin/conf/dev/conf3 (checksum)

Example C
If you create a snapshot using the following three selection criteria (by adding a file
option):

Directory /cust/app/bin (recursive, checksum)

Directory /cust/app/bin/conf (not recursive, no checksum)
File /cust/app/bin/conf/confl (checksum)

The snapshot will record the following file system information:

/cust/app/bin/ (directory)
/cust/app/bin/filel (checksum)
/cust/app/bin/conf/ (directory)
/cust/app/bin/conf/confl (*checksum*)
/cust/app/bin/conf/conf2 (no checksum)
/cust/app/bin/conf/dev/ (directory)
/cust/app/bin/conf/dev/conf3 (checksum)

In this example, the very detailed selection criteria for conf1 override the

/cust/app/bin/conf selection criteria.

Snapshots

A snapshot is a record of how an Opsware-managed server is configured at a certain
date and time. This record is intended to capture information about the state of a known
working server. By creating a server snapshot, you can identify attributes of files and
directories on a managed server as a baseline record. A snapshot can also be considered
as a way to back up a managed server, especially if you plan to make changes to the
server and want to keep a record of it before you change anything. You can schedule
when you want a snapshot to be created (either once or as a recurring job) and who you
want to receive email notification about the status of the job.
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In addition to recording information about objects on managed servers, a snapshot can
contain the content of some objects. A server snapshot also identifies attributes of other
objects on specific types of operating systems, such as the Windows registry and
Windows services.

In Server Compliance, a snapshot can be used as a source and a target in the auditing
process. See “Auditing” on page 334 in Chapter 8 for more information.

The snapshot process records information about objects on a managed server at a
particular point in time. The captured information can also include content of some
objects and object attributes on specific types of operating systems, such as the
Windows registry and Windows services.

Server Compliance uses snapshots in the audit process to compare Opsware-managed
servers to determine how objects, and some object content, may differ.

Each snapshot requires a snapshot template that specifies a target and selection criteria.
A target is a managed server or server group that you are recording information about.
Selection criteria instruct Opsware SAS to record information about a managed server.

Depending on the server objects that you select for the snapshot, you can set up options
for a more detailed snapshot that includes file content and checksum, file inclusions and
exclusions, and Windows Registry key options. Figure 8-2 illustrates the server snapshot
process.
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Figure 8-2: The Server Snapshot Process
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Ways to Create a Snapshot

In Server Compliance, you can create a snapshot to record information that is derived
from an Opsware-managed server and launch the snapshot from the following different
windows in the OCC Client.

Launching a Snapshot from All Managed Servers
H Launch the OCC Client. From the Navigation pane, select Servers and then select All
Managed Servers.

H From the Content pane, select one or more managed servers.
Select Actions » Create Snapshot.

Launching a Snapshot from Server Groups

Launch the OCC Client. From the Navigation pane, select Servers and then select
Server Groups.

H From the Content pane, select a server group.
E Select Actions » Create Snapshot.
Launching a Snapshot from the Server Explorer

H Launch the OCC Client. From the Navigation pane, select Servers and then select All
Managed Servers.

H From the Content pane, select a managed server, and then open it.
From the Server Explorer window, select Actions » Create Snapshot.

Launching a Snapshot from the Compliance Window

Launch the OCC Client. From the Navigation pane, select Software Library and then
select Compliance.

H Select the Snapshot Template Tab.

Select a Snapshot Template and then select Actions » Create Snapshot.
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Snapshot Templates

This section discusses the following topics:

« Creating a Snapshot Template

+ Setting Up Snapshot Selection Criteria

» Creating a Snapshot

« Saving Snapshot Selection Criteria for Reuse
» Loading Snapshot Selection Criteria

« Managing Your Snapshot Selection Criteria

+ Editing a Snapshot Template

« Copying a Snapshot Template for Reuse

+ Deleting a Snapshot Template

A snapshot template identifies the information (selection criteria) you want to capture
about the state and configuration of a managed server or server group (target), at a
particular point in time. A snapshot template must define selection criteria and one or
more targets.

You can modify snapshot templates that you originally created, and copy and re-use them
to routinely record information about the managed servers in Opsware SAS. To conserve
disk space, you can remove snapshot templates that you no longer need from the
Software Repository.

Since selection criteria are specific to an operating system, such as Unix or Windows, you
cannot have one (universal) template for different operating systems of managed servers
in Opsware SAS. Figure 8-3 illustrates a sample snapshot template that was used to
gather and record information about a Windows 2003 server.
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You must have a set of permissions to create and modify snapshot templates. To obtain

V these permissions, contact your Opsware administrator. See the Opsware® SAS
Configuration Guide for more information.

Figure 8-3: Sample Snapshot Template
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Creating a Snapshot Template

You must create a snapshot template to identify your targets and selection criteria for the

snapshot process. An asterisk (*) at the beginning of a field name indicates that this
information is required.

To create a snapshot template, perform the following steps:

From one of the starting points described in “Ways to Create a Snapshot” on
page 310, select Create Snapshot. The Snapshot Template window opens.

In the Name field, enter a name for the snapshot you are creating. This name must
be unigue in your Opsware System.

K (Optional) In the Description field, enter a brief description of the type of snapshot
that you are creating.

312
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The Targets field displays the name, IP address, and operating system of the
managed server that you selected for the snapshot.

« If you want to add to this list of targets, click Add and select additional servers and
server groups from the Target Chooser window. See “Target Chooser” on page 42
in Chapter 3 for more information.

=
J"J Use the search tool to dynamically filter this list by entering a server name, IP
address, or operating system.

« If you want to remove targets from this list, select one or more servers or server
groups and then click Remove.

Select your selection criteria in the right field, and click Add to move it into Criteria
Type window. See “Setting Up Snapshot Selection Criteria” on page 313 for more
information.

When you are finished selecting sources, click the Add button that is below the
Selection Criteria field.

Click Create Snapshot to launch the snapshot process and display a job status
window that indicates the progress.

Click Save to save your snapshot template in the Model Repository or click Cancel
to close this window without saving your changes.

Snapshots are stored in the Software Repository.

Setting Up Snapshot Selection Criteria

To define the selection criteria for the server snapshot process, perform the following
steps:

From one of the starting points described in “Ways to Create a Snapshot” on
page 310, select Create Snapshot. The Snapshot Template window opens.

To specify your selection criteria, click Add below the Selection Criteria field.

In the Selection Criteria Editor, select a source and click Add. You can also remove
Selection Criteria, by selecting the sources and clicking Remove.
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To include all COM objects in a snapshot of a Windows server, you must select the
OLE/COM top-level node in the Selection Criteria Editor. Opsware SAS categorizes
the COM objects based on an attribute of the object, where the COM object
specifies zero or more categories. Opsware SAS displays all COM objects in one
node (OLE/COM) in the server object tree in case you do not know the category or
the object did not specify one.

In the Selection Criteria Editor you can select a Windows COM category (folder) whether it
AN
contains objects or not. The Selection Criteria Editor and the Server Explorer display all
Windows COM folders, whether they are empty or not.

When finished, click the Add button that is below the Selection Criteria field. This
returns you to the Snapshot Template window.

Bl Inthe Options pane, select the Content tab to specify whether the snapshot will
include contents of subdirectories (Recursive), full contents of a file (Contents),
Windows NT Access Control List (ACL), and checksum for each file (Checksum). You
can also select more detailed Selection Criteria for checksum, you can have the
snapshot include all of the content of the files (Full) or only the first megabyte (MB) of
each file (Lite). Checksum is performed on the contents of a file. File owner and file
permission changes are not included in a snapshot. The default for checksum is Full.

You can specify snapshot content that applies to the entire file system or Windows
Registry of the managed server or you can specify snapshot content that applies
only to selected subdirectories or files in the file system or Windows registry. If you
do not specify options for subdirectories, the default snapshot content is the parent
directory. See “Snapshot Selection Criteria Overlap” on page 306 in this chapter for
more information.

B If you have selected objects that have subfolders, select the Inclusions/Exclusions
tab. Select Include or Exclude to specify the directories and files that you want
included in and excluded from the snapshot.

+ Select Include and enter the path or file name in the text box. Click Add to display
this information in the list of content that will be included in the snapshot.

« Select Exclude and enter the path or file name in the text box. Click Add to display
this information in the list of content that will be excluded from the snapshot.
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See “Inclusion and Exclusion Rules” on page 302 in this chapter for more
information.

(Optional) Select an individual directory or file in the Criteria Type field. Check
Override Default Options to override the selection criteria that apply to the entire file
system. This option allows you to specify different selection criteria for different
directories and files. The selection criteria specified at the file system level (default
options) will not be applied to these individual objects during the snapshot process.
The selection criteria you defined for these individual objects will be applied during
the snapshot process.

For the Windows Registry object, only the Content tab is enabled and only the Recursive

and full Contents options are available. Options are not available for Windows Services

objects.

Click Save to save this snapshot template in the Model Repository or click Cancel to
close this window without saving your changes.

Creating a Snapshot

To create a snapshot, you must run a snapshot template. In Server Compliance, you can

create a snapshot in several different ways. You can:

Create and save a snapshot template, and then create a snapshot.

Create a snapshot template and then create a snapshot without saving the template.
This is known as creating an ad hoc snapshot.

Select an existing snapshot template and then create the snapshot.
Edit an existing snapshot template, save your changes, and then create the snapshot.

Edit an existing snapshot template and then create the snapshot without saving the
changes you made to the template.

Select multiple managed servers, or modify an existing and perform an ad hoc
snapshot.

See “Creating a Snapshot Template” on page 312 in this chapter for more information and
“Editing a Snapshot Template” on page 318 in this chapter for more information.
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To create a snapshot, you must have read permissions for all targets (servers and server

V groups) that are specified in the snapshot template. To obtain these permissions, contact

your Opsware administrator. See the Opsware® SAS Configuration Guide for more
information.

To create a snapshot and track its progress, perform the following steps:

E From one of the starting points described in “Ways to Create a Snapshot” on
page 310, select Create Snapshot. The Snapshot Template window opens.

H To check the status of a snapshot process, select Jobs and Sessions from the
Navigation pane, and then select Job Logs.

In the Content pane, select Create Snapshot from the drop-down list.

Click Update. The status of snapshots will now display. For more information, see
“Viewing a Snapshot Job” on page 333.

To prevent runaway processes, the snapshot process will time-out if it exceeds 60

minutes or if the data that is collected from a managed server exceeds 1 gigabyte (GB). If
you specify that you want to collect the full contents of files in the selection criteria, the
data collected may exceed the maximum size that can be successfully recorded in a
snapshot.

Saving Snapshot Selection Criteria for Reuse
You can save selection criteria and use it in other snapshot templates.
To save your selection criteria, perform the following steps:

Launch the OCC Client. From the Navigation pane, select Software Library and then
select Compliance.

From the Content pane, select the Snapshot Templates tab.
Select the template that you want to make a copy of, and then open it.
In the Snapshot Template window, select Actions » Save Selection Criteria As.

In the Save Selection Criteria As window, enter a unigue name.

(Optional) Enter a description of the Selection Criteria.
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Click Save to save your Selection Criteria or click Cancel to close this window
without saving your changes.
Loading Snapshot Selection Criteria

When you load previously-saved snapshot selection criteria, you do not create an
association between the selection criteria and the snapshot template.

To load selection criteria, perform the following steps:

Launch the OCC Client. From the Navigation pane, select Software Library and then
select Compliance.

From the Content pane, select the Snapshot Templates tab.
Select the template you want to make a copy of, then open it.

In the Snapshot Template window, select Actions » Load Selection Criteria.

In the Load Selection Criteria window, select a selection criteria and click Load to
load your selection criteria or click Close to close this window.

Managing Your Snapshot Selection Criteria

To view, rename, copy, or delete selection criteria, perform the following steps:

E Launch the OCC Client. From the Navigation pane, select Software Library and then
select Compliance.

From the Content pane, select the Snapshot Templates tab.

BN

Select the template you want to manage and then open it.

In the Snapshot Template window, select Actions » Manage Selection Criteria.

In the Manage Selection Criteria window, select a selection criteria name and click
any of the following buttons:

» Open: To view detailed information about the selection criteria, including the date
and time it was last modified and by whom.

* Rename: To change the name of the selection criteria.

+ Save As: To make a copy of (clone) the selection criteria.

Delete: To delete selection criteria. You can select multiple selection criteria names
to perform a mass delete.
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Editing a Snapshot Template

If you originally created a snapshot template, you can modify the selection criteria and
targets.

To modify a snapshot template, perform the following steps:

Launch the OCC Client. From the Navigation pane, select Software Library and then
select Compliance.

H From the Content pane, select the Snapshot Templates tab.

Select the template that you want to edit and then open it.

Make changes to the target names, snapshot description, or selection criteria as
needed, and click Save. This saves changes to the current template and will
overwrite the previous version of the template.

H (Optional) You can also perform any of the following actions:
1. Click Create Snapshot to create an another snapshot.

2. Select Actions » Save Template As to save your snapshot template using a
different name.

3. Click Cancel if you want to close this window without saving your changes.

Saving Snapshot Selection Criteria for Reuse

You can save snapshot selection criteria to reuse it, or you can modify it, save it, and then
reuse it to record objects on different targets (managed servers and server groups). As a
best practice, this is something you should do if this is the type of snapshot that you need
to create frequently. You can save selection criteria from a new template that you are
creating or from an existing template to reuse it in other snapshot templates.

To save selection criteria that is in a snapshot template, perform the following steps:

Launch the OCC Client. From the Navigation pane, select Software Library and then
select Compliance.

H From the Content pane, select the Snapshot Templates tab.

Select the template you want to edit and then open it.

Make changes to the target names, snapshot description, and selection criteria as
desired.

H Sclect Actions » Save Selection Criteria As.
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In the Save Selection Criteria As window, enter a unigue name.
(Optional) Enter a description of the selection criteria.

Click Save to save your selection criteria or click Cancel to close this window without
saving your changes.

See “Loading Snapshot Selection Criteria” on page 317 in this chapter for information
on loading your saved selection criteria.

Copying a Snapshot Template for Reuse

You can copy a snapshot template and reuse the selection criteria to record information
about other targets. To copy a snapshot template, perform the following steps:

(o [ o I~ I o I |

[~

Launch the OCC Client. From the Navigation pane, select Software Library and then
select Compliance.

From the Content pane, select the Snapshot Templates tab.

Select the template you want to make a copy of, and then open it.

In the Snapshot Template window, select Actions » Save Template As.
In the Save Template As window, enter a unique name.

(Optional) Enter a description of the template.

Click Save to save the snapshot template in the Model Repository or click Cancel to
close this window without saving your changes.

Deleting a Snapshot Template

To conserve disk space, you should delete snapshot templates that you no longer need
from the Model Repository. You can delete an existing snapshot template only if you
originally created it.

To delete an snapshot template, perform the following steps:

Launch the OCC Client. From the Navigation pane, select Software Library and then
select Compliance.

From the Content pane, select the Snapshot Templates tab.
Select one or more templates and then select Actions » Delete.

In the Confirmation Dialog, click Yes to delete this snapshot template or click No if
you do not want to delete it.
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When you delete a snapshot template, you do not delete any of the snapshots that were

created from it. See “Deleting a Snapshot” on page 333 in this chapter for more
information. However, when you delete a snapshot template, all schedules that you own
(created), that are also associated with that snapshot template, will be deleted. See
“Snapshot Scheduling” on page 320 in this chapter for more information.

Snapshot Scheduling

This section discusses the following topics:
+ Scheduling a Snapshot

+ Viewing a Snapshot Schedule

» Editing a Snapshot Schedule

+ Deleting a Snapshot Schedule

A snapshot schedule specifies when you want Opsware SAS to create a snapshot (either
once or as a recurring job) and who you want to receive email notification about the
status of the job. You can also view, edit, and delete existing snapshot schedules. When
you delete a snapshot template, all schedules that you own (created), that are also
associated with that snapshot template, will be deleted.

You must have permissions to create, view, edit, and delete snapshot schedules. To

V obtain these permissions, contact your Opsware administrator. See the Opsware® SAS

Configuration Guide for more information.

Scheduling a Snapshot

You can define a schedule that specifies when you want a snapshot created after you
have completed the Snapshot Template and saved it. To schedule a snapshot job,
perform the following steps:

E Launch the OCC Client. From the Navigation pane, select Software Library and select
Compliance.

H From the Content pane, select the Snapshot Templates tab and then select a
snapshot and open it. The Snapshot Template window opens.
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In the Snapshot Template window, click Schedule. The Schedule Job window will

display.

Figure 8-4: Snapshot Schedule
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In the Schedule field, choose whether you want the snapshot to be created once,
daily, weekly, monthly, or on a custom schedule.

enter a Start Time that specifies when you want the job to begin:

field changes to Daily when you subsequently edit the snapshot schedule.

When you initially specify a snapshot schedule, the Schedule field default is Weekly. If
you check every day of the week when the Schedule field is set to Weekly, the Schedule

H Depending on the type of Schedule you selected, use the following guidelines to

« To create a snapshot only once, enter the complete date and time, such as
October 5, 2005 12:01AM.

+ To create a snapshot daily, weekly, or monthly, enter the time of day, such as

12:01AM.
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« To create a snapshot on a custom schedule, use the following syntax to enter a
crontab string that specifies the day, date, and time you want the job to begin, as
shown in Table 8-5:

Figure 8-5: Crontab

*  * % % ¥ command to be executed

|
I dav of week (0 - 6) (Sunday=0)

do month (1 - 12)
Fommmee- day of month (1 - 31)
Fommmeeeeee hour (0 - 23)
oo min (0 - 59)

An asterisk (*) in any of these fields represent all days of the month, all months of the
year, all days of the week, and so on. For example, the following crontab string will
create the snapshot at midnight every weekday:

00**1-5

The crontab string can include serial (1,2,3,4) and range (1-5) values. For more

information about crontab entry formats, consult the Unix man pages.

@ Select a default time zone for the job execution time, or accept the default time zone.
The default time shown converts the scheduled time to the time zone set in your
user preferences. If you do not set a preferred time zone, the time zone is derived
from the Opsware SAS core server (typically UTC).

Depending on which Schedule you selected, complete one of the following steps:

« If you selected Weekly, select the days of the week that you want the snapshot to
be created in the Days to Run field.

« If you selected Monthly, select the Day of the month to create the snapshot. You
must also select the months of the year to create the snapshot in the Months to

Run field.

B Inthe Run Jobs Between These Dates section, select a Start and End time to specify
when you want the snapshot process to begin and end.

El (Optional) Select No End Date if you do not want the snapshot schedule to expire.
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EXJ (Optional) In the Job Run Notification Email section, enter email addresses
(separated by a comma or a space) of those you want to receive information on the
status of the snapshot job, including IDs of servers affected. Enter email addresses in
one or both of the following fields:

On Success: Email addresses that will receive natifications of jobs that completed
successfully, such as name@opsware.com, name2@opsware.com.

On Failure: Email addresses that will receive notifications of jobs that failed to
complete, such as name@opsware.com, name2@opsware.com.

Click OK to save your schedule information or Cancel to close this window without
saving any information.

Viewing a Snapshot Schedule

You can view a snapshot schedule after you have created (or edited) and saved it. To view
a snapshot schedule, perform the following steps:

E Launch the OCC Client. From the Navigation pane, select Software Library and select
Compliance.

H From the Content pane, select the Snapshot Templates tab and then select a
snapshot and open it. The Snapshot Template window opens.
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In the Snapshot Template window, select Actions » View Schedules or click
Schedule to display the Scheduled Jobs window.

Figure 8-6: Scheduled Snapshots
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Bl Open the snapshot job that you want to review.
H Inthe Scheduled Jobs window, review the detailed schedule information.

@ Click Cancel to close this window.

Editing a Snapshot Schedule

You can edit a snapshot schedule after you have created and saved it. To edit a snapshot
schedule, perform the following steps:

Launch the OCC Client. From the Navigation pane, select Software Library and select
Compliance.

H From the Content pane, select the Snapshot Templates tab and then select a
snapshot and open it. The Snapshot Template window opens.

In the Snapshot Template window, select Actions » View Schedules or click
Schedule to display the Scheduled Jobs window. See Figure 8-6.
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Select the Schedule that you want to change and click Edit. Make your schedule
changes.

Click OK to save your changes or Cancel to close this window without saving your
changes.

Deleting a Snapshot Schedule

You can delete a saved snapshot schedule. To delete a snapshot schedule, perform the

following steps:

Launch the OCC Client. From the Navigation pane, select Software Library and select
Compliance.

From the Content pane, select the Snapshot Templates tab and then select a
snapshot and open it. The Snapshot Template window opens.

In the Snapshot Template window, select Actions » View Schedules to display the
Scheduled Jobs window. See Figure 8-6.

Select the snapshot schedule you want to delete and then click Delete.

In the Confirmation Dialog, click Yes to delete the schedule or click No if you do not
want to delete it.

(Optional) Click Cancel to close this window without deleting the selected snapshot
schedule.

Uses of Snapshots

In Server Compliance, you can use snapshots in several different ways. You can:

.

Browse snapshot contents to view detailed information about the objects on a
managed server.

Convert a snapshot to a general snapshot to disassociate it from the managed
server.

Copy file system objects from a snapshot to a managed server.

Compare a snapshot with servers that are not performing well to discover whether
objects on the noncompliant server are missing or out-of-date.

Delete snapshots that are old or no longer required to conserve disk space.
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Ways to Find a Snapshot

After you have created a snapshot, you can find it using different windows in the OCC
Client.

In the Compliance window:

E From the Navigation pane, select Software Library and then select Compliance.
H Select the Snapshots tab.

EF Select a snapshot and then open it.

In the Jobs and Sessions window:

From the Navigation pane, select Jobs and Sessions and then select Job Logs.
H In the Content pane, select Create Snapshot from the Job Types drop-down list.

HE (Optional) Specify a job ID, date and time range, and job status options to narrow
your search for a snapshot job.

1 Click Update to view a list of snapshots based on your search criteria.

B Select a snapshot in the list and then open it.

In the Server Explorer:

E From the Navigation pane, select Servers.

H Select All Managed Servers and then select a server from the Content pane.
B Select a server and then open it.
4]

In the Server Explorer window, select Compliance and then select the Snapshots tab.
All the snapshots for that server or server group will display.

Select a snapshot and then open it.
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Browsing Contents of a Snapshot

You can browse the contents of a snapshot and view detailed information about the
server objects that were recorded.

To browse the contents of a snapshot, perform the following steps:

From one of the starting points described in “Ways to Find a Snapshot” on page 326,
open a snapshot.

Figure 8-7: Sample Snapshot Browser of a Windows Server

© Snapshot - warning windows test Tue May 17 01:35:06 2005

Snapshot  Wiew  Actions  Help

Summmary %

7 Installed Hardware warning windows test
). File: System
t';l Installed Packages o] hot
Windows Services Created: Tue May 17 01:35:06 2005
Installed Patches Created By: jazzy
@;’ ‘Windows Registry '
ﬁ OLE[COM Target: MO12 WORKGROUP {192,163,194,21)

i [f‘I;J Metabase Size: 8.27 MB
1Dy 3310039

Selection Criteria. .. |

Results
Installed Hardware &

File Syster 400

Installed Packages 14

Windows Services 69

Installed Patches 67

Warnings

Failed to open registry key or entry
HKEY_ISERS\5-1-5-21-12295 72621 - 1450960922-11 7723891 5-500_Classes); (2, 'RegOpenkeyEx’, 'The
system cannot find the file specified.”).

Failed to open registry key or entry
HKEY_USERS15-1-5-21-1229272821-1450960922-11 7723591 5-5000unkl,: (2, 'RegOpenkeyEx’, ‘The system
cannat find the file specified.”).

| | rikane | Tue May 17 17:45 2005 UTC

In the Snapshot Browser window, you can select:

« Summary to view general information about a snapshot, such as the date and
time the snapshot was created and by whom, the snapshot source (name of the
managed server), the size of the snapshot file, and a snapshot ID number.

+ Installed Hardware to view information about the type of CPU processor and
speed, cache size, memory size for SWAP and RAM, and storage devices that
were recorded in the snapshot.
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+ Installed Patches to view information about the installed patches that were

recorded in the snapshot, such as the patch type.

« Installed Packages to view information about the installed packages that were

recorded in the snapshot, such as package type, package version, and release
number.

+ File System to view the directories, file properties and attributes, and contents of

files recorded in the snapshot. See “Browsing File Properties, Permissions, and
Content” on page 329 in this chapter for more information.

If a file in the snapshot exceeds 2MB in file size, Server Compliance cannot display the

N
file contents.

.

.

Windows Services to view information about the running services recorded in a
snapshot, such as the name, description, startup state, startup type, and log on
account. See “Viewing a Snapshot Job” on page 333 in Chapter 8 for more
information.

Windows Registry to view information about Windows registry entries in the
snapshot, such as the registry key, registry value, and subkey. A registry key is a
directory that contains registry values, where registry values are similar to files
within a directory. A subkey is similar to a subdirectory. The content area in this
window excludes subkeys. Server Compliance supports the following Windows
registry keys: HKEY_CLASSES ROOQT, HKEY_CURRENT_CONFIG, HKEY_LOCAL
MACHINE, and HKEY_USERS.

Valid control characters for the contents of the key entry (Data) include: #x9, #xA,
[#xD, #x20-#xD7FF], [#xE000-#xFFFD], and [#x10000-#x10FFFF]. Invalid control
characters cannot be stored by Opsware SAS and will be converted to XML
entities and will display as &#;. For example, if the data value is 00 00 (in bytes),
&#x00; will display in this column.

OLE/COM to view information about Windows COM (Component Object Model)
objects in the snapshot, such as the name and GUID (Globally Unique Identifier) of
the object, and the path to the in-process server DLL.

Opsware SAS provides warning messages that explain how Windows COM folders
were processed. The following scenarios apply:

When you create a snapshot where you selected a Windows COM folder that
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does not contain any objects, the Snapshot Browser displays a summary.
Opsware SAS displays a warning that the GUID (Globally Unique Identifier) for that
folder is invalid, which means that the Windows COM folder does not contain any
objects.

When you create a snapshot where you selected a Windows COM object that
does not exist on a target, Opsware SAS displays a warning that the folder is
invalid.

When you create a snapshot where you selected a Windows COM folder that
does not contain any objects and a Windows COM folder that does contain
objects, the Snapshot Browser displays the folder. Opsware SAS displays a
warning that the folder is empty.

+ Metabase to view information about IS Metabase objects in the snapshot, such
as the ID, name, path, attributes, and data of the object.

Browsing File Properties, Permissions, and Content

You can view the properties and permissions of directories and files, and contents of files,
that were recorded in a snapshot. Properties include the file path, file type, file size,
checksum, user and group permissions, and so on. Permissions are displayed by their
corresponding user and user group, such as Full Control, Modify, Read, Write, and so on.

For a snapshot of a Unix file system, you can also view file modes (access permissions),
such as rw-r--r--.

For a snapshot of a Windows file system, you can also view file attributes, such as Read-
only, Hidden, System, Directory, Archive, Device, Normal, Temporary, Sparse File, Reparse
Point, Compressed, Offline, Not Content Indexed, and Encrypted.

To browse the properties and contents of a directory or file, perform the following steps:

E From one of the starting points described in “Ways to Find a Snapshot” on page 326,
open a snapshot.

H In the Views pane, find a directory or file that you want to view properties and
permissions for.
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In the Content pane, select the object and then open it.

Figure 8-8: Sample Object Browser for a Unix Directory
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Modified Date [% Sak May 14 00:05:17 2005
Base File Name a
Directory Name C:itempitemplsubdic
User Permission Administrators (BUILTIN' Administrators)
Group Permission  None (MO18\Nane)

2 items

Bl Click Close to close the object browser.

Converting a Snapshot to a General Snapshot

A snapshot is typically associated with the server (source) that it was generated from. If
you need to keep the snapshot and decommission its associated server, you must first
convert the snapshot to a general snapshot—so that the snapshot is no longer associated
with the server it was generated from. This allows the server to be used for other
purposes while still allowing the snapshot to be used in an audit.

You must have a set of permissions to convert a snapshot to a general snapshot. To

V obtain these permissions, contact your Opsware administrator. See the Opsware® SAS

Configuration Guide for more information.

To convert a snapshot to a general snapshot, perform the following steps:
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E From one of the starting points described in “Ways to Find a Snapshot” on page 326,
select a snapshot.

From the OCC Client, select Actions » Save Snapshot.

Click OK to save the snapshot in the Software Repository. After you save the
snapshot, a general snapshot icon replaces the server snapshot icon.

When you decommission a managed server, all snapshots associated with that server will
be deleted from the Software Repository.

Overview of Copying Objects from a Snapshot to a Server

After you have reviewed your snapshot contents, you may need to copy certain objects to
a destination server. Server Compliance allows you to copy the following objects to a
managed server: directories, files, Windows Services (state only), and Windows Registry
keys.

Before you copy these objects over to a managed server, it is important to understand
what actually gets copied to or created on the destination server:

« When you select a directory, only the directory will be copied to the destination server,
excluding any files in that directory. For example, if dir1 contains file1 and file2, and you
select dir1, Server Compliance copies only dir1 (not file1 and file2) to the destination
server.

+ When you select a file and its parent directory does not exist on the destination server,
Server Compliance will create the directory on and copy the files to the destination
server. For example, if you select file1 and dir1 does not exist on the destination server,
Server Compliance will create dir1 on and copy file1 to the destination server.

« When you copy a Windows Services object, you copy the state of the service, such as
started, stopped, paused, and so on. You can select one or more Windows Services
objects for a single copy process.

* When you copy a Windows Registry object, you can select one or more registry keys
and subkeys for a single copy process.
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You must have write permission on the destination server to be able to copy an object to

V it. To obtain these permissions, contact your Opsware administrator. See the Opsware

®

SAS Configuration Guide for more information.

Copying Objects from a Snapshot to a Server

To copy an object from a snapshot to a managed server, perform the following tasks:

From one of the starting points described in “Ways to Find a Snapshot” on page 326,
open a snapshot.

In the Views pane, select a File System, Windows Services, or Windows Registry.
In the Content pane, select one or more objects that you want to copy.
Select Actions » Copy To.

In the Select Server window, select a destination server.

=
-l""'l Use the search tool to dynamically filter this list by entering a server name, IP
address, or operating system.

Click Select to copy the object to that managed server or click Cancel to close this
window without saving your changes.

For other types of server objects, such as packages and patches, you can also create
A
installable packages to update a destination server. See “Visual Packager” on page 363
in Chapter 9 for more information.
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Viewing a Snapshot Job

You can monitor the progress of a server snapshot process to determine whether it has
completed or is still running. To view a snapshot job, perform the following steps:

H In the Navigation pane, select Jobs and Sessions and then select Jobs Logs.

H nthe Content pane, select Create Snapshot from the drop-down list and select a
status, such as In Progress or Completed.

You can search for snapshots according to job ID, start time, and status of the
snapshot process, including the number of managed servers and server groups in
the snapshot.

E Click Update to see the snapshots that meet your selection criteria.

Bl Open a snapshot to view detailed information.

Deleting a Snapshot

As a best practice, you should delete snapshots that you no longer need from the
Software Repository to conserve disk space.

You must have read permissions for the snapshot to be able to delete it. To obtain these
permissions, contact your Opsware administrator. See the Opsware® SAS Configuration
Guide for more information.

To delete snapshots, perform the following steps:

From one of the starting points described in “Ways to Find a Snapshot” on page 326,
select a snapshot or select multiple snapshots and then select Actions » Delete.

H n the Confirmation Dialog, click Yes to delete this snapshot or click No if you do not
want to delete it.

When you delete a snapshot, you do not delete the snapshot template that was used to
create it. See “Deleting a Snapshot Template” on page 319 in this chapter for more
information.
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Auditing
An audit is a process that compares Opsware-managed servers to determine how objects

and object content differ. Each audit requires an audit template that specifies the
following requirements:

Selection criteria: These are rules that instruct Opsware SAS. You can set the criteria to
select particular server objects to collect information about, select the files to compare,
and select the objects to include and exclude. You can also set how the system will
collect the server objects.

Source: This is the existing snapshot or server that you are comparing selection criteria
from.

Target: This is the existing snapshot, server, or server group that you are comparing
selection criteria to.

Depending on the server objects that you select for the audit, you can set up options for a
more detailed comparison, such as file content and checksum, file inclusions and
exclusions, file last modification date, user permissions, and user group access.
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Figure 8-9: The Server Auditing Process
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Ways to Perform an Audit

In Server Compliance, you can perform an audit in several different ways, based on the
Opsware-managed server, a server snapshot, an audit template, or an existing audit
result. The section reviews the following actions:

« Performing an Audit from a Managed Server
« Performing an Audit form a Server Group

You can also perform an ad hoc audit by editing an existing template. An ad hoc audit
differs from a regular audit, in that you launch the audit process without saving your
changes. The results from this audit allow you to see differences between servers that
may affect their ability to operate properly. See “Editing an Audit Template” on page 346 in
this chapter for more information.

« Performing an Audit from an Audit Template

* Re-running an Audit from Audit Results

Performing an Audit from a Managed Server
To perform an audit from a managed server, the managed server must be reachable.
E From the Navigation pane, select Servers and then select All Managed Servers.

H Select a managed server and then select Actions » Perform Audit.

Performing an Audit form a Server Group
From the Navigation pane, select Servers and then select Server Groups.

H Select a server group, and the select Actions » Perform Audit. (When you perform
an audit by selecting a server group, you must select an individual server in that
group as the source.)

A server group cannot be used as a source in the audit process. However, a server group

AS
can be used as a target in the audit process.
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Performing an Audit from a Snapshot
From the Navigation pane, select Software Library and then select Compliance.
H From the Content pane, select the Snapshot Tab.

Select a snapshot and then select Actions » Perform Audit.

Performing an Audit from an Audit Template
E From the Navigation pane, select Software Library and then select Compliance.
H From the Content pane, select the Audit Templates Tab.

E Select an audit template and then select Actions » Perform Audit.

Re-running an Audit from Audit Results
E From the Navigation pane, select Software Library and then select Compliance.
H From the Content pane, select the Audit Results Tab.

E nthe Content pane, select audit results and then select Actions » Re-Run Audit.

Audit Templates

An audit template identifies the source and targets that will be compared, including the
selection criteria that will be used in the audit process. You can modify audit templates,
and copy and re-use them to compare other sources and targets in Opsware SAS. When
you no longer need an audit template, you can remove it from the Model Repository.
Figure 8-10 illustrates a sample audit template.
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You must have a set of permissions to create and modify audit templates. To obtain these

V permissions, contact your Opsware administrator. See the Opsware® SAS Configuration
Guide for more information.

Figure 8-10: Sample Audit Template
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Since selection criteria is specific to an operating system, such as Unix or Windows, you

AS
cannot have one (universal) audit template for different operating systems of managed
servers in Opsware SAS.

Creating an Audit Template

You must create an audit template to identify your source and targets, and to define the
selection criteria used in the comparison audit.

An asterisk (*) at the beginning of a field name indicates that this information is required.
To create an audit template, perform the following steps:

From one of the starting points described in “Ways to Perform an Audit” on
page 336, select Actions » Perform Audit. The Audit Template Window appears.
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H Inthe Name field, enter a name for the audit you are creating. This name must be
unique in Opsware SAS.

E (Optional) In the Description field, enter a brief description of the type of audit you
are creating.

Bl Specify a managed server or a snapshot that you want to be used as the source in
the audit process. The source is what the audit compares selection criteria from.
Specify your selection criteria. See “Setting Up Audit Selection Criteria” on page 340
in this chapter for more information.

B Specify the servers, server groups, and snapshots that you want to be used as
Targets in the audit process.

@ Click Save to save your audit template in the Model Repository or click Cancel to
close this window without saving your changes.

When ready to launch the audit, click Perform Audit.

Specifying Source and Targets in the Audit Template

Depending on whether you decide to perform an audit by selecting single or multiple
managed servers, or by selecting a server group, there are several ways to specify the
source and targets that you want to be used in the audit process.

Performing an Audit by Selecting a Single Server
When you perform an audit by selecting a single server, by default that server is defined
as the source for the audit process. You can modify the default source as follows:

From one of the starting points described in “Ways to Perform an Audit” on
page 336, select Actions » Perform Audit.

H n the Audit Template Window, click Edit to select a different managed server (using
the Source Chooser) that will be used as the source in the audit.

Click Make Target to change the default source server to a target that will be used in
the audit.

Performing an Audit by Selecting Multiple Servers

When you perform an audit by selecting multiple servers, by default they are all defined
as targets for the audit process and are listed in the Targets section in the audit template.
You can modify this list of default targets as follows:
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+ In the Audit Template Window, select a server and then click Make Source to specify
that the server will be used as the source (instead of a target) in the audit. You may
be required to do this to correct a setup error and if objects on your reference server
have changed.

» Select one or more servers and then click Remove so that the servers will not be
used as targets in the audit.

+ Click Add to select one or more servers, server groups, and snapshots (using the
Target Chooser) that will be used as targets in the audit.

If you do not make any changes to the default targets, all of the managed servers in the

AN
list will be used as targets in the audit process.

Setting Up Audit Selection Criteria

You can set up audit selection criteria in different ways. You can re-use existing
(previously-saved) audit or snapshot selection criteria, or you can define new audit
selection criteria.

To use existing audit or snapshot selection criteria, you load it into your audit template as
is, or you load it into your audit template and then modify it as required.

To define new selection criteria, you choose server objects from the Selection Criteria
Editor.

To set up selection criteria for the server audit process, perform the following steps:

From one of the starting points described in “Ways to Perform an Audit” on
page 336, select Actions » Perform Audit. The Audit Template Window appears.
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H In the Audit Template, specify the selection criteria that will be used in the audit
process using any of the following methods:

« If you want to define new selection criteria in your audit template, then at the
bottom of the Criteria Type pane, click Add to open the Selection Criteria Editor
window where you can select one or more server objects you want to include in
the audit. You can also select one or more objects you want to delete from your
selection criteria and then click Remove.

« To include all COM objects in an audit of a Windows server, you must select the
OLE/COM top-level node in the Selection Criteria Editor. Opsware SAS categorizes
the COM objects based on an attribute of the object, where the COM object
specifies zero or more categories. Opsware SAS displays all COM objects in one
node (OLE/COM) in the server object tree in case you do not know the category or
the object did not specify one.

» See “Setting Up Audit Selection Criteria” on page 340 in this chapter for more
information.

H Inthe Audit Template window, select the Content tab to specify whether the audit will
include:

+ Contents of subdirectories (Recursive)
» Full contents of a file (Contents)

* Windows NT Access Control List (ACL)
» Checksum for each file (Checksum)

You can select more detailed selection criteria for checksum, depending on
whether you want the audit to include all of the content of the files (Full) or only
the first megabyte (MB) of each file (Lite). Checksum is performed on the
contents of a file. File owner and file permission changes are not audited. The
default checksum is Full.

You can also specify audit content that applies to the entire file system or
Windows Registry of the managed server, or you can specify audit content that
applies only to selected subdirectories or files in the file system or Windows
Registry. If you do not specify options for subdirectories, the default audit content
is the parent directory.

Bl Select the Inclusions/Exclusions tab to specify the directories and files in the file
system you want included in and excluded from the audit.
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+ Select Include and enter the path or file name in the text box. Click Add to display
this information in the list of content that will be included in the audit.

+ Select Exclude and enter the path or file name in the text box. Click Add to display
this information in the list of content that will be excluded from the audit.

See “Inclusion and Exclusion Rules” on page 302 in this chapter for more
information.

B Select the Comparison Criteria tab and select whether you want the audit to
compare the file modification date (Date), and the user and group access
permissions (Access).

@ (Optional) Select an individual directory or file in the file system and then check
Override Default Options to override the selection criteria that apply to the entire file
system. This option allows you to specify different selection criteria for different
directories and files. The selection criteria that is specified at the file system level
(default options) will not be applied to these individual objects during the audit
process. The selection criteria you defined for these individual objects will be applied
during the audit process.

For the Windows Registry object, only the Content tab is enabled and only the Recursive
A
and full Contents options are available. Options are not available for Windows Services
objects.

Click Save to save this audit template in the Model Repository or click Cancel to
close this window without saving your changes. See “Performing an Audit” on
page 342 in this chapter for more information on launching the audit process.

Performing an Audit

In Server Compliance, you can perform an audit in several different ways. You can:

« Create and save an audit template, and then run the audit process. See “Creating an
Audit Template” on page 338 in this chapter for more information.

+ Select an existing audit template and then run the audit process. See “Re-running an
Audit from Audit Results” on page 337 in this chapter for more information.

+ Edit an existing audit template and then run the audit process. See “Editing an Audit
Template” on page 346 in this chapter for more information.
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« Select multiple managed servers and perform an ad hoc audit.

To perform an audit, you must have read permissions for all sources and targets (servers,
server groups, and snapshots) that are specified in the audit template. To obtain these
permissions, contact your Opsware administrator. See the Opsware® SAS Configuration
Guide for more information.

Depending on the source and targets, the audit process can occur quickly or it can
require additional time to perform background tasks, as follows:

+ If the source and all of the targets defined in the audit template are all snapshots, the
auditing process requires little time.

When you perform an audit and an existing snapshot is defined as the source, the
selection criteria that was used when the snapshot was created is the selection criteria
that will be used in the audit process.

+ If the source or any of the targets defined in the audit template are not snapshots,
Server Compliance will create temporary snapshots of them to be able to perform
comparison tasks. The snapshot process runs in the background so that you can
continue to use other OCC Client features.

« If atarget is a live server, Server Compliance creates a temporary snapshot of it, which
requires additional time. When this occurs, the audit process will run in the background
(on the Command Engine) so that you can continue to use other OCC Client features.

If a target defined in the audit template is a heterogeneous server group (a server group
that contains different operating systems), Server Compliance will filter the server group
by the operating system that is specified in the Criteria Type. For example, if there are
Windows and Unix servers in a server group, where the Criteria Type in the audit template
specifies Unix as the operating system, Server Compliance will filter out all Windows
servers during the audit process. Only the Unix servers in the target (server group) will be
audited.

Tracking an Audit’s Progress

To track an audit’s progress, perform the following steps:
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E To check the status of an audit, select Jobs and Sessions and then select Job Logs
in the Navigation pane.

H Select Audit Servers from the drop-down menu in the Content pane.
Click Update. Audit Jobs will be displayed.

Bl Select an audit and then open it to view details.

Saving Audit Selection Criteria for Reuse

You can save audit selection criteria to reuse it, or you can modify it, save it, and then
reuse it to compare server objects on different targets (managed servers, server groups,
and snapshots). As a best practice, this is something you should do if this is the type of
audit that you need to perform frequently. You can save selection criteria from a new
template you are creating or from an existing template to reuse it in other audit templates.

To save selection criteria in an audit template, perform the following steps:

From one of the starting points described in “Ways to Perform an Audit” on
page 336, select Actions » Perform Audit. The Audit Template Window appears.

A In the Audit Template window, specify the selection criteria that will be used in the
audit process. See “Setting Up Audit Selection Criteria” on page 340 in this chapter
for more information.

When finished, select Actions » Save Selection Criteria As.
In the Save Selection Criteria As window, enter a unique name.

(Optional) Enter a description of the selection criteria.

Click Save to save your selection criteria or click Cancel to close this window without
saving your changes.

Loading Audit Selection Criteria

You can re-use existing (previously-saved) audit or snapshot selection criteria by loading
them into your audit template. You can load the selection criteria into your audit template
and leave it as is, or you can load them into your audit template and then modify as
required.

If the Source in the audit template is a managed server, the Load Selection Criteria
window will display a list of existing audit selection criteria.
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If the Source in the audit template is a snapshot, the Load Selection Criteria window will
display a list of existing snapshot selection criteria. Server Compliance allows you to use
snapshot selection criteria in an audit process.

To load audit or snapshot selection criteria into your audit template, perform the following

steps:

From one of the starting points described in “Ways to Perform an Audit” on
page 336, select Actions » Perform Audit. The Audit Template Window appears.

In the Audit Template window, specify the selection criteria that will be used in the
audit process.

When finished, select Actions » Load Selection Criteria to choose from a list of
existing selection criteria in the Load Selection Criteria window. This list will contain
only selection criteria that support the type of operating system (Unix or Windows) of
the Source (managed server or snapshot) that is specified in the audit template.
Server Compliance filters out any selection criteria that does not apply to the
operating system of the source.

In the Load Selection Criteria window, select a criteria name and then click Load to
add the selection criteria to your audit template, or click Close to close this window
without saving your changes.

If you want to modify the loaded selection criteria, at the bottom of the Criteria Type
pane in the audit template, click Add to open the Selection Criteria Editor window
where you can select one or more server objects that you want to include in the
audit. You can also select one or more objects that you want to delete from your
selection criteria and then click Remove.

Managing Your Audit Selection Criteria

After you have previously saved your selection criteria, you can view, rename, save as, and
delete them as required.

To manage your audit selection, perform the following steps:

From the Navigation pane, select Software Library and then select Compliance.
In the Compliance window, select Actions » Manage Selection Criteria.

In the Manage Selection Criteria As window, select a selection criteria name and
click any of the following buttons:

* Open: To view the selection criteria.

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2006 Opsware Inc. All Rights Reserved.

345



Opsware® SAS 5 User’s Guide

* Rename: To change the name of the selection criteria.
+ Save As: To make a copy of the selection criteria.

Delete: To delete selection criteria. You can select multiple selection criteria names
to perform a mass delete.

.

.

Close: To close this window without saving your changes.

Editing an Audit Template

To perform an ad hoc audit, edit a template and run it without saving it.

You must have write permissions to edit an audit template. To obtain these permissions,
Iz contact your Opsware administrator. See the Opsware® SAS Configuration Guide for

more information.

To modify an audit template, perform the following steps:

Launch the OCC Client. From the Navigation pane, select Software Library and then
select Compliance.

Select the Audit Templates tab, and then open an audit template.
Make changes to the template as necessary.
After you make your changes, choose any of the following actions:

Click Perform Audit to launch the audit process without saving your changes. This is
commonly known as performing an ad hoc audit.

Click Save to save the revised audit template in the Model Repository. This action will
overwrite the previous version of the template.

Click Schedule to schedule the audit.

Click Cancel if you want to close this window without saving your changes.

Copying an Audit Template for Reuse

You can copy an audit template so that you can reuse the selection criteria to compare
other sources and targets.

To copy an audit template, perform the following steps:
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Launch the OCC Client. From the Navigation pane, select Software Library and then
select Compliance.

Select the Audit Templates tab, and then open an audit template.
In the Audit Template window, select Actions » Save Template As.
In the Save Template As window, enter a unique name.

(Optional) Enter a description of the template.

Click Save to save the audit template in the Model Repository or click Cancel to
close this window without saving your changes.

Deleting an Audit Template

As a best housekeeping practice, you should delete audit templates that you no longer
need from the Model Repository.

You must have write permissions to delete an audit template. To obtain these
permissions, contact your Opsware administrator. See the Opsware® SAS Configuration
Guide for more information.

To delete an audit template, perform the following steps:

Launch the OCC Client. From the Navigation pane, select Software Library and then
select Compliance.

A Select the Audit Templates tab, and then select one or more audit templates and
select Actions » Delete.

H nthe Confirmation Dialog, click Yes to delete this audit template or click No if you do
not want to delete it.

Audit Schedules

An audit schedule specifies when you want an audit to be performed (either once or as a
recurring job) and who you want to receive email notification about the status of the job.
You can also view, edit, and delete existing audit schedules. When you delete an audit
template, all schedules that you own (created), that are also associated with that audit
template, will be deleted.
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You must have permissions to create, view, edit, and delete audit schedules. To obtain

V these permissions, contact your Opsware administrator. See the Opsware® SAS
Configuration Guide for more information.

Scheduling an Audit

After you have completed the Audit Template and saved it, you can define a schedule that
specifies when you want the audit performed.

To schedule an audit job, perform the following steps:

Launch the OCC Client. From the Navigation pane, select Software Library and then
select Compliance.

H Select the Audit Templates tab, and then open an audit template.

H nthe Audit Template window, select Actions » New Schedule to display the
Schedule Job window.

Figure 8-11: Audit Schedule

B Audit Template - Sample Audit 2

Template  Wiew B SN Help
*Mame: [samy  Perform Audi... — 7
Mew Schedule. . # Schedule Job

@:l *Source: [m

Ef; *selection|  Save Template Schedue: [Weeky =)

Criteria Type: | Save Template As... Start Time: | 06:32 PM [Z]
[+ Load Selection Criteria... Time Zone: |UTC - uTC = | s e
I Fi
[) File Syste Day(s)to Run: [¥] Sunday [ | Monday [] Tuesday [ ] Wednesday
Save Selection Criteria As... [] Thursday [ ] Friday [ ] Saturday

Manage Selection Criteria,.

U Installed F Global Shell...

Run Jobs between these Dates
Start: [ October 28, 2005 [5] kcksum)

End: | |
Mo End Date

— || Job Run Notification Email
*Targets ] On Success: | |
|Name On Fallure: | | | Add..
Ei m031.dev.cpsware,com (For example: name@opsware, com)
@” mi30.dev .opsware, com
2| mos3.dev.opsware. com | @ | ‘ oK J | e |
@” m180.dev.opsware. com =
LERI -t osen o R RTRET T
10 230040 | Petform Audit ‘ | Save || Cancel

Bl Inthe Schedule field, choose whether you want the audit to be performed once,
daily, weekly, monthly, or on a custom schedule.
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When you initially specify an audit schedule, the Schedule field default is Weekly. If you
check every day of the week when the Schedule field is set to Weekly, the Schedule field
changes to Daily when you subsequently edit the audit schedule.

B Depending on the type of Schedule that you selected, use the following guidelines to
enter a Start Time that specifies when you want the job to begin:

« To perform an audit only once, enter the complete date and time, such as October
5, 2005 12:01AM.

« To perform an audit daily, weekly, or monthly, enter the time of day, such as
12:01AM.

« To perform an audit on a custom schedule, use the following syntax to enter a
crontab string that specifies the day, date, and time you want the job to begin, as
shown in Table 8-12:

Figure 8-12: Crontab

*  ® & % * command to be executed

— month (1 - 12)
dEemmmmeees day of month (1 - 31)
R hour (0 - 23)
e min (0 - 59)

An asterisk (*) in any of these fields represents all days of the month, all months of
the year, all days of the week, and so on. For example, the following crontab string
will perform the audit at midnight every weekday:

00**1-5
The crontab string can include serial (1,2,3,4) and range (1-5) values. For more

information about crontab entry formats, consult the Unix man pages.

@ Select a default time zone for the job execution time, or accept the default time zone.
The default time shown converts the scheduled time to the time zone set in your
user preferences. If you do not set a preferred time zone, the time zone is derived
from the Opsware SAS core server (typically UTC).
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Depending on the Schedule that you selected, complete one of the following steps:

« If you selected Weekly, select the days of the week you want the audit to be
performed in the Days to Run field.

« If you selected Monthly, select the Day of the month to perform the audit. You must
also select the months of the year to perform the audit in the Months to Run field.

B Inthe Run Jobs Between These Dates section, select a Start and End time to specify
when you want the audit process to begin and end.

El (Optional) Select No End Date if you do not want the audit schedule to expire.

(Optional) In the Job Run Notification Email section, enter email addresses
(separated by a comma or a space) of those that you want to receive information
about the status of the audit job, including IDs of servers affected. Enter email
addresses in one or both of the following fields:

On Success: Email addresses that will receive notifications of jobs that completed,
such as name@opsware.com, name2@opsware.com.

On Failure: Email addresses that will receive notifications of jobs that completed,
such as name@opsware.com, name2@opsware.com.

Click OK to save your schedule information or Cancel to close this window without
saving any information.
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You can view an audit schedule after you have created (or edited) and saved it. To view an

audit schedule, perform the following steps:

Launch the OCC Client. From the Navigation pane, select Software Library and then

select Compliance.

Chapter 8: Server Compliance

H Select the Audit Templates tab, and then open an audit template.

In the Audit Template window, select Actions » View Schedules or click Schedule

to display the Scheduled Jobs window.

Figure 8-13: Scheduled Audits

¥ Audit Template - Sample Audit 3

Template  Wiew BENEGEN Help

Perform Audi..,,

*Mame: |Samp
Mew Schedulz.

Drescription:

8—” *Source: |su

Eﬁ *gelection C
Criteria Type:

Wiew Schedules..

it Make Target

Save Template As...

Options: Instaled Hardware

@ Load Selection Criteria...

@ Installed A

% Windavis Save Selection Criteria As...

Installed A . . Frequency Status Runs |User

= Manage Selection Criteria...

B Metabase =

] Global Shell... Diaily EXPIRED 3 nkane

%4 OLE[COM Monthiy RECURRING 1'kane

{204 Daily RECURRING 10 rkane

— — = [
e ] (e CESCES e ]
@ *Targets
|Name . |IP Address |OS | Add...

_@ﬂ winZk3iisj 192,165.8.231 Microsoft Windows Server 2003, Stan...

B-” winZkserver,opsware.com 192,165.8. 151 Microsoft Windows 2000 Server Servic...

I0: 260040

—
e

Bl Open the audit job you want to review.

H nthe Scheduled Jobs window, review the detailed audit schedule information.

@ Click Cancel to close this window.
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Editing an Audit Schedule

You can edit an audit schedule after you have created and saved it. To edit an audit
schedule, perform the following steps:

Launch the OCC Client. From the Navigation pane, select Software Library and then
select Compliance.

Select the Audit Templates tab, and then open an audit template.

In the Audit Template window, select Actions » View Schedules to display the
Scheduled Jobs window. See Figure 8-13.

Select a job and then click Edit to display the Schedule Job window.
Make your schedule changes.

Click OK to save your changes or Cancel to close this window without saving your
changes.

Deleting an Audit Schedule

You can delete a saved audit schedule. To delete an audit schedule, perform the following
steps:

Launch the OCC Client. From the Navigation pane, select Software Library and then
select Compliance.

Select the Audit Templates tab, and then open an audit template.

In the Audit Template window, select Actions » View Schedules to display the
Scheduled Jobs window. See Figure 8-13.

Select the audit schedule you want to delete and then click Delete.

In the Confirmation Dialog, click Yes to delete the schedule or click No if you do not
want to delete it.

(Optional) Click Cancel to close this window without deleting the selected audit
schedule.

Audit Results

Audit results contain only the differences that were discovered during the server audit
process. You can view differences between servers and snapshots, and differences
between two files (side by side and line by line).
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You can use these audit results to determine what type of remediation tasks are required
for the server that is not compliant. To conserve disk space, you should delete audit
results that you no longer need from the Software Repository.

You must have read write permissions to delete audit results. To obtain these permissions,
contact your Opsware administrator. See the Opsware® SAS Configuration Guide for
more information.

Ways to View Audit Results

You can review audit results in the Audit Result windows in the OCC Client. The Audit
Result window provides visual cues that indicate whether server object differences were
discovered in the audit process. In the server object tree in the Audit Result window,
objects that differ are displayed in blue text and are followed by an asterisk (*). See
Figure 8-14 on page 354 for an illustration.

In the Jobs and Sessions window:
From the Navigation pane, select Jobs and Sessions and then select Job Logs.
H In the Job Types drop-down list, select Audit Servers.

HE (Optional) Specify a job ID, date and time range, and job status options to narrow
your search for audit results.

B Click Update to view a list of audit results based on your search criteria.

B Select an audit in the list and then open it.

In the Compliance window:

E From the Navigation pane, select Software Library and then select Compliance.
H Select the Audit Results tab.

E Select an audit and then open it.

In the All Managed Servers window:

E From the Navigation pane, select Servers and the All Managed Servers.

From the View Menu, select Software Library » Compliance.

In the Compliance window, select the Audit Results tab.

Select an audit and then open it.
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Viewing Audit Results on a Server by Server Basis

To view audit results on a server-by-server basis, perform the following steps:

From one of the starting points described in “Ways to View Audit Results” on

page 353, open an audit result. The Audit Results Window appears.

Figure 8-14: Sample Audit Result Window

¥ Audit Result - Jacques test adhoc audit Fri May 13 20:17:00 2005

Audit  Wiew  Actions  Help

Installed Hardware*
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7

Audit Result

Created:
Created By:
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Size:
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IC:

Fri May 13 20:17[%0 2005
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980039
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Failed to open registry key or entry HKEY LOCAL MACHIME)SoftwareiMortgageapp',: (2

1
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Failed to stat C:\Program FilesiMortgagesppl234: [Errno 2] Mo such file or directory:
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«
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|

H In the Audit Result window, you can select:

+ Summary to view a summary of your audit results, such as the date and time the

audit was created, the audit source (an existing snapshot or a server) that was

compared to the targets, the size of the audit file, the total number of differences
found for each target in the audit, an audit ID number, warning messages, and a
list of targets in the audit. The warning messages are useful for searching the
database to troubleshoot problems.

+ Installed Hardware to view the hardware audit results for your source and targets,

such as CPU model, amount of RAM, storage differences, different cache size,

processor speed, owner, permissions, and interfaces. The number in parentheses
next to the tab name indicates how many differences were discovered for that type
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of source and target comparison. Browse the tabs to view hardware differences
that were found only on the source, only on the targets, or on both the source and
the targets. See “Viewing Contents of Objects that Differ” on page 356 in this
chapter for more information.

Installed Packages to view the installed packages differences for your source and
targets, such as the package version and package type. Server Compliance
supports the following types of packages: Slowpoke for Unix, MSI for Windows,
LPP for AIX, Depot for HPUX, and RPM. The number in parentheses next to the tab
name indicates how many differences were discovered for that type of source and
target comparison. Browse the tabs to view installed packages differences that
were found only on the source, only on the targets, or on both the source and the
targets.

Patches to view the installed patches differences for your source and targets, such
as the patch type. The number in parentheses next to the tab name indicates how
many differences were discovered for that type of source and target comparison.
Browse the tabs to view installed patch differences that were found only on the
source, only on the targets, or on both the source and the targets.

File System to view the file system audit results for your source and target servers,
such as checksum, permissions, and file size. You can also view differences
between two files (side by side and line by line). The number in parentheses next
to the tab name indicates how many differences were discovered for that type of
source and target comparison. Browse the tabs to view installed file system
differences that were found only on the source, only on the targets, or on both the
source and the targets. In the View Contents window, select an item from the
Encoding drop-down list to specify the character encoding of the data displayed.

Windows Services to view the running services audit results for your source and
targets, such as the name, status, startup type, and log on (as a particular user,
such as LocalSystem, NT Authority, and so on) of the service. The number in
parentheses next to the tab name indicates how many differences were
discovered for that type of source and target comparison. Browse the tabs to view
differences that were found only on the source, only on the targets, or on both the
source and the targets.

Windows Registry to view the registry key audit results for your source and
targets, such as HKEY_CLASSES ROOT, HKEY_CURRENT_CONFIG, HKEY _
LOCAL_MACHINE, and HKEY_USERS. The number in parentheses next to the tab
name indicates how many differences were discovered for that type of source and
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target comparison. Browse the tabs to view Windows registry key differences that
were found only on the source, only on the targets, or on both the source and the
targets.

Valid control characters for the contents of the key entry (Data) include: #x9, #xA,
[#xD, #x20-#xD7FF], [#xE000-#xFFFD], and [#x10000-#x10FFFF]. Invalid control
characters cannot be stored by Opsware SAS and will be converted to XML
entities and will display as &#;. For example, if the data value is 00 00 (in bytes),
&#x00; will display in this column.

+ OLE/COM to view Windows COM (Common Object Model) audit results for your
source and targets, such as the name and GUID (Globally Unique User ID) of the
object, and the path to the in-process server DLL. The number in parentheses next
to the tab name indicates how many differences were discovered for that type of
source and target comparison. Browse the tabs to view OLE/COM object
differences that were found only on the source, only on the targets, or on both the
source and the targets. See “Viewing OLE/COM Objects that Differ” on page 357
in this chapter for more information.

+ Metabase to view IS Metabase object audit results for your source and targets,
such as the ID, name, path, attributes, and data of the object. The number in
parentheses next to the tab name indicates how many differences were
discovered for that type of source and target comparison. Browse the tabs to view
Metabase object differences that were found only on the source, only on the
targets, or on both the source and the targets. See “Viewing Metabase Objects that
Differ” on page 359 in this chapter for more information.

Viewing Contents of Objects that Differ

For some objects that were audited, you can view content differences side by side and
line by line. You can see which lines in a file were added, deleted, or modified.

To view the contents of two objects that differ, perform the following steps:

From one of the starting points described in “Ways to View Audit Results” on
page 353, open an audit result. The Audit Results Window appears.

H nthe Views pane, select an object in the File System.
E Inthe Content pane, select the On Both but Different tab and select two objects.

B Select Actions » View Differences.
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B Inthe Comparison window, select an item from the Encoding drop-down list to

specify the character encoding of the data displayed.

@ Click the arrows to find the first, next, previous, or last lines that were added, deleted,
or modified in the file that is in the source or in the file that is in a target. Differences
are highlighted according to the following color scheme:

— Green: This content was added.

Blue: This content was modified.

Red: This content was deleted.

Black: No changes were made to this content.

Click Close to close this window.

If one of the files you are comparing exceeds 2MB in file size, Server Compliance cannot
display the file differences.

Viewing OLE/COM Objects that Differ

For OLE/COM objects that were audited, you can view differences in object properties
and user group permissions, side by side.

To view the contents of two objects that differ, perform the following steps:

From one of the starting points described in “Ways to View Audit Results” on
page 353, open an audit result. The Audit Results Window appears.

H In the Views pane, select the OLE/COM object.

In the Content pane, select the On Both but Different tab.
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Bl nthe Content pane, select objects and then select Actions » View Differences.

Figure 8-15: Sample OLE/COM Object Browser

%) [6BC09897-0CE6-11D1-BAAE-00CO4FC2E20D3

Yiew:
Source: sust-wzk3vmware]  sust.opsware,com (192, 168,199.6)
Target: win2k3iisj (192,168.8,231)

Properties |

Source! {6BC09397-0CEE-1101-BAAE-00CO4FC2E200}

Target: {6BC09897-0CEE-1101-BAAE-00COHFCZE20DT

{EBCO9597-0CE6-11D1-BAAE-O0CO4FCZEZOD )=
M=
E}---Innrocsarver[]=c Swwindowstsystem3Ztiassam, dl
+-Product Version=5.2,3790.0
- File Version=5.2,3790.0

{EBCO9897-0CE6-1 1D1-BAAE-O0CO4FCZEZ0D} =
o Mame=
E}---InnrocServer[]=c:\windowslsystem32\iassam.dl\
+-Product Version=5.2,3790,1330
L.-File Version=5.2,3790.1530

Close

B nthe View window, select one of the tabs (Properties, Access Permissions, or
Launch Permissions) to view those types of differences for the selected object.
Object properties and permissions that differ are displayed in blue text.

When you perform an audit of two servers using selection criteria that includes
installed hardware where the RAM size is different on the source and target, this
information is displayed in the file object browser as the same RAM size, even
though the RAM size is really different. The OCC Client collects RAM size in bytes
and converts it to megabytes (MB). If the RAM size difference is very slight, it will not
be recorded as a difference in megabytes. However, the difference will be displayed
in kilobytes (KB) in parenthesis next to the MB display.

In the object browser, only the parent (top-level) nodes are displayed in blue text. Child

node differences are not displayed in this tree structure. To identify differences in child

nodes, you must individually inspect them.

@ Click Close to close the object browser window.
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Viewing Metabase Objects that Differ

For Metabase objects that were audited, you can view differences in connection
information, bandwidth, server state and size, ISAdmin Extensions, cache extensions,
Allow Keep Alives, and so on.

To view the contents of two objects that differ, perform the following steps:

From one of the starting points described in “Ways to View Audit Results” on
page 353, open an audit result. The Audit Results Window appears.

H In the Views pane, select the Metabase object.
E Inthe Content pane, select the On Both but Different tab.
Bl Select an object and then select Actions » View Differences.

Figure 8-16: Sample IIS Metabase Object Browser

Yiew:

Source: eking's ST for testing Metabase criteria @

Target: md36.dev.opsware.com {192, 163,194 .45)

Fraperties |

Source: [ISAdmin Extensions Target: IISAdmin Extensions

Id 1028 1028

Marne 1I5Admin Extensions 1I5Admin Extensions

Path JLMJTISADMIN/EXTEMNSIONS/DCOMCLSIDS || | JLMTISADMINIEXTENSIONS/DCOMCILSIDS Il
= |-

Attributes  Mone Mone

uT Server Server

oT Mulkisz Mulkisz

Data {61738644-F196-11D0-9953-00C04FD919C1) |~ | {9F0BD3A0-ECO1-11D0-A6A0-00A0C922E752F |~ |
| |, 461735644-F196-11D0-9953-00C04FD2L 21} |

| Close |

In the View window, review the blue text for object properties that differ.

Click Close to close the object browser window.
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Overview of Copying Objects to a Destination Server

After you have reviewed your audit results, you may need to copy certain objects to a
destination server. Server Compliance allows you to copy the directories, files, Windows
Services (state only), and Windows Registry keys. If an audit discovers that any of these
objects exist only on the source or are on both the source and the target but differ, you
can copy them to a destination server. The process works in the following manner:

» When you select a directory, only the directory will be copied to the destination server,
excluding any files in that directory. For example, if dir1 contains file1 and file2, and you
select dir1, Server Compliance copies only dir1 (not file1 and file2) to the destination
server.

+ When you select a file and its parent directory does not exist on the destination server,
Server Compliance will create the directory on and copy the files to the destination
server. For example, if you select file1 and dir1 does not exist on the destination server,
Server Compliance will create dir1 on and copy file1 to the destination server.

+ When you copy a Windows Services object, you copy the state of the service, such as
started, stopped, paused, and so on. You can select one or more Windows Services
objects for a single copy process.

« When you copy a Windows Registry object, you can select one or more registry keys
and subkeys for a single copy process.

You must have write permissions on the destination server to copy an object to it. To
IZ obtain these permissions, contact your Opsware administrator. See the Opsware® SAS
Configuration Guide for more information.

Copying an Object from a Source or Target
To copy an object from a source or a target, perform the following steps:

E From one of the starting points described in “Ways to View Audit Results” on
page 353, open an audit result. The Audit Results Window appears.

In the Views pane, select an object in the File System.
In the Content pane, select the Only on Source or the On Both but Different tab.

Select one or more objects and select Actions » Copy To.

In the Select Server window, select the server you want to copy the object to.
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=
--l""h"I Use the search tool to dynamically filter this list by entering a server name, IP
address, or operating system.

[ Click Select to copy the object or click Cancel to close this window without saving
your changes.

For other types of server objects, such as packages and patches, you can also create
installable packages to update a destination server. See “Visual Packager” on page 363
in Chapter 9 for more information.

Exporting Audit Results to HTML or CSV

If you need to use audit results in a different file format, you can export them to an HTML
report orto a CSV file.

To export audit results to HTML or CSV, perform the following steps:

E From one of the starting points described in “Ways to View Audit Results” on
page 353, open an audit result. The Audit Results Window appears.

H In the Audit Results window, select Audit » Export » HTML.
Or
Select Audit » Export >» CVS.

In the Export window, enter a file name and specify the location to save this file.

Click Open (for HTML) or Export (for CVS) to save the file, or click Cancel to close
the Export window without saving your changes.

Deleting Audit Results

As a best practice, you should delete audit results that you no longer need from the
Software Repository to conserve disk space. You can delete audit results only if you
performed the audit.

To delete audit results, perform the following steps:

From one of the starting points described in “Ways to View Audit Results” on
page 353, select one or more audit results and select Actions » Delete.

H n the Confirmation Dialog, click Yes to delete or click No to close the window.
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This section discusses the following topics:

» Overview of Visual Packager

» Packaging Server Setup

» Overview of Packages

» Packaging Process

+ Ways to Create a Package

« Creating a Package

+ Adding New Package Content

» Specifying Options for New Package Content

+ Viewing Package Details

Overview of Visual Packager

Visual Packager is an Opsware feature that helps you install software on managed
servers. It guides you through the process of creating installable software packages using
server compliance information, such as server snapshots and audit results. File system
objects recorded in a snapshot and compliance information produced by an audit help
you define the content of packages, and packages, in turn, can be used to update servers
with new server objects.

Server objects can be selectively packaged according to the operating system of the
servers that the package will be distributed to. Visual Packager supports Unix and
Windows Operating Systems by allowing packages to contain the following objects:

+ A Unix package can contain files (including attributes), directories, packages, patches,
and patch clusters.

+ A Windows package can contain files (including attributes), directories, packages,
patches, Windows registry, and Windows services.
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When you create a package, Visual Packager creates an application node in the Software
Tree and verifies that all other packages and non-package content are attached to this
same application node. Packages can consist of other packages, patches, and non-
package content such as the Windows registry, Windows services, and file system
objects. When you create a package that contains any of these items, Visual Packager
analyzes the objects that you have selected and characterizes them in the following ways:

+ When a package contains a package or a patch that does not exist in the Software
Repository, Visual Packager lets you provide the missing information for selected
packages and patches.

+ When a package contains a package or a patch that already exists in the Software
Repository and you want to overwrite them, Visual Packager lets you select the source
location of the preferred version.

* When a package contains non-package content or patch data, Visual Packager creates
a new package that contains them. You can specify a set of options that apply only to
the non-package content, such as reboot requirements and pre/post install scripts. This
non-package content is considered to be a package that is part of the same
application node that the other packages and patches are attached to.

To get started using Visual Packager, select Create Package under the Actions menu in
the OCC Client.

You must have RPM installed on your packaging server to enable the Visual Packager
AN
feature to create an RPM package for Solaris and AIX. The Visual Packager feature does
not verify whether RPM is available on the packaging server.

Packaging Server Setup

Visual Packager requires a packaging server for each type of operating system for the
packages you plan to create. For example, for Solaris packages you need a Solaris
packaging server, and for MSI (Microsoft® Installer Utility) packages you need a Windows
packaging server.
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When you are using Visual Packager to create a package for a Red Hat Linux operating
system, the operating system version and architecture of the packaging server must be
identical to the operating system version and architecture that you want the package
created for and installed on. Table 9-1 illustrates these requirements.

Table 9-1: Red Hat Linux Packaging Servers and Packages

Red Hat Enterprise Linux 3 AS 32 bit x86 | Red Hat Enterprise Linux 3 AS 32 bit x86
Red Hat Enterprise Linux 3 AS 64 bit x86 | Red Hat Enterprise Linux 3 AS 64 bit x86
Red Hat Enterprise Linux 3 ES 32 bit x86 | Red Hat Enterprise Linux 3 ES 32 bit x86
Red Hat Enterprise Linux 3 ES 64 bit x86 | Red Hat Enterprise Linux 3 ES 64 bit x86
Red Hat Enterprise Linux 3 WS 32 bit x86 | Red Hat Enterprise Linux 3 WS 32 bit x86
Red Hat Enterprise Linux 3 WS 64 bit x86 | Red Hat Enterprise Linux 3 WS 64 bit x86

The following installation and configuration tasks are required to set up a packaging
server:

« You must first install the ISM Development Kit 2.0 (IDK) on a packaging server by using
the Opsware Command Center (OCC). The packaging server must already be a
managed server.

» You can then configure preferences for a packaging server by using the OCC Client
itself.

The IDK must be installed on the packaging server by using a template in the OCC.
Installing the IDK by using a template also enables the Visual Packager feature. See the
Opsware® SAS ISM Development Kit Guide for more information.

Installing the IDK on a Packaging Server

To install the IDK on a packaging server, perform the following tasks:
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Log into the OCC and click Manage Servers to select a server that you want to
designate as your packaging server.

Figure 9-1: Installing the IDK Using a Template in the OCC

~
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From the Tasks menu, select Install » By Templates. Find the appropriate Visual
Packager template in the Templates » Opsware Tools » Visual Packager »
<platform> Visual Packager node, and then install it. This declares the server that
you selected in Step 1 as your packaging server by installing the IDK on it.

The Templates » Opsware Tools » Visual Packager » <platform> Visual Packager

node contains the platform-specific application node, including the ISMTool service level

node. All nodes up to Visual Packager are customer independent and OS independent.

<platform> is customer independent and OS specific.
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Configuring Options for a Packaging Server

To configure a packaging server, perform the following tasks:
Launch the OCC Client.

H From the Tools menu, select Options.

H nthe Set Options window, select Packaging Servers in the object tree to display a
list of managed servers that already have the IDK installed on them. Not Configured
in the Default Server column indicates that the server has not been set up as a
packaging server for a specific operating system

Figure 9-2: Sample Set Options Window.

eneral 05 Default Server .
Hnmanaged Servers AN 43 Mat Configured Edit.. J[ Clear |~
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Red Hat Enterprize Linux ES 3 ... Mot Configured
Fed Hat Erterprize Linux ES 4 Mot Configured
Red Hat Enterprize Linux ES 4 ... Mot Configured
Fed Hat Erterprize Linux WS . Mot Configured
Red Hat Enterprize Linux WS 3 Mot Configured

Save [ Cancel ] [ Help ]

Bl In the content area, select an operating system and click Edit to display a list of
managed servers for that operating system, or click Clear if you want to remove your
edits.

H nthe Select Server window, select the managed server that you want to configure
as the packaging server and then click Select.
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The Select Server window will be empty if you do not have Read permission to the
Service Level node. To obtain node stack permissions, contact your Opsware
administrator. See the Opsware® SAS Configuration Guide for more information.

In the Set Options window, the Default Server column will now display the IP address
of the server. Before you configured this as the packaging server, the Default Server
column displayed Not Configured.

=
-~ Use the search tool to dynamically filter by entering a server name, IP address,
or operating system.

[ nthe Set Options window, click Save to save your changes or click Cancel to close
this window without saving your changes.

Overview of Packages

A package is installable software that includes server objects that contain applications,
data, documentation, and configuration information for a managed server. These server
objects can be files, directories, other packages and patches, Windows Registry,
Windows Services, and so on. All packages are stored in the Software Repository.

Table 9-2 identifies the types of server objects you can include in a package, according to
the operating system you plan to distribute the package to.

Table 9-2: Objects That Can Be Packaged

Files/Directories Yes Yes
Packages Yes Yes
Patches* Yes Yes
Windows Registry** No Yes
Windows Services No Yes
MTS/COM+ No No
IIS Metabase No No
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*Patches do not apply to Linux operating systems.
** You can package selected Windows registry keys, such as HKEY _CLASSES_ROOQT,
HKEY _CURRENT_CONFIG, HKEY LOCAL_MACHINE, and HKEY USERS.

Different types of server objects can be included in a package. For example, you can
include multiple files, multiple patches, and multiple Windows services in one package.
The IDK creates an installable package of these objects, in the native format of the
operating system, such as Solaris Package for Unix, MSI for Windows, LPP for AIX, Depot
for HPUX, and RPM for Linux.

In addition to selecting server objects that you want included in a package, you can also
select packages and patches that already exist in Opsware SAS.
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Packaging Process

The packaging process consists of several steps. The packaging process collects your
package content, creates a background snapshot of the content, creates an executable
wrapper for it, and then attaches it to an application node in the Software Tree. Figure 9-3
illustrates this workflow.

Figure 9-3: The Packaging Process

VISUAL PACKAGER PROCESS
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- Server the new package.

During the packaging process, a snapshot of your selected package content is
transferred from the source server to the packaging server. This snapshot is used to
create an Intelligent Software Module (ISM). The IDK (which must be installed on the
packaging server) creates an executable wrapper for your package content. See the
Opsware® SAS ISM Development Kit Guide for more information.
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When you create a package, an application node is created in a user-defined, package
location in the Software Tree. Your package is then attached to this node.

Ways to Create a Package

In Visual Packager, you can create a package in several different ways, depending on the
content source. The content of a package is based on any of the following sources:

« An Opsware-managed server

+ Audit results

« A server snapshot

Depending on the content source you select, you can launch the Visual Packager process
from different windows in the OCC Client.

Creating a Package from a Managed Server

You can create a package from a managed server by using the following different
windows in the OCC Client.

In the All Managed Servers window:

From the Navigation pane, select Servers and then select All Managed Servers.
H From the Content pane, select one or more managed servers.

El Select Actions > Create Package.

In the Server Groups window:

From the Navigation pane, select Servers and then select Server Groups.

H From the Content pane, select one or more servers in a server group.

El Select Actions > Create Package.

You cannot create a package for a server group. However, you can create a package for a
server that is in a server group.

In the Server Explorer window:
From the Navigation pane, select Servers and then select All Managed Servers.
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From the Content pane, select a managed server and open it.
From the Server Explorer, select Actions » Create Package.
Or

Select a server object in the object tree, select an object in the content area, and
then select Actions » Create Package. If the object does not exist in the Software
Repository, you will be prompted to provide the source.

Creating a Package from Audit Results

You can create a package from audit results by using the following different windows in
the OCC Client.

In the Server Explorer window:

From the Navigation pane, select Servers and then select All Managed Servers.
H From the Content pane, select a managed server and open it.

From the Server Explorer, select Compliance.

Bl From the Content pane, select the Audit Results tab.

B Select an audit and then select Actions » Create Package.

In the Compliance window:

From the Navigation pane, select Software Library and then select Compliance.
H From the Content pane, select the Audit Results tab.

Select an audit and then select Actions » Create Package.

In the Audit Results window:

From the Navigation pane, select Software Library and then select Compliance.
H From the Content pane, select the Audit Results tab.

Select an audit and then open it.

Bl From the Audit Results window, select Actions » Create Package.

Creating a Package from a Snapshot

You can create a package from a snapshot by using the following different windows in the
OCC Client.
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In the Server Explorer window:
E From the Navigation pane, select Servers and then select All Managed Servers.

H From the Content pane, select a managed server and open it.

E From the Server Explorer, select Compliance.

B From the Content pane, select the Snapshots tab.

B Select a snapshot and then select Actions » Create Package.

In the Snapshot Browser window:

E From the Navigation pane, select Software Library and then select Compliance.
From the Content pane, select the Snapshots tab.

Select a snapshot and then open it.

From the Snapshots Browser window, select Actions » Create Package.
Or

In the object tree, select a server object and right-click. Only objects that were
included in the selection criteria (in the snapshot template) are displayed.

In the Compliance window:
E From the Navigation pane, select Software Library and then select Compliance.

H From the Content pane, select the Snapshots tab.

E Select a snapshot and then select Actions » Create Package.

Creating a Package

You can create installable packages in native formats, such as Solaris Package and MSI.
When you create an installable package, you must specify where you want it uploaded in
the Software Tree. You can create a new application node or add the package to an
existing node in the Software Tree. When you add a package to an existing node in the
Software Tree, the contents of your new application will overwrite the contents of the
existing application node. See the Opsware® SAS Configuration Guide for information
about how to upload packages to and manage packages in the Software Tree.

Optionally, you can assign your package to a customer and specify the operating system
versions that you want this package installed on.
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To create a package, perform the following steps:

From one of the starting points described in “Ways to Create a Package”, select
Create Package.

If you have not already set up your packaging server, a warning icon displays
in the Create Package window. See “Packaging Server Setup” on page 364 in
Chapter 9 for more information.

You must have a set of permissions to manage selection criteria. To obtain these
permissions, contact your Opsware administrator. See the Opsware® SAS Configuration
Guide for more information.
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H In the Create Package window, select the Details tab.

Figure 9-4: Sample Create Package Window (Details Tab)
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HE Next to the Package Location field, click Browse. This is a required field, as indicated

by the asterisk (*). The Specify Application window appears.

Bl In the Specify Application window, specify the location in the Software Tree where
you want to create an application node by completing the following steps:

L‘ﬁ' To navigate back up the hierarchy, modify the Look In field.

1.

hierarchy.

2. Click OK to add the new application node.
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If you enter a new application node name that is identical to a node name that already
A exists in the Software Tree, the contents of your new application will overwrite the
contents of the existing application node.

See the Opsware® SAS Configuration Guide for more information about the
categories used in the top level of the Software Tree.

B In the Customer Assignment field, select one of the following customer types to
assign to your new package:

+ Customer Independent: A global customer in Opsware SAS. Resources
(applications, patches, and templates) that are associated with Customer
Independent can be installed on any managed server, no matter what customer it
is associated with.

* Not Assigned: The servers are not associated with a customer. You can install
applications, patches, or templates that are Customer Independent on Not
Assigned servers. However, you cannot install or use any resources associated
with a customer on a server that is not assigned to a customer.

« Other: The name of this customer assignment varies, because it is created by the
customer and is derived from the customer’'s environment.

If you modify the customer assignment and it does not correspond to the package
N
location that is currently specified, Create Package will instruct you to also change the
package location so that it corresponds to the new customer assignment.

@ Inthe OS field, select one or more operating system versions that you want to install
this package on. The operating systems in this list represent the operating system
family that you previously configured as a packaging server. You can only select from
this list of operating system versions. See “Configuring Options for a Packaging
Server” on page 367 in this chapter for more information.

In the Selections field, select the server objects that you want to include in your
package, such as File System, Installed Packages, Installed Patches, Windows
Services, and so on. If you select installed packages or installed patches that need to
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be added to the Software Repository, Visual Packager will instruct you to select the
Contents tab to perform this task. See “Adding New Package Content” on page 377
in this chapter for more information.

For Windows Services, you are selecting only the state of the service, such as Started,
Stopped, Paused, and so on.

B Click Create to create the package and save it in a new or existing application node
in the Software Tree, or click Cancel to close this window without creating a package.

Adding New Package Content

After you have selected packages, patches, or non-package content, Create Package
examines them to determine if additional information is required. At this point, Create
Package also allows you to pick and choose which packages you want to include or
exclude, and which non-package content objects will be packaged.

To add new package content, perform the following steps:

From one of the starting points described in “Ways to Create a Package”, select
Create Package.
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H In the Create Package window, select the Contents tab.

Figure 9-5: Sample Create Package Window (Contents Tab)
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H nthe “Packages that need to be added to the software repository” section, a list of
packages or patches (previously selected in the Details tab) that the Software
Repository does not have yet is displayed. Create Package requires that you specify
the source location of these packages or patches so that they will be uploaded to the
Software Repository. Without this source information, Create Package cannot create
a package. The following information about these packages is displayed:

+ Name: The name of the package.
« Type: The type of package, such as Sol_Pkg, MIS, RPM, and so on.

+ OS: The operating system the package is intended for.
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+ Action: If the action status is Supply Source, you must specify the location of the
package so that it will be included in the upload process.

You can pick and choose which packages and patches you want to provide source
information for by performing the following steps:

1. To exclude particular packages from the upload process, select one or more
packages and click Skip to exclude them from the upload process. These
packages will not be attached to the application node.

2. Toinclude a package in the upload process, select a package and click Choose
File to locate it in your local file system or in the network file system of the
packaging server. This package will be attached to the application node.

You can also specify the character encoding for the metadata of Unix packages that
are displayed in the “Packages that need to be added to the software repository”
section. Package metadata includes comments, READMEs, scripts, descriptions, and
content lists. Before storing the package internally, Opsware SAS translates the
metadata from the specified encoding into UTF-8. The default encoding is
determined by the source of the package content, either a managed server, server
snapshot, or audit results.

To specify character encoding for Unix package metadata, from the “Package
metadata encoding” list, select a character encoding, such as Shift-JIS for Japanese.
(For Windows packages, the encoding is set to UTF-8.)

In the “Packages that exist in the software repository” section, a list of packages or
patches (previously selected in the Details tab) that currently exist in the Software
Repository is displayed. If you want to overwrite these packages and patches with
different versions, you must provide the source locations of them. Different package
and patch versions are typically ones that you have previously used (and therefore
know) are the ones you need to include in the package.

The following information about these packages is displayed:

+ Name: The name of the package as it appears in the Software Tree.

Type: The type of package as it exists in the Software Tree, such as Sol_Pkg, MIS,
RPM, and so on.

+ OS: The operating system the package is intended for, such as SunOS 5.8.

Action: If the action status is Supply Source, you must specify the location of the
package so that it will be included in the upload process.
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To choose a package or patch that you want to overwrite the version in the Software
Repository, select one and then click Choose File to point to its storage location in
your local file system or in the network file system of the packaging server.

H Inthe “ltems to add to new package that will be created” section, a list of
non-package content (previously selected in the Details tab) is displayed. By default,
Create Package creates a new package that contains all of these items. You can
specify a separate set of options that apply only to these non-package content items,
such as reboot requirements and pre/post install and pre/post uninstall scripts. This
non-package content is considered to be a package that is part of the same
application node that the other packages (packages and patches) are attached to.

The following information about these packages is displayed:

+ Name: The name of the object, such as a directory, file, Windows Registry,
Windows Services, and so on.

« Type: The type of object.

Click Options to display the New Package Options window where you can specify
additional settings for all items in the new package content. Visual Packager enables
Options only if there is additional package content. See “Specifying Options for New
Package Content” on page 380 in this chapter for more information.

B Click Create to attach this new package content to the application node, or click
Cancel to close this window without attaching any new package content to the
application node.

Specifying Options for New Package Content

When you add new package content to a package that you have already created, you can
specify additional settings that apply only to the new package content. These settings
include which customer types this package applies to, whether to reboot after your
package is installed or uninstalled, which pre/post install and pre/post uninstall scripts will
be run, and so on.

To specify options for new package content, perform the following steps:

Follow the instructions in step 5 in “Adding New Package Content” on page 377 to
display the New Package Options window.
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In the New Package Options window, select or enter your preferred options.

Figure 9-6: Sample New Package Options Window
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| .@ | | [o]4 _J | Cancel |

In the Name field, Visual Packager presets the name of the package. However, if
required, you can carefully modify the package name. The following rules apply to
package names:

+ For Solaris packages, the package name must not exceed five characters, such as
123 S.

« For all other types of packages, the package name must not exceed 64 characters,
such as m123acmecomContent_89787. These types of package names are
derived from the source name with the text Content and a 5-digit timestamp
appended to it.

« For all package names, alphanumeric characters and the underscore (_) character
are valid.

This is a required field, as indicated by the asterisk (*).
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Bl Inthe Customer Assignment field, select one of the following customer types you
want to assign to your new package content:

+ Customer Independent: A global customer in Opsware SAS. Resources
(applications, patches, and templates) that are associated with Customer
Independent can be installed on any managed server, no matter what customer it
is associated with.

* Not Assigned: The servers are not associated with a customer. You can install
applications, patches, or templates that are Customer Independent on Not
Assigned servers. However, you cannot install or use any resources associated
with a customer on a server that is not assigned to a customer.

« Other: The name of this customer assignment varies, because it is created by the
customer and is derived from the customer’s environment.

If you modify the customer assignment and it does not correspond to the package
AN
location that is currently specified, Create Package will instruct you to also change the
package location so that it corresponds to the new customer assignment.

H The Source field identifies the name of the source of the package. A package source
can be a managed server, a snapshot, or an audit result. You cannot modify this field.

B nthe Package Type drop-down list, you can only select package formats for Solaris
Package and LPP (for AIX). Create Package presets the package type for all MSI (for
Windows), Depot (for HPUX), and RPM (for Linux) packages.

You must have RPM installed on your packaging server to enable the Visual Packager
A
feature to create an RPM package for Solaris and AIX. The Visual Packager feature does
not verify whether RPM is available on the packaging server.

In the Reboot field, perform any of the following steps:

« Check After Install to specify that the server will be rebooted after your package is
installed. The default is an unchecked reboot option.

« Check After Uninstall to specify that the server will be rebooted after your package is
uninstalled. The default is an unchecked reboot option.
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Reboot settings are saved in the Model Repository.

B nthe “Encoding of scripts” list, select a character encoding, such as Shift-JIS for
Japanese.

This encoding applies to the contents of the pre/post install and pre/post uninstall
scripts when they are deployed on a managed server. The default encoding is
determined by the source of the package content. Before installing the package on a
managed server, Opsware SAS converts the scripts into the specified encoding.
Internally, Opsware SAS stores the scripts in UTF-8.

For Linux, if a script contains non-ASCII characters, then include the shell execution
command (such as #! /bin/sh) at the beginning of the script.

El In pre/post install and pre/post uninstall scripts section, you can perform any of the
following actions:

+ To specify that a script is run before the package is installed, enter the Pre-install
Script or click Edit to enter the script in the Specify Post-install Script window.

+ To specify that a script is run after the package is installed, enter the Post-install
Script or click Edit to enter the script in the Specify Post-install Script window.

+ To specify that a script is run before the package is uninstalled, enter the
Pre-uninstall Script or click Edit to enter your script in the
Specify Pre-uninstall Script window.

+ To specify that a script is run after the package is uninstalled, enter the
Post-uninstall Script or click Edit to enter your script in the
Specify Post-uninstall Script window.

Pre/post install and pre/post uninstall scripts are stored in the Model Repository.

Create Package cannot verify that a script will successfully execute. Opsware, Inc.
A recommends that you test all scripts before you add them as package options.

Click OK to save your new package options, or click Cancel to close this window
without saving your new package options.
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Viewing Package Details

You can use the Job Manager in the OCC Client to review the following information about
your package process:

- Job ID, start and end time, the name of the packaging server, the status of the
packaging process, and so on.

+ Log details about the package creation process, such as error descriptions.
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This section discusses the following topics:
+ Overview of Global Shell

* Remote Terminal

+ Global Shell Session

» Opsware Global File System (OGFS)

+ Directories in the OGFS

« Server Filtering in the OGFS

+ Remote Opsware Shell (rosh)

« Character Encoding for OGFS

+ Error Messages

Overview of Global Shell

The Opsware Global Shell feature enables you to remotely perform the following tasks:
« Complete routine maintenance tasks on managed servers.
« Troubleshoot, identify, and remediate problems on managed servers.

The Global Shell consists of a file system and a command-line interface to that file system
for managing servers in Opsware SAS. The file system is known as the Opsware Global
File System (OGFS). All object types in the OGFS (such as servers, customers, and
facilities) are represented as directory structures in this file system. Global Shell enables
you to manage user permissions for accessing the file system, Windows Registry, and
Windows Services objects on managed servers, and it provides an audit trail that records
the events performed on managed servers. Opsware SAS also provides recommended
scripts that you can run from the Global Shell interface; for more information on these
scripts see
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Remote Terminal

The Remote Terminal feature opens a terminal window for each selected Unix server or an
RDP client window for each selected Windows server.

You must have login permissions on the managed server to use this feature. See the
N
Opsware® SAS Configuration Guide for more information.

In the OCC Client, the Remote Terminal feature is accessible from the Server list and
Server Explorer windows. In the Server list window, select a managed server and select
Remote Terminal. In the Server Explorer, to access the File System, Windows Services,
and Windows Registry nodes of a managed server, you must first select a node, and then
right-click and select a valid user group, such as root, Administrator, or LocalSystem.

You can specify your terminal and RDP client preferences for a Remote Terminal or Global
Shell session, such as telnet for a Windows terminal, xterm for a Unix terminal,
rdesktop for an RDP client, and so on, in the Set Preferences window. See “Terminal
and Shell” on page 110 in Chapter 3 for more information.

Opening a Remote Terminal

The type of remote terminal you open for a managed server depends on the operating
system of the server. For a Unix server, a terminal window is opened. For a Windows
server, an RDP session is opened. (You cannot login to a remote terminal with a user
name or password that contains multi-byte characters.)

For a Unix Server:
You can open a terminal window for a Unix server from the Server list window and from
the Server Explorer.

In the Server list window, perform the following steps:

Launch the OCC Client. From the Navigation pane, select Servers and then select
Managed Servers.

HA Select a managed Unix server.
E From the Actions menu, select Remote Terminal.

In the Server Explorer (for a Unix server), perform the following steps:
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E Launch the OCC Client. From the Navigation pane, select Servers and then select
Managed Servers.

Select a managed Unix server. Open it. The Server Explorer window opens.

Select File System in the object treg, right-click, and then select a login name (such
as root or Administrator). See the Opsware® SAS Configuration Guide for more
information.

B Select Actions » Remote Terminal.
For a Windows Server:

You can open an RDP session for a Windows server from the Server list window and from
the Server Explorer.

In the Server list window, perform the following steps:

E Launch the OCC Client. From the Navigation pane, select Servers and then select
Managed Servers.

H Select a managed Windows server.
HE Select a Windows server, and then select Actions » Remote Terminal.
In the Server Explorer (for a Windows server), perform the following steps:

Launch the OCC Client. From the Navigation pane, select Servers and then select
Managed Servers.

H Select a managed Windows server. Open it. The Server Explorer window opens.

Select File System in the object tree, right-click, and then select a login name (such
as LocalSystem). See the Opsware® SAS Configuration Guide for more information.

Bl Select Actions » Remote Terminal.

Global Shell Session

The Global Shell feature enables you to open a terminal window for the OGFS in Opsware
SAS.
Opening a Global Shell Session

You can open a Global Shell session with an ssh client or from within the OCC Client.
When you open a session, the working directory is /home/user-name.
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To open a Global Shell session with an ssh client, perform the following steps:

On a host that is not an Opsware core server or a managed server, open a terminal
window.

H In the terminal window, enter an ssh command with the following syntax:
ssh -p 2222 user-name@ogfs-host

To use this command, port 2222 must be open on the firewall that protects the OGFS
server. The user-name is your Opsware user and the ogfs-host is the host name (or
IP address) of the core server running the OGFS. After you enter the ssh command,
the OGFS prompts for the password of the Opsware user.

To open a Global Shell session from within the OCC Client, from the Actions menu,
select Global Shell.

Copying Files To and From the OGFS

You can securely copy files between the OGFS and a server that is not part of Opsware
SAS. To copy the files, perform the following steps:

On a host that is not an Opsware core server or a managed server, open a terminal
window.

A In the terminal window, enter either the scp, sftp, or rsync command and specify
port 2222, your Opsware user name, and the host running the OGFS.

The following three scp examples perform the same operation: They copy the file
myscript.sh from the local machine to the file /home/jdoe/myscript.sh in the
OGFS. The Opsware user is jdoe and the host running the OGFS is 192.168.166.178.

scp -P 2222 myscript.sh jdoe@192.168.166.178:myscript.sh
scp -P 2222 myscript.sh jdoe@192.168.166.178:/home/jdoe
scp -P 2222 myscript.sh jdoe@192.168.166.178:

The following example copies myscript . sh from the home directory of jdoe in the
OGFS to the local machine:

scp -P 2222 jdoe@192.168.166.178:myscript.sh myscript.sh

The following sftp example copies myscript . sh from the local machine to the OGFS:

sftp -oPort=2222 jdoe@192.168.166.178
Connecting to 192.168.166.178...

Opsware Global Shell
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jdoe@opsware's password:
sftp> put myscript.sh

The following rsync example transfers files from /path on the local machine to
/other/path in the OGFS:

rsync -av -e "ssh -p 2222" /path \
jdoe@192.168.166.178:/other/path

Opsware Global File System (OGFS)

The OGFS is a tree hierarchy of directories and files (objects) on all managed servers in
Opsware SAS. The structures of these directories range from a list of objects to a
hierarchical structure of objects, which can contain lists of related objects. To optimally
navigate through the OGFS to get to a destination of your choice it is important to
understand these directory structures.

The following example illustrates how to search a directory that contains a hierarchical
structure of different types of related objects:

To find all servers that are associated with facilities and customers, specify the following
path to search the Server directory:

$ 1ls /opsw/Server/@/
With regard to a destination of your choice, the Opsware Global Shell feature recognizes
that you may not always be searching for a server. Therefore, hierarchical directory
structures allow you to search by a variety of object types.

When you add or edit server custom attributes in the Opsware Global File System (using
Global Shell), Opsware SAS preserves leading and trailing whitespace characters in
custom attribute values.
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Directories in the OGFS

The following directories in the OGFS are best explained by structure diagrams and
supporting text:

« root Directory

« opsw Directory

« Facility Directory

» Group Directory

« Server Directory

+ Script Directory

+ Application Directory
+ Customer Directory
« OS Directory

* Realm Directory

+ Servicelevel Directory

Diagram Conventions

The structure diagrams use the following typographical and formatting conventions, as
shown in Table 10-1.

Table 10-1: Opsware Global File System (OGFS) Diagram Conventions

Times The name of the object type as it appears in the OGFS, such
as bin, Group, Facility, Server, Customer, and so on.

Courier An object in the OGFS that is user-defined, such as
server-1l-name, group-1l-name, facility-1-name,

custom-attribute-1-name, and so on.

Courier Italics A brief description of the corresponding object and its
relationship to other objects in the OGFS. Used only in the
Server directory diagram.
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root Directory

At the root level of the OGFS is a directory for each Opsware user. Each user directory
and all files and directories under it are visible only to processes in an authenticated
session. Figure 10-1 illustrates the root directory structure.

Figure 10-1: root Directory

/ (root)
— bin
— dev
— etc
— home
— lib

— opsw
— proc
— sys
— tmp
— usr
— var

Each Opsware user has the following private directories:
+ A home directory which is at /home/user-name (Opsware user name)
« Temporary directories which are at /tmp, /var/tmp and /usr/tmp

Each user's home directory contains a public directory (/home/user-name/public)
which is readable by all other Opsware users and can be used to share files with other
Opsware users.

opsw Directory

The opsw directory is also known as the Opsware model space. The Application,
Customer, Facility, Group, OS, Realm, Script, Server, and ServiceLevel
directories represent objects in the Opsware Model Space. Applications can navigate
through this model space. The bin directory contains only Opsware SAS programs.
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Figure 10-2 illustrates the structure of the opsw directory.
Figure 10-2: opsw Directory

/opsw

— bin

— Application
— Customer
— Facility

— Group

— OS

— Realm

— Script

— Server

L ServiceLevel

Facility Directory

The Facility directory contains a list of facilities and facility details. Figure 10-3
illustrates the structure of the Facility directory.

Figure 10-3: Facility Directory

/opsw/Facility
— facility-1-name

L@

id
info
CustAttr

custom-attribute-1-name
— custom-attribute-2-name

— facility-2-name
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Group Directory

The Group directory contains Public and Private user groups, user group details
(where @ represents the group itself), child groups, and grandchild groups. This structure
essentially contains groups within groups. Figure 10-4 illustrates the structure of the
Group directory.

Figure 10-4: Group Directory

/opsw/Group

— Public

— group-1l-name
— @

id
info
CustAttr

custom-attribute-1-name
— custom-attribute-2-name

—child-group-1-name
@

grandchild-group-1-name

—e

grandchild-group-2-name

—child-group-2-name

— group-2-name

— Private

— group-1l-name

B3

— child-group-1-name

@
grandchild-group-1-name

-@

grandchild-group-2-name

—child-group-2-name

— group-2-name

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2006 Opsware Inc. All Rights Reserved.

393



Opsware® SAS 5 User’s Guide

394

Server Directory

The server directory contains all managed servers and different types of related objects.
To optimally navigate this directory and find servers by group, by facility, by customer, and
SO 0N, you can use a server filter. See “Server Filtering in the OGFS” on page 400 in this
chapter for more information.

Figure 10-5 illustrates the structure of the Server directory.

There are lower server directories (such as server-1-name, server-2-name, and SO
on) within the top-level server directory. When you modify files in the lower directories,
you do so as a specific user (such as Iogin-1-name). Modifying files includes the
adding, deleting, and editing actions.

Text in parentheses in (Courier Italics) denotes a brief description of the
corresponding object and its relationship to other objects in the OGFS.
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Figure 10-5: Server Directory

/opsw/Server
— @ (all servers)
— server-1l-name
—.id
— info
— CustAttr
custom-attribute-1-name
custom-attribute-2-name
— files
— login-1-name
(server-1 filesystemas seen by login-1)
— login-2-name
(server-1 filesystemas seen by login-2)
— registry
— login-1-name
(server-1registry as seen by login-1)
— login-2-name
(server-1registry as seen by login-2)

— server-2-name

— @Group

—group-1l-name

@ (all servers in group-1)

— server-1l-name

child-group-1-name

— @ (all servers in child-group-1)
‘L server-1l-name

@Facility

— facility-1-name

!» @ (all servers in both group-1 and facility-1)
— server-1l-name

—facility-2-name

— group-2-name
— @Facility
—facility-1-name
@ (all serversin facility-1)
— server-1l-name
@Group
group-1l-name
:L @ (all servers in both group-1 and facility-1)
— server-1l-name

group-2-name

—facility-2-name

— @Application
— @Customer

— @0s

— @Realm

— @ServiceLevel
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Script Directory

The Script directory contains a list of shared scripts and script details. Figure 10-6
illustrates the structure of the Script directory.

Figure 10-6: Script Directory

/opsw/Script
"~ Shared

script-1l-name
description
policy
source
version

script-2-name
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Application Directory

The Application directory contains applications, application details, child applications,
and grandchild applications. This directory structure is similar to the application node
hierarchy in the Software Tree. Figure 10-7 illustrates the structure of the Application
directory.

Figure 10-7: Application Directory

/opsw/Application
— Application Servers

—application-1-name
— @

id
info
CustAttr

custom-attribute-1-name
— custom-attribute-2-name

—child-application-1-name
@

grandchild-application-1-name

~e

grandchild-application-2-name

—child-application-2-name

—application-2-name

— Database Servers
‘L application-1l-name

— Operating System Extras
—application-1-name

— Other Applications
—application-1-name
— System Utilities
—application-1-name

— Web Servers
‘L application-1-name
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Customer Directory

The Ccustomer directory contains a list of customers and customer details. Figure 10-8
illustrates the structure of the Customer directory.

Figure 10-8: Customer Directory

/opsw/Customer
— customer-1-name
L e
id
info
CustAttr
custom-attribute-1-name

: custom-attribute-2-name

— customer-2-name

OS Directory

The 0s directory contains a list of operating systems and operating system details.
Figure 10-9 illustrates the structure of the 0s directory.

Figure 10-9: OS Directory.

/opsw/OS
— os-1l-name-version
— Not Assigned
L@
ad
info
CustAttr
custom-attribute-1-name
— custom-attribute-2-name

—os-definition-1-name
L@
id
info
CustAttr
custom-attribute-1-name
: custom-attribute-2-name

— os-definition-2-name

— os-2-name-version
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The Realm directory contains a list of realms and realm details. Figure 10-10 illustrates
the structure of the Realm directory.

Figure 10-10: Realm Directory

/opsw/Realm
realm-1-name

L@

N

id
info

realm-2-name

ServicelLevel Directory

The ServiceLevel directory contains service levels, service level details, service level
children, and service level grandchildren. Figure 10-11 illustrates the structure of the
Service Level directory.

Figure 10-11: ServicelLevel Directory

/opsw/ServiceLevel

— @

— servicelevel-1-name

id

info

CustAttr
custom-attribute-1-name

; custom-attribute-2-name

—child-servicelevel-1-name

@

grandchild-servicelevel-1-name

-

grandchild-servicelevel-2-name
— child-servicelevel-2-name

— servicelevel-2-name
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Server Filtering in the OGFS

As you navigate down the OGFS tree, the path grows longer and more specific—where
fewer servers are visible in the Server directory. In the OGFS, the /opsw directory
contains subdirectories for several types of objects in the Opsware model space, such as
Server, Group, Facility, 0S, Application, Customer, and So on.

In the Global Shell interface, you can filter your view of these object types in the Server
directory by specifying an axis (@) in the path. A path in the Opsware model space can be
a list of filtering criteria that selects objects of a given type. This path begins with the
desired object type, such as /Server, and each filtering criteria begins with an @, such as
@Customer. An ending @ denotes the end of the filtering criteria.

Figure 10-12 is graphical representation of related objects (customers and facilities) in a
hierarchical Server directory. The small boxes represent managed servers. Examples of
ways that you can filter this directory immediately follow the diagram.

Figure 10-12: Filtering in the Server Directory
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Based on Figure 10-12, the following examples illustrate ways to narrow your search for
servers:

« To find all 16 servers, specify the following path:
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$ 1ls /opsw/Server/e@

« To find servers in the Atlanta facility, specify the following path:

$ 1ls /opsw/Server/@Facility/Atlanta/e@

+ To find servers that belong to customer Alpha, specify the following path:

$ 1ls /opsw/Server/@Customer/Alpha/@
« To find servers in the Atlanta facility that belong to customer Alpha, specify either of the

following paths:

$ 1ls /opsw/Server/@Facility/Atlanta/@Customer/Alpha/@
$ 1ls /opsw/Server/@Customer/Alpha/@Facility/Atlanta/@

The following paths are filtered away by the OGFS, because they would yield a dead-end.

There are no servers belonging to customer Gamma in the Atlanta facility.

$ 1ls /opsw/Server/@Facility/Atlanta/@Customer/Gamma/@
$ 1ls /opsw/Server/@Customer/Gamma/@Facility/Atlanta/@

This same filtering logic can be applied to @Realm, @Group, and @Application.

Remote Opsware Shell (rosh)

The Remote Opsware Shell (rosh) command makes a client connection that enables
you to remotely run programs on managed servers. You invoke the rosh command from
within a Global Shell session. The rosh command has the following syntax:

rosh (-n server-name | -i server-id) [-d dir] [-1 login-name]
[-s] [-t | -T] [command [arg ...]]

Table 10-2 describes the rosh options.

Table 10-2: rosh Options and Commands

-d dir Sets the working directory (path) on the remote server. The
default is the remote user's home directory.

-1 gerver-id Specifies the server by its ID, which must already exist in the
/opsw/ .Server. ID directory.
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Table 10-2: rosh Options and Commands (continued)

-1 login-name | Specifies the login name of the remote user who performs
operations on a remote server, which must already exist in the
/opsw/Server directory.

-n server-name Specifies the server by its name, which must already exist in
the /opsw/Server directory.

-r Relays RDP data to a managed server (on Windows).

-s script-name Treats a command as the name of a saved script that will be
sent to and run on the remote server.

-t Forces the remote session to run in a pseudo terminal (for
Unix servers only).

-T Forces the remote session to run without a pseudo terminal
(for Unix servers only).

command Runs a program or saved script.
[args . . .]

The following usage rules apply to the rosh program:

» Specify either the -n or -i option to log into or run programs on a managed server.
These options are mutually exclusive, but if both are specified the -1 option has
precedence.

« If neither the -n, -1, and id options are specified, the managed server can be
inferred if your working directory is at or below:

/opsw/Server/.../server-name/

Or
/opsw/ .Server.ID/server-1id/
« If -r is specified, no other option (excluding -n or -1i) can be specified.

« If -1 is not specified, the login-name can be inferred if your working directory is at or
below:

/opsw/Server/.../server-name/files/login-name/

Or
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/opsw/ .Server.ID/server-id/files/login-name/

+ If -s is specified and command is a saved shared script with a setuid policy, the
login-name specified by the -1 option will be overridden. In this case, the -1 option
may be omitted. These scripts are stored in /opsw/Script/Shared.

« If your working directory is not below server/files/login-name and -4 is not
specified, the cwdpath defaults to the home directory for login-name. To default to
the home directory, you must specify - 1.

rosh Operations

The rosh command establishes a client connection which enables you to remotely run
programs on managed servers. The Opsware Global Shell feature provides the following
modes of operation for rosh:

« jump: This operation starts a shell session in a pseudo-terminal on a managed server.
This mode operates when you do not use the -s option and when you do not specify a
command or a script. You must have the 1loginToServer permission on the
managed server to jump.

« reach: This is a remote execution of commands that are native to the operating system
of the managed server. This mode operates when you specify a command. You must
have the runCommandOnServer permission on the managed server to reach.

« push: This is a remote execution of a script on a managed server. The script is stored in
the OGFS and is sent to the managed server by rosh. Depending on the type of script,
the following permissions may be required:

+ For shared saved scripts, which are stored in /opsw/Script/Shared, you can
require the runTrustedOnServer permission on the managed server or other
permissions that are specified by the policy of the script.

+ For any other script file, you must have the runCommandOnServer permission on
the managed server.

The following examples illustrate what these operations look like for an Opsware user
named psi at the path:

/opsw/Server/@/salish.snvl.corp.opsware.com/files/root/etc

[psi@mle8 etc] (538) $ uname -n; id; pwd
mlé68.dev.opsware.com

uid=59796 (psi) gid=59796 (psi) groups=59796 (psi)
/opsw/Server/@/salish.snvl.corp.opsware.com/files/root/etc

Opsware Inc. Confidential Information: Not for Redistribution. Copyright © 2000-2006 Opsware Inc. All Rights Reserved.

403



Opsware® SAS 5 User’s Guide

The rosh jump command would display the following information about the managed
server:

[psi@mlée8 etc] (539) $ rosh

[root@salish etcl]l# uname -n; id; pwd
salish.snvl.corp.opsware.com

uid=0 (root) gid=0 (root)

groups=0 (root) , 1 (bin), 2 (daemon),3(sys), 4 (adm), 6 (disk), 10 (wheel)
,12(mail), 7(1lp),4 (adm), 9 (kmem) , 6 (disk),5(tty),3(sys), 2 (daemon) ,
8 (mem)

/etc

[root@salish etcl# logout

The rosh reach command displays the following information about the managed server:

[psi@mlée8 etc] (541) $ rosh "uname -n; id; pwd"
salish.snvl.corp.opsware.com

uid=0 (root) gid=0 (root)

groups=0 (root) , 1 (bin), 2 (daemon),3(sys), 4 (adm), 6 (disk), 10 (wheel)
,12(mail), 7 (1lp) , 4 (adm), 9 (kmem), 6 (disk) ,5(tty),3 (sys), 2 (daemon),
8 (mem)

/etc

The rosh push command displays the following information about the managed server:

[psi@eml168 etc] (544) $ cat /tmp/who.sh

#!/bin/sh
uname -n
id
pwd

[psi@eml168 etc] (543) $ rosh -s /tmp/who.sh
salish.snvl.corp.opsware.com

uid=0(root) gid=0 (root)

groups=0 (root) ,1(bin), 2 (daemon) , 3 (sys),4 (adm),6 (disk),10 (wheel)
,12(mail), 7(1lp), 4 (adm), 9 (kmem) , 6 (disk),5(tty),3(sys), 2 (daemon) ,
8 (mem)

/etc

Character Encoding for OGFS

To support international environments, the OGFS can display information in different
character encodings such as Shift-JIS (Japanese) and EUC-KR (Korean). You can control
the encoding of Global Sessions in the following ways:

+ To specify the encoding of your Global Shell sessions, in the Terminal and Shell
Preferences of the OCC Client, select an item from the Encoding drop-down list.
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» To change the encoding of an active Global Shell session, run the swenc command
with the -e option.

If you change the encoding of an active session, you must also change the encoding of
the terminal application for that session. This procedure varies according to the terminal
application.

Terminal Application Configuration

The terminal application that is hosting a Global Shell or Remote Terminal session must
be configured to use the same encoding expected by the session. If the encodings do
not match, the data might be displayed incorrectly.

When the OCC Client launches the terminal application, it composes the command
specified by the Terminal Client field in the Terminal and Shell Preferences. If the Terminal
Client field includes the %e substitution variable, the OCC Client replaces %e with an
encoding name. For Global Shell sessions, this encoding name is specified by the
Encoding field of the Terminal and Shell Preferences. For Remote Terminal sessions, this
encoding name is the value of the Encoding field in the Properties section of the Server
Explorer. If the terminal application does not support the encoding that replaces the %e
variable, or if the %$e variable is not specified, you must change the encoding manually in
the terminal application after it starts.

Data that Cannot Be Displayed

Data that cannot be displayed might be from a managed server (such as the contents of
files) or it might be the name of an object in the Opsware model. If the session’s
encoding does not support the data to be displayed, the data often appears as question
marks. (However, it might appear as other characters such as exclamation points.) The
session attempts to display this data with the current encoding. Usually, this data cannot
be accessed. To access this data, select a compatible encoding for the session.

Objects in the Opsware model, such as Facility and Server, appear as file names in the
OGFS. If these file names contain characters that cannot be represented by the encoding
of the session, they are displayed as question marks, appended by the Opsware ID of the
object. In the following example, the IDs are 10002 and 11002:

New York

Paris
Montr?al~10002
??2~11002
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If the model object does not have an ID, such as a custom attribute, then the session
attempts to display the name with the current encoding.

swenc Command (Switching Character Encoding)

The swenc command enables you to change the character encoding within a Global
Shell session. The swenc command has the following syntax:
swenc [-e encoding] [-T {on | off}] [-E] [-x] [-c command]

Table 10-3 describes the swenc options.

Table 10-3: swenc Options

-¢ command Executes command and exits, reverting
the session encoding to its previous state.

-E Lists the valid character encodings.

-e encoding Changes the character encoding of the
current session.

-T {on | off} Turns on or off the transcoding of data from
the Unix managed server. (Data from Win-
dows servers does not need to be
transcoded.) See “Transcoded Data in a
Managed Server” on page 408 in this
chapter for more information.

-x Prevents the launching of a sub-shell.

The following usage rules apply to the swenc utility:

« If you specify no options, swenc displays the character encoding and transcoding
mode of the current session.

+ Unless you specify the -x option, swenc starts a new sub-shell, which uses the
encoding specified with the -e option. To leave the sub-shell and revert to the previous
encoding, enter exit.

« Changing the encoding with swenc affects all processes in the current session,
including background processes. If you change the encoding while background
processes are running, the background processes might encounter errors.
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+ The swenc command affects only the current Global Shell session. For example, if you

run the rosh command after the swenc -e command, the rosh command does not
inherit the encoding that you changed with the swenc command.

+ The swenc command does not change the working directory of the session, unless the

working directory contains path names that cannot be represented in the new
encoding. In this case, the working directory is the user's home directory.

If you change the character encoding, make sure that the encoding of the terminal
application that hosts the Global Shell and Remote Terminal sessions is set properly. To
view or change the terminal client, go to the Terminal and Shell Preferences of the OCC
Client.

LANG and LC_CTYPE Environment Variables

Many Unix commands (such as 1s) rely on the character encoding, which is determined
by the LANG or LC_CTYPE environment variables. In a Global Session, if the encoding is
changed with the swenc command, the system attempts to reset these variables.

Opsware SAS determines the new value of the LANG variable with the following process:

The value of LANG is generated by combining the language of the user’s profile in
the Opsware Command Center with the current session encoding. For example, if
the language is English and the session encoding is UTF-8, LANG is set to en_
US.utf8.

The value determined by the preceding step is compared with the set of valid locales
on the OGFS server (according to the output of locale -a). If the value is a valid
locale, LANG is set to this value.

If the value is not a valid locale, the system attempts to find a valid locale that
specifies the user’s language without the encoding. For example, if the user’s
language is English and the session encoding is EUC-JP, and this combination does
not form a valid locale, LANG is set to en_US. If no matching locale is found, LANG is
left unspecified.

The new value of the LC_CTYPE variable is determined in the following order:

Opsware SAS attempts to find a valid locale that matches the session encoding,
regardless of the language.

If a valid locale is found, LC_CTYPE is set to this locale. For example, if the session
encoding is EUC-JP, the LC_CTYPE variable is set to ja_JP.eucjp.
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B If no matching locale is found, LC_CTYPE is left unspecified.

Bl If Opsware SAS cannot set the LANG or LC_CTYPE variables with the preceding
process, you should set them manually.

Transcoded Data in a Managed Server

Transcoding is the conversion of data from one character encoding to another. Opsware
SAS automatically transcodes some of the data between Global Shell sessions and other
sources of data. For example, the file names of managed servers are transcoded, but the
contents of the files are not. To see which data is transcoded, see Table 10-4. To display
the transcoding mode of the current Global Shell session, enter the swenc command
with no options.

Table 10-4: Data Transcoded for Global Shell Sessions

Objects in the Opsware model space, such | Between UTF-8 and the session encoding.
as Facility, Customer, and Server.

These objects are stored in the Opsware

Model Repository (database) in UTF-8.

File and directory names of managed
servers.

Meta-data of managed servers, such as
user names and registry key names.

File contents of managed servers.

Contents of Windows registries, services,
COM objects, and IIS metabases.

rosh: Contents of saved scripts executed
on managed servers (a rosh push
operation).

rosh: Ad-hoc scripts executed on man-
aged servers.

rosh: Command-line arguments to pro-
grams executed on managed servers.

Between the managed server encoding
and the session encoding.

Between the managed server encoding
and the session encoding.

None

None

None

None

None
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Table 10-4: Data Transcoded for Global Shell Sessions

rosh: Data streams (such as stdin and None
stdout) of programs executed on managed
servers.

rosh: Data streams of rosh jump None
operations.

OGFS home, tmp, and var/tmp None
directories.

Disabling the Transcoding of Managed Server Data

On Unix servers, file and directory names can contain characters in arbitrary encodings.
When accessed through the OGFS, file and directory names are transcoded by Opsware
SAS. If the encoding of the names does not match the default encoding of the managed
server, the transcoded data might be unusable.

You can disable transcoding with the swenc command. To turn transcoding on or off, use
the -T option:

swenc -T {on | off}
If transcoding is disabled, file and directory names are passed unmodified from the
managed servers. Therefore, you must manually configure the encoding of the terminal
application to display the names correctly.

Windows servers store their file system data internally in the UTF-16 encoding. Because
the encoding is known, transcoding is performed correctly and does not need to be
disabled. Therefore, the -T option of the swenc command has no effect on Windows
servers.
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Error Messages

The Global Shell feature provides the file system error messages that are described in

Table 10-5

Table 10-5: Global Shell Errors

Input/output error

Operation not permitted.

Permission denied.

RFS Specific error
<ns1:XMLFault xmlns:ns1="http://cxf.apache.org/bindings/xformat"><ns1:faultstring xmlns:ns1="http://cxf.apache.org/bindings/xformat">java.lang.OutOfMemoryError: Java heap space</ns1:faultstring></ns1:XMLFault>